
Infor Back Office Connect
Administration Guide



Copyright © 2017 Infor

Important Notices
The material contained in this publication (including any supplementary information) constitutes and
contains confidential and proprietary information of Infor.

By gaining access to the attached, you acknowledge and agree that the material (including any
modification, translation or adaptation of the material) and all copyright, trade secrets and all other
right, title and interest therein, are the sole property of Infor and that you shall not gain right, title or
interest in the material (including any modification, translation or adaptation of the material) by virtue
of your review thereof other than the non-exclusive right to use the material solely in connection with
and the furtherance of your license and use of software made available to your company from Infor
pursuant to a separate agreement, the terms of which separate agreement shall govern your use of
this material and all supplemental related materials ("Purpose").

In addition, by accessing the enclosed material, you acknowledge and agree that you are required to
maintain such material in strict confidence and that your use of such material is limited to the Purpose
described above. Although Infor has taken due care to ensure that the material included in this publication
is accurate and complete, Infor cannot warrant that the information contained in this publication is
complete, does not contain typographical or other errors, or will meet your specific requirements. As
such, Infor does not assume and hereby disclaims all liability, consequential or otherwise, for any loss
or damage to any person or entity which is caused by or relates to errors or omissions in this publication
(including any supplementary information), whether such errors or omissions result from negligence,
accident or any other cause.

Without limitation, U.S. export control laws and other applicable export and import laws govern your
use of this material and you will neither export or re-export, directly or indirectly, this material nor any
related materials or supplemental information in violation of such laws, or use such materials for any
purpose prohibited by such laws.

Trademark Acknowledgements
The word and design marks set forth herein are trademarks and/or registered trademarks of Infor and/or
related affiliates and subsidiaries. All rights reserved. All other company, product, trade or service
names referenced may be registered trademarks or trademarks of their respective owners.

Publication information

Release: Infor Back Office Connect (Version 10.8)

Publication Date: September 28, 2017



Contents

About this guide............................................................................................................13
Intended audience...................................................................................................................................13
Related documents..................................................................................................................................13

Registering to receive Infor Back Office Connect knowledge base e-mail updates............................14
Contacting Infor.......................................................................................................................................14

Chapter 1: Introduction................................................................................................15
Product overview.....................................................................................................................................15
Infor Back Office Connect applications....................................................................................................16
Infor Back Office Connect documentation...............................................................................................16
Navigation and user interface..................................................................................................................17

Chapter 2: Preparing for the Infor Back Office Connect installation.......................19
Pre-installation tasks checklist.................................................................................................................19

Retrieving your Salesforce.com organization ID..................................................................................19
Getting Infor Back office Connect logical ID and ION tenant information from Infor............................20
Enabling multiple currencies................................................................................................................21
Creating Infor Back Office Connect profiles.........................................................................................21
Creating required Infor Back Office Connect users.............................................................................24
Enabling quotes...................................................................................................................................27
Enabling social networks for accounts and contacts...........................................................................27

Chapter 3: Infor Back Office Connect installation.....................................................29
Installation tasks checklist.......................................................................................................................29

Purchasing the Infor Back Office Connect app from the Salesforce AppExchange............................29
Installing Infor Back Office Connect.....................................................................................................29
Confirming the Infor Back Office Connect package installation...........................................................30

Chapter 4: Infor Back Office Connect configuration.................................................33
Key configuration concepts......................................................................................................................33

Recommended Inbound Batch Scope values for initial data load........................................................33
Understanding price books..................................................................................................................34
Understanding unit group processing in Infor Back Office Connect....................................................34
Understanding many-to-many configuration settings...........................................................................36

Post-installation tasks checklist...............................................................................................................39
Enabling feed tracking for sync failure notifications.............................................................................40
Configuring the Infor Back Office Connect application for ERP integration.........................................40

Infor Back Office Connect Administration Guide | 3

Contents



Configuring multiple currencies............................................................................................................58
Enabling history tracking for standard objects.....................................................................................59
Performing the initial data load............................................................................................................59
Publishing code definitions from ERP..................................................................................................60

Configuring reports..................................................................................................................................61
Disabling reports for custom objects (optional).......................................................................................62
Creating and modifying page layouts for an Infor Back Office Connect read only user (optional)..........62

Creating an Infor Back Office Connect read only account page layout...............................................62
Removing new buttons from account-related lists on the read only account page layout...................63
Creating an Infor Back Office Connect read only contact page layout................................................64
Removing new buttons from contact-related lists on the read only contact page layout.....................64
Creating an Infor Back Office Connect read only bill-to page layout...................................................65
Removing new buttons from bill-to related lists on the read only bill-to page layout...........................66
Creating an Infor Back Office Connect read only pay-from page layout..............................................67
Removing new buttons from pay-from related lists on the read only page layout...............................67
Creating an Infor Back Office Connect read only ship-to page layout.................................................68
Removing new buttons from ship-to related lists on the read only page layout...................................69

Eliminating optional master data dependency.........................................................................................69
Address line validation rules (optional)....................................................................................................70

Account and contact object address line validation rules....................................................................71
Bill-to, pay-from, and ship-to object address line validation rules........................................................72

Chapter 5: Infor Back Office Connect customization................................................73
Understanding the reasons for customizing Infor Back Office Connect..................................................73
Understanding the Infor Back Office Connect objects used to modify default BOD XML documents.....74
Overview of Infor Back Office Connect BOD mapping documents.........................................................74
Viewing inbound messages.....................................................................................................................75

Modifying the BOD XML for an inbound message...............................................................................77
Modifying outbound messages................................................................................................................77

Modifying the BOD XML for an outbound message.............................................................................78
Customizing Infor Back Office Connect...................................................................................................79

Customizing inbound messages..........................................................................................................80
Customizing outbound messages........................................................................................................89
Configuring conditional outbound message processing......................................................................92

Working with Infor Back Office Connect BOD objects.............................................................................94
Marking inbound messages for reprocessing......................................................................................94
Marking outbound messages for reprocessing....................................................................................95
Viewing BOD type names....................................................................................................................96
Viewing the BOD type version number................................................................................................96
Updating the BOD Version ID or BOD Release ID..............................................................................97
Viewing BOD field mappings in Infor Back Office Connect..................................................................97
Viewing BOD entity mappings in Infor Back Office Connect................................................................99

4 | Infor Back Office Connect Administration Guide

Contents



Viewing inbound messages in Infor Back Office Connect.................................................................100
Viewing outbound messages in Infor Back Office Connect...............................................................101
Viewing outbound transactions in Infor Back Office Connect............................................................102
Viewing the configured BOD message sources.................................................................................102
Viewing outbound confirm BODs.......................................................................................................103

Chapter 6: Any BOD....................................................................................................105
Creating Any BODs...............................................................................................................................105

List of required object fields for any BODs.........................................................................................105
Any BOD reference package.............................................................................................................106
Creating a BOD type for the Sync, Acknowledge, Show, and Process BODs...................................107
Creating a BOD entity mapping for an Any BOD...............................................................................108
Mapping the BOD type version..........................................................................................................109
Mapping BOD field mappings for Any BOD.......................................................................................111
Mapping the BOD type version to the message source.....................................................................111
Adding a message source entity........................................................................................................112
Creating a custom handler and configuring the handler name in the BOD Entity Mapping...............112
Creating a sample any BOD trigger...................................................................................................117

Chapter 7: Multi-company installation and configuration.......................................119
Installing the multi-company reference package...................................................................................119
Understanding accounting entity mapping............................................................................................120
Navigating the accounting entity table...................................................................................................121
Choosing a deployment scenario..........................................................................................................122
Creating a public group..........................................................................................................................122
Understanding the sample trigger.........................................................................................................123

Adding the standard objects sample trigger to Infor Back Office Connect.........................................123
Adding the custom objects sample trigger to Infor Back Office Connect...........................................125

Creating a sharing rule for a simple deployment scenario....................................................................128
Creating a sharing rule for a complex deployment scenario.................................................................128
Setting objects to private for a simple or complex deployment scenario...............................................129
Assigning a role hierarchy.....................................................................................................................129
Understanding the unique ID.................................................................................................................130
Modifying the Infor Back Office Connect page layout to add the message source lookup...................131
Adding the user default message source to the user page layout.........................................................132
Configuring the default message sources for users..............................................................................132

Determining the required message sources for users.......................................................................132
Creating the default message source pick list values........................................................................133
Setting the default message source for a user..................................................................................133

Adding the lookup filter to a lookup object to include message source.................................................134
Adding fields to the search layouts for the account and contact objects...............................................135
Filtering standard field lookups for message sources...........................................................................136

Infor Back Office Connect Administration Guide | 5

Contents



Adding a filter to standard field objects..............................................................................................136
Adding multi-company validation rules to lookups (optional).................................................................137

Setting validation rules for a lookup...................................................................................................139
Setting validation rules for ERPs that do not support shared records between accounting
entities................................................................................................................................................140

Chapter 8: Multiple back office configuration..........................................................141
Multiple back office configuration tasks.................................................................................................141

Creating a document flow for each BOD noun and ERP...................................................................142
Adding an application to an activity....................................................................................................142
Adding documents to the activities....................................................................................................142
Add routing to the document flow......................................................................................................142
Setting the top and bottom applications' routing................................................................................143
Adding a routing condition to the applications...................................................................................143
Creating the first and second condition builders................................................................................143
Selecting the condition branches.......................................................................................................144
Configuring message source settings for multiple back office integration.........................................144

Chapter 9: Upgrading.................................................................................................147
Overview of Infor Back Office Connect 10.8 compatibility.....................................................................148
Infor Back Office Connect pre-upgrade checklist..................................................................................149

Confirming the Infor Back Office Connect version number................................................................150
Downloading the Infor Back Office Connect release notes................................................................150
Stopping the scheduler......................................................................................................................151
Verifying whether the scheduler is stopped.......................................................................................151

Upgrading Infor Back Office Connect....................................................................................................151
Post-upgrade tasks checklist.................................................................................................................153

Understanding the data migration process for the Infor Back Office Connect 10.8 upgrade.............154
Migrating existing data to Infor Back Office Connect version 10.8....................................................154
Updating custom object page layouts for Infor Back Office Connect version 10.7............................155
Verifying existing data content for Infor Back Office Connect version 10.8.......................................161
Updating the Infor Back Office Connect logo for Infor Back Office Connect version 10.8.................161
Migrating units of measure (optional).................................................................................................162

Chapter 10: Creating a customized quote PDF template........................................165
Enabling development mode for the user creating or editing Visualforce pages..................................165
Installing the Custom Quote PDF Reference package..........................................................................166
Confirming the components installed with the Custom Quote PDF Reference package......................166

Confirming the installation of the customPDF static resource file......................................................167
Confirming the installation of the QuoteDocumentController1 Apex class........................................167
Confirming the installation of the QuoteToPagePDF1 Visualforce page...........................................167

Replacing the default quote PDF logo with your company logo............................................................168

6 | Infor Back Office Connect Administration Guide

Contents



Downloading the customPDF static resource file to a local drive......................................................168
Replacing the default logo in the custom PDF static resource file.....................................................169
Updating the custom PDF static resource file in Infor Back Office Connect......................................169
Updating the custom quote PDF Visualforce page to reference your custom company logo............170
Validating the custom logo is displayed in quote PDF output............................................................171

Configuring Infor Back Office Connect to use the custom quote PDF Visualforce page.......................171
Verifying the custom PDF Visualforce page configuration.................................................................172

Defining properties for the custom quote PDF Visualforce page custom.css file..................................172
Changing the font weight of a style element......................................................................................173
Changing the font size of a style element..........................................................................................174
Changing the text-transform property of a style element...................................................................175
Changing the background color of a table header.............................................................................177
Changing the font family defined of a style element..........................................................................178
Changing the text-align property of a style element...........................................................................179
Changing the font style property of a style element...........................................................................180
Changing the color of a text element.................................................................................................181
Changing the padding property of an element...................................................................................182
Adding a block of static text to the QuoteToPDFPage1 Visualforce page.........................................184
Adding multiple sections to the QuoteToPDFPage1 Visualforce page..............................................185
Adding nested sections to the generated quote PDF........................................................................186
Adding custom fields to the generated quote PDF............................................................................188
Adding custom field sets to the generated quote PDF.......................................................................190

Recovering the original quote PDF document template........................................................................191
Uninstalling the Custom Quote PDF Reference package.....................................................................192

Chapter 11: Infor quote migration.............................................................................193
Before beginning the migration process................................................................................................193
Infor quote migration task sequence.....................................................................................................194
Overview of the quote migration process..............................................................................................195
Synchronized ERP quotes and the Infor Back Office Connect Migration application...........................196
Understanding quote record types assignments in Infor Back Office Connect version 10.8.................197
Setting the Infor Quote record type as the default record type for the System Administrator user.......197
Installing the Infor Back Office Connect Migration application..............................................................198
Accessing the Infor Back Office Connect Migration application............................................................199
Understanding the Infor Back Office Connect Migration application.....................................................199

Working with the Migration Objects tab.............................................................................................200
Working with the Migration Errors tab................................................................................................209
Working with the Infor Back Office Connect Migration tab.................................................................209

Migrating quote data to the Infor quote object.......................................................................................211
Migrating addresses on Quote records..............................................................................................211
Preparing Infor Back Office Connect for the Infor quote migration....................................................211
Executing the initial quote data migration..........................................................................................212

Infor Back Office Connect Administration Guide | 7

Contents



Post Infor quote migration tasks............................................................................................................213
Deleting all Infor Back Office Connect Migration application working objects from the
organization........................................................................................................................................214
Integration settings to support regular quote and opportunity business processes...........................219
Users and Quote Record ownership..................................................................................................220
Non-Infor quote record clean-up on Infor quote object......................................................................221
Re-implement Quote and Opportunity custom workflows, approval processes, and triggers for use
with the Infor quote object..................................................................................................................223
Permanently delete standard Salesforce Quote records from the Salesforce Quote object.............223

Migration errors......................................................................................................................................224
Reviewing and resolving error details for records that fail to migrate................................................224
Rerunning the quote migration after fixing record errors...................................................................225

Uninstalling the Infor Back Office Connect Migration application..........................................................226

Chapter 12: Uninstallation..........................................................................................227
Preparing to uninstall Infor Back Office Connect...................................................................................227

Stopping the scheduler to uninstall Infor Back Office Connect..........................................................227
Reassigning standard profiles to Infor Back Office Connect users....................................................228
Deleting Infor Back Office Connect profiles.......................................................................................228
Uninstalling the Infor Back Office Connect package..........................................................................228

Chapter 13: Data management..................................................................................231
Understanding message processing status codes................................................................................231
Marking variation conflict BODs as successful......................................................................................232
Reprocessing inbound BODs................................................................................................................232
Purging messages from the Infor Back Office Connect message queue..............................................233

Chapter 14: Error logging...........................................................................................235
Setting the error logging level and number of log messages................................................................235
Downloading and deleting the error log.................................................................................................236

Downloading the error log..................................................................................................................237
Deleting the error log..........................................................................................................................237

Working with the error log list................................................................................................................237
Creating a custom logger...................................................................................................................238
Changing the owner of an error message..........................................................................................238
Editing a logger..................................................................................................................................239
Deleting a logged error message.......................................................................................................239

Chapter 15: Territories................................................................................................241
Viewing territories..................................................................................................................................241
Creating territories.................................................................................................................................242
Modifying a territory...............................................................................................................................242

8 | Infor Back Office Connect Administration Guide

Contents



Deleting a territory.................................................................................................................................242

Chapter 16: Troubleshooting.....................................................................................245
Common failure scenarios.....................................................................................................................245

ION Adapter Connection test fails......................................................................................................245
ION integration scheduler is down.....................................................................................................246
Batch Apex job fails............................................................................................................................247
InboundMessageBatch job is not displayed in the Apex Jobs list......................................................248
OutboundMessageBatch job is not displayed in the Apex Jobs list...................................................248
Verifying the status of Apex Jobs.......................................................................................................248
Inbound message processing unable to obtain exclusive access to a record...................................249
Salesforce storage usage is over limit...............................................................................................249
ION Connect and proxy tenant names do not match.........................................................................249
NO_ROUTE_FOUND error................................................................................................................250
Account or contact record will not publish..........................................................................................250

Common Apex error messages.............................................................................................................250
Setting the Infor Back Office Connect Opportunity page layouts for the Opportunity layout master
record type.............................................................................................................................................254

Assigning the Infor Back Office Connect Opportunities page layout to the Opportunity layout master
record.................................................................................................................................................254
Assigning the Infor Back Office Connect ERP Opportunities page layout to the Opportunity layout
master record.....................................................................................................................................254

Cloning ERP Quotes owned by sales users..........................................................................................255
Increasing External ID field capacity.....................................................................................................255

Verifying the number of External ID fields for the Account object......................................................255
Verifying the number of External ID fields for the Contact object......................................................256

Appendix A: Understanding BODs............................................................................257
Messaging through BODs......................................................................................................................257
Generating BODs..................................................................................................................................259
Understanding the execution flow of BOD processing by the Infor Back Office Connect scheduler.....259
Posting Chatter feeds for BOD sync failure notifications.......................................................................260
Key concepts and terminology..............................................................................................................261

BODs..................................................................................................................................................261
BOD nouns.........................................................................................................................................261
BOD verbs..........................................................................................................................................262
BOD type names................................................................................................................................264
BOD type versions.............................................................................................................................264
BOD field mappings...........................................................................................................................264
BOD entity mappings.........................................................................................................................265
Message source.................................................................................................................................265
Message source BOD type version...................................................................................................265

Infor Back Office Connect Administration Guide | 9

Contents



Inbound messages.............................................................................................................................266
Outbound messages..........................................................................................................................267
Outbound transactions.......................................................................................................................267

Appendix B: Object permission settings for Infor Back Office Connect user
profiles.........................................................................................................................269

Recommended object permissions for Infor Back Office Connect User profile.....................................269
Recommended object permissions for Infor Back Office Connect Administrator and Developer
profiles...................................................................................................................................................272

Appendix C: Standard object custom fields.............................................................277
Account object custom fields.................................................................................................................277
Contact object custom fields..................................................................................................................279
Leads object custom fields....................................................................................................................281
Opportunities object custom fields.........................................................................................................281
Products object custom fields................................................................................................................282
Quotes object custom fields...................................................................................................................283
Quote line item object custom fields......................................................................................................285

Appendix D: Custom objects and tabs.....................................................................289
Custom objects......................................................................................................................................289

Controlled custom objects..................................................................................................................289
Account contact role and address sync.............................................................................................290
Address custom object.......................................................................................................................290
Account contact role custom object...................................................................................................290

Custom tabs...........................................................................................................................................291
Custom object definition details.............................................................................................................291

Account Contact Relationship object.................................................................................................291
Accounting Entity Table object...........................................................................................................292
Address object...................................................................................................................................293
Message Source object......................................................................................................................294
Message Source BOD Type Versions object.....................................................................................295
Bill-to object........................................................................................................................................296
Bod Entity Mapping object.................................................................................................................298
Bod Field Mapping object...................................................................................................................299
Bod Type object.................................................................................................................................300
Bod Type Version object....................................................................................................................301
Classification Code object..................................................................................................................302
ConfigCategory object........................................................................................................................303
ConfigCategoryProp object................................................................................................................303
Contact Bill-to Role object..................................................................................................................304

10 | Infor Back Office Connect Administration Guide

Contents



Contact Messenger object.................................................................................................................305
Contact PayFrom Role object............................................................................................................306
Contact Shipto Role object.................................................................................................................306
Customer Return object.....................................................................................................................307
Customer Return Line object.............................................................................................................310
Inbound Message object....................................................................................................................311
Infor quote object...............................................................................................................................313
Infor quote Clone Setting object.........................................................................................................317
Infor quote Line Item object................................................................................................................318
Invoice object.....................................................................................................................................321
Invoice Line object.............................................................................................................................324
Logger object.....................................................................................................................................326
Lookup object.....................................................................................................................................327
Lookup Category object.....................................................................................................................328
Outbound Confirm BOD object..........................................................................................................328
Outbound Message object.................................................................................................................329
Outbound Transaction object.............................................................................................................330
Pay-from object..................................................................................................................................331
Person object.....................................................................................................................................333
Price List object..................................................................................................................................334
Quote Document object.....................................................................................................................335
Receivable object...............................................................................................................................336
Receivable Line object.......................................................................................................................340
Sales Order object.............................................................................................................................341
Sales Order Line object......................................................................................................................345
Ship-to object.....................................................................................................................................348
Shipment object.................................................................................................................................349
Shipment Line object..........................................................................................................................352
Social Media object............................................................................................................................354
Territory object...................................................................................................................................355
Warehouse object..............................................................................................................................356
UOM Object.......................................................................................................................................356
Unit Group object...............................................................................................................................357
zz_Account Bill-to Role object............................................................................................................358
zz_Account Ship-to Role object.........................................................................................................359
zz_BillTo-PayFrom Role object..........................................................................................................359
zz_Carrier Party object.......................................................................................................................360
zz_Classification Code object............................................................................................................361
zz_Sales Order Address object..........................................................................................................361
zz_Serial Lot object............................................................................................................................362
zz_Ship-to Bill-to Role object.............................................................................................................363
zz_Shipto-Carrier Party Role object...................................................................................................364

Infor Back Office Connect Administration Guide | 11

Contents



zz_Transaction Address object..........................................................................................................365

Glossary.......................................................................................................................367

12 | Infor Back Office Connect Administration Guide

Contents



About this guide

This guide includes tasks that you must complete in your Salesforce organization before you install
Infor Back Office Connect. The guide also includes information about how to install and configure Infor
Back Office Connect, including information to help you plan for and prepare your Salesforce organization
for an Infor Back Office Connect implementation. Administration topics and instructions to upgrade,
uninstall, and troubleshoot Infor Back Office Connect are also provided.

Intended audience
This guide is intended for certified Salesforce administrators with experience in user management,
security, workflow, approvals, and reporting.

At minimum, we recommend that the Infor Back Office Connect system administrator complete the
Salesforce Administration Essentials for New Admins (ADM201) training or equivalent. Additional
experience with advanced analytics, automation, and the use of complex functions is also encouraged.
Contact Salesforce services for information on Salesforce training and certification.

We also recommend that Infor Back Office Connect system administrators have experience in XML
messaging, Business Object Documents (BOD), Infor ION Connect integration, and basic knowledge
of writing Salesforce Object Query Language (SOQL) queries.

Related documents
Additional documentation is available in the product documentation section of the Infor Xtreme Support
portal, as described in "Contacting Infor".

• Infor Back Office Connect BOD Mapping (Inbound)
• Infor Back Office Connect BOD Mapping (Outbound)
• Infor Back Office Connect User Guide
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Registering to receive Infor Back Office Connect knowledge base
e-mail updates
We recommend that you check the support portal web site periodically to download software, patches,
and upgrades, to search the Infor Back Office Connect product knowledge base (KB), and to access
and print release notes and documentation. You must sign up for the Infor Back Office Connect mailing
list to receive e-mail notifications related to Infor Back Office Connect products.

To register to receive Infor Back Office Connect knowledge base e-mail updates:

1 Open a web browser.
2 Enter the URL for the Infor Xtreme Support portal login screen: http://www.inforxtreme.com/allogin/

allogin.aspx.
3 Specify the e-mail address and password for your Infor Xtreme user account.
4 Click Login. The Infor Infor Xtreme Support Home Page is displayed.
5 Select Knowledge Base > Search. The KB Search page is displayed.
6 In the Available Product Lines list, select Salesforce and click Add.
7 In the Search For field, specify the Infor Back Office Connect KB number 1149054 and click Search.
8 Locate Infor Back Office Connect Release Updates in the search results and click Sign up. A

confirmation message is displayed.
9 Locate Infor Back Office Connect Documentation in the search results and click Sign up. A

confirmation message is displayed.
10 Click Close.

Contacting Infor
If you have questions about Infor products, go to the Infor Xtreme Support portal.

If we update this document after the product release, we will post the new version on this website. We
recommend that you check this website periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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1Introduction

This chapter describes the purpose of the Infor Back Office Connect application and the business
solutions that it provides. It introduces the system components and concepts associated with the
process of installing and configuring Infor Back Office Connect including users, profiles, objects, settings,
and permissions. This chapter also includes an overview of the Infor Back Office Connect BOD
integration process.

Product overview
The Infor Back Office Connect application integrates Salesforce.com Customer Relationship Management
(CRM) and Enterprise Resource Planning (ERP) solutions to provide users with the ability to leverage
the power of shared information and common processes between the different systems.

Infor Back Office Connect provides a number of custom profiles to access back-office (ERP) information
within Salesforce including current Master Data for Customers, Contacts, Products, and Historical
Transactional Data for Quotes, Sales Order, Shipments, Invoices, Payments, and Customer Returns.

Communications between Infor Back Office Connect and ERP are sent as business object documents
(BOD) that are routed through Infor ION Connect, an enterprise messaging system for integrating Infor
applications with each other and with outside applications.

This diagram shows a high-level illustration of a Salesforce and ERP integration using Infor Back Office
Connect:
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Infor Back Office Connect applications
Infor Back Office Connect consists of two core applications: the Infor Back Office Connect user
application and the Infor Back Office Connect Administration application. Both applications are installed
during the Infor Back Office Connect installation process and are accessible from the Force.com App
menu in Salesforce. See "Force.com App Menu" in the Infor Back Office Connect User Guide.

Infor Back Office Connect documentation
Infor Back Office Connect documentation provides procedure-based instructions on how to complete
tasks associated with system functions and features. Each procedural task provides field descriptions
for only the fields that are non-intuitive in their meaning and purpose. For example, most name and
date fields are self-explanatory and descriptions are not provided.
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Navigation and user interface
Salesforce.com includes several menus and options for navigating to quickly and easily find the pages
and information you need. Navigate through the system by clicking icons, menus, buttons, tabs, and
hyperlinks on each page.

The Infor Back Office Connect User Guide provides information on the documentation conventions
used to describe user interface elements and system navigation. See "Basics" in the Infor Back Office
Connect User Guide.

Note: The navigation instructions presented in this document are based on the Salesforce New User
Interface Theme being enabled in the Setup > User Interface section of the Summer'14 release.
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2Preparing for the Infor Back Office Connect
installation

Before installing the Infor Back Office Connect application, you must prepare your Salesforce organization
for the Infor Back Office Connect installation. This chapter provides detailed information on the
pre-installation tasks and procedures you must complete before you install Infor Back Office Connect.

Pre-installation tasks checklist
This checklist includes the list of pre-installation tasks you must complete before installing Infor Back
Office Connect. See the appropriate section of this guide for detailed instructions on how to complete
these tasks.

We recommend that you complete the pre-installation tasks in this order:

• Retrieve the Salesforce organization ID for the organization on which you are installing Infor Back
Office Connect

• Get Infor Back Office Connect logical ID and ION tenant information from Infor
• Enable multi-currency (if your organization requires the use of multiple currencies)
• Increase External ID field capacity
• Create and assign Infor Back Office Connect profiles
• Create required Infor Back Office Connect users
• Enable quotes for your Salesforce organization
• Enable social networks for accounts and contacts

Retrieving your Salesforce.com organization ID
To install Infor Back Office Connect, you must have an Infor Back Office Connect Logical ID and an
Infor ION Tenant for your Salesforce.com organization. To get the Logical ID and ION tenant, you must
provide Infor customer support with your Salesforce.com organization ID. See "Getting Infor Back office
Connect logical ID and ION tenant information from Infor" on page 20.
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To retrieve your Salesforce.com organization ID:

1 Select Setup.
2 In the sidebar column, select Administration Setup > Company Profile > Company Information.
3 In the Organization Detail section, locate the Salesforce.com Organization ID field and copy the

code displayed.

Getting Infor Back office Connect logical ID and ION tenant
information from Infor
To install and configure Infor Back Office Connect, you require an Infor Cloud tenant which is used to
establish the integration of Infor Back Office Connect and ERP through Infor ION Connect. Your ION
tenant includes the connection point information required to configure Infor Back Office Connect to
communicate with the ION proxy server. The ION proxy server houses the proxy container in ION to
which messages are published and the proxy server that interacts with the Salesforce adapter that
manages the sending and receiving of messages to and from ERP.

During the post-installation configuration process, you will need the details of your ION Service and
Infor Back Office Connect application to configure ION Connect connection points and the Infor Back
Office Connect adapter and scheduler settings to enable communication between your integrated
applications.

To get your Infor Cloud tenant details, contact Infor customer support and provide this information:

• Primary Contact Email Address for your company.
• Company/customer name, for example, ACME Corp.
• SalesForce Organization ID.
• If this is a production or non-production Organization.
• Country and Region information of the location of your company. This information is required to

create the tenant in the correct region for optimal data transfer performance.

See "Contacting Infor".

Infor customer support generates your Cloud tenant information and provide you this information (for
example, cloud tenant information for ACME Corp.):

ION Connection Information for Cloud Account for ACME Corp:

• ID: AKIBJIQ2ZFT34QZPABEF
• Security Key: vb0J7uXwPWT67bWohfROdQVmLftd/LrRS8HjNLMN

IBOC Connection Information for Salesforce Org ID 00Bn0123456efgh:

• IBOC Logical ID: lid://infor.sfdc.iboc_prd
• Tenant: ACMECORP01_PRD
• User Name: icboc-00Bn0123456efgh.sfdc
• Password: ibocpwd1234
• Endpoint URL: https://iboc01.inforcloudsuite.com/iboc_proxy/IonProxyGenService?wsdl
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See "Understanding ION Tenant Information" on page 42.

Enabling multiple currencies
Optionally, to enable multiple currencies (multi-currency) for your Salesforce organization, contact
Salesforce support. See Salesforce documentation for information on multi-currency.

You must include this information in your request:

• Your Salesforce organization ID (production or sandbox). See "Retrieving your Salesforce.com
organization ID" on page 19.

• The default currency for current and future records. For example, USD, EUR, GBP.

You must also confirm this information:

• You understand that multi-currency cannot be disabled after it has been enabled
• You are a system administrator who is authorized to request that multi-currency be enabled for your

organization
• You give permission to Salesforce to lockout your organization for the time required to enable

multi-currency, which will vary depending on your organization’s data usage volume

Creating Infor Back Office Connect profiles
You must create these Infor Back Office Connect profiles:

• Infor Back Office Connect Administrator
• Infor Back Office Connect Developer
• Infor Back Office Connect User
• Infor Back Office Connect Read Only

To create these profiles, you clone the corresponding Salesforce profiles and map the associated
permissionsas part of the Infor Back Office Connect installation process. See "Object permission settings
for Infor Back Office Connect user profiles" on page 269 for information on the recommended profile
object permission configuration settings to assign to the Infor Back Office Connect user profiles.

Creating the Infor Back Office Connect Administrator profile
The Infor Back Office Connect Administrator profile is configured with the object and user interface
permissions that are required to install, configure, manage, and troubleshoot Infor Back Office Connect.
To create the Infor Back Office Connect administrator, you clone the Salesforce System Administrator
profile.

To create the Infor Back Office Connect Adminstrator profile:

1 Log in to Salesforce as the system administrator.
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2 Select Setup.
3 In the sidebar column, select Administration Setup > Manage Users > Profiles to display the

User Profiles page.
4 In the Profile section, click New to display the Clone Profiles page.
5 Specify this information:

Existing Profile
Select System Administrator. The user license is populated with Salesforce.

Profile Name
Specify Infor Back Office Connect Administrator as the profile name.

6 Click Save. You do not have to modify the cloned profile. The profile will be updated by the Infor
Back Office Connect installation.

Creating the Infor Back Office Connect Developer profile
The Infor Back Office Connect Developer profile is configured with the same permissions as the Infor
Back Office Connect Administrator. The Infor Back Office Connect Developer profile is configured with
the object and user interface permissions that are required to install, configure, manage, and troubleshoot
Infor Back Office Connect.

To create the Infor Back Office Connect Developer profile:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Manage Users > Profiles to display the

User Profiles page.
4 In the Profile section, click New to display the Clone Profiles page.
5 Specify this information:

Existing Profile
Select System Administrator. The user license is populated with Salesforce.

Profile Name
Specify Infor Back Office Connect Developer as the profile name.

6 Click Save. You do not have to modify the cloned profile. The profile will be updated by the Infor
Back Office Connect installation.

Creating the Infor Back Office Connect User profile
The Infor Back Office Connect User profile is configured with the permissions to manage account
relationships, coordinate sales engagements, and report their progress to management. The Infor Back
Office Connect User profile is configured with the object and user interface permissions to create and
complete tasks, answer calls, quote prices, and sell products to customers. The Infor Back Office
Connect User can also qualify contacts into leads. The Infor Back Office Connect User profile is also
used by managers.
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To create the Infor Back Office Connect User profile:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Manage Users > Profiles to display the

User Profiles page.
4 In the Profile section, click New to display the Clone Profiles page.
5 Specify this information:

Existing Profile
Select Standard User. The user license is populated with Salesforce.

Profile Name
Specify Infor Back Office Connect User as the profile name.

6 Click Save. You do not have to modify the cloned profile. The profile will be updated by the Infor
Back Office Connect installation.

Creating an Infor Back Office Connect Read Only profile
An Infor Back Office Connect Read Only user does not have permissions to create, update, or delete
records or information from Infor Back Office Connect. These steps are for manually configuring Infor
Back Office Connect profiles. Infor Back Office Connect profiles are configured as part of the installation
process.

Note:  After installing Infor Back Office Connect, you must configure page layouts for the Infor Back
Office Connect Read Only profile. See "Creating and modifying page layouts for an Infor Back Office
Connect read only user (optional)" on page 62 and "Installing Infor Back Office Connect" on page 29.

.

Note: If a warning message displays during this process, click OK.

To create an Infor Back Office Connect Read Only profile:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectManage Users > Profiles.
5 Click New.
6 In the Existing Profile field, specify Infor Back Office Connect User. Use the Infor Back Office

Connect User profile as the template to create the new Read Only profile.
7 In the Profile Name field, specify the name of the new profile. For example, name the new profile

Infor Back Office Connect READ ONLY User.
8 Click Save.
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Assigning Infor Back Office Connect profiles to users
After you create the Infor Back Office Connect profiles, assign the profiles to your Salesforce users
based on the system privileges that they require.

To assign Infor Back Office Connect profiles to users:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Manage Users > Users to display the All

Users page.
4 Click New User.
5 Specify the information that you require. See additional details about these fields:

User License
Select Salesforce.

Profile
Select the Infor Back Office Connect profile to assign to the user.

6 Select the Generate new password and notify user immediately check box.
7 Click Save.

Creating required Infor Back Office Connect users
You must also create two required users: the integration user and the default record owner. Each of
these users are assigned one of the Infor Back Office Connect profiles and have unique functions in
the Infor Back Office Connect integration. See "Creating Infor Back Office Connect profiles" on page
21.

Note: The integration user and the default record owner can be existing Salesforce users, but the users
must be assigned to the proper corresponding profile required for the user and be used consistently
throughout the integration.

Creating the integration user
The integration user is assigned the Infor Back Office Connect Administrator profile and is used to start
and stop the Infor Back Office Connect integration scheduler. The integration scheduler executes the
scheduled processes that communicate with the host ERP system.

Note: The integration user cannot be a functional Salesforce user or the default record owner because
record updates generated by the integration user do not initiate data transfers to the host ERP system.

To create the integration user:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
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3 In the sidebar column, select Administration Setup > Manage Users > Users to display the All
Users page.

4 Click New User.
5 In the General Information section, specify information for these fields:

• Last Name
• Alias
• Email
• Username
• Nickname
• Role
• User License
• Profile

6 In the Mailing Address section, specify information for these fields:

• Optionally, Street
• Optionally, City
• Optionally, State/Province
• Optionally, Zip/Postal Code
• Optionally, Country

7 In the Single Sign On Information section, specify information for these fields:

• Optionally, Federation ID

8 In the Locale Settings section, specify information for these fields:

• Time Zone
• Locale
• Language
• Currency

Note: For new records created by the interface to display the correct time, set the Time Zone for
the Integration user to GMT+00:00 Greenwich Mean Time.

9 In the Approver Settings section, specify information for these fields:

• Optionally, Delegated Approver
• Optionally, Manager
• Receive Approval Request Emails

10 In the salesforce.com Newsletter Settings section, specify information for these fields:

• Optionally, select the Receive the salesforce.com newsletter check box.
• Optionally, select the Receive the salesforce.com administrator newsletter check box.
• Optionally, select the Generate new password and notify user immediately check box.

11 Click Save.
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Creating the default record owner
When sales-related objects publish records from ERP to Infor Back Office Connect, the default record
owner is assigned as the interim owner of the record until an actual owner is assigned. The default
record owner user must be assigned the Infor Back Office Connect User profile.

Note: Do not assign the default record owner user to a role in a role hierarchy.

After a record is published in Infor Back Office Connect, administrator, users, or the default record
owner can reassign the ownership of the record to the existing Salesforce users.

To create the default record owner:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Manage Users > Users.
4 Click New User.
5 In the General Information section, specify information for these fields:

• Last Name
• Alias
• Email
• Username
• Nickname
• Optionally, Title
• Optionally, Company
• Optionally, Department
• Optionally, Division
• Role
• User License
• Profile

6 In the Mailing Address section, specify information for these fields:

• Optionally, Street
• Optionally, City
• Optionally, State/Province
• Optionally, Zip/Postal Code
• Optionally, Country

7 In the Single Sign On Information section, specify information for these fields:

• Optionally, Federation ID

8 In the Locale Settings section, specify information for these fields:

• Time Zone
• Locale
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• Language
• Currency

9 In the Approver Settings section, specify information for these fields:

• Optionally, Delegated Approver
• Optionally, Manager
• Receive Approval Request Emails

10 In the salesforce.com Newsletter Settings section, specify information for these fields:

• Optionally, select the Receive the salesforce.com newsletter check box.
• Optionally, select the Receive the salesforce.com administrator newsletter check box.
• Optionally, select the Generate new password and notify user immediately check box.

11 Click Save.

Enabling quotes
Salesforce Quotes must be enabled in the organization prior to installing the Infor Back Office Connect
application due to legacy dependencies on the Quote object. As of Infor Back Office Connect 10.8.x,
integrated ERP quotes are stored in the custom Infor Quote object.

To enable quotes:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Quotes > Settings.
4 Select the Enable Quotes check box.

5 Click Save. The Page Layout Selection page is displayed.

Caution: Do not select the Opportunity Layout or the Append to user's personal related
list check box.

6 Click Save.

Enabling social networks for accounts and contacts
Enable social networks for Accounts and Contacts if you have not already done so.

To enable social networks for Accounts and Contacts:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
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3 In the sidebar column, select App Setup > Customize > Social Accounts and Contacts > Settings.
4 Select the Enable Social Accounts and Contacts check box.
5 Click Save.
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3Infor Back Office Connect installation

This chapter describes the tasks that you must complete to install Infor Back Office Connect on your
Salesforce organization.

Installation tasks checklist
This checklist includes the list of tasks you must complete to install Infor Back Office Connect:

• Purchase the Infor Back Office Connect app from the Salesforce AppExchange
• Install the Infor Back Office Connect package on your Salesforce organization
• Confirm the Infor Back Office Connect installation in Salesforce

See the appropriate section of this guide for detailed instructions on how to complete these tasks.

Purchasing the Infor Back Office Connect app from the Salesforce
AppExchange
The Infor Back Office Connect application is available for purchase on the Salesforce AppExchange
(http://appexchange.salesforce.com/). After purchasing Infor Back Office Connect, your Infor account
manager will send you a link to the Infor Back Office Connect package URL from which you can install
the application in your Salesforce organization. For example, https://login.salesforce.com/packaging/
installPackage.apexp?p0=000000000000000.

Installing Infor Back Office Connect
After completing the pre-installation tasks and receiving the URL to the package installer, you can
install Infor Back Office Connect on your Salesforce organization.

Note:  The system administrator profile used during the installation should not be dependent upon any
of the Infor Back Office Connect related profiles.
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To install Infor Back Office Connect:

1 Log in to Salesforce as the system administrator.
2 Click the URL for the Infor Back Office Connect package installer provided by Infor to display the

Package Installation Details  page.

Note: If you are installing Infor Back Office Connect in a sandbox organization, you must change
the beginning of the package URL to http://test.salesforce.com.

3 View the package installation details and click Continue. The Approve Third-Party Access window
is displayed.

4 Select the Yes, grant access to these third-party web sites check box and click Continue to
display the Step 1. Approve Package API Access page.

5 Review the extended object permissions and click Next to display the Step 2. Choose security level
page.

6 Select the Select security settings option. The Customize security section is displayed.
7 In the Profile list, select the Infor Back Office Connect Administrator profile.
8 In the Access Level list for the Infor Back Office Connect Administrator profile, selectInfor Back

Office Connect Administrator.
9 In the Profile list, select the Infor Back Office Connect Developer profile.
10 In the Access Level list for the Infor Back Office Connect Developer profile, select Infor Back Office

Connect Developer.
11 In the Profile list, select the Infor Back Office Connect User profile.
12 In the Access Level list for the Infor Back Office Connect User profile, select Infor Back Office

Connect User.
13 In the Profile list, select the Infor Back Office Connect READ ONLY profile.
14 In the Access Level list for the Infor Back Office Connect READ ONLY profile, select Infor Back

Office Connect READ ONLY User.
15 Click Next to display the Step 3. Install Package page.
16 Click Install. The package installation begins and a confirmation is displayed. After the package is

installed successfully, Salesforce sends an e-mail notification to the e-mail address configured in
the Salesforce user profile of the installer.

17 After you receive the e-mail notification indicating the Infor Back Office Connect package installation
was successful, confirm the package installation on your Salesforce organization. See "Confirming
the Infor Back Office Connect package installation" on page 30.

Confirming the Infor Back Office Connect package installation
After you receive the e-mail notification from Salesforce indicating that your request to install the Infor
Back Office Connect package was successful, confirm the package installation on your Salesforce
organization.

To confirm the Infor Back Office Connect package installation:

1 Log in to Salesforce as the system administrator.
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2 Select Setup.
3 In the sidebar column, select Installed Packages.
4 In the Installed Packages sections, click the Infor Back Office Connect package name. The Package

Details window is displayed.
5 In the Version Name field, verify that the correct version of Infor Back Office Connect is installed.
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4Infor Back Office Connect configuration

After installing the Infor Back Office Connect application on your Salesforce organization you must
configure the application. This chapter provides detailed information on the post-installation tasks and
procedures you must complete to configure Infor Back Office Connect.

Key configuration concepts
Before configuring the Infor Back Office Connect application for integration with ERP, there are several
key concepts to understand and integration settings to consider based on the business needs of your
integration. These key configuration settings are:

• The recommended inbound batch scope settings
• Price books
• Processing units of measure (unit groups or a standard unit group) for Item Master BODs
• Many to many configuration settings

The information in this section includes conceptual information on these concepts and settings to help
you as you begin the configuration process.

After reviewing these configuration concepts, see "Post-installation tasks checklist" on page 39 to guide
you through the Infor Back Office Connect configuration process.

Recommended Inbound Batch Scope values for initial data load
This table shows the recommended Inbound Batch Scope values for the initial data load of Infor Back
Office Connect BOD documents:

Recommended Inbound Batch Scope ValueBOD

10Code Definition

10Contact Master

10Customer Party Master
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Recommended Inbound Batch Scope ValueBOD

2Item Master

8Transactions with 50 items or less

2Transactions with 51 to 200 items

Note: Infor Back Office Connect supports Transaction BODs containing >1000 lines and supports a
BOD Size of up to 2.5 MB. Any BOD larger than 2.5 MB will fail.

Understanding price books
Price books contain a list of products and their associated prices. In Salesforce, you can use the
standard price book or create custom price books. The standard price book is generated automatically
and contains a master list of all products and their standard prices. The combination of a product and
its associated price is a price book entry.

When Infor Back Office Connect processes an ItemMaster BOD, price book entries are added to the
standard price book by default. If you want to add products to custom price books, you can select one
or more price books when configuring your BOD message source settings. If you select one or more
custom price books, products are added to the standard and each of the selected price books. Price
book entries are also added to all currencies created for your Salesforce organizations. These example
scenarios describe this functionality:

Scenario 1:  A Salesforce organization is configured with USD, CAD, and GBP custom price books
and no price book is selected for the message source. When the ItemMaster BOD is processed, the
price book item is added to the standard price book for USD, CAD, and GBP. A total of three price
book items are added.

Scenario 2: A Salesforce organization is configured with USD, CAD, and GBP custom price books
and the preferred price list is selected for the message source. When the ItemMaster BOD is processed,
the price book item is added to the standard and preferred price lists. A total of six price book items
are added.

Understanding unit group processing in Infor Back Office Connect
As Item Master BODs are synchronized, units of measure and unit groups are created or updated in
Infor Back Office Connect for each item master. By default, unit groups functionality is enabled.

There are two possible unit group processing scenarios in Infor Back Office Connect:

• Unit Groups enabled (default): A unit group with a set of units of measure is created for each Item
Master BOD, and each unit group contains each unit of measure only once.

• Standard Unit Group enabled: If the use of a Standard unit group is required for your integration
scenario, you can also configure Infor Back Office Connect to process units of measure using a
Standard unit group. In this scenario, as Item Master BODs are processed, all units of measure are
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added to the Standard unit group. To configure Infor Back Office Connect to use a Standard unit
group, you must select the Enable Standard Unit Group configuration setting on the Integration
Setup page. Some additional configuration steps are also required. See "Configuring Infor Back
Office Connect settings" on page 45.

If you are installing Infor Back Office Connect as a clean install, the unit groups functionality will be
enabled by default. If you are upgrading to the latest version of Infor Back Office Connect from a
previous version, or if you want to enable the Standard unit group functionality, we recommend that
you complete these additional configuration steps:

• Migrate all unit group data to the Standard unit group. See "Migrating units of measure from unit
groups to a Standard unit group" on page 162.

• Make the Unit Group field non-required on your page layouts and the Unit Group field must be
removed entirely from the Products page layout. See Salesforce documentation.

Note:  If you configured Infor Back Office Connect to process units of measure using a Standard unit
group and want to restore the default unit group processing functionality, you must complete these
steps to migrate your units of measure from the Standard unit group to unit groups:

• Clear the Enable Standard Unit Group check box in the Infor Back Office Connect settings on the
Integration Setup page.

• Republish all Item Master BODs

Example: Unit groups enabled
When unit groups are enabled, a unit group and unit is created for every base unit of measure (UOM)
assigned to an item. For example, EA (Each) is a base UOM for ITEM01. As the Sync Item Master
BOD is processed, the BOD includes item ITEM01, so a unit group called ITEM01 is created. Because
EA is assigned as the UOM for ITEM01, EA is added to the ITEM01 unit group.

When the Sync Item Master BOD is processed again, the master data includes ITEM01 again, but it
contains three records: ITEM01 with EA as its UOM, ITEM01 with BOX as its UOM, and ITEM02 with
EA as its UOM. As a result, a new unit group for ITEM02 is created and the UOM EA is added to the
unit group. For unit group ITEM01, the UOM BOX is added to the unit group, but EA is not duplicated
in the unit group because it already exists.

After processing, the resulting unit groups are:

UOMItem

EAITEM01Unit group: ITEM01

BOXITEM01

UOMItem

EAITEM02Unit group: ITEM02
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Example: Standard unit group enabled
When standard groups are enabled, all units of measure are added to the Standard unit group. When
the Sync Item Master BOD is processed, the master data includes these items:

• ITEM01 with EA as its UOM
• ITEM01 with BOX as its UOM
• ITEM02 with BOX as its UOM
• ITEM03 with PALLET as its UOM
• ITEM04 with EA as its UOM
• ITEM05 with EA as its UOM

ITEM01, ITEM03, and ITEM04 are all assigned EA as their UOM. Another ITEM01 and ITEM02 are
assigned BOX as UOMs. Though shared by multiple items, the EA and BOX UOMs are only inserted
into the Standard unit group only once. They are not duplicated for the each item sharing the UOM.

After processing, the resulting unit groups are:

Item(s)UOM

ITEM01, ITEM04, ITEM05EAStandard unit group

ITEM01, ITEM02BOX

ITEM03PALLET

Understanding many-to-many configuration settings
The sections describes the many-to-many configuration settings available in Infor Back Office Connect.

Understanding account-to-contact relationships
Infor Back Office Connect supports two types of relationships between Customers (Accounts) and
Contacts:

1 In a one-to-many relationship, an account can have one or more contacts. To support this
one-to-many relationship:

• Contacts are specified in the Contact related list of the Account page
• Contacts can also be specified by the Account field on the Contact page
• The Contact related list represents the list of employees for a given Account

2 In a many-to-many relationship, an account can have one or more contact roles. To support this
many-to-many relationship:

• Contact roles are specified in the Contact Role related list of the Account page
• Contact roles can also be specified by the Account related list of the Contact page
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• Contact roles allow consultant type contacts to be associated with multiple accounts

To configure the type of account-to-contact relationship mirroring for your in Infor Back Office Connect
implementation, check or clear the Mirror Account Contact Role check box in Step 4: Configure Infor
Back Office Connect Settings section of the Integration Setup page. See "Configuring Infor Back Office
Connect settings" on page 45.

Note: Related lists that are not supported by an ERP should be removed from both the Account and
Contact page layouts as part of a standard Infor Back Office Connect implementation and configuration.
Contact Roles that are automatically created by the Mirror Contact Role option are created as a
Business User.

Understanding the account relationship to each Party Master
This section describes the account relationships of CustomerPartyMaster many-to-many relationships
with Ship-to, Bill-to, and Pay-from records.

Note:  ERP-LN provides support for a Ship-to record to be attached to more than one Customer; but
only if the two customers are related by a Parent Account relationship. ERP-A+ provides support for a
Bill-to record to be shared across multiple related customers.

Many to Many support for the Ship-to, Bill-to and Pay-from records is provided by the Message Source
based configuration options. You must select the check box for each of these options in Step 4: Configure
Infor Back Office Connect Settings section of the Integration Setup page as they are not selected by
default (see "Configuring Infor Back Office Connect settings" on page 45):

• Account Ship-to Many to Many Enabled
• Account Bill-to Many to Many Enabled
• Ship-to Bill-to Many to Many Enabled
• Bill-to Pay-from Many to Many Enabled

When enabled, the Master Detail Many to Many relationships is based on the junction object supporting
the corresponding Ship-to, Bill-to or Pay-from Many to Many Related List.

When disabled, the corresponding Master Detail relationships are based on the One to Many relationship
supported by the Ship-to Account, Bill-to Account, Bill-to Ship-to and Pay-from Bill-to lookup fields.

Understanding the many-to-many ship-to configuration

This section describes the many-to-many Account Ship-to relationship.

When the Account Ship-to Many to Many Enabled configuration is selected:

• The Account Ship-to many-to-many relationship is supported by the Account Ship-to junction object.
• Inbound BODs may contain multiple CustomerPartyIDs.
• Additions and deletions of Account Ship-to junction records result in ProcessShipToPartyMaster

BODs.
• The ProcessShipToPartyMaster BOD CustomerPartyID Array is based on the Account Ship-to

many-to-many junction records for the given Ship-to Master.
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When the Account Ship-to Many to Many Enabled configuration is not selected:

• The Account Ship-to one-to-many relationship is supported by the Ship-to Account Lookup field.
• Inbound SyncShipToPartyMaster BODs may not contain more than one CustomerPartyID.

Note: If BODs contain more than one CustomerPartyID a Confirm BOD error message is displayed.
To correct the error, you must configure Infore to support common Ship-to master data across
multiple customers by enabling the Ship-to Many to Many Enabled configuration setting.

• The ProcessShipToPartyMaster BOD CustomerPartyID Array is based on the value of the Ship-to
Account Lookup field.

Understanding the many to many bill-to configuration

This section describes the Many to Many Account Bill-to and the Many to Many Ship-to Bill-to
relationships.

When the Account Bill-to Many to Many Enabled configuration is selected:

• The Account Bill-to Many to Many relationship is supported by the Account Bill-to junction object.
• Inbound BODs may contain multiple CustomerPartyIDs.
• Additions and deletions of Account Bill-to junction records result in ProcessBillToPartyMaster BODs.
• The ProcessBillToPartyMaster BOD CustomerPartyID Array is based on the Account Bill-to Many

to Many junction records for the given Bill-to Master.

When the Account Bill-to Many to Many Enabled configuration is not selected:

• The Account Bill-to One to Many relationship is supported by the Bill-to Account Lookup field.
• Inbound SyncBillToPartyMaster BODs may not contain more than one CustomerPartyID.

Note: BODs containing more than one CustomerPartyID will cause this Confirm BOD error message
to display: Bill-to Many to Many in Infor Back Office Connect must be enabled to support common
Bill-to master data across multiple customers.

• The ProcessBillToPartyMaster BOD CustomerPartyID Array is based on the value of the Bill-to
Account Lookup field.

When the Ship-to Bill-to Many to Many Enabled configuration is selected:

• The Ship-to Bill-to Many to Many relationship is supported by the Ship-to Bill-to junction object.
• Inbound BODs may contain multiple ShipToPartyIDs.
• Additions and deletions of Ship-to Bill-to junction records result in ProcessBillToPartyMaster BODs.
• The ProcessBillToPartyMaster BOD ShipToPartyID Array is based on the Ship-to Bill-to Many-to-Many

junction records.

When the Ship-to Bill-to Many to Many Enabled configuration is not selected:

• The Ship-to Bill-to One to Many relationship is supported by the Bill-to Ship-to Lookup field.
• Inbound SyncBillToPartyMaster BODsmay not contain more than one ShipToPartyID.

38 | Infor Back Office Connect Administration Guide

Infor Back Office Connect configuration



Note: BODs containing more than one ShipToPartyID will cause this Confirm BOD error message
to display: Ship-to Bill-to Many to Many in Infor Back Office Connect must be enabled to support
common Bill-to master data across multiple Ship-to Addresses.

• The ProcessBillToPartyMaster BOD ShipToPartyID Array is based on the value of the Bill-to Ship-to
Lookup field.

Understanding the many to many pay-from configuration

This section describes the Many to Many Bill-to Pay-from relationship.

When the Many to Many Bill-to Pay-from Enabled configuration is selected:

• The Bill-to Pay-from Many to Many relationship is supported by the Bill-to Pay-from junction object.
• Inbound BODs may contain multiple BillToPartyIDs.
• Additions and deletions of Bill-to Pay-from junction records result in ProcessPayFromPartyMaster

BODs.
• The ProcessPayFromPartyMaster BOD BillToPartyID Array is based on the Bill-to Pay-from

Many-to-Many junction records for the given Pay-from Master.

When the Many to Many Bill-to Pay-from Enabled configuration is not selected:

• The Bill-to Pay-from One-to-Many relationship is supported by the Pay-from Bill-to Lookup field.
• Inbound SyncPayFromPartyMaster BODs may not contain more than one BillToPartyID.

Note: BODs containing more than one BilltoPartyID will cause this Confirm BOD error message to
display: Bill-to Pay-from Many-to-Many in Infor Back Office Connect must be enabled to support
common Pay-from master data across multiple Bill-to.

• The Process PayFromPartyMaster BOD BilltoPartyID Array is based on the value of the Pay-from
Bill-to Lookup field.

Post-installation tasks checklist
This checklist includes the list of post-installation tasks you must complete to continue with the Infor
Back Office Connect configuration and administration process. See the appropriate section of this guide
for detailed instructions on how to complete these tasks.

After installing the latest Infor Back Office Connect upgrade package on your Salesforce organization,
complete each of these post-upgrade tasks:

• Review the version-specific upgrade instructions in the Infor Back Office Connect Release Notes

Note: The post-upgrade tasks defined in the Infor Back Office Connect Release Notes supercede
the instructions provided in this document.

• Enable feed tracking for sync failure notifications
• Configure the Infor Back Office Connect application integration with ERP
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• Publish code definitions from ERP
• Optionally, configure multiple currencies based on your business requirements
• Enable history tracking for standard Salesforce objects
• Perform initial data load
• Configure reports
• Creating and modifying page layouts for an Infor Back Office Connect read only user (optional)

Enabling feed tracking for sync failure notifications
Infor Back Office Connect includes a feature that will post Salesforce Chatter notifications to failed
records when BOD sync failures occur for custom objects. You must enable feed tracking for the custom
objects to generate these notifications.

To enable feed tracking for sync failure notifications:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, select App Setup > Customize > Chatter > Feed Tracking.
5 In the Object section, select the Bill-to object. The fields in the bill-to records are displayed.
6 Select the Enable feed tracking check box and click Save. A confirmation message is displayed.
7 In the Object section, select the Pay-from object. The fields in the pay-from records are displayed.
8 Select the Enable feed tracking check box and click Save. A confirmation message is displayed.
9 In the Object section, select the Ship-to object. The fields in the ship-to records are displayed.
10 Select the Enable feed tracking check box and click Save. A confirmation message is displayed.
11 In the Object section, select the Territory object. The fields in the territory records are displayed.
12 Select the Enable feed tracking check box and click Save. A confirmation message is displayed.
13 In the Object section, select the Infor Quote object. The fields in the Infor quote records are displayed.
14 Select the Enable feed tracking check box and click Save. A confirmation message is displayed.
15 In the Object section, select the Infor Back Office Connect Order object. The fields in the Infor Back

Office Connect order object records are displayed.
16 Select the Enable feed tracking check box and click Save. A confirmation message is displayed.

Configuring the Infor Back Office Connect application for ERP
integration
Infor Back Office Connect includes default configuration settings that are required for integration with
ERP. Because some settings are specific to your customer environment, the default configuration
settings must be configured prior to the ERP integration.
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The Integration Setup tab is divided into sections that guide you through the configuration process
sequentially with a series of configuration tasks. The tasks include:

• Loading seed data
• Configuring the ION Connect connection points in ION Desk
• Configuring BOD message source settings
• Configuring Infor Back Office Connect settings
• Configuring Infor Back Office Connect adapter and scheduler settings
• Configuring Infor quote and opportunity settings
• Starting the scheduler
• Verify whether the scheduler started

To configure the Infor Back Office Connect application for ERP integration:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 Click the heading of the section of the tab related to the configuration task you must complete.

Complete each of the steps in the order in which they are presented on the tab. For example, click
Step 1: Load Seed Data. After loading the seed data, click Step 2: Configure ION Connection
Point/Document Flow.

Loading seed data
To load seed data:

1 On the Integration Setup tab, click Step 1: Load Seed Data.
2 Click Load Seed Data. The status of the data loading process is displayed until the load process

is complete.

Note: The Load Seed Data button does not automatically display on certain browsers. If you do
not see the button, click in the grey area of the page. The page will refresh and the button will be
displayed.

3 Click the Integration Setup tab to refresh the settings.
4 Continue to the next step of the configuration process. See "Configuring the ION Connect connection

points" .

Configuring the ION Connect connection points
After loading the seed data, you must configure the ION Connect middleware for the Infor Back Office
Connect integration with ERP.

To complete this part of the Infor Back Office Connect configuration process, Infor ION Suite 10.3 or
later is required, and you must have an Infor ION Desk login. When you receive your Infor ION Desk
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login information, you will also receive a URL where you can log into ION Desk . For example, http://
usalvicrmbw0k00.pmm.com:0000/IONDesk/ShellPage.aspx.

Understanding ION Tenant Information

During the pre-installation process, you requested Infor ION tenant and an ION proxy tenant for your
Salesforce organization. See "Getting Infor Back office Connect logical ID and ION tenant information
from Infor" on page 20. Your ION tenant includes the connection point information required to configure
Infor Back Office Connect to communicate with the ION proxy server. The ION proxy server houses
the proxy container in ION to which messages are published and the proxy server that interacts with
the Salesforce adapter that manages the sending and receiving of messages to and from ERP.

After Infor ION support sets up your ION tenants, you will receive an e-mail containing your ION tenant
information. This information will be used during several of the post-installation configuration tasks.
This table shows the ION service and Infor tenant information for the Salesforce organization ID
00OO0000000OcfO:

Infor Cloud tenant details for Infor Back Office Connect Application
This table shows the details of the ION Connection details: ACMECORP_PRD

ValueField

AKIBJIQ2ZFT34QZPABEFID

vb0J7uXw-
PWT67bWohfROdQVmLftd/LrRS8HjNLMN

Security Key

This table shows the Infor Back Office Connect details:

ValueField

https://iboc01.inforcloudsuite.com/iboc_proxy/Ion-
ProxyGenService?wsdl

Endpoint URL

lid://infor.sfdc.iboc_prdIBOC Logical ID

ACMECORP01_PRDTenant

icboc-00Bn0123456efgh.sfdcUser Name

ibocpwd1234Password

Creating a new Cloud Account

1 In Infor ION Desk, select Connect (the paper clip icon) > Model > Cloud Accounts >  Insert (the
new document icon).

2 Click Cancel to dismiss the pop-up window titled Provide Infor Cloud Credentials.
3 Specify the Cloud Account ID  and Security Key field sent in the Tenant details and click Load.

If the ERP uses any tenant other than “Infor”, select the check box next to Tenant and enter the
tenant name used by ERP , see example. You must check with your ERP administrator the details
of the Tenant is used or verify the Tenant  field in the ERP Connection Point in ION. The default
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value used by most customers is “Infor” (blanks indicates the default value of “Infor”) but different
values can be used.

Note: Do not specify the tenant that you received from Infor support (for example,
ACMECORP01_PRD) in the tenant field.

4 Click Save.

Downloading the sample integration document flow

Infor has created a file ( InforBackOfficeConnect_DocumentFlow.xml) that includes a sample ION
document flow and connection points for the Infor Back Office Connect integration with ION. Download
the ION document flow from the Infor Back Office Connect application to upload into ION Desk.

To download the Infor Back Office Connect document flow:

1 On the Integration Setup tab, click Step 2: Configure ION Connection Point/Document Flow.
2 Right-click the InforBackOfficeConnect_DocumentFlow.xml and save the document to a local drive.

Importing the sample integration document into Infor ION Desk

To import the sample integration file into ION Desk :

1 Sign in to Infor ION Desk.
2 Select Model > Connect > Document Flow.
3 Click Import and locate the InforBackOfficeConnect_DocumentFlow.xml file.
4 Click Open. The document is imported and a confirmation message is displayed.
5 Click OK.

Creating an Associate Cloud Account with the iboc-cloud connection point

1 Select Model  > Connect > Connection Points. Select the new Connection Point (called iboc-cloud)
in the Connection Points list and click Details. However, you can modify the name of the Connection
Point.

2 Select Cloud Account and specify the cloud account created in previous steps. In the drop-down
list for the cloud application, select the value that is displayed.

3 Click Save.
4 Click Test. The Test must succeed. If there are any issues, review the settings against the received

Tenant registration details.
The Test must succeed. If there are any issues, review the settings in comparison with the received
Tenant registration details.

Configuring the application task activity nodes

By default, the Infor Back Office Connect application has three activity nodes: Activity1, Activity2, and
Activity3.

To configure the application task activity nodes:
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1 In Infor ION Desk, select Model > Connect > Document Flows.
2 In the Flow Name list, double-click the Infor Back Office Connect document flow file. The Document

Flow Modeler page is displayed.
3 Click on the Activity1 node in the flow modeler.
4 In the Application Task section, click Add. The Add Application window is displayed.
5 Select the iboc-cloud connection point name.
6 Click OK.
7 Repeat these steps for the Activity2 and Activity3 nodes.

Adding supported documents to the ION integration document flow

After configuring the connection points for the activity nodes, add the documents supported by the ERP
to the ION integration document flow.

To add supported documents to the ION integration document flow:

1 In Infor ION Desk, select Model > Connect > Document Flows.
2 In the Flow Name list, double-click the Infor Back Office Connect document flow file. The Document

Flow Modeler page is displayed.
3 Click the document icon between the Activity2 and Activity3 nodes.
4 In the Documents section, click Add. The Add Documents window is displayed.
5 Select the document(s) to add and click OK. The document is added and updates the Documents

list.

Activating the Infor Back Office Connect document flow

After configuring the application connection point, activate the Infor Back Office Connect document
flow.

To active the Infor Back Office Connect document flow:

1 In Infor ION Desk, select Model > Connect > Document Flows.
2 In the Flow Name list, select the document flow to activate.
3 Click Activate. A confirmation message is displayed.
4 Sign out of Infor ION Desk.
5 Continue to the next step of the configuration process. See "Configuring message source settings"

on page 44.

Configuring message source settings
The message source settings specify the Message Source, Default Accounting ID, and ION Logical
ID that are used to configure ERP to publish BOD documents to ION. Message source settings are
customer-specific based on the ERP system being connected with ION and Infor Back Office Connect.
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Based on your business requirements, you can also configure multiple message sources and associate
the message sources with different entities, such as Account, Ship To, Confirm BOD. See "Configuring
message source settings for multiple back office integration" on page 144.

To configure message source settings:

1 Login to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 Click Step 3: Configure Message Source Settings.
5 Click New Message Source to display the Message Source Edit window.
6 Specify this information:

Message Source Name
The default value is Message Source. To modify the value, specify the ERP that is your system of
record. The message source is the application you are integrating with Infor Back Office Connect
through ION. For example, ERP LN.

Logical ID
The default value is lid://infor.erp.instanceid. Modify this value to match the value that is set up in
the ERP. This should be the "From LogicalID" in the BODs published by the ERP.

URL (optional)
The URL of the message source.

Default Accounting Entity ID
The default value is Default. To modify the value, specify the accounting entity ID from your ERP.
For example, if you are integrating with ERP LN, the value specified corresponds with the Company
Number in ERP LN. This value is required.

Default Location ID
Specify the default location for the ERP with which you are integrating. Default Location ID is used
when the ERP is configured with multiple sites. This value is optional.

7 In the Entities Selection list, select the BOD noun(s) you want to be published to the message source
you selected and click >> to add the noun(s).

Note:  Press Ctrl + Click to select multiple nouns.

8 Click Save.
9 Continue to the next step of the configuration process. See "Configuring Infor Back Office Connect

settings" on page 45.

Configuring Infor Back Office Connect settings
The Infor Back Office Connect settings define the Infor Back Office Connect connection with your ION
tenant, which enables Infor Back Office Connect to communicate with the ION proxy server and the
ION proxy container to which messages are published.

To configure Infor Back Office Connect settings:
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1 On the Integration Setup tab, click Step 4: Configure Infor Back Office ConnectInfor Back Office
Connect Settings.

2 Specify this information:

Component ID
The default value is sfdc. If the value is not already populated, specify sfdc. The value must be
entered in lower-case letters.

Acknowledgment Message Timeout (In Minutes)
The default value is 5. To modify the value, specify the time interval in minutes that the application
is to wait to receive the BOD acknowledgement message when it receives the Sync BOD for a
given process prior to the BOD acknowledgement. If a BOD acknowledgement is not received
within the specified interval, Infor Back Office Connect processes the Sync BOD and adds duplicate
records.

Logical ID
Specify the logical ID for the Infor Back Office Connect connection point in ION. For example,
lid://infor.sfdc.iboc_prd. The value specified must be the same as the Logical ID in the Infor Back
Office Connect section of the Infor Cloud tenant details for Infor Back Office Connect Application
provided to you by Infor ION support. See "Understanding ION Tenant Information" on page 42 .

Message Expiration (In minutes)
Specify the length of time in minutes that inbound and outbound messages are stored in Infor Back
Office Connect. If no value is specified, no inbound and outbound messages are deleted. We
recommend setting this value to 30. If set to 30, successful messages older than 30 minutes are
deleted.

Tenant
Specify the tenant for the Infor Back Office Connect application connection point on ION. The default
value is Infor. The value specified must be the same as the Tenant in the Infor Back Office Connect
section of the Infor Cloud tenant details for Infor Back Office Connect Application provided to you
by Infor ION support. See "Understanding ION Tenant Information" on page 42 .

Message Retry Count
The default value is 10. To modify this value, specify the number of attempts Infor Back Office
Connect should make to process BODs with dependency on other objects. For example, if an
inbound BOD for a child entity is received in Infor Back Office Connect before receiving a BOD
message for its parent, the child record is locked and processing is continued until the parent record
is found. If the parent record is not found after the specified number of attempts, the processing of
the child BOD record is cancelled, the Was Processed field is set to 9, and an outbound Confirm
BOD is sent.

Note: You can see the processing status of inbound messages on the Inbound Messages tab. See
"Viewing inbound messages in Infor Back Office Connect" on page 100and "Working with outbound
confirm BODs".

Integration Context User
Select the data source for inbound messages from the Owner Lookup. The value selected must
be the user configured as the integration user. See "Creating the integration user" on page 24 .

Confirmation Code
The default value is OnError, and this value cannot be modified.
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Default Record Owner
Select the Infor Back Office Connect user assigned to the default record owner role from the Owner
Lookup. The selected user is the default record owner for all sales-related objects published from
ERP. This value is used as an interim record owner until an actual owner is assigned. See "Creating
the default record owner" on page 26 .

3 If you are integrating Infor Back Office Connect with ION, select the Publish Outbound Message
check box to enable Infor Back Office Connect to publish outbound messages.

Note: If you are not integrating Infor Back Office Connect with ION, Infor Back Office Connect
functions as a standalone application and should not publish outbound messages. If you are using
Infor Back Office Connect as a stand alone application, clear the Publish Outbound Message
check box to disable outbound message publishing.

4 By default, the Mirror Account Contact Role check box is selected. When the Mirror Account
Contact Role Contacts check box is selected, contacts are associated with accounts using either
a one-to-many or many-to-many relationship. The type of account-to-contact relationship (one-to-many
or many-to-many) you use is determined by the relationships supported by your ERP system(s). If
your ERP uses many-to-many account-contact relationships, Infor Back Office Connect will mirror
that relationship. Likewise, if your ERP uses one-to-many account-contact relationships, Infor Back
Office Connect will mirror that relationship. If you want to support both relationship types, clear the
Mirror Account Contact Role checkbox and disable the New Contact button on the Contact Role
related list on your Account page layout. See "Understanding account-to-contact relationships" on
page 36.

5 The setting of the Enable Standard Unit Group checkbox determines how unit groups for units of
measure are processed within Infor Back Office Connect. If the checkbox is selected, a unit group
is created for each item master BOD that is processed. By default, the Enable Standard Unit Group
checkbox is not selected and the unit groups functionality is disabled. When Standard unit group
functionality is enabled by selecting this check box, item masters share a common Standard unit
group and units of measure are not duplicated within this Standard unit group. See "Understanding
unit group processing in Infor Back Office Connect" on page 34.

Note: If the Enable Standard Unit Group checkbox is not selected, you must make the Unit Group
field non-required on your page layouts and the Unit Group field must be removed entirely from
the Products page layout. See Salesforce documentation.

6 In the Many to Many Configuration section, select the check box for each of the many to many
master data relationships you want to configure:

• Account Ship-to Many to Many Enabled
• Account Bill-to Many to Many Enabled
• Ship-to Bill-to Many to Many Enabled
• Bill-to Pay-from Many to Many Enabled

If you do not select the many-to-many configuration master data set, then the configuration for that
data set will default to a one-to-many master data relationship. See "Understanding account-to-contact
relationships" on page 36.

Note: If your current data contains a many to many relationship and you want to migrate to a one
to many relationship, an error message is displayed that indicates the number of existing many to
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many records in your existing data. To continue with the migration, you must choose whether to
keep or remove the many to many relationships for the affected records.

7 Click Save.
8 Continue to the next step of the configuration process. See "Configuring the Infor Back Office Connect

adapter and scheduler settings" on page 48.

Configuring the Infor Back Office Connect adapter and scheduler settings
The Infor Back Office Connect adapter and scheduler settings are used to establish the connections
to ION for Salesforce and ERP. The scheduler settings define the rate at which the Infor Back Office
Connect scheduler sends and receives messages to and from ION from Salesforce and Infor Back
Office Connect. The adapter acts as a listener that sends and receive messages pushed through the
ION proxy container and the ION proxy server to and from ERP.

The Infor Back Office Connect adapter and scheduler configuration process includes these tasks:

• Creating the remote site for the ION Proxy Server
• Configuring the Infor Back Office Connect adapter settings
• Configuring the Infor Back Office Connect scheduler settings
• Testing the adapter connection

Creating the remote site for the ION proxy server

To create the remote site for the ION proxy server:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, select Administration Setup > Security Controls > Remote Site Settings.
5 Click New Remote Site.
6 Specify this information:

Remote Site Name
Specify the name of the ION proxy server. For example, ION_XMPP_Server.

Remote Site URL
Specify the URL for the ION proxy server container, which is the endpoint URL, that you received
from Infor. For example, https://ionsfdc101.saas.infor.com. See "Understanding ION Tenant
Information" on page 42.

7 Clear the Disable Protocol Security check box.
8 Select the Active check box.
9 Click Save.
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Configuring Infor Back Office Connect scheduler settings

The Infor Back Office Connect scheduler settings define the login credentials for the ERP system to
sign into ION and enable ION to hear and receive messages between ION and ERP.

During the pre-installation tasks, you requested to receive Infor ION tenant and ION proxy tenant
information from Infor. See "Getting Infor Back office Connect logical ID and ION tenant information
from Infor" on page 20. Most of the parameter values required for the adapter settings are taken from
the Infor ION tenant and ION proxy tenant information provided to you by Infor. See "Understanding
ION Tenant Information" on page 42.

This table shows the Infor Back Office Connect adapter parameters and their recommended settings:

ValueName

Specify True. This value is used to enable communication between Infor
Back Office Connect and the ION proxy server.

Enable Adapter

Specify the URL of the Salesforce adapter web service endpoint. The
value specified must be the same as the Endpoint URL in the Infor Back

ION Proxy Container End-
point URL

Office Connect section of the Infor Cloud tenant details for Infor Back Office
Connect Application provided to you by Infor ION support. See "Creating
the remote site for the ION proxy server" on page 48.

Specify the user name of the Infor Cloud tenant. For example, icboc-
00Bn0123456efgh.sfdc.The value specified must be the same as the

Username

Username in the Infor Back Office Connect section of the Infor Cloud
tenant details for Infor Back Office Connect Application provided to you
by Infor ION support.

Specify the password of the Infor Back Office Connect ION Cloud tenant.
For example, ibocpwd1234. The value specified must be the same as the

Password

Password in theInfor Back Office Connect section of the Infor Cloud tenant
details for the Infor Back Office Connect Application provided by Infor ION
support.

Specify the Tenant of Infor Back Office Connect Cloud tenant. For example,
ACMECORP01_PRD. The value specified must be the same as the Tenant

ION Proxy Tenant

in the Infor Back Office Connect section of the Infor Cloud tenant details
for Infor Back Office Connect Application provided to you by Infor ION
support.

Specify the maximum amount of time in milliseconds that the Infor Back
Office Connect scheduler will wait for a response after making a web ser-

Request Timeout

vice callout. The specified value must not be greater than 100000. We
recommend that you specify 40000.

Specify the size in megabytes of the response to be received from the ION
Proxy Container. The specified value must not be greater than 1.5MB. We
recommend that you specify 1.5MB.

Response Size
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ValueName

Specify the size in kilobytes of the BOD XML chunks to be processed by
the adapter. The specified value should not be greater than 700KB. We
recommend that you specify 700KB.

Chunk Size

To configure the adapter settings:

1 On the Integration Setup tab, click Step 5: Infor Back Office Connect Scheduler Settings.
2 In the Configure Infor Back Office Connect Scheduler Settings section, select the parameter to

configure and click Edit. The parameter Name and Value fields are displayed.
3 In the Name field, specify the appropriate field value for the selected parameter.
4 Click Save.
5 Repeat these steps for each of the scheduler settings.
6 Continue to the next step of the configuration process. See "Configuring the scheduler settings" on

page 50

Configuring the scheduler settings

The scheduler settings define the rate at which web services push and pull scheduled jobs between
Salesforce and ION.

This table shows the Infor Back Office Connect scheduler parameters and their recommended settings:

ValueName

Specify the frequency interval in seconds that the job scheduler runs.
We recommend that you specify 15 seconds.

Job Frequency

Specify the total number of concurrent Batch Apex jobs supported by
Salesforce. We recommend that you specify 5. The setting of this

Total Batch Jobs

parameter determines how many concurrent InboundMessageBatch
jobs are scheduled in Infor Back Office Connect.
Note: Stop all custom batch jobs when performing the initial data load
to improve performance.
If Total Batch Jobs is set to 5, the number of batch jobs is calculated
using this formula:
# of concurrent InboundMessageBatch jobs = Total
Batch Jobs - (# of active custom batch jobs + 1)

The (+1) in this equation is reserved for the OutboundMessageBatch.

Specify the number of records that the InboundMessageBatch job
passes to the execute method at one time. The default value is 5. We

Inbound Batch Scope

recommend that you specify 10. Increasing the value of this parameter
speeds up inbound BOD performance.
Note: Specifying a value greater than 10 may cause the Sales-
force.com governor exceptions.
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ValueName

The setting of this parameter determines how often to force the Out-
bound BOD processing polling job during heavy load times. The nu-

Max. Outbound Delay Count

merical value specified indicates an interval after which the regular
processing cycle will force the processing of outbound BODs to publish
any pending outbound BODs and delete any successful outbound
BODs.
Inbound BODs are given priority over outbound BODs during the
regular BOD processing cycles. As a result, during heavy load times,
the number of threads allocated for BOD processing in Salesforce
may be exhausted by the inbound BOD traffic, thus causing the out-
bound BOD processing to stall. By setting a value for this parameter,
the polling job for processing will force the outbound BOD processing
job to resolve potential delays in outbound BOD processing.
The default setting for this parameter is 3. The minimum value that
can be specified is 1. There is no maximum value. For example, if
you specify 2 as the setting for this parameter, after two regular BOD
processing cycles, the third cycle will force the outbound processing.
Thus, the forced cycle rotation is derived by adding 1 to the specified
value.

The BOD noun priority parameters define the sorting order for inbound
BOD processing that determines the order in which the documents
are read and processed.

[BOD Noun] Priority

Currently the BOD nouns are organized in increments of 100 (100,
200, 300, etc.), which specifies the order of the initial data load. These
values maybe modified to support customer needs.
The supported BOD nouns and their default priority settings are:

100CodeDefinition

200ItemMaster

300ContactMaster

400CustomerPartyMaster

500ShipToPartyMaster

600BilltoPartyMaster

700PayFromPartyMaster

800Quote

900SalesOrder

1000Shipment

1100CustomerReturn

1200Invoice

1300ReceivableTransaction
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ValueName
As BOD nouns are processed, the lowest value will be processed first
(100) followed by the next highest (200, 300, etc.) until the processing
is completed.
To edit the value click the Edit hyperlink next to the BOD noun in the
Field Name column, and then modify the Value field in the header of
the Configure
Scheduler Settings section. After modifying the value, click Save.
For example, you can click Edit next to the ShipToPartyMaster Priority
noun and modify the value from 500 by decreasing or increasing the
number in increments of 100 to the new value to indicate its priority.
For example, you could enter 300 to process the ShipToPartyMaster
BOD earlier, or you could enter 700 to process the BOD later.

To configure the scheduler settings:

1 On the Integration Setup tab, click Step 5: Infor Back Office Connect Scheduler Settings.
2 In the Configure Scheduler Settings section, select the parameter to configure and click Edit. The

parameter Name and Value fields are displayed.
3 In the Name field, specify the appropriate field value for the selected parameter.
4 Click Save.
5 Repeat these steps for each of the scheduler settings.
6 Continue to the next step of the configuration process. See "Testing the Infor Back Office Connect

scheduler and scheduler connection" on page 52.

Testing the Infor Back Office Connect scheduler and scheduler connection

After configuring the Infor Back Office Connect scheduler and scheduler settings, test the connection
to see if the configuration is successful.

To test the scheduler connection:

1 On the Integration Setup tab, click Step 5: Infor Back Office Connect Scheduler Settings.
2 In the Configure Infor Back Office Connect Scheduler Settings section, click Test Scheduler

Connection. A confirmation message is displayed. If the confirmation message indicates that the
connection was unsuccessful, verify the scheduler configuration settings.

Configuring Infor quote and opportunity settings
Configure your Infor Quote and Opportunity settings in the Step 6: Configure Quote and Opp Settings
section of the Integration Setup tab.

Infor Back Office Connect includes the Infor Quotes custom object, which replaces the standard
Salesforce Quotes object.

The standard Salesforce Quotes object requires that all quotes are associated with a parent opportunity.
See Salesforce documentation. Because many ERP systems do not use opportunities, inbound quotes

52 | Infor Back Office Connect Administration Guide

Infor Back Office Connect configuration



sent from your ERP to Infor Back Office Connect may not contain an opportunity reference depending
on your ERP configuration.

To provide you with greater flexibility in your ERP and Salesforce integration, the Infor Quotes custom
object is configured by default to create quote records without an opportunity. But, you also have the
option to configure Infor Back Office Connect to create a system opportunity for all inbound quotes
sent to Infor Back Office Connect from ERP.

The Infor Quote object also enables you to clone quote documents and email quote PDF documents
directly from the Quote object to customers for their review. You may also configure your default settings
for cloning quotes and your email template in the Step 6: Quote and Opp Settings section of the
Integration Setup tab.

Configuring Infor Back Office Connect to create system opportunities

By default, the Infor Quotes custom object is configured to create quote records without an opportunity
for inbound quotes received from ERP. You also have the option to configure Infor Back Office Connect
to create a system opportunity for all inbound quotes from ERP. If you plan to use system opportunities
for inbound ERP, we recommend that you define a Default Value to identity these system opportunities
in your Integration Setup configuration settings. For example, if the Default Value is set to NEW DEAL,
all system opportunities are assigned NEW DEAL as the opportunity Name.

Note: You also have the option to disable the system opportunities feature at any time.

To configure Infor Back Office Connect to create system opportunities:

1 On the Integration Setup tab, click Step 6: Quote and Opp Settings.
2 Select the Create System Opportunity check box.

Note: To disable the system opportunities feature, clear the Create System Opportunity check
box and click Save.

3 Click Save.
4 Continue to the next step of the configuration process. See "Setting the system opportunity default

values" on page 53.

Setting the system opportunity default values

In Salesforce, opportunities and quotes have a parent-child relationship, so a quote cannot exist without
an associated parent opportunity. See Salesforce documentation. Infor Back Office Connect includes
the Infor Quotes custom object, which replaces the standard Salesforce Quotes object.

Because many ERP systems do not use opportunities, inbound quotes sent from ERP to Infor Back
Office Connect do not contain an opportunity. When Infor Back Office Connect is installed, Infor Quotes
custom object overrides the Salesforce system constraint requiring an opportunity on a quote, and by
default Infor Back Office Connect is configured to create quote records without an opportunity.

However, you also have the option to configure Infor Back Office Connect to create a system opportunity
for all inbound quotes sent to Infor Back Office Connect from ERP. When Infor Back Office Connect
creates the system opportunity, the default record owner is assigned as the owner of the opportunity.

Infor Back Office Connect Administration Guide | 53

Infor Back Office Connect configuration



In the Configure System Opportunity Default Values section of the Integration Setup tab, you can
specify default values for the fields used by Infor Back Office Connect to create system opportunities.

Note: You must set default values for all of the mandatory fields configured for the Opportunities object.
Specifically, Name, Stage, Close Date.

To set the opportunity default values:

1 On the Integration Setup tab, click Step 6: Quote and Opp Settings.
2 In the Configure System Opportunity Default Values section, select the field for which to set a default

value from the Name list.

Note: If you do not define a default value for the opportunity Name, the system opportunity is
automatically assigned the quote EXTID as the opportunity name.

3 In the Default Value field, specify the default value for the selected field.
4 Click Save.
5 Repeat steps 2 - 4 for Stage and Close Date to complete the configuration of all the mandatory

fields and also for any other fields for which you would like to define default values.
6 Continue to the next step of the configuration process. See "Configuring the Infor quote cloning

settings" on page 54.

Configuring the Infor quote cloning settings

Clone quote documents of any status to create a quote from an existing quote the Infor Quote object.
Configure your default settings for cloning quotes and in the Step 6: Quote and Opp Settings section
of the Integration Setup tab.

To configure Infor quote cloning settings:

1 On the Integration Setup tab, click Step 6: Quote and Opp Settings.
2 In the Configure Quote Clone fields/related objects section, specify information in these fields:

• In the Object Name list, select the quote-related object. You can select any of these objects:
Attachment, Content, Content Document Link, Entity Subscription, Event, Feed Comment, Feed
Item, Infor quote, Infor quote Line Item, Note, Opportunity, Quote Document, Share: Infor quote,
or Task.

• In the Field Name list, select the field on the selected object for which to specify a default value.
• In the Default Value field, specify the default value to populate the selected field with whenever

a quote is cloned.
• Select the Override? check box if you want the default value to replace any data that may be in

the field from the source quote. If the Override? check box is selected, Infor Back Office Connect
will copy the value in the source field to the cloned record.

3 Click Save.
4 Repeat steps 2 and 3 for each object and field that requires default values.
5 Continue to the next step of the configuration process. See "Configuring quote PDF document

settings" on page 55.
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Configuring quote PDF document settings

The Infor Quote object includes a feature to create PDF documents to directly quote to customers for
their review. By default, Infor Back Office Connect also includes an PDF quote document template
(QuoteToPDFPage) that is used to generate PDF documents of Infor quotes.

To modify or customize a quote PDF template based on your business requirements, you must install
Custom Quote PDF Reference package and then modify the custom PDF Visualforce page
(QuoteToPDF1) to replace the default quote PDF template. See "Creating a customized quote PDF
template" on page 165.

This part of the configuration process is optional. If you want to use the default quote PDF template
and do not need to customize or modify a quote PDF document template, continue to the next step of
the configuration process. See "Starting the scheduler".

Modifying page layouts for the many to many configuration (optional)
When the Many to Many Message Source based configuration options for the Ship-to, Bill-to and
Pay-from records are enabled, these page layouts must be modified:

• Account page layout
• Bill-to page layout
• Pay-from page layout
• Ship-to page layout

Modifying the account page layout for many to many configurations

To modify the Account page layout for the Account Ship-to and Account Bill-to Many to Many Enabled
configurations:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Customize > Accounts > Page Layouts.
5 In the Account Page Layouts section, click the Edit hyperlink for the Infor Back Office Connect

Account Layout. See Salesforce documentation.
6 Remove the Ship-to Records related list.
7 Add the Ship-to Roles related list.
8 Click Save.
9 Repeat Steps 1 through 8 for the Account Bill-to Many to Many Enabled configuration for these

related lists:

• Add the Bill-to Roles related list.
• Remove the Bill-to Records related list.
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Modifying the bill-to page layout for many to many configurations

To modify the Bill-to page layout for the Account Bill-to, Ship-to Bill-to, and Bill-to Pay-from Many to
Many Enabled configurations:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Create > Objects.
5 In the Label column, click the Bill-to link.
6 In the Bill-to (Managed) window, select Page Layouts.
7 Click the Edit hyperlink for the Infor Back Office Connect Bill To Layout.
8 Remove the Account lookup field.
9 Add the Account related list.
10 Click Save.
11 Repeat Steps 1 through 10 for the Ship-to Bill-to Many to Many Enabled configuration for this related

list and field:

• Add the Ship-to Roles related list.
• Remove the Ship-to lookup field.

12 Repeat Steps 1 through 10 for the Bill-to Pay-from Many to Many Enabled configuration for these
related lists:

• Add the Pay-from Roles related list.
• Remove the Pay-from Records related list.

Modifying the pay-from page layout for many to many configurations

To modify the page layout for the Bill-to Pay-from Many to Many Enabled configuration:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, select App Setup > Create > Objects.
5 In the Label column, click the Pay-from link.
6 In the Pay-from (Managed) window, select Page Layouts.
7 Click the Edit hyperlink for the Infor Back Office Connect Pay From Layout.
8 Remove the Bill-to lookup field.
9 Add the Pay-from related list.
10 Click Save.
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Modifying the ship-to page layout for many to many configurations

To modify the Ship-to page layout for the Account Ship-to and Ship-to Bill-to Many to Many Enabled
configurations:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Create > Objects.
5 In the Label column, click the Ship-to link.
6 In the Ship-to (Managed) window, select Page Layouts.
7 Click the Edit hyperlink for the Infor Back Office Connect Ship-to Layout.
8 Remove the Account lookup field.
9 Add the Account related list.
10 Click Save.
11 Repeat Steps 1 through 10 for the Ship-to Many to Many Enabled configuration for these related

lists:

• Add the Bill-to Roles related list.
• Remove the Bill-to Records related list.

Starting the scheduler
The scheduler is the Infor Back Office Connect component that sends messages. The messages trigger
the processing of inbound and outbound Batch Apex jobs (by the adapter) to process inbound and
outbound messages.

Note: The scheduler should be stopped any time the ION Document Flow is disabled to prevent false
notifications from being sent to Infor Back Office Connect.

To start the scheduler:

1 Log in to Salesforce as the Integration context user.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 On the Integration Setup tab, click Step 7: Start/Stop Scheduler.
5 Click Start ION Integration Scheduler. A confirmation message is displayed.
6 Continue to the next step of the configuration process. See "Verifying whether the scheduler is

started" on page 57.

Verifying whether the scheduler is started
To verify whether the scheduler is started:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
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2 Select Setup.
3 In the sidebar column, select Administration Setup > Monitoring > Scheduled Jobs.
4 In the All Scheduled Jobs list, verify that the Job Name IONBatchExecutor is displayed. If the

IONBatchExecutor job is displayed, the scheduler started correctly. If the IONBatchExecutor is not
displayed, verify the Infor Back Office Connect configuration settings.

Configuring multiple currencies
Optionally, if your Salesforce organization uses multiple currencies for opportunities, quotes, and other
objects that support multiple currency, you must create, activate, and configure all of your currencies
before initiating BOD communication between ERP and Infor Back Office Connect. Every currency that
you create must also have a corresponding price book. See Salesforce documentation for information
on multi-currency.

Adding currencies
After you have enabled multiple currencies, add the currencies required for your Salesforce organization.

To add currencies:

1 Log in to Salesforce as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectAdministration Setup > Company Profile > Manage Currencies.
5 In the Active Currencies section, click New.
6 Specify this information:

Currency Type
Select the currency to define. The available currencies are displayed in alphabetical order according
to the ISO currency code.

Conversion Rate
Specify the conversion rate to use when converting the corporate currency into this new currency.

Decimal Places
Specify the number of decimal places to use to the right of the decimal point when displaying this
new currency. The value specified must be an integer between 0-6. By default, Infor Back Office
Connect stores four decimal places to the right of the decimal for prices and two for amounts. The
value specified for this setting will replace the default number of decimal places displayed for both
prices and amounts.

7 Click Save.
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Activating currencies
Activate additional currencies for your Salesforce organization that have already been defined but are
currently inactive.

To activate currencies:

1 Log in to Salesforce as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectAdministration Setup > Company Profile > Manage Currencies.
5 Select the currency to activate from the Inactive Currencies list and click Activate.

Changing the default currency
If necessary, you can change the default currency to the corporate currency of your Salesforce
organization to another supported currency. If you change the default currency, all of your current
currency conversion rates are modified to reflect the change in default currency.

To change the default currency:

1 Log in to Salesforce as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectAdministration Setup > Company Profile > Manage Currencies.
5 In the Active Currencies section, click Change Corporate.
6 Select the currency to set as the default from the New Corporate Currency list.
7 Click Save.

Enabling history tracking for standard objects
By default, history tracking is enabled for these fields: InForceEW_extid_c (the ERP key value) and
InForceEW_extaccountingentityid_c (Company ID) on all Infor Back Office Connect custom objects.

For standard Salesforce objects, history tracking is not enabled by default, and you must configure
history tracking manually. See Salesforce documentation for information on history tracking and how
to configure field history tracking.

Performing the initial data load
After completing the post-installation tasks, perform the initial data load from ERP into Infor Back Office
Connect. See Infor Back Office Connect BOD Mapping and Descriptions (Inbound). For specific data
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load sequencing information for your ERP, see your ERP integration guide. Also, see "Recommended
Inbound Batch Scope values for initial data load" on page 33 for each data set you are loading.

Note: To prevent duplicate Units of Measure from being created during the initial data load of the Item
Master BOD, you must change the value of the Total Batch Jobs setting to 2. After performing the
initial data load of the Item Master BOD, change the Total Batch Jobs setting back to 5 and continue
loading the remaining data. See "Configuring the scheduler settings" on page 50.

This table shows the recommended initial data load sequence:

BODERP ObjectsData Set

Code DefinitionGeographic Area1

Code DefinitionCustomer Types1

Code DefinitionIndustries1

Code DefinitionMarkets1

Code DefinitionNAICS1

Code DefinitionPayment Terms1

Code DefinitionTerritories1

Item MasterItems2

Contact Party MasterContact4

Customer Party MasterCustomer5

Bill-to Party MasterBill-to6

Ship-to Party MasterShip-to7

Pay-from Party MasterPay-from8

QuotesQuotes9

Sales OrdersSales Orders10

ShipmentsShipments11

Customer ReturnsCustomer Returns12

InvoicesInvoices13

ReceivablesReceivables14

Publishing code definitions from ERP
After configuring the Infor Back Office Connect application to synchronize with ERP, you must publish
the required code definitions from ERP to Infor Back Office Connect. Code definition objects are only
synchronized one way and are published only from ERP to Infor Back Office Connect. Any updates
made to code definition objects in Infor Back Office Connect are not synchronized back to the ERP.
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Code definitions and their values appear in Infor Back Office Connect as lookup categories and lookups.
Lookups are used to search for records. In Salesforce you have standard and enhanced or custom
lookups.

After the code definitions are published successfully, you can view them on the Lookups and Lookup
Categories tabs.

Viewing code definition lookup categories
To view code definition lookup categories:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Lookup Categories tab.
4 View the code definition lookup categories.

Viewing code definition lookups
To view code definition lookups:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Lookups tab.
4 View the code definition lookups.

Configuring reports
By default, data associated with Infor Back Office Connect custom objects and tabs is available for
reporting using the standard Salesforce reporting features. To configure Infor Back Office Connect
reports, you can:

• Add Infor Back Office Connect custom fields to any existing regular reports
• Add Infor Back Office Connect custom fields to any existing custom reports you have created
• Add additional custom reports to report on ERP data. For example, you can add a report that compile

data on all accounts with sales orders.

See Salesforce documentation for information on Salesforce reporting and creating reports.
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Disabling reports for custom objects (optional)
You can disable reports for these custom objects:

• Inbound Message
• Lookup
• Lookup Category
• Outbound Message
• Outbound Transaction

Note: This is an optional step.

To disable reports for custom objects:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Create > Objects.
5 In the Custom Objects list, select a custom object.
6 Click Edit.
7 In the Optional Features section, clear the Allow Reports checkbox.
8 Click Save.
9 Repeat Steps 5 through 8 for the remaining objects.

Creating and modifying page layouts for an Infor Back
Office Connect read only user (optional)
When preparing for the Infor Back Office Connect installation process, you may optionally create an
Infor Back Office Connect read only profile. See "Creating an Infor Back Office Connect Read Only
profile" on page 23. After installing Infor Back Office Connect, you must configure the page layouts for
the Infor Back Office Connect read only profile. This process includes creating an Infor Back Office
Connect read only page layout for the Account, Contacts, Bill-to, Pay-from, and Ship-to objects, and
removing new buttons on the related lists on these objects.

Creating an Infor Back Office Connect read only account page layout
An Infor Back Office Connect Read Only Account Page Layout must be assigned to Infor Back Office
Connect Read Only profile users.

To create an Infor Back Office Connect Read Only Account Page Layout:

1 Log in to Infor Back Office Connect as the system administrator.
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2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Customize > Accounts > Page Layouts.
5 Click New.
6 In the Existing Page Layout field, specify the Infor Back Office Connect Account Layout option.
7 In the Page Layout Name field, specify the name of the new profile. For example, Infor Back Office

Connect READ ONLY Account.
8 Click Save.

Note:  Make note of the Related Lists in the Mini Page Layout window.

Note:  Use standardized naming conventions for your custom objects to ensure that they are easily
identifiable by the Infor Back Office Connect Administrator or Implementer.

Removing new buttons from account-related lists on the read only
account page layout
When the Infor Back Office Connect Read Only Account Page Layout is created, new buttons associated
with Related Lists display on the page. These new buttons must be removed.

To remove a new button from an account-related list:

1 In the Infor Back Office Connect Read Only Account page, go to the Addresses section.
2 Click the Wrench icon.
3 In the Related Lists Properties - Addresses window, click Buttons Plus (+).
4 In the Selected Buttons section, select New Address.
5 Click Remove. The New Address button is moved to the Available Buttons section.

Note: You can also clear the standard button check box to remove the button from the related list.

6 Click OK.
7 Repeat Steps 1 through 6 for these related lists:

Related List Properties - Contacts
Clear the New check box.

Related List Properties - Contact Roles
Remove New Contact Role.

Related List Properties - Ship-to Records
Clear the New check box.

Related List Properties - Bill-to Records
Clear the New check box.

Related List Properties - Opportunities
Clear the New check box.
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Related List Properties - Cases
Clear the New check box.

8 Click Save.
9 In the Account Page Layout page, select Page Layout Assignment.
10 Click Edit Assignment.
11 In the Profiles column, select the Infor Back Office Connect  READ ONLY User profile.
12 In the Page Layout to Use field, specify the Infor Back Office Connect Read Only Account page

layout option.
13 Click Save.

Creating an Infor Back Office Connect read only contact page layout
An Infor Back Office Connect Read Only Contact Page Layout must be assigned to Infor Back Office
Connect Read Only Profile users.

To create an Infor Back Office Connect Read Only Contact Page Layout:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Customize > Contacts > Page Layouts.
5 Click New.
6 In the Existing Page Layout field, select the Infor Back Office Connect Contact Layout or specify

a contact layout profile you want to use as your template.
7 In the Page Layout Name field, specify the name of the new read only page layout. For example,

Infor Back Office Connect READ ONLY Contact.
8 Click Save.

Note:  Make note of the Related Lists in the Mini Page Layout window.

Note:  Use standardized naming conventions for your custom objects to ensure that they are easily
identifiable by the Infor Back Office Connect Administrator or Implementer.

Removing new buttons from contact-related lists on the read only
contact page layout
When the Infor Back Office Connect Read Only Contact Page Layout is created, new buttons associated
with Related Lists display on the page. These new buttons must be removed.

To remove a new button from the contact-related list:

1 In theInfor Back Office Connect Read Only Contact page, go to the Accounts section.
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2 Click the Wrench icon.
3 In the Related Lists Properties - Accounts window, click Buttons Plus (+).
4 In the Selected Buttons section, select New Account.
5 Click Remove. The New Account button is moved to the Available Buttons section.

Note: You can also clear the standard button check box to remove the button from the related list.

6 Click OK.
7 Repeat Steps 1 through 6 for these related lists:

Related List Properties - Addresses
Remove New Address.

Related List Properties - Pay-from Roles
Remove New Pay-from Role.

Related List Properties - Social Media
Remove New Social Media.

Related List Properties - Ship-to Roles
Remove New Ship-to Role.

Related List Properties - Messengers
Clear the New checkbox.

Related List Properties - Bill-to Roles
Remove New Bill-to Role.

8 Click Save.
9 In the Contact Page Layout page, select Page Layout Assignment.
10 Click Edit Assignment.
11 In the Profiles column, select the Infor Back Office Connect Read Only profile.
12 In the Page Layout to Use field, specify the Infor Back Office Connect  READ ONLY Contact

page layout option.
13 Click Save.

Creating an Infor Back Office Connect read only bill-to page layout
An Infor Back Office Connect Read Only Bill-to Page Layout must be assigned to Infor Back Office
Connect Read Only profile users.

To create an Infor Back Office Connect Read Only Bill-to Page Layout:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Create > Objects.
5 In the Label column, click the Bill-to link.
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6 In the Bill-to (Managed) window, go to the Page Layouts section.
7 Click New.
8 In the Existing Page Layout field, specify Infor Back Office Connect Bill To Layout or select a

layout profile to use as your template.
9 In the Page Layout Name field, specify the name of the new read only page layout. For example,

Infor Back Office Connect READ ONLY Bill-to.
10 Click Save.

Note:  Make note of the Related Lists in the Mini Page Layout window.

Note:  Use standardized naming conventions for your custom objects to ensure that they are easily
identifiable by the Infor Back Office Connect Administrator or Implementer.

Removing new buttons from bill-to related lists on the read only
bill-to page layout
When the Infor Back Office Connect Read Only Bill-to Page Layout is created, new buttons associated
with Related Lists display on the page. These new buttons must be removed.

To remove a new button from a Bill-to related list:

1 In the Bill-to (Managed) window, go the Page Layout section.
2 Click the Infor Back Office Connect READ ONLY Bill-to Edit link.
3 Go to the Addresses section and click the Wrench button.
4 In the Related Lists Properties - Addresses window, click the Buttons Plus (+) button.
5 In the Selected Buttons section, select New Address.
6 Click Remove.
7 Click OK.
8 Repeat Steps 3 through 7 for these related lists:

Related List Properties - Contacts Roles
Remove New Contact Role.

Related List Properties - Pay-from Records
Clear the New standard button.

9 Click OK.
10 Click Save.
11 In the Custom Object Bill-to (Managed) window, click Page Layout  > Page Layout Assignment.
12 Click Edit Assignment.
13 In the Profiles column, select Infor Back Office Connect READ ONLY User.
14 In the Page Layout To Use field, select Infor Back Office ConnectREAD ONLY Bill-to page layout

option.
15 Click Save.
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Creating an Infor Back Office Connect read only pay-from page
layout
An Infor Back Office Connect Read Only Pay-from Page Layout must be assigned to Infor Back Office
Connect Read Only profile users.

To create an Infor Back Office Connect Read Only Pay-from Page Layout:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 SelectSetup.
4 In the sidebar column, selectApp Setup > Create > Objects.
5 In the Label column, click the Pay-from link.
6 In the Pay-from (Managed) window, go to the Page Layouts section.
7 Click New.
8 In the Existing Page Layout field, select Infor Back Office Connect Pay From Layout or select a

layout profile to use as your template.
9 In the Page Layout Name field, specify the name of the new read only page layout. For example,

Infor Back Office Connect READ ONLY Pay-from.
10 Click Save.

Note:  Make note of the Related Lists in the Mini Page Layout window.

Note:  Use standardized naming conventions for your custom objects to ensure that they are easily
identifiable by the Infor Back Office Connect Administrator or Implementer.

Removing new buttons from pay-from related lists on the read only
page layout
When the Infor Back Office Connect Read Only Page Layout is created, new buttons associated with
Related Lists display on the page. These new buttons must be removed.

To remove a new button from a Pay-from related list:

1 In the Pay-from (Managed) window, go to the Page Layout section.
2 Click the Infor Back Office Connect READ ONLY Pay-from Edit link.
3 Go to the Addresses section and click the Wrench button.
4 In the Related Lists Properties - Addresses window, click the Buttons Plus (+) button.
5 In the Selected Buttons section, select New Address.
6 Click Remove.
7 Click OK.
8 Repeat Steps 3 through 7 for the Contacts related list:
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Related List Properties - Contacts
Remove New Contact Role.

9 Click OK.
10 Click Save.
11 In the Custom Object Pay-from (Managed) window, click Page Layout > Page Layout Assignment.
12 Edit Assignment.
13 In the Profiles column, select Infor Back Office Connect READ ONLY User.
14 In the Page Layout To Use field, select Infor Back Office Connect READ ONLY Pay-from page

layout option.
15 Click Save.

Creating an Infor Back Office Connect read only ship-to page layout
An Infor Back Office Connect Read Only Ship-to Page Layout must be assigned to Infor Back Office
Connect Read Only profile users.

To create an Infor Back Office Connect Read Only Ship-to Page Layout:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Your name > Setup.
4 In the sidebar column, selectApp Setup > Create > Objects.
5 In the Label column, click the Ship-to link.
6 In the Ship-to (Managed) window, go to the Page Layouts Related List section.
7 Click New.
8 In the Existing Page Layout field, select Infor Back Office Connect Ship-to Layout or specify a

layout profile to use as your template.
9 In the Page Layout Name field, specify the name of the new read only page layout. For example,

Infor Back Office Connect READ ONLY Ship-to.
10 Click Save.

Note:  Make note of the Related Lists in the Mini Page Layout window.

Note:  Use standardized naming conventions for your custom objects to ensure that they are easily
identifiable by the Infor Back Office Connect Administrator or Implementer.
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Removing new buttons from ship-to related lists on the read only
page layout
When the Infor Back Office Connect Read Only Page Layout is created, new buttons associated with
Related Lists display on the page. These new buttons must be removed.

To remove a new button from a Ship-to related list:

1 In the Ship-to (Managed) window, go to the Page Layout section.
2 Click the Infor Back Office Connect READ ONLY Ship-to Edit link.
3 Go to the Addresses section and click the Wrench button.
4 In the Related Lists Properties - Addresses window, click the Buttons Plus (+) button.
5 In the Selected Buttons section, select New Address.
6 Click Remove.
7 Click OK.
8 Repeat Steps 3 through 7 for these related lists:

Related List Properties - Accounts
Remove New Account.

Related List Properties - Contacts
Remove New Contact Role.

Related List Properties - Bill-to Records
Clear the New standard check box.

9 Click OK.
10 Click Save.
11 In the Custom Object Ship-to (Managed) window, click Page Layout > Page Layout Assignment.
12 Edit Assignment.
13 In the Profiles column, select Infor Back Office ConnectREAD ONLY User.
14 In the Page Layout To Use field, select Infor Back Office Connect READ ONLY Ship-to page

layout option.
15 Click Save.

Eliminating optional master data dependency
Implementations currently using the Account Ship-to, Bill-to, or Pay-from many-to-many relationships
can remove the many-to-many Master Data dependency from the Infor Back Office Connect
implementation based upon their business needs.

Eliminating the optional master data dependency results in these changes:

• A reduction is storage requirements for your data. Specifically, the Account Bill-to Role, Account
Ship-to Role, Bill-to Pay-from Role, and the Ship-to Bill-to Role junction objects are no longer used.
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• Bill-to, Pay-from, and Ship-to records are created and updated in ERP only. These records are not
sent from ERP to Infor Back Office Connect, and the records do not exist in Infor Back Office Connect.
Instead, the name and address information for Bill-to, Pay-from, and Ship-to records are part of
each transaction record.

• To view Bill-to, Pay-from, and Ship-to transaction data for quotes, orders, and invoices, you must
search for the Bill-to, Pay-from, and Ship-to records by name.

To eliminate optional master data:

1 Disable the desired BODs in the BOD Type Version tab.

Note:  Disable the Nouns in ION Desktop Document Flow to avoid unsupported Inbound BOD errors
in Infor Back Office Connect.

2 Remove Transactional Data dependencies by clearing the active flag in the BOD Field Mapping for
each of these dependent Lookup fields:

• Ship-to

InvoiceLine__c.shipto__c, QuoteLineItem__c.shipto__c, Quote__c.shipto__c,
SalesOrderLine__c.shiptoid__c, SalesOrder__c.shipto__c, and Shipment__c.extshipto__c.

• Bill-to

CustomerReturn__c.billto__c, Invoice__c.billto__c, Quote__c.billto__c, Receivable__c.billto__c, and
SalesOrder__c.billto__c.

• Pay-from

Quote__c.payfrom__c, Receivable__c.payfrom__c, and SalesOrder__c.payfrom__c.

3 Remove the pre-existing master data.
a Log in to the Data Loader as the Integration User.
b Export the SFDC ID for the desired objects (Ship-to, Bill-to, and Pay-from records and Account

Ship-to Roles, Account Bill-to Roles, Ship-to Bill to Roles, and Bill-to Pay-from Roles).
c Delete the records based on the export file.

Caution: Deleting Ship-to, Bill-to, or Pay-from records with any user other than the
integration user will result in DELETE BODs being sent to your ERP system of record.
Always use the Integration User login for data clean-up processes.

Address line validation rules (optional)
Infor Back Office Connect uses the standard Salesforce Street Address Line for the multiple address
lines that are mapped in the BOD. To help with data quality, below are steps on how to add sample
validation rules for each of the objects that have a Street Address. They are currently configured to
allow only 5 address lines that are each limited to 100 characters. You can change the length of the
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line by replacing each of the 100 with the desired length. For fewer lines, you can remove the last
REGEX line and the comma on the previous line to reduce it to 4 lines.

Account and contact object address line validation rules
These are the steps for adding sample validation rules for the Account and Contact objects.

To add Account and Contact object address line validation rules:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Customize > Accounts > Validation Rules..
5 Click New.
6 Specify this information:

Rule Name
The name of the validation rule.

Error Condition Formula
The error condition formula of the validation rule. This is the Account Object Validation Rule:

NOT(OR(REGEX(BillingStreet,".{0,100}"),
REGEX(BillingStreet,".{0,100}\r\n.{0,100}"),
REGEX(BillingStreet,".{0,100}\r\n.{0,100}\r\n.{0,100}"),
REGEX(BillingStreet, ".{0,100}\r\n.{0,100}\r\n.{0,100}\r\n.{0,100}"),
REGEX(BillingStreet,".{0,100}\r\n.{0,100}\r\n.{0,100}\r\n.{0,100}\r\n.
{0,100}")
))

This is the Contact Object Validation Rule:

NOT(OR(REGEX(MailingStreet,".{0,100}"),
REGEX(MailingStreet,".{0,100}\r\n.{0,100}"),
REGEX(MailingStreet,".{0,100}\r\n.{0,100}\r\n.{0,100}"),
REGEX(MailingStreet,".{0,100}\r\n.{0,100}\r\n.{0,100}\r\n.{0,100}"),
REGEX(MailingStreet,".{0,100}\r\n.{0,100}\r\n.{0,100}\r\n.{0,100}\r\n.
{0,100}")
))

Error Message
The message that appears when the Error Condition formula is true. This is the sample error
message: The address entered has a line longer than 100 characters or more than 5 lines.

7 Click Save.
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Bill-to, pay-from, and ship-to object address line validation rules
These are the steps for adding sample validation rules for the Bill-to, Pay-from, and Ship-to objects.

To add Bill-to, Pay-from, and Ship-to object address line validation rules:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Create > Objects > Bill-to > Validation Rules.
5 Click New.
6 Specify this information:

Rule Name
The name of the validation rule.

Error Condition Formula
The error condition formula of the validation rule. This is the Bill-to, Pay-from, and Ship-to Object
Validation Rule:

NOT(OR(REGEX(InForceEW__Primaryaddressstreet__c,".{0,100}"),
REGEX(InForceEW__Primaryaddressstreet__c,".{0,100}\r\n.{0,100}"),
REGEX(InForceEW__Primaryaddressstreet__c,".{0,100}\r\n.{0,100}\r\n.{0,
100}"),
REGEX(InForceEW__Primaryaddressstreet__c,".{0,100}\r\n.{0,100}\r\n.{0,
100}\r\n.{0,100}"),
REGEX(InForceEW__Primaryaddressstreet__c,".{0,100}\r\n.{0,100}\r\n.{0,
100}\r\n.{0,100}\r\n.{0,100}")))

Error Message
The message that appears when the Error Condition formula is true. This is the sample error
message: The address entered has a line longer than 100 characters or more than 5 lines.

7 Click Save.
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5Infor Back Office Connect customization

This chapter describes the tasks that you must complete to customize Infor Back Office Connect to
meet your business requirements.

Many of the steps required to customize Infor Back Office Connect involve making modifications to the
inbound and outbound BOD documents and BOD field mappings that are published in the default BOD
data set, or seed data, that is installed during the Infor Back Office Connect installation. Detailed
information on the default data set is published in the Infor Back Office Connect BOD Mapping and
Descriptions (Inbound) and Infor Back Office Connect BOD Mapping and Descriptions (Outbound)
guides. See also "Understanding BODs" on page 257.

Note: We recommend that Infor Back Office Connect administrators or developers attempting to
customize Infor Back Office Connect have experience in XML messaging and working with BODs and
basic knowledge of writing Salesforce Object Query Language (SOQL) queries.

Understanding the reasons for customizing Infor Back
Office Connect
These are the primary reasons for customizing Infor Back Office Connect:

• To add new fields to support inbound or outbound processes. To add new fields, you must update
the corresponding inbound or outbound BODs to include the new fields.

• To update inbound or outbound BODs to change the value of an element in the inbound or outbound
BOD. For example, the default value of the <CustomerStatus> element in a BOD is Inactive. However,
you want to change the default value of the element to Active, and to do so you must update the
BOD containing the element.

• To create test debugging scenarios. If BODs are generating errors due to information that is missing
from the ERP, the inbound and/or outbound BODs can be updated to test possible solutions.

• To create a new BOD to support inbound and outbound message processes. You can create new
BODs Infor Back Office Connect Any BOD if you create a new custom object in Infor Back Office
Connect or Salesforce or if you create new business processes that are not supported by the default
Infor Back Office Connect BODs or the or the BODs that are supported by your ERP. See "Any
BOD" on page 105.
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Note: Each ERP system has a comprehensive set of fields that are mapped to the core Infor Back
Office Connect BOD types. The Infor Back Office Connect integration uses only a subset of these fields.
If you require additional fields supported by your ERP system, you can add those fields to the Infor
Back Office Connect inbound and outbound BOD mappings and the actual BOD XML without having
to create a new BOD. See the BOD documentation for your ERP to view the comprehensive list of
fields supported by the ERP.

Understanding the Infor Back Office Connect objects
used to modify default BOD XML documents
This table shows the Infor Back Office Connect objects used to modify default BOD XML documents
with a brief description of each object:

DescriptionInfor Back Office Connect object

Inbound Messages

Outbound Messages

Bod Entity Mappings

Bod Field Mappings

Bod Types

Bod Type Versions

Message Source

Message Source BOD Type Versions

Overview of Infor Back Office Connect BOD mapping
documents
The default BOD data set is published in the Infor Back Office Connect BOD Mapping and Descriptions
(Inbound) and Infor Back Office Connect BOD Mapping and Descriptions (Outbound) guides. See also
"Understanding BODs" on page 257.

The Infor Back Office Connect BOD Mapping and Descriptions (Inbound) guide includes:

• Descriptions of every BOD mapped to Infor Back Office Connect to support inbound SYNC (BOD)
processing

• Each BOD contains all of the Salesforce and Infor Back Office Connect fields mapped to inbound
SYNC BODs

74 | Infor Back Office Connect Administration Guide

Infor Back Office Connect customization



The Infor Back Office Connect BOD Mapping and Descriptions (Outbound) guide includes:

• Descriptions of every BOD mapped to Infor Back Office Connect to support outbound PROCESS
(BOD) processing

• Each BOD contains all of the Salesforce and Infor Back Office Connect fields mapped to an outbound
PROCESS BODs

Viewing inbound messages
The functionality to view Inbound messages is primarily for administrative diagnostics. In some cases
the administrator can decide to clear the Processing Status, Retry Count and Was Processed
indicator to reprocess a BOD after resolving the root cause of the previous processing error.

To view an inbound message:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 From the Force.com App Menu select Infor Back Office Connect Administration.
3 Click the Inbound Messages tab.
4 Select the desired filter from the View list and click Go! to display the list of inbound messages.
5 In the Message ID column, click the hyperlink of the message ID to display the Inbound Message

Detail page. For example, click USALVICRMBW2K84-51535-1361102258711-2:0:99:1:1.
6 The following fields are displayed in the Information section:

• Message ID: The Message ID is a unique identifier for the message. For example,
ID:USALVICRMBW2K84-51535-1361102258711-2:0:99:1:1.

• Message Type: The message type consists of a BOD pairing the BOD verb Sync, Show, or
Confirm and the BOD noun. For example, Sync.CustomerPartyMaster.

• Retry Count: The value displayed indicates the number of attempts that have been made to
reprocess the message.

• Message Priority: The Message Priority field displays the system generated message priority
based on where the BOD noun falls in the BOD dependency order.

• Accounting Entity: The Accounting Entity is defined by the integrated ERP. This value is also
used in the Unique ID for Infor Back Office Connect records.

• Logical ID: The ION Logical ID assigned to the integrated ERP. Based on Logical ID, ION
identifies what connection point to send or receive BODs.

• Header XML: This field displays the header XML of the inbound message.
• The Owner field is read-only and displays the user assigned as the integration context user in

Infor Back Office Connect.
• Bod XML: This field displays the XML of the inbound BOD. See "Modifying the BOD XML for an

inbound message" on page 77.

Note: Large BODs exceeding the Bod XML field size are handled as an attachment to the inbound
message.
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• Was Processed: This field displays a code that indicates the processing status of the BOD. If
a processing error occurs, the code helps the administrator determine where the error occurred
and troubleshoot the error. The table explains the valid values.

DescriptionValue

Not processed - awaiting processing.0

Processed without error1

ERP Error9

Variation Error99

Salesforce error999

Note: A variation ID is assigned to a BOD by Infor Back Office Connect to identify the number
of times a record with a specific set of attributes has been published for the accounting entity
and location. The variation ID is used to ensure that Infor Back Office Connect is reading in the
latest version of the BOD. For example, a BOD with a variation ID of 5 is received and processed.
If then Infor Back Office Connect receives another BOD for the same record with a variation ID
4, the outdated information is automatically detected and discarded by the system. The integration
setup step 4 provides the option of handling Variation errors as an error resulting in a Was
Processed value of 99.

• Marked as Processed: This field displays a code that indicates whether the message was
received by Infor Back Office Connect. Valid values are:

DescriptionValue

New message not yet confirmed0

Message receipt has been confirmed back to
ION.

1

• Processing Status: This field indicates the current status of the message in the processing life
cycle. Valid values are:

DescriptionValue

Message processing has not been initiated for
the message

None

The message has been added to the scheduled
job queue

In Process

The message was processed.Completed

• Error Message: If a processing error occurred, this field displays the message associated with
the processing issue.
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Modifying the BOD XML for an inbound message
In previous versions of Infor Back Office Connect (prior to version 10.8), BOD XML content was accessed
from the Notes & Attachments related list. To reduce storage requirements for the Infor Back Office
Connect application, XML attachments have been replaced with an editable Bod XML field, from which
you can copy and edit the BOD XML content of an inbound message in a text editor to modify the XML
as necessary.

To modify the BOD XML for an inbound message:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 From the Force.com App Menu select Infor Back Office Connect Administration.
3 Click the Inbound Messages tab.
4 Select All from the View list and click Go! to display the complete list of inbound messages.
5 In the Message ID column, click the hyperlink of the message ID to display the Inbound Message

Detail page. For example, click USALVICRMBW2K84-51535-1361102258711-2:0:99:1:1.
6 Click Edit to display the Inbound Message Edit page.
7 Locate the Bod XML field, and copy the XML content to the clipboard.
8 Past the XML content into a text editor.
9 Modify the XML based on your business requirements.

Note:  All BOD XML files must first be linearized in order for Infor Back Office Connect to read them.

10 Copy the updated XML from the text editor to the clipboard.
11 Paste the updated XML from the clipboard to the Bod XML field.
12 Specify 0 as the value for the Retry Count field.
13 Specify 0 as the value for the Was Processed field.
14 Select --None-- as the value of the Processing Status field.
15 Click Save.

Modifying outbound messages
This section describes the steps required to modify an outbound message.

To modify an outbound message:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 From the Force.com App Menu select Infor Back Office Connect Administration.
3 Click the Outbound Messages tab.
4 Select All from the View list and click Go! to display the complete list of inbound messages.
5 In the Message ID column, click the hyperlink of the message ID to display the Outbound Message

Detail page. For example, click USALVICRMBW2K84-51535-1361102258711-2:0:99:1:1.
6 Click Edit to display the Outbound Message Edit page.
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7 In the Information section, edit or update the information for these fields as necessary:

• Message ID: The Message ID is a unique identifier for the message. For example,
ID:USALVICRMBW2K84-51535-1361102258711-2:0:99:1:1.

• Message Type: The message type consists of a BOD pairing beginning the BOD verb Sync,
Show, or Confirm and the BOD noun. For example, Sync.CustomerPartyMaster.

• Header XML: This field displays the header XML of the inbound message.
• The Owner field is read-only and displays the user assigned as the integration context user in

Infor Back Office Connect.
• Bod XML: This field displays the XML of the inbound BOD. You can copy and edit the BOD XML

as necessary. See "Modifying the BOD XML for an inbound message" on page 77.

Note: The Bod XML field replaces attachments used in previous editions of Infor Back Office
Connect.

• Processing Complete: This field displays a code that indicates the processing status of the
BOD. If a processing error occurs, the code helps the administrator determine where the error
occurred and troubleshoot the error. Valid values are: 9=ERP Error, 1=Processed without error,
99=variation ID error, 999=Salesforce error, and 0=not processed - awaiting processing.

Note: A variation ID is assigned to a BOD by Infor Back Office Connect to identify the number
of times a record with a specific set of attributes has been published for the accounting entity
and location. The variation ID is used to ensure that Infor Back Office Connect is reading in the
latest version of the BOD. For example, a BOD with a variation ID of 5 is received and read in
Infor Back Office Connect. Infor Back Office Connect then receives another BOD for the same
record with a variation ID of 4. Upon receiving the BOD with the variance ID of 4, this BOD is
assigned a processing status of 99 to indicate that the variation ID of 4 is older then the variation
ID of 5.

• Error Message: If a processing error occurred, this field displays the message associated with
the processing issue.

8 Click Save.

Modifying the BOD XML for an outbound message
In previous versions of Infor Back Office Connect (prior to version 10.8), BOD XML content was accessed
from the Notes & Attachments related list. To reduce storage requirements for the Infor Back Office
Connect application, XML attachments have been replaced with an editable Bod XML field, from which
you can copy and edit the BOD XML content of an outbound message in a text editor to modify the
XML as necessary.

To modify the BOD XML for an outbound message:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 From the Force.com App Menu select Infor Back Office Connect Administration.
3 Click the Outbound Messages tab.
4 Select All from the View list and click Go! to display the complete list of outbound messages.
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5 In the Message ID column, click the hyperlink of the message ID to display the Outbound Message
Detail page. For example, click USALVICRMBW2K84-51535-1361102258711-2:0:99:1:1.

6 Click Edit to display the Outbound Message Edit page.
7 Locate the Bod XML field, and copy the XML content to the clipboard.
8 Past the XML content into a text editor.
9 Modify the XML based on your business requirements.

Note:  All BOD XML files must first be linearized in order for Infor Back Office Connect to read them.

10 Copy the updated XML from the text editor to the clipboard.
11 Paste the updated XML from the clipboard to the Bod XML field.
12 Click Save.

Customizing Infor Back Office Connect
After installing and configuring Infor Back Office Connect, you can customize Infor Back Office Connect
to meet your business requirements. By default, the Infor Back Office Connect application installs the
Business Object Documents (BOD) used to communicate data between ERP and Salesforce. These
default BODs include a default data set configured to the specifications of your ERP.

By customizing Infor Back Office Connect to your business requirements, you can add, change, and
remove data elements and fields on Infor Back Office Connect and Salesforce objects and modify the
default Infor Back Office Connect BOD Mapping documents to support customization in both Infor Back
Office Connect and ERP.

You can customization Infor Back Office Connect in these ways:

• Create new field mappings for inbound data elements in BOD messages to populate data from ERP
into custom fields added in Infor Back Office Connect

• Customize outbound BOD messages to publish data from custom fields added in Infor Back Office
Connect to ERP

• Configure Infor Back Office Connect to conditionally publish outbound BOD messages based on
specific business requirements and rules

The default BOD data set containing all the standard BOD field mappings is published in the Infor Back
Office Connect BOD Mappings and Descriptions (Inbound) and Infor Back Office Connect BOD Mappings
and Descriptions (Outbound) guides. These guides are available for download on the Integration
Setup tab of the Infor Back Office Connect application.

Because Infor Back Office Connect is integrated with your ERP, the process of adding customizations
to inbound messages may require you to make changes in both Infor Back Office Connect and ERP.

To begin the inbound BOD customization process in your ERP, you must first determine which BOD(s)
contain the field(s) you want to add to Infor Back Office Connect and confirm that the BOD does not
already include the desired field(s). If the field(s) exist in the BOD(s), you do not need to update the
BOD. If the field(s) do not exist, you will need to add the field(s) to the UserArea in the BOD. See
"Adding custom fields to a BOD document" on page 80.
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This section describes the tasks that you must complete in Infor Back Office Connect and ERP to add
customizations to inbound messages in Infor Back Office Connect.

Customizing inbound messages
Inbound messages are generated in ERP and sent to Infor Back Office Connect. See "Understanding
inbound message processing" on page 266. These inbound messages trigger field updates in Infor Back
Office Connect and communicate processing error messages and statuses. Inbound messages can
be viewed by Infor Back Office Connect administrators on the Inbound Messages tab in Infor Back
Office Connect.

The Infor Back Office Connect BOD Mapping and Descriptions (Inbound) guide describes all the fields
that are currently mapped for synchronization in Infor Back Office Connect. After reviewing this document
and speaking with Infor Back Office Connect users, you can determine which custom fields should be
added to the current Infor Back Office Connect BOD Mappings.

Adding custom fields to a BOD document
After determining which BOD(s) contain the field(s) you want to add to Infor Back Office Connect and
confirming that the BOD does not already include the desired field(s), add the field(s) to the user aea
in the BOD. To add the field(s) to the BOD:

• Locate the BOD user area. See "Locating the BOD user area" on page 80.
• Update the property element in the BOD to include the field. See "Updating a property element" on

page 81.

Locating the BOD user area

The user area is a user-defined field section of a BOD document that contains information that is not
included in the standard BOD field descriptions. User-defined fields can be fields used by ERP or
additional fields requested by the Saleforce or Infor Back Office Connect user.

The user area is housed within the <UserArea> element and is usually located at the end of a BOD
document. User-defined fields are always published using the <Property> element. This sample shows
a user area containing several property elements:

<UserArea>
<Property>
<NameValue name="ln.SalesIndicator" type="IndicatorType">false</Name
Value>
</Property>
<Property>
<NameValue name="ln.ProductionIndicator" type="IndicatorType">false</
NameValue>
</Property>
<Property>
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<NameValue name="ln.CostingIndicator" type="IndicatorType">false</Name
Value>
</Property>

</UserArea>

Updating a property element

To create a custom field in a BOD document, the ERP user must enter the user-defined field (UDF) or
custom field information into the property element in the user area of the BOD. The UDF property must
include information for the <NameValue name> and <Type> elements and a description. This is an
example of a properly formed property element containing a custom field for Sales Indicator:

<Property>
<NameValue name="ln.SalesIndicator" type="IndicatorType">false</Name
Value>
</Property>

The <NameValue name> element is used to define the name-value pair. For example, if you want to
add a custom field called Amount, add this to the <Property> element in the user area: <NameValue
name="CustomAmountField"

The description part of the element contains a general description of the custom field and its use. For
example, in this <NameValue name="ln.SalesIndicator" type="IndicatorType">false
</NameValue> custom field, false is the description.

Creating custom fields in Infor Back Office Connect
When Infor Back Office Connect receives inbound messages from ION, the updates are targeted to
specific fields in Infor Back Office Connect. If the target field does not exist in Infor Back Office Connect
or Salesforce, you must create a custom field.

After adding the custom field, you can then map the custom field to receive the custom field in inbound
messages.

Complete these tasks to create custom fields in Infor Back Office Connect:

• Create the custom field(s) in Salesforce. You can create custom fields by customizing a standard
object, such as Accounts, Contacts, or by creating a custom object. See Salesforce documentation.

• Make a note of the object where you added the custom field. For example, if the custom field is
added to the Salesforce standard Account object, the Object Name is Account.

• Make a note of the API name assigned to the custom field on the object on which it was created.
This information is located in the [Object Name] Custom Fields & Relationships section. For example,
if the custom field is Toll Free #, the API name would be Toll_Free__c.

• Create the custom field mapping to receive inbound messages. See "Creating new BOD field
mappings in Infor Back Office Connect" on page 82.
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Creating new BOD field mappings in Infor Back Office Connect
Create new BOD field mappings to customize the inbound data import process. Inbound BOD field
mappings are associated with a particular BOD Type Version. As updated mappings are created, new
BOD schema versions become available. When an inbound message is received, the message source
is verified to determine which associated BOD Type Versions can be used to parse the message.

Note: Information on the relationships between objects and fields is located on the Fields page for a
particular object. To access information on the Contacts object fields, select Setup and then select
App Setup > Customize > Contacts > Fields in the sidebar column.

When Infor Back Office Connect processes the inbound BOD, it locates the highest version ID number
found in the BOD Type Version Name to parse the message. For example, if there are multiple versions
of the SyncCustomerPartyMaster BOD numbered BTV-0000000000 to BTV-0000000040, Infor Back
Office Connect will process BTV-0000000040.

Note: BOD type versions are backwards compatible with prior BOD type versions.

To create new BOD field mappings in Infor Back Office Connect:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Message Sources.
4 Click Go! to display the configured message sources.
5 Click the message source name to display the message source details. The message source details

display a list of all available BOD type versions for the configured ERP.
6 In the Messages Source BOD Type Versions list, click the hyperlink of the BOD type version name

to display the message source BOD version details. For example, click MSBTV-0002.
7 In the Message Source BOD Type Detail section, click the hyperlink of the BOD type version to

display the BOD Type Version Detail page. For example, click BTV-0000000012.
8 In the Bod Fields Mapping section, click New Bod Field Mapping.
9 Specify this information:

Bod Field Mapping Name
Specify a descriptive name for the new BOD field mapping. For example, specify ERP Account
Number.
CRM Entity Name
Specify the Infor Back Office Connect custom object or standard Salesforce object where the field
is located. For example, account.
Bod Type Version
The Bod type version is automatically populated based on the selected BOD type version.

CRM Attribute Name
Specify the named to display for the field on the object. For example, specify extid__c.

BOD Xpath
Specify the BOD element where you can find the field mapping information from the Infor Back
Office Connect BOD Mapping and Descriptions (Inbound) guide. The value specified must correspond
with the related Xpath from the noun element in the BOD XML message. For example, specify
/CustomerPartyMaster/PartyIDs/ID.
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Default Value
Specify the default value for the field that is displayed when the field is visible.

Is Custom
Select the Is Custom check box if the field mapping is a custom mapping. When this option is
selected, the Load Seed data will not modify this customized field. Standard records cannot be
modified, but can be disabled by clearing the Active check box.

Active
Select the Active check box if the field is to be included in the current field mappings for the BOD.
Clear the Active check box if the field is to be excluded from the current field mappings.

Mandatory Flag
Select the Mandatory Flag check box if the field is a required field.

Related Object Api Name
Specify the API name associated to the custom field you are mapping.

Field Type
Select the data type associated with the field you are mapping.

10 Click Save.

Modifying existing BOD field mappings
To further customize inbound message processing to meet your business requirements, you can also
modify existing BOD field mappings to map an existing BOD XPath to a different field.

Caution: BOD type versions must have different version numbers. If a standard BOD type
version is cloned to create an Any BOD type version, Infor Back Office Connect will disable the
standard BOD type version.

To modify existing BOD field mappings:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Bod Field Mappings.
4 Select All from the View list and click Go! to display the complete list of BOD field mappings.
5 Locate the Process BOD related to the object on which you added the custom field. For example,

if you added a custom field to the Contacts object, locate the ProcessContactMaster BOD type.
6 In the ID column, click the hyperlink of the BOD field mapping to display the Bod Field Mapping

Detail page. For example, click BFM-0000000000.
7 Click Clone to display the BOD Entity Mapping Edit page.

Note: If you want to disable a BOD Field Mapping, you do not have to clone the mapping first. To
disable the field mapping, you can clear the Active checkbox for the mapping and save the record.

8 In the BOD XPath field, specify the new BOD XPath for the existing field mapping.
9 Verify that the Active check box is selected.
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10 Complete the additional information that you require on this page
11 Click Save. A confirmation message is displayed.
12 Click OK. Clicking OK will overwrite any the existing active records for the BOD entity mapping and

activate the modified field mapping.

Editing a BOD type version
This section describes the steps required to delete a message source BOD type version.

To delete a message source BOD type version:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Bod Type Versions.
4 Select All from the View list and click Go! to display the complete list of message source BOD type

versions.
5 In the ID column, click the hyperlink of the BOD type version name to display the message source

BOD type version details. For example, click BTV-0000000000.
6 Click Edit to display the BOD Type Version Edit page.
7 In the Information section, edit or update the information for these fields as necessary:

• BOD Type Version Name: The BOD Type Version Name defines the schema versions of a BOD
type. The combination of the BOD type and BOD schema version indicate the supported
combination of a BOD verb and a BOD noun.

• BOD Version ID: The BOD Version ID indicates the specific version or revision number of the
BOD. For example, the BOD Version ID is 2.8.0.

• BOD Type: The BOD Type is an alpha-numeric identifier that specifies the BOD type. For example,
BT-0000000000 is the BOD Type of the AcknowledgeContactMaster BOD.

• BOD Release ID: The BOD Version ID indicates the specific release version of the BOD. For
example, the BOD Release is 9.2.

• The Is Custom check box is selected by default. Clear the check box to indicate that this BOD
type version is a standard BOD type version.

• The Active check box is selected by default. Clear the check box if you do not want the BOD
type version to be activated when the record is saved.

See "BOD type versions" on page 264f or more information on the iteration or release number
assigned to a BOD type version.

8 Click Save.

Deleting a custom BOD type version
This section describes the steps required to delete a custom BOD type version.

Note: Standard BOD versions cannot be deleted without resulting in custom validation errors. Only
custom BOD type versions can be deleted.
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To delete a custom BOD type version:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Bod Type Versions.
4 Select All from the View list and click Go! to display the complete list of BOD type versions.
5 In the ID column, click the hyperlink of the custom BOD type version name to display the BOD type

version details.
6 Click Delete. A warning message is displayed.
7 Click OK. The BOD type version is deleted.

Cloning a BOD type version
This section describes the steps required to clone a BOD type version.

Caution: When you clone a BOD type version, the originating BOD type version is deactivated
when you save the cloned record. You can only have one existing BOD type version for an
entity at a time.

To clone a BOD type version:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Bod Type Versions.
4 Select All from the View list and click Go! to display the complete list of BOD type versions.
5 In the ID column, click the hyperlink of the BOD type version name to display the Bod Type Version

Detail page.
6 Click Clone to display the BOD Type Version Edit page.
7 By default, all of the fields in the Information section are populated from the cloned BOD type version

record to the new BOD type version record. Edit or update information for these fields as necessary:

• BOD Type Version Name: The BOD Type Version Name defines the schema versions of a BOD
type. The combination of the BOD type and BOD schema version indicate the supported
combination of a BOD verb and a BOD noun.

• BOD Version ID: The BOD Version ID indicates the specific version or revision number of the
BOD. For example, the BOD Version ID is 2.8.0.

• BOD Type: The BOD Type is an alpha-numeric identifier that specifies the BOD type. For example,
BT-0000000000 is the BOD Type of the AcknowledgeContactMaster BOD.

• BOD Release ID: The BOD Version ID indicates the specific release version of the BOD. For
example, the BOD Release is 9.2.

• The Is Custom check box is selected by default. Clear the check box to indicate that this BOD
type version is a standard BOD type version.

• The Active check box is selected by default. Clear the check box if you do not want the BOD
type version to be activated when the record is saved.
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Note: See "BOD type versions" on page 264 for more information on the iteration or release number
assigned to a BOD type version.

8 Click Save.

Creating a message source BOD type version
This section describes the steps required to create a message BOD type version clone a BOD type
version.

To create a message BOD type version clone a BOD type version:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 Click Go! to display the In the All Tabs list, click Message Source BOD Type Versions.
4 Click New to display the Message Source BOD Type Version Edit page.
5 In the Information section, specify information for these fields:

• In the BOD Type Version lookup, select the BOD type version for the message source BOD
type definition. See "BOD type versions" on page 264.

• In the Message Source lookup, select the message source for the message source BOD type
definition. See "Mapping the BOD type version" on page 109.

6 Click Save.

Cloning a message source BOD type version
This section describes the steps required to clone a message source BOD type version.

To clone a message source BOD type version:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Message Source BOD Type Versions.
4 Select All from the View list and click Go! to display the complete list of message source BOD type

versions.
5 In the Message Source BOD Type Version Name column, click the hyperlink of the message

source BOD type version name to display the message source BOD type version details.
6 Click Clone to display the Message Source BOD Type Edit page.
7 In the Information section

Bod Type Version
The Bod type version is automatically populated based on the selected BOD type version.
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Back Office
The default value is Message Source. To modify the value, specify the ERP that is your system of
record. The message source is the application you are integrating with Infor Back Office Connect
through ION. For example, ERP LN.

8 Click Save.

Deleting a message source BOD type version
This section describes the steps required to delete a message source BOD type version.

To delete a message source BOD type version:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Message Source BOD Type Versions.
4 Select All from the View list and click Go! to display the complete list of message source BOD type

versions.
5 In the Message Source BOD Type Version Name column, click the hyperlink of the message

source BOD type version name to display the message source BOD type version details.
6 Click Delete. A warning message is displayed.
7 Click OK. The message source BOD type version is deleted.

Recovering a deleted message source BOD type version from the Salesforce
recycling bin
If you delete a message source BOD type version, it can be recovered from Salesforce recycling bin
for 15 days after it is deleted.

To recover a message source BOD type version from the Salesforce recycling bin:

1 In the sidebar column, click Recycle Bin.
2 Locate the message source BOD type version to recover from the recycling bin list and select the

Action check box for the item.
3 Click Undelete. The recycle bin is refreshed and the selected message source BOD type version

is recovered.

Disabling a BOD type version for message source BOD type version
This section describes the steps required to disable a BOD type version for a message source BOD
type version.

To disable a BOD type version for a message source BOD type version:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
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3 In the All Tabs list, click Message Source BOD Type Versions.
4 Select All from the View list and click Go! to display the complete list of message source BOD type

versions.
5 In the Message Source BOD Type Version Name column, click the hyperlink of the message BOD

type version name to display the Message Source BOD Type Version Detail page. For example,
click MSBTV-0000.

Note: The message source BOD type version record cannot be edited from the Message Source
BOD Type Version Detail screen.

6 In the BOD Type Version field, click the hyperlink of the BOD type version for the message source
to display the Bod Type Version Detail page. For example, click BTV-0000000005.

7 Click Edit to display the BOD Type Version Edit page.
8 In the Information section, clear the Active check box to disable the BOD type version for the

message source.
9 Click Save.

Disabling a BOD field mapping
This section describes the steps required to disable a BOD field mapping.

To disable a BOD field mapping:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click BOD Field Mappings.
4 Select All from the View list and click Go! to display the complete list of BOD field mappings.
5 Locate the Process BOD to disable and click the hyperlink of the BOD field mapping in the ID column

to display the Bod Field Mapping Detail page. For example, click BFM-0000000000.
6 Click Edit to display the BOD Entity Mapping Edit page.
7 Clear the Active  checkbox to disable the mapping.
8 Click Save. A confirmation message is displayed.
9 Click OK. Clicking OK disables the field mapping.

Cloning a message source
This section describes the steps required to clone a message source. See "Multiple back office
configuration" on page 141.

To clone a message source:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Message Sources.
4 Select All from the View list and click Go! to display the complete list of message sources.
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5 In the Message Source Name column, click the hyperlink of the message source name to display
the Back Office Detail page.

6 Click Clone to display the Message Source Edit page.
7 By default, all of the fields in the Information section are populated from the cloned message source

record to the new message source record. See "Configuring message source settings for multiple
back office integration" on page 144 for information on the fields in the Information section. Edit or
update information for these fields as necessary:

• Message Source Name
• Default Accounting Entity ID
• Logical ID
• Default Location ID
• URL
• The Active check box is selected by default. Clear the check box if you do not want the message

source to be activated when the record is saved.
• In the Entity Selection field, select the BOD noun(s) you want to be published to the message

source you selected and click << to add the BOD noun(s) to the message source.

8 Click Save. The cloned message source settings can now be configured in the Step 3. Configure
Message Source Settings section of the Integration Setup tab. See "Configuring message source
settings" on page 44.

Disabling a message source
This section describes the steps required to clone a message source. See "Multiple back office
configuration" on page 141.

To clone a message source:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Message Sources.
4 Select All from the View list and click Go! to display the complete list of message sources.
5 In the Message Source Name column, click the hyperlink of the message source name to display

the Message Source Detail page.
6 Click Edit to display the Message Source Edit page.
7 In the Information section, clear the Active check box to disable the message source.
8 Click Save.

Customizing outbound messages
Infor Back Office Connect administrators and developers can customize outbound data that is sent
from Infor Back Office Connect to ERP message source. To customize outbound messages you can:
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• Add custom fields
• Modify fields on custom Infor Back Office Connect or standard Salesforce objects
• Customize outbound messages to send the new/modified fields to the ERP message source

The BOD Type Version object plays key role during outbound message processing. This object creates
the outbound message XML. The BOD Type version record for each BOD process type contains an
XML template. This XML template contains the structure and placeholders for field values. Outbound
message processing uses this template to generate the runtime outbound message XML with the
object’s data. For example, an administrator adds a Favorite Sports custom field to the standard
Salesforce Contacts object. To configure the output from the Favorite Sports field to update ERP, the
administrator must customize the Contact outbound message to publish this new field.

Preparing to add customizations to outbound messages in Infor Back Office
Connect
When adding customizations to outbound messages, you must modify PROCESS BOD types.

To add customizations to outbound messages in Infor Back Office Connect:

• Log in to Salesforce as the Infor Back Office Connect developer.
• Stop the scheduler and verify that it is stopped. See "Stopping the scheduler" on page 151 and

"Verifying whether the scheduler is stopped" on page 151.
• Create the custom field(s) in Salesforce. You can create custom fields by customizing a standard

object, such as Accounts or Contacts. See Salesforce documentation.
• When you create the custom field(s), make a note of the object where you added the custom field,

the field label, the field data type, and the field API name. See "Creating custom fields in Infor Back
Office Connect" on page 81

• Locate the BOD type version template associated with the intended object and operation of the
custom field.

Downloading a BOD type version template for a Process BOD
Download a BOD type version template to modify the XML content to add BOD field mappings for
custom fields for outbound BOD processing.

To download a BOD type version template for a Process BOD:

1 Log in to Salesforce as the developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Bod Type Versions.
4 Click Go! to display the complete list of BOD type versions.
5 Locate the Process BOD related to the object on which you added the custom field. For example,

if you added a custom field to the Contacts object, locate the ProcessContactMaster BOD type.
6 In the ID column, click the hyperlink of the BOD type version to display the Bod Type Version page.

For example, click BTV-0000000005.

90 | Infor Back Office Connect Administration Guide

Infor Back Office Connect customization



7 In the Notes & Attachments section, click the hyperlink of the title of the XML file to display the
Attached File page. For example, click ProcessContactMaster 9.2-2.8.0.xml.

8 In the Attachment Details section, right-click View File and save the attachment to a local drive.

Modifying a BOD type version template for a Process BOD
After downloading a BOD type version template, modify the XML content to add BOD field mappings
for custom fields.

To modify a BOD type version template for a Process BOD:

1 Locate the downloaded BOD type version template and open the XML file in a text editor.
2 Place the cursor in the location within the XML document where you want to add the field.

Note: Add the field in the most useful and logical place for the user. Review the object page layout
and compare the field location on the page with the location in the XML file to determine the best
place to add the field.

3 Add the tag for the new field using this syntax: <Field Label>{!Object API Name.Field
API Name}</Field Label>. For example, to add a new Toll Free Number field to the BOD, add
this tag: <TollFreeNumber>{!Contact.Toll_free_number__c}</TollFreeNumber>

4 Optionally, add additional tags for other fields.
5 Save the changes to the XML file to a local drive.

Attaching a new BOD type version template
After modifying a BOD type version template, attach the XML document to the BOD type version. Before
attaching the new BOD type version template, delete the existing document.

Caution: A BOD type version can only have one template attached to it.

To attach a new BOD type version:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Bod Type Versions.
4 Click Go! to display the complete list of BOD type versions.
5 Locate the Process BOD related to the object on which you added the custom field. For example,

if you added a custom field to the Contacts object, locate the ProcessContactMaster BOD type.
6 In the ID column, click the hyperlink of the BOD type version to display the Bod Type Version page.

For example, click BTV-0000000005.
7 In the Notes & Attachments section, select the BOD type version attachment to replace and click

Del. A confirmation message is displayed.
8 Click OK.
9 In the Notes & Attachments section, click Attach File.
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10 Click Choose File and locate the XML document to attach.
11 Click Attach File. A confirmation message is displayed.
12 Click Done. The BOD type version is attached and outbound messages are updated with the new

field.

Configuring conditional outbound message processing
Depending on your business needs, you can configure Infor Back Office Connect to conditionally send
outbound BOD messages for synchronization with other applications. You can customize Infor Back
Office Connect to send outbound messages based on a trigger event or trigger condition. The BOD
Entity Mapping object defines the change events related to a particular BOD using two fields: the BOD
Trigger Event field and the BOD Trigger Condition field.

Caution: The default BOD Entity Mapping object cannot be modified. Infor Back Office Connect
administrators and developers must clone the default BOD Entity Mapping and define the clone
BOD Entity Mapping to meet your business requirements for outbound processing.

Understanding BOD trigger events
The BOD Trigger Event field is a pick list from which you can select one or more triggers to configure
the change events that will be published as outbound messages by Infor Back Office Connect. There
are currently three trigger event options that can be performed on a BOD: Insert, Update, and Delete.
Depending on which of these trigger events are selected, the addition, update, or deletion of a record
of the associated CRM entity type will trigger the publishing of an outbound message from Infor Back
Office Connect to ERP.

For example, you have a business requirement stating that only new Contacts and updates to existing
contacts must be synchronized with the external applications, while the deletion of a contact will not
be synchronized. In this scenario, you would select only Insert and Update as the BOD trigger event.
See "Creating conditional BOD trigger events and conditions" on page 93.

Understanding BOD trigger conditions
The BOD Trigger Condition field is used to define the conditions in which Infor Back Office Connect
will publish outbound messages to external applications using Salesforce Object Query Language
(SOQL) query statements. See Salesforce documentation.

A BOD Trigger Condition represents a valid SOQL statement that establishes a conditional clause that
must be satisfied by the current entity being processed for an outbound message to be published.

For example, you have a business requirement requesting Infor Back Office Connect to send outbound
messages for only the Accounts whose status is not Closed. To create this condition, you must open
the BOD Entity Mapping record for the CRM entity Account (ProcessCustomerPartyMaster) and then
specify this query in the BOD Trigger Condition field: condition = statuscode__c <>'Closed'
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Note: If you are defining multiple BOD trigger conditions for a BOD entity mapping, you must enclose
the trigger condition in brackets. For example, AND(Message_Source_c != null, NOT( IsBlank
(Message_Source_c))).

Creating conditional BOD trigger events and conditions
Create conditional BOD trigger events and conditions by cloning and customizing BOD entity mappings
to configure Infor Back Office Connect to send outbound messages based on the specified events and
conditions. See "Understanding BOD trigger events" on page 92 and "Understanding BOD trigger
conditions" on page 92. After the conditions are created, Infor Back Office Connect will check these
conditions during the run-time processing of an entity to see whether the entity satisfies the conditions.

To create conditional BOD trigger events and conditions:

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Bod Entity Mappings.
4 Select All from the View list and click Go! to display the full list of BOD entity mappings.
5 In the ID column, click the hyperlink of the BOD entity mapping to display the Bod Entity Mapping

Detail page. For example, click BEM-0000000000.
6 Click Clone to display the BOD Entity Mapping Edit page.

Caution: The default BOD Entity Mapping object cannot be modified. When creating a
conditional BOD trigger event, you must clone the default BOD entity mapping and then
define a cloned BOD entity mapping to meet your business requirements for outbound
processing.

7 Specify this information:

BOD Entity Mapping Name
Specify a descriptive name for the new BOD field mapping. For example, specify Custom ERP
Account Number.
CRM Entity Name
Specify the Infor Back Office Connect custom object or standard Salesforce object where the field
is located. For example, account.
Bod Type
Specify the BOD type for which the entity mappings are being created. The BOD type will be the
unique identifier for the BOD. For example, BT-0000000005. This unique identifier is also associated
with a BOD noun type. For example, ProcessContactMaster.

Entity Acronym
Specify an abbreviated identifier for the BOD entity mapping function. For example, specify BT for
Bill-To or CT for Contact.

BOD Trigger Event
Specify one or more trigger events that will publish outbound messages.
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Sharable
Select the Sharable check box if this entity mapping can be shared. If the Sharable check box is
selected, Infor Back Office Connect configures the default record owner user as the owner of the
record for all associated BODs during data synchronization. See "Creating the default record owner"
on page 26.

BOD Trigger Condition
Specify the conditions that will publish outbound messages using Salesforce SOQL query statements.

Note: If you are defining multiple BOD trigger conditions for a BOD entity mapping, you must enclose
the trigger condition in brackets. For example, AND(Message_Source_c != null, NOT( Is
Blank(Message_Source_c))).

Is Custom
Select the Is Custom check box if this entity mapping is being associated with an any BOD. When
this option is selected, the Load Seed data will not modify this customized field. Standard records
cannot be modified, but can be disabled by clearing the Is Active check box.

Handler Class Name
Specify the fully qualified name of a user-defined Java class that extends the Java class for the
particular URL protocol. For example, ContactMasterHandler.

Is Active
Select the Is Active check box to activate this entity mapping. Selecting the Is Active check box
will overwrite

Sync Direction
Select the type of directional publishing that the entity mapping will process. Valid values are
Inbound, Outbound, or Both.

8 Click Save. A confirmation message is displayed.
9 Click OK. Clicking OK will overwrite any existing active records for the BOD entity mapping.

Working with Infor Back Office Connect BOD objects
Infor Back Office Connect installs a number of custom objects to manage BODs, BOD entity and field
mappings, BOD versions and types. This section provides an overview of these Infor Back Office
Connect BOD objects and their functionality.

Marking inbound messages for reprocessing
If inbound messages need to be reprocessed, you can manually set the message processing status
to reprocess the message.
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You can also reprocess inbound messages in batches based on a specified date range, message
status(es), and message type(s) on the Data Management tab. See "Reprocessing inbound BODs"
on page 232.

To mark inbound messages for reprocessing.

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Inbound Messages tab.
4 Optionally, select a filter from the View list and click Go! to display the list of inbound messages.
5 To edit the record(s) using inline editing, select the checkbox for each inbound BOD record to

reprocess.
6 Double click the Was Processed field to display the Edit Was Processed window.
7 Specify “0” as the processing status in the Was Processed field.
8 In the Apply changes to section, select the check box to apply the changes to All [number] selected

records.
9 Click Save.
10 Double click the Processing Status field to display the Edit Processing Status window.
11 Select --None-- in the Processing Status field.
12 In the Apply changes to section, select the check box to apply the changes to All [number] selected

records.
13 Click Save.
14 Repeat these steps for each set to reprocess.

Marking outbound messages for reprocessing
If outbound messages need to be reprocessed, you can manually set the message processing status
to reprocess the message.

To mark outbound messages for reprocessing.

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Outbound Messages tab.
4 Optionally, select a filter from the View list and click Go! to display the list of outbound messages.
5 To edit the record(s) using inline editing, select the checkbox for each outbound BOD record to

reprocess.
6 Double click the Processing Complete field to display the Edit Processing Complete window.
7 Specify “0” as the processing status in the Processing Complete field.
8 In the Apply changes to section, select the check box to apply the changes to All [number] selected

records.
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9 Click Save.
10 Repeat these steps for each set to reprocess

Viewing BOD type names
View BOD type names on the Bod Types custom object.

To view BOD type names:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Bod Types.
5 Select All from the View list and click Go! to display the complete list of BOD types and their BOD

Type Names. For each BOD type record the ID, the BOD type name, the BOD noun, the BOD verb,
and whether the BOD is active and/or an any BOD is displayed.

6 Optionally, in the ID column, click the hyperlink of the BOD type to display the Bod Type Detail page.
For example, click BT-0000000005.

Note:  Editing the BOD types that are installed by default will cause data processing errors, but Infor
Back Office Connect administrators and developers can create additional BOD Types to support
business processes. See "Customizing Infor Back Office Connect" on page 79.

Viewing the BOD type version number
View a particular BOD type's BOD type version numbers on the Bod Types Version screen, which is
an Infor Back Office Connect custom object.

To view the BOD type version number:

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Bod Types.
5 Select ALL from the View list and click Go to display the complete list of BOD types.
6 In the ID column, click the hyperlink of the BOD type to display the Bod Type Detail page. For

example, click BT-0000000005.
7 In the Bod Type Versions section, locate the BOD type version to view.
8 In the ID column, click the hyperlink of the BOD type version to display the Bod Type Version Detail

page. For example, click BTV-0000000005. The full BOD type version number is displayed in BOD
Type Version Name BOD BOD field. For example, AcknowledgeContactMaster 9.2-2.8.0.
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Note: ERP and Infor Back Office Connect must use the same BOD Release ID and BOD Version
ID for a particular BOD type to process the BOD successfully.

Updating the BOD Version ID or BOD Release ID
Update a particular BOD type's BOD type version number or release ID on the Bod Type Version Edit
page.

To view the BOD type version number:

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Bod Type Versions.
5 Select ALL from the View list and click Go! to display the complete list of BOD Type Versions.
6 In the ID column, click the hyperlink of the BOD type version to display the Bod Type Version Detail

page. For example, click BTV-0000000005. The full BOD type version number is displayed in BOD
Type Version Name field. For example, AcknowledgeContactMaster 9.2-2.8.0.

7 Click Edit.

Note: ERP and Infor Back Office Connect must use the same BOD Release ID and BOD Version
ID for a particular BOD type to process the BOD successfully.

8 In the BOD Type Version Edit page, specify the following:

BOD Version ID
Specify the new BOD Version ID.

BOD Release ID
Specify the new BOD Release ID.

Note:  Load Seed Data will not change these values unless the Seed Data value is greater than
the value currently in BOD Type Version.

9 Click Save.

Viewing BOD field mappings in Infor Back Office Connect
View BOD field mappings on the Bod Field Mappings custom object. This object can be used to create
new BOD field mappings and edit existing BOD field mappings.

See "Creating new BOD field mappings in Infor Back Office Connect" on page 82 if you want to create
new BOD field mappings to customize the inbound data import process.

To view BOD field mappings in Infor Back Office Connect:
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1 Login to Salesforce as the system administrator or Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click BOD Field Mappings.
5 Select All from the View list and click Go! to display the complete list of BOD field mappings. For

each BOD field mapping record this information is displayed:
6 View the BOD field mapping information. For each BOD field mapping record this information is

displayed:

• The ID field displays a unique identifier for the BOD field mapping. For example, BFM-0000000030
• The Bod Field Mapping Name field displays a descriptive name for the BOD field mapping. For

example, ERP Account Number.
• The CRM Entity Name field displays the Infor Back Office Connect custom object or standard

Salesforce object where the field is located. For example, account.
• The CRM Attribute Name field displays the API name assigned to the field. For example, extid__c.
• The Related Object Api Name field displays the API name associated with the custom field you

are mapping. For example, extid__c.
• The Field Type field displays the data type associated with the field you are mapping. Valid

values are Text, Number, Date, Email, Lookup, Master Detail, Role Junction, or Contact Role.

DescriptionField Type

Text, Text Area, Checkbox and Pick List field typesText

Number, Percent, and Currency field typesNumber

Date and Date Time field typesDate

Email field typesEmail

If you add the object name to the front of the CRM At-
tribute Name followed by a "#" , it indicates to Infor Back

Lookup

Office Connect what object to map to. The following ex-
ample shows how to map the BOD Field Mapping to the
salesorder_c object and the salesorderfieldc field in the
current object. Infor Back Office Connect will use this to
make the relationship to the salesorder_c object for the
ID specified in the BOD element. Note for custom objects,
remove the __c for the object name. CRM Attribute ex-
ample: salesorder#salesorderfield__c

Master Detail field typesMaster Detail

Supports a many-to-many relationshipRole Junction

Related ContactContact Role

Address street field typesAddress Street

Primary address field typesPrimary Address

Secondary address field typesSecondary Address
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Note: You cannot map multiple BOD elements into one object field. This will cause inbound
messages to fail.

• The BOD Xpath field displays the BOD element where you can find the field mapping information
from the Infor Back Office Connect BOD Mapping and Descriptions (Inbound) guide. The value
specified must correspond with the related Xpath from the noun element in the BOD XML
message. For example, CustomerPartyMaster/PartyIDs/ID.

• The Active check box indicates whether the field is to be included in the current field mappings
for the BOD.

• The Is Custom check box indicates whether the field is a custom field. When this option is
selected, the Load Seed data will not modify this customized field. Standard records cannot be
modified, but can be disabled by clearing the Active  check box.

• The Default Value field displays the default value for the field if the mapped Salesforce field is
required and the BOD does not publish a value for the field.

• The Bod Type Version field displays the BOD type version associated with the field mapping.
See "BOD type versions" on page 264.

Viewing BOD entity mappings in Infor Back Office Connect
View BOD entity mappings on the Bod Entity Mappings custom object.

To view BOD entity mappings in Infor Back Office Connect:

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Bod Field Mappings.
5 Select All from the View list and click Go! to display the complete list of BOD field mappings.
6 View the BOD field mapping information. For each BOD field mapping record this information is

displayed:

• The ID field displays a unique identifier for the BOD entity mapping. For example,
BEM-0000000030

• The Bod Entity Mapping Name field displays the object, and if applicable, the BOD verb/noun
pairing for the BOD.

Note: In most cases, the BOD verb is Process. See "BOD nouns" on page 261 and "BOD verbs"
on page 262. The entities listed in Bod Entity Mapping Name field are subject to two-way update
when the BOD verb/noun pairing is referenced. When no BOD pairing is referenced, only one-way
(ERP to Infor Back Office Connect) updates are supported.

• The CRM Entity Name displays the API name assigned to the field. For example, extid__c.
• The Entity Acronym field displays an abbreviated identifier for the BOD entity mapping function.

For example, BT for Bill-To or CT for Contact.
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• The Active check box indicates whether the entity mapping is to be included in the current entity
mappings for the BOD.

• The Is Custom check box indicates whether the entity mapping is a custom mapping. When this
option is selected, the Load Seed data will not modify this customized field. Standard records
cannot be modified, but can be disabled by clearing the Active check box.

• The BOD Trigger Event field displays the trigger events that will publish outbound messages.
Valid values are Insert, Update, and Delete. See "Understanding BOD trigger events" on page
92 and "Understanding BOD trigger conditions" on page 92.

• The BOD Trigger Condition field display the Salesforce SOQL query statements that establish
the conditions that will publish outbound messages.

• The Field Type field displays the data type associated with the field you are mapping. Valid
values are Text, Number, Date, Email, Lookup, Master Detail, Role Junction, or Contact Role.

• The Sharable check box indicates whether this entity mapping can be shared. If the Sharable
check box is selected, Infor Back Office Connect configures the default record owner user as
the owner of the record for all associated BODs during data synchronization. See "Creating the
default record owner" on page 26.

• The Handler Class Name field displays the fully qualified name of a user-defined Java class
that extends the Java class for the particular URL protocol. For example, ContactMasterHandler.

• The Sync Direction field displays type of directional publishing that the entity mapping will
process. Valid values are Inbound, Outbound, or Both.

Viewing inbound messages in Infor Back Office Connect
View inbound messages sent from ERP to Infor Back Office Connect on the Inbound Messages custom
object.

Note: If an inbound message need to be reprocessed, you can manually reprocess the message. See
"Reprocessing inbound BODs" on page 232 and "Marking inbound messages for reprocessing" on page
94.

To view inbound messages in Infor Back Office Connect:

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Inbound Messages tab.
4 Select All from the View list and click Go! to display the complete list of inbound messages.
5 View the inbound message information. For each inbound message record this information is

displayed:

• The Message ID field displays a unique identifier for the message. For example,
ID:USALVICRMBW2K84-51535-1361102258711-2:0:99:1:1.

• The Message Type field displays the type of message. For inbound messages, the message
type consists of a BOD pairing beginning the BOD verb Sync, Show, or Confirm and the BOD
noun. For example, Sync.CustomerPartyMaster.
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• The Was Processed field displays a code that indicates the processing status of the BOD. If a
processing error occurs, the code helps the administrator determine where the error occurred
and troubleshoot the error. Valid values are: 9=ERP Error, 1=Processed without error, 99=variation
ID error, 999=Salesforce error, and 0=not processed - awaiting processing.

Note: A variation ID is assigned to a BOD by Infor Back Office Connect to identify the number
of times a record with a specific set of attributes has been published for the accounting entity
and location. The variation ID is used to ensure that Infor Back Office Connect is reading in the
latest version of the BOD. For example, a BOD with a variation ID of 5 is received and read in
Infor Back Office Connect. Infor Back Office Connect then receives another BOD for the same
record with a variation ID of 4. Upon receiving the BOD with the variance ID of 4, this BOD is
assigned a processing status of 99 to indicate that the variation ID of 4 is older then the variation
ID of 5.

• If a processing error occurs, the Error Message field displays the message associated with the
processing issue.

• The Marked as Processed field displays a code that indicates whether the message was
processed. Valid values are: 1=processed, 0=not processed.

• The Retry Count field displays the number of attempts that have been made to reprocess the
message.

• The Created By field displays the owner of the BOD.
• The Last Modified Date field displays the date the message was last processed.
• The Created Date field displays the date that the message was created.

Note:  All BOD XML files must first be linearized in order for Infor Back Office Connect to read them.

Viewing outbound messages in Infor Back Office Connect
View outbound messages sent from ERP to Infor Back Office Connect on the Outbound Messages
custom object.

Note: If an outbound message need to be reprocessed, you can manually set the message processing
status to reprocess the message. See "Marking outbound messages for reprocessing" on page 95.

To view outbound messages in Infor Back Office Connect:

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Outbound Messages tab.
4 Select All from the View list and click Go! to display the complete list of outbound messages.
5 View the outbound message information. For each outbound message record this information is

displayed:

• The Message ID field displays a unique identifier for the BOD entity mapping. For example,
BEM-0000000030
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• The Message Type field displays the unique identifier for the BOD Entity Mapping. For outbound
messages, the message type consists of a BOD pairing beginning the BOD verb Process or
Confirm. For example, Confirm.BODs.

• The Was Processed field displays a code that indicates the processing status of the BOD. If a
processing error occurs, the code helps the administrator determine where the error occurred
and troubleshoot the error. Valid values are: 9=ERP Error, 1=Processed without error,
999=Salesforce error, and 0=not processed - awaiting processing.

• If a processing error occurs, the Error Message field displays the message associated with the
processing issue.

• The Marked as Processed field displays a code that indicates whether the message was
processed. Valid values are: 1=processed, 0=not processed.

• The Created By field displays the owner of the BOD. All outbound messages are created by the
Integration user.

• The Last Modified Date field displays the date the message was last processed.
• The Created Date field displays the date that the message was created.

Viewing outbound transactions in Infor Back Office Connect
Viewing outbound transactions on the Outbound Transactions custom object.

To view outbound transactions in Infor Back Office Connect:

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Outbound Transactions tab.
4 Select All from the View list and click Go! to display the complete list of all outbound transactions.
5 View the outbound transaction information.

Viewing the configured BOD message sources
To view the configured BOD message sources:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Message Sources to display the Message Sources Home page.
5 Select All from the View list and click Go! to display the configured message sources.
6 Click the message source name to display the message source details. The message source details

display a list of all available BOD type versions for the configured ERP.
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The Bod Type Version Name column displays the schema versions of a BOD type. The combination
of the BOD type and BOD schema version indicate the supported combination of a BOD verb and
a BOD noun.

7 In the Messages Source BOD Type Versions list, click the message source BOD type version name
to display the message source BOD version details.

Note: BOD type versions are backwards compatible with previous BOD type versions.

8 In the Message Source BOD Type Detail section, click the BOD type version hyperlink to display
the BOD Type Version Detail page.
The BOD Fields Mapping section displays the BOD field mapping related to the selected BOD type
version name. The BOD field mappings indicate which Salesforce object and field must be updated
in Salesforce when an inbound message is received.

Viewing outbound confirm BODs
Confirm outbound messages sent from Infor Back Office Connect to ERP on the Outbound Messages
custom object.

To view outbound confirm BODs in Infor Back Office Connect:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 Select All from the View list and click Go! to display theIn the Force.com App menu, select Infor

Back Office Connect Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Outbound Confirm BODs.
5 Select All from the View list and click Go! to display the complete list of outbound confirm BODs.
6 View the outbound confirm BODs.
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6Any BOD

Optionally, you can use Any BOD to create and customize your own BODs that are not supported by
the Infor Back Office Connect standard BODs. See "Infor Back Office Connect customization" on page
73 for additional information on how to customize Infor Back Office Connect to meet your business
requirements and "Understanding BODs" on page 257 for information on Infor Back Office Connect
BODs.

This chapter describes the tasks you must complete to create any BODs in Infor Back Office Connect.

Note: Using Any BOD is an optional step in the Infor Back Office Connect installation, configuration,
and implementation process. If you do not need to use the Any BOD functionality, you can skip this
chapter.

Creating Any BODs
Complete these tasks to create Any BODs in Infor Back Office Connect:

• Create a BOD Type for the Sync, Acknowledge, Show, and Process BODs
• Create a BOD Entity Mapping
• Map BOD Type Version
• Create a BOD Field Entity
• Map the BOD Type Version to the Message Source
• Create a custom handler and configure the handler name in the BOD Entity Mapping
• Create a record in the BOD Type Version object for each Any BOD
• View the Sample Process BOD

List of required object fields for any BODs
These object fields are required to support the Any BOD functionality for any new object created in
Infor Back Office Connect that will be mapped to use an Any BOD.
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LengthField TypeField API Name (without
namespace)

Field Name

255TextExternal IDextId__cExt Id

255Textlocationid__cLocation Id

255Textextlogicalid__cExt Logical Id

Checkbox Default=UnCheckedinsync__cIn Sync

Checkbox Default=UnCheckedcansendbod__cCan Send BOD

Picklist Values: Open, Closed,
Deleted, Pending

statuscode__cStatus Code

Length -18
Decimals - 0

Numericvariationid__cVariation Id

255Textextaccountingentityid__cExt Accounting Enti-
ty Id

255TextextRecordId__cExt Record Id

Lookup to Message Source object.
This field is only required for Out-
bound BODs.

Message_Source__cMessage Source

Any BOD reference package
The Any BOD reference package provides a sample Any BOD configuration to use as a guide when
configuring Any BOD to conform to your business needs. Throughout this section, the
SupplierPartyMaster BOD is used as the sample for configuring both Infor Back Office Connect and
ION to support this BOD.

Installing the Any BOD reference package
To install the Any BOD reference package:

1 Log in to Salesforce as the system administrator.
2 In another browser window or tab, login to the Infor Xtreme Support portal and navigate to the Infor

Back Office Connect KB number 1149054. See "Registering to receive Infor Back Office Connect
knowledge base e-mail updates" on page 14.

3 Locate the Any BOD Reference Package Installation URL and click the link to begin the Any BOD
package installation. The Package Installation Details page is displayed in your Salesforce
organization. A summary of the Inforce package you are installing and the changes the package
makes to your Salesforce organization are displayed.

4 Review the package installation details and click Continue.
5 In the Any BOD Reference Package page, click Next.
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6 In the Security Level page, specify the Select Security Settings option.
7 Select Full Access for each user profile that requires full access to the Any BOD package. We

recommend full access for the Inforce Administrator and the Inforce Developer profiles.
8 Click Next.
9 In the Install Package page, click Install. The Install Complete Page is displayed and an email will

be sent to the email address of your system administrator user profile.
10 Select Your name > Setup.
11 In the sidebar column, select App Setup > Installed Packages.
12 In the Installed Packages sections, click the Infor Back Office Connect package name. The Package

Details window is displayed.
13 Confirm that the Any BOD reference package is installed in your Salesforce organization.

Accessing the Any BOD static references file
The Any BOD reference package installs static references as examples using the SupplierPartyMaster
BOD. These static references can be downloaded and modified for your deployment.

To access the Any BOD static references file:

1 Log in to Salesforce as the system administrator.
2 Select Your name > Setup.
3 In the sidebar column, select App Setup > Develop > Static Resources.
4 In the Static Resources list, click the SupplierPartyMasterSeedData hyperlink. The Static Resource

Detail window is displayed.
5 Click the View File hyperlink.
6 Save the .zip file to your computer.
7 Open the .zip file to view the files.

Creating a BOD type for the Sync, Acknowledge, Show, and Process
BODs
You must first define the Sync, Acknowledge, Show, and Process BODs to create an Any BOD in
Inforce.

To create a BOD Type for Sync and Acknowledge BODs:

1 Log in to Inforce as the Inforce developer.
2 In the Force.com App menu, select Inforce Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Bod Types.
5 Click New.
6 Specify this information:
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Bod Type Name
Specify the combination of the BOD Verb and Noun. For example, SyncSupplier.

Verb
Specify Sync as the BOD verb.

Active
Selecting or clearing this check box determines whether the Bod Type is currently active.

Noun
Specify the noun for the data you are publishing. For example, Supplier.

Is Custom
Selecting or clearing this check box determines whether the Bod Type is custom.

Note: You must select this check box for any Any BOD Types you create.

7 Click Save.
This message is displayed: Any other existing active records for this BOD Type will be deactivated.

8 Click OK.
9 Repeat steps 1 - 8 for these BOD verbs:

• Acknowledge
• Process
• Show

Refer to the Any BOD Static Resources SupplierPartyMasterSeedData.zip for an example.

Creating a BOD entity mapping for an Any BOD
To create a BOD Entity Mapping:

1 Login to Salesforce as the Inforce developer.
2 In the Force.com App menu, select Inforce Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click BOD Entity Mappings.
5 Click New.
6 Specify this information:

Bod Entity Mapping Name
Specify the Noun of the BOD.

Bod Type
Specify the BOD Type created for the Process verb when creating a BOD type for the Sync and
Acknowledge BODs. See "Creating a BOD type".

BOD Trigger Event
Specify the events that trigger Inforce to publish Outbound BODs to the ERP.

• Insert: A BOD is generated when a record is inserted by a user.
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• Update: A BOD is generated when a record is updated by a user.
• Delete: A BOD is generated when a record is deleted by a user.

BOD Trigger Condition
Specify the condition that will be used by Inforce to publish BODs based on the BOD Trigger Event.

Handler Class Name
Specify the name of the handler called by Inforce when a BOD is processed.

Handler Type
Specify when the handler will be called to process BODs.

• None: No handler is called.
• Inbound: The handler is called for Inbound BODs.
• Both: The handler is called for both Inbound and Outbound BODs.
• Outbound: The handler is called for Outbound BODs.

Note: To add a Custom Handler: click App Setup> Develop> Apex Classes> New.

CRM Entity Name
Specify the API name of the object created for the BOD.

Entity Acronym
Specify a unique 2 character value for this BOD Entity.

Sharable
Select this check box for Inforce to configure the Default Record Owner user as the record owner
for all records during data synchronization.

Is Custom
Select this check box for any new BOD Entity Mappings you create. When this option is selected,
the Load Seed data will not modify this customized field. Standard records cannot be modified, but
can be disabled by clearing the Active check box.

Active
Select this check box if the BOD Entity is active.

7 Click Save. Refer to the Any BOD Static Resources SupplierPartyMasterSeedData.zip for an
example. You must add the Salesforce ID for the Process BOD Type defined when creating a BOD
type for the Sync and Acknowledge BODs. See "Creating a BOD type for the Sync, Acknowledge,
Show, and Process BODs" on page 107.

Mapping the BOD type version
This task controls the version of the BOD Type you created.
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Caution: BOD type versions must have different version numbers. If a standard BOD type
version is cloned to create an Any BOD type version, Inforce will disable the standard BOD
type version.

To map the BOD type version:

1 Login to Salesforce as the Inforce developer.
2 In the Force.com App menu, select Inforce Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Bod Type Versions.
5 Click New.
6 Specify this information:

Bod Type Version Name
The name should include the Verb, Noun, Version ID, and Release ID of the BOD you are mapping.
For example, SyncSupplier 9.2-2.8.0.

Bod Type
Specify the BOD Type created during the previous task. Verify that the Verb and Noun match the
BOD Type Version you are creating.

Is Custom
Select this check box for any new BOD Entity Mappings you create. When this option is selected,
the Load Seed data will not modify this customized field. Standard records cannot be modified, but
can be disabled by clearing the Active check box.

BOD Version Id
Specify the version ID of the BOD.

BOD Release Id
Specify the release ID of the BOD.

Active
Select this check box if the BOD Type Version is active.

7 Click Save.
8 Repeat steps 1- 7 for each of the BOD Types created in the previous version.
9 For the Process BOD Type Version, you must attach the outbound BOD Type Version template.

The sample ProcessSupplierMaster 9.2-1.9.0.xml is included in the static resource
SupplierPartyMasterSeedData.zip file. See "Modifying a BOD type version template for a Process
BOD" on page 91 for information on the process of modifying the BOD Type Version template. Refer
to the Any BOD Static Resources SupplierPartyMasterSeedData.zip for an example. You must add
the Salesforce ID for the Process BOD Type defined when creating a BOD type for the Sync and
Acknowledge BODs. See "Creating a BOD type for the Sync, Acknowledge, Show, and Process
BODs" on page 107.
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Mapping BOD field mappings for Any BOD
This task maps the Sync BOD Type Version created in a previous step and maps BOD elements to
object fields in Inforce. This task instructs Inforce which BOD elements will map to which fields.

To map the BOD Field Mappings:

1 Log in to Salesforce as the Inforce Developer.
2 In the Force.com App menu, select Inforce Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Bod Field Mappings.
5 Click New.
6 Specify this information:

Bod Field Mapping Name
The unique name for this field mapping.

Bod Type Version
The BOD Type Version ID for the Sync Any BOD created in the Mapping the BOD type version
task.

BOD XPath
The XPath in the BOD where this value will be retrieved.

Is Custom
True.

Related Object API Name
CRM Entity Name
The API name of the object Inforce will use.

CRM Attribute Name
The API name of the field of the CRM Entity Name Inforce will map the value to.

Field Type
See "Viewing BOD entity mappings in Infor Back Office Connect" on page 99.

7 Click Save.
8 Repeat steps 5 through 7 for each field. Refer to the Any BOD Static Resources

SupplierPartyMasterSeedData.zip for an example. You must add the Salesforce ID for the Process
BOD Type defined when creating a BOD type for the Sync and Acknowledge BODs. See "Creating
a BOD type for the Sync, Acknowledge, Show, and Process BODs" on page 107.

Mapping the BOD type version to the message source
This task includes the steps you must complete to map the BOD Type Version to the configured
Message Source. If you have not configured the Message Source, see "Configuring message source
settings for multiple back office integration" on page 144.
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Caution:  When adding new BOD Type Versions to a Message Source, older BOD Type
Versions should be removed from the Message Source BOD Type Version before processing
BODs.

To map the BOD Type Version to the Message Source:

1 Login to Salesforce as the Inforce developer.
2 In the Force.com App menu, select Inforce Administration.
3 Click the plus icon (+) to display all tabs.
4 In the All Tabs list, click Message Source BOD Type Versions.
5 Click New.
6 Specify this information:

Bod Type Version
Select the BOD Type Version created during the previous task.

Message Source
Select the Message Source that Inforce will use to publish to the ERP.

7 Click Save.
8 Repeat steps 5 through 7 for each BOD Type Version created and for each Message Source that

supports the Any BOD created in the previous tasks.

Adding a message source entity
To add a message source entity:

1 Login to Salesforce as the Inforce developer.
2 In the Force.com App menu, select Inforce Administration.
3 Click Configure Message Source Settings.
4 Click Edit for the Message Source to add the Any BOD.
5 In the Entity Selection section, select the Any BOD name and click the add icon (>>).
6 Click Save.
7 Repeat steps 4 through 6 for each Message Source adding the Any BOD.

Creating a custom handler and configuring the handler name in the
BOD Entity Mapping
Note: To add this handler to other objects you must change the API name "Suppliername__c" to an
API name. We recommend a search and replace process.

To create a custom handler:
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1 Log in to Salesforce as the Inforce developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select your name > Setup.
4 Click App Setup > Develop > Apex Classes > New.
5 In the Apex Class section, copy and paste this script:

global with sharing class CustomSupplierPartyMasterHandler extends 
InforceEW.PartyMasterHandler implements InforceEW.HandlerInterface
{
    private InforceEW.ReturnResult retResult = new InforceEW.Return
Result();
    private List<Supplier__c>  lstExistingSupplier = null;
    private List<Supplier__c> lstSupplier = null;
    private InforceEW.Logger logger = new InforceEW.Logger('Custom
Supplier');
    global void setInboundMessage(InforceEW.InboundMessage inbound
Message){
        this.message = inboundMessage;
        
    }
    
    global String getExtraFields(){     
        return '';
    }
    global InforceEW.ReturnResult handleOutboundMsg(InforceEW.Outbound
Message messageOB){
        
        super.handleOutbound(messageOB);
    
        List<SObject> sObj = getSObjectFromTemplateObj(messageOB);
        
        messageOB.ionDataObj = getIONObjFromTemplateObj( messageOB.
principalObjName , messageOB.ionTemplateObj , sObj[0] );
        
        /**
         * translate the mappings for the principal object now.
         */
        translateTemplateXML(messageOB);
        
        retResult.put('isProcessed', false);
        
        return retResult;
    }
    
    global InforceEW.ReturnResult handleInboundMsg(InforceEW.Return
Result returnResult, String verbName)
    {
        logger.log(InforceEW.LoggerConstants.ComponentCategory.Inbound_
Handler,' Start handleInboundMsg..............');
        
        if(verbName.equalsIgnoreCase('Sync') ||  verbName.equalsIgnore
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Case('Show'))
        {
            handleSyncSupplierPartyMaster(returnResult);
        }
        else if(verbName.equalsIgnoreCase('Acknowledge'))
        {
            handleAckSupplierPartyMaster();
        }
        else
        throw new InforceEW.InvalidBODException('Unsupported BOD');
        logger.log(InforceEW.LoggerConstants.ComponentCategory.Inbound_
Handler,' End handleInboundMsg..............');
        return retResult; 
               
    }
    
    private void handleSyncSupplierPartyMaster(InforceEW.ReturnResult
 retRes)
    {
        logger.log(InforceEW.LoggerConstants.ComponentCategory.Inbound_
Handler,' Start handleSyncSupplierPartyMaster..............');
        String supplierSFID = null;
        Set<String> setExtIdAcctngIdComb = (Set<String>)retRes.get
('uniqueKeys'); 
        lstExistingSupplier = (List<Supplier__c>)retRes.get( 'existing
Records' );
        
        if(!isAckBodReceived(message,lstExistingSupplier,Boolean.value
Of(retRes.get('hasNewRecord')))
          && lstExistingSupplier != null && lstExistingSupplier.size
() > 0)
        {  
            retResult.put('entity', lstExistingSupplier[0]);
            retResult.put('isProcessed', false);
            return;   
        }
        lstSupplier = (List<Supplier__c>)retRes.get( 'newRecords' );

        
       /**
        * Checking the status code.
        * If status tag is missing from the BOD.
        */       
        for(Supplier__c newSupplier : lstSupplier){                 

            if(newSupplier.statuscode__c == null)
            {
                newSupplier.statuscode__c ='';             
            } 
        }           
         
        /**
         * No need to process anything if the status code is Deleted,
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 just delete the bill to master and exit         * 
         */
        String StatusCodeVal =  String.valueOf(lstSupplier[0].get
('statusCode__c'));
        if (StatusCodeVal.equalsIgnoreCase('Deleted'))
        {
            if(lstExistingSupplier != null && lstSupplier != null &&
 lstExistingSupplier.size() == lstSupplier.size())
            {
                List<Supplier__c> lstSupplierDelete = new List
<Supplier__c>();
                /**
                 * Deleting Supplier records which are not already 
deleted
                 */
                for(Supplier__c supplier: lstExistingSupplier){     
                
                    if( !supplier.isdeleted){
                        lstSupplierDelete.add(supplier);            
               
                    }
                }
                if(lstSupplierDelete.size() > 0){
                    delete lstSupplierDelete;
                    emptyRecycleBin(lstSupplierDelete);
                }                   
                retResult.put( 'isProcessed' , true);
                return;              
            }
            else
            {
                throw new InforceEW.InvalidBODException('Supplier 
party does not exist in Inforce.' +' '+ 'ExtId -' + String.valueOf
(lstSupplier[0].extid__c));               
            }
        } 
        else 
        {
            if (validate()) 
            {
                setInSyncCanSend(lstSupplier, true, true);
                List<Supplier__c> lstSupplierNew = new List<Supplier__
c>();
                for(Supplier__c supplier: lstSupplier){
                    lstSupplierNew.add((Supplier__c)supplier);
                }
                logger.log(InforceEW.LoggerConstants.ComponentCategory.
Inbound_Handler,' CSPM:116........lstSupplierNew entity.....'+lst
SupplierNew[0]);
                InforceEW.SFIonIntegration.isGenerateExtId = true;
                upsert lstSupplierNew extid__c; 
                logger.log(InforceEW.LoggerConstants.ComponentCategory.
Inbound_Handler,' CSPM:119........lstSupplierNew entity.....'+lst
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SupplierNew[0]);
                retResult.put( 'entity' , lstSupplier[0]);
                retResult.put( 'isProcessed' , true);
                return; 
                
           }
       }
         retResult.put( 'isProcessed' , false);
         logger.log(InforceEW.LoggerConstants.ComponentCategory.
Inbound_Handler,' End handleSyncSupplierPartyMaster..............');

      }
      
      private boolean validate(){
        for(Supplier__c supplier: lstSupplier){
            
            if (supplier.addressline__c == null && supplier.
addressline__c == ''){
                throw new InforceEW.InvalidBODException('Address Line
 Missing in Supplier Party Master BOD');
                return false;
                
            }
        }
        return true;
      }
      
       /**
         * Method to handle acknowledgeSupplierPartyMaster BOD
         * @param
         *      
         * @return
         * void
         */
        public void handleAckSupplierPartyMaster()
        {
            logger.log(InforceEW.LoggerConstants.ComponentCategory.
Inbound_Handler,' Start handleAckSupplierPartyMaster..............');

            Supplier__c entity = (Supplier__c)handleAcknowledgeParty
Master('Supplier__c');
            
            if(message.getactionCode().equals( 'Accepted' ) && 
(Boolean.Valueof(entity.get('isDeleted'))))
            {       
                retResult.put( 'isProcessed' , true);
                return;
            }
            else if(entity != null)
            {
                update entity;
            }
            retResult.put( 'entity' , entity);
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            retResult.put( 'isProcessed' , true);
            logger.log(InforceEW.LoggerConstants.ComponentCategory.
Inbound_Handler,' End handleAckSupplierPartyMaster..............');
        }
     /*********************************** Extra method 
writtern**************************/
    
     private void emptyRecycleBin(List<SObject> entitylst){
        /**
        * Method to delete record from recyle bin
        */
        if (entitylst != null && entitylst.size() > 0) {
            Integer dmlLimit = Limits.getLimitDMLRows() - Limits.get
DMLRows();
            /**
             * Avoid hiting governor limit by checking available dml
 limits
             * We can empty 200 records at a time form recycle bin 
             */
            if(dmlLimit > 200){
                dmlLimit = 200;
            }
            List<SObject> lstToDelete = new List<SObject>();        
    
            if(entitylst.size() > dmlLimit){
                for(integer i =0 ;i<dmlLimit;i++){
                    lstToDelete.add(entitylst[i]);
                }
            }else{
                lstToDelete = entitylst;
            }
            List<Database.EmptyRecycleBinResult>  deletedRecord= 
Database.emptyRecycleBin(lstToDelete);
        }
        
    }
    
}

6 Click Save. Refer to the SupplierMasterHandler in the Apex Classes as an example.

Creating a sample any BOD trigger
Note: This sample is for the Supplier Party Master BOD. To add this trigger to other objects you must
change the trigger name "supplier__c" to the desired custom object name. We recommend a search
and replace process.

To create a sample any BOD trigger:

1 Log in to Salesforce as the Inforce developer.

Infor Back Office Connect Administration Guide | 117

Any BOD



2 In the Force.com App menu, select Inforce Administration.
3 Select Your name > Setup.
4 In the sidebar column, select App Setup > Create > Objects.
5 Select a custom object.
6 In the Triggers section, click New.
7 In the Apex Trigger section, copy and paste this script:

trigger SupplierCRUD on Supplier__c (after insert, after Update) {  
   
    if(trigger.isInsert || trigger.isUpdate){               
       List<String> lstSupplierId = new List<String>();
        for(supplier__c supplier : trigger.new){
            lstSupplierId.add (supplier.id);       
        }
         System.debug(LoggingLevel.DEBUG, 'Supplier Created' + lst
SupplierId.size());
        /**        
         * insert record in transaction object
         */        
        if(lstSupplierId.size()>0){ 
            System.debug(LoggingLevel.DEBUG, 'Supplier Created' + lst
SupplierId.size());
                InforceEW.IonTxnUtility.conditionalInsertIonTxn(lst
SupplierId,'Supplier__c', trigger.isInsert, trigger.isUpdate, trigger.
isDelete);             
            System.debug(LoggingLevel.DEBUG, 'Transaction Created');

        }
    }
 }

8 Click Save. Refer to the trigger for the Supplier custom object as an example.
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7Multi-company installation and
configuration

An ERP's multi-company functionality enables the grouping of business operations recorded in ERP
into one or many discrete groupings called financial entities. In Infor Back Office Connect, the
Multi-company Reference Package provides the ability to manage data by organizing enterprise
operations into multiple financial entities. The Multi-company Reference Package supports the
segmentation and consolidation of all master data and operational transactions that result from the
activities in the enterprise and link to each financial company.

Optionally, you can install and configure the Multi-company Reference Package to create a simple
deployment and complex deployment option that allow for configurations based on specific security
business requirements. The simple deployment uses two accounting entities and the complex deployment
uses a role hierarchy based on accounting entities.

Note:  Infor Back Office Connect remains a managed package. The Multi-company Reference Package
is an additional un-managed package that supports installation-specific customization.

When the Multi-company Reference Package is installed and configured, Infor Back Office Connect
manages the new unique IDs to publish BODs to the proper ERP accounting entity. A sample trigger
to set ownership of new records based on accounting entity ID and location ID must be configured by
the system administrator in the Accounting Entity Table (AET). This leverages the existence of role
hierarchies and sharing rules already deployed in your organization

Note: Installing and configuring the Multi-company Reference Package is an optional step in the Infor
Back Office Connect installation, configuration, and implementation process. If you do not need to
implement Infor Back Office Connect using a multi-company deployment, you can skip this chapter.

Installing the multi-company reference package
To install the Multi-company Reference Package:

1 Log in to Salesforce as the system administrator.
2 Login to the Infor Xtreme Support portal and navigate to the Infor Back Office Connect KB 1149054.
3 Locate the Reference Package Installation URL and click the link to begin the multi-company package

installation. The Installation Details page is displayed in your Salesforce organization. This page
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displays a summary of the Infor Back Office Connect package you are installing and the changes
the package will make to your Salesforce organization.

4 Review the package installation details and click Continue.
5 In the Multi-company Reference Package page, click Next.
6 In the Security Level page, specify the Select Security Settings option.
7 Select Full Access for each user profile that require full access to the multi-company package. We

recommend full access for the Infor Back Office Connect Administrator and the Infor Back Office
Connect Developer profiles.

8 Click Next.
9 In the Install Package page, click Install. The Install Complete Page will display and an email will

be sent to the email address of your system administrator user profile.
10 Select  Setup > App Setup > Installed Packages.
11 Confirm the Multi-company Reference Package is installed in your Salesforce organization.

Understanding accounting entity mapping
Accounting Entity Mapping is used to relate the record owner based on Accounting Entity ID or
Accounting Entity ID and Location ID. Accounting Entity Mapping is a configurable table maintained
by the system administrator to support the sample trigger that assigns the owner of a new record.
Accounting Entity Mapping is part of the multi-company reference package deliverable with the Sample
Trigger.

RequiredDefault ValueValuesLengthTypeName

Yes255TextAccounting Entity ID

No255TextLocation ID

YesGroupUserUserOwner

These are the fields included in the Accounting Entity Mapping:

Accounting Entity ID
An Accounting Entity ID relates a single user to an Accounting Entity and should always have a value.
The Location ID may be blank for one record for the Master BODs to use to assign the record owner
when they are received by Infor Back Office Connect from the ERP.

Location ID
A Location ID relates a single user to an Accounting Entity and Accounting Entity. This field should
only be used when a deployment requires that the Accounting Entity be divided by Locations. There
should only be a single combination of the Accounting Entity ID and Location ID in the table as it
assigns the record owner for transactional BODs when they are received by Infor Back Office Connect
from the ERP.
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Owner
This is the value used by the sample trigger to assign the owner of a new record when a ERP is
received by Infor Back Office Connect from the ERP. The owner must be a username for the
organization.

Depending on your business requirements, you may you have an organization that has only a few or
many accounting entities. These tables show how to create the mapping for Master and Transactional
Data for simple and complex deployment scenarios.

Note: Master Data only requires an Accounting Entity while Transactional Data requires an Accounting
Entity and Location ID as both are defined in the BODs that are published to Infor Back Office Connect.

This table shows a simple deployment scenario:

OwnerLocation IDAccounting Entity ID

Salesperson AID #1

Salesperson BID #2

This table shows a complex deployment scenario:

OwnerLocation IDAccounting Entity ID

Salesperson ACustomer #1

Salesperson BCustomer #2

Salesperson CCustomer #3

Salesperson DATLCustomer #4

Salesperson ENYCCustomer #4

Navigating the accounting entity table
To navigate the Accounting Entity Table:

1 Click the plus icon (+) to display all tabs.
2 Click Accounting Entity Tables.
3 Click Go.
4 Click the button for the action you want to complete:

New Accounting Entity
To create a new accounting entity.

Edit
To edit an accounting entity.
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Delete
To delete an accounting entity.

Choosing a deployment scenario
Prior to choosing a deployment scenario, ensure that Infor Back Office Connect is installed and properly
configured with all required message sources, ION is installed and configured for each of the message
sources, and the Multi-company Reference Package is installed.

To choose a deployment scenario:

1 Create a layout of your Accounting Entity structure.
2 Define your security model by determining your users' access needs.
3 Ask yourself these questions:

• Do you have more than 1 Accounting Entity?
No: No trigger or AET is required.
Yes: Continue with the next question.

• Do all users need to view all of the data?
Yes: No trigger or AET is required.
No: Continue with the next question.

• Do you use a role hierarchy today?
Yes: Use the complex deployment scenario.
No: Continue with the next question.

• Do most users need to view one Accounting Entity's data?
Yes: Use the simple deployment scenario.
No: Use the complex deployment scenario.

Note: These are suggested recommendations. For assistance with determining your deployment
scenario, contact the Infor ICS team.

Creating a public group
Public groups allow users in the same group to share record information as determined by a sharing
rule. You must create a public group prior to creating a sharing rule.

To create a public group:
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1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Manage Users > Public Groups.
4 Click New.
5 Specify a Label.
6 In the Search drop-down-list, select Users.
7 In the Available Members list, select the users and Add them to the Selected Members list.
8 Click Save.
9 Repeat these steps for every group you create.

Understanding the sample trigger
The sample trigger is designed to change the ownership of a record after it is imported from the ERP
into Infor Back Office Connect. This sample trigger allows deployments to use their existing security
models.

Adding the standard objects sample trigger to Infor Back Office
Connect
Note: To add this trigger to other objects you must change the trigger name "ContactInsert" and the
object name "Contact". We recommend a search and replace process.

To add the standard objects sample trigger to Infor Back Office Connect:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Contact > Triggers.
4 Click New.
5 In the Apex Trigger section, copy and paste this script:

trigger ContactInsert on Contact (before insert) { 
Map<String,String> mapAEldOwner = new Map<String,String>();
set<String> setCompositeKey = new set<String>();
String locationIdApiName = ";
String entityName= string.valueof(Trigger.New[0].getsobjecttype();

if(InforceEW.IonTxnUtility.checkIntegrationUser()){
/**
* Step1: Create Composite Key which will be combination of AEID and 
LocId.
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*/
for(SObject obj: Trigger.New)
{
  if(obj.get(*InforceEW__extaccountingentityid__c') != null){
      if(obj.get('InforceEW__locationid__c') != null){ 
      setCompositeKey.add(obj.get('InforceEW__extaccountingentityid__
c') + ':' + 
obj.get('InforceEW__locationid__c'));}

     else{

setCompositeKey.add(string.valueof(obj.get('InforceEW__
extaccountingentityid__c')));

    }
  }
  else{
    setCompositeKey.add(");
  }
}
/**
* Step2: Query to retrieve records from AET table based on composite
 Key.

*/

if(setCompositeKey.size() > 0){

   List<accountingEntityTable__c> lstAcccEntity = [select
id.accountingEntityID__c,owner__c, locationID__c, compositeKey__c 
from
accountingEntityTable__c where compositeKey__c in : setCompositeKey];

  if(lstAcccEntity != null && lstAcccEntity.size() >0){

      for(accountingEntityTable__c accEntity: lstAcccEntity){

            mapAEldOwner.put(accEntity.compositeKey__c,accEntity.
owner__c);

      }
      /**
      * Step3: Assigning default user from AET table as the owner of
 the record.
      */
      for(SObject objNew: Trigger.New){
         String compKey = null;
         if (objNew.get('InforceEW__location__c') !=null{

             compKey = objNew.get('InforceEW__extaccountingentityid__
c') + '.' +
objNew.get('InforceEW__locationid__c');
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      }
      else{
         compKey =
String.valueof(objNew.get('InforceEW__extaccountingentityid__c'))

        }
        if(mapAEldOwner.get(compKey) !l
        {
          objNew.put('ownerid', mapAEldOwner.get(compKey));
          InforceEW.SFIonIntegration.isOwnerinsert = true;

        }
      }
    }
}
}
}

6 Click Save.
7 Repeat these steps for the Account object. The ContactInsert and AccountInsert are installed during

the Multi-Company Reference Package installation. See "Installing the multi-company reference
package" on page 119.

Adding the custom objects sample trigger to Infor Back Office
Connect
Note: To add this trigger to other objects you must change the trigger name "ContactInsert" and the
object name "Contact". We recommend a search and replace process.

This example uses the Bill-to trigger.

To add the custom objects sample trigger to Infor Back Office Connect:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Create.
4 Select the Bill-to object name to the locate the Trigger section.
5 Click New.
6 In the Apex Trigger section, copy and paste this script:

trigger BilltoInsert on InforceEW__billto__c (before insert) { 
Map<String,String> mapAEldOwner = new Map<String,String>();
set<String> setCompositeKey = new set<String>();
String locationIdApiName = ";
String entityName= string.valueof(Trigger.New[0].getsobjecttype();
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if(InforceEW.IonTxnUtility.checkIntegrationUser()){
/**
* Step1: Create Composite Key which will be combination of AEID and 
LocId.
*/
for(SObject obj: Trigger.New)
{
  if(obj.get(*InforceEW__extaccountingentityid__c') != null){
      if(obj.get('InforceEW__locationid__c') != null){ 
      setCompositeKey.add(obj.get('InforceEW__extaccountingentityid__
c') + ':' + 
obj.get('InforceEW__locationid__c'));}

     else{

setCompositeKey.add(string.valueof(obj.get('InforceEW__
extaccountingentityid__c')));

    }
  }
  else{
    setCompositeKey.add(");
  }
}

/**
* Step2: Query to retrieve records from AET table based on composite
 Key.

*/

if(setCompositeKey.size() > 0){

   List<accountingEntityTable__c> lstAcccEntity = [select
id.accountingEntityID__c,owner__c, locationID__c, compositeKey__c 
from
accountingEntityTable__c where compositeKey__c in : setCompositeKey];

  if(lstAcccEntity != null && lstAcccEntity.size() >0){

      for(accountingEntityTable__c accEntity: lstAcccEntity){

            mapAEldOwner.put(accEntity.compositeKey__c,accEntity.
owner__c);

      }
      /**
      * Step3: Assigning default user from AET table as the owner of
 the record.
      */
      for(SObject objNew: Trigger.New){
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         String compKey = null;
         if (objNew.get('InforceEW__location__c') !=null{

             compKey = objNew.get('InforceEW__extaccountingentityid__
c') + '.' +
objNew.get('InforceEW__locationid__c');

      }
      else{
         compKey =
String.valueof(objNew.get('InforceEW__extaccountingentityid__c'))

        }
        if(mapAEldOwner.get(compKey) !l
        {
          objNew.put('ownerid', mapAEldOwner.get(compKey));
          InforceEW.SFIonIntegration.isOwnerinsert = true;

        }
      }
    }
}
}
}

7 Click Save.
8 Repeat these steps for these objects:

Object NameTrigger NameObject

InforceEW__billto__cBilltoInsertBill-to

InforceEW__payfrom__cPayfromInsertPay-from

InforceEW__Quote__cInforceQuotesInsertInfor Quotes

InforceEW__shipto__cShiptoInsertShip-to

InforceEW__shipment__cShipmentInsertShipment

Note: The triggers are automatically added when the Multi-Company Reference Package is installed
for all of the required Infor Back Office Connect objects. See "Installing the multi-company reference
package" on page 119.
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Creating a sharing rule for a simple deployment
scenario
Your security requirements will determine whether your organization allows sharing of records based
on user groups.

To create a sharing rule:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Security Controls > Sharing Settings.
4 In the Account Sharing Rules section, click New.
5 Specify the Label.
6 Select the Rule Type: Based on record owner option.
7 In the Account: owned by members of drop-down-list boxes, select Public Groups and specify

the group.
8 In the Share with: drop-down-list boxes, specify Public Groups and specify the group.
9 Set these drop-down-list boxes to Read Only:

• Default Account, Contract and Asset Access
• Opportunity Access
• Case Access

10 Click Save.
11 Repeat these steps for each group that you created.

Creating a sharing rule for a complex deployment
scenario
Your security requirements will determine whether your organization allows sharing of records based
on user groups.

To create a sharing rule:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Security Controls > Sharing Settings.
4 In the Account Sharing Rules section, click New.
5 Specify the Label.
6 Select the Rule Type: Based on record owner option.
7 In the Account: owned by members of drop-down-list boxes, select Roles and specify the role.
8 In the Share with: drop-down-list boxes, select Roles and Subordinates and specify the role.
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9 Set these drop-down-list boxes to Read Only:

• Default Account, Contract and Asset Access
• Opportunity Access
• Case Access

10 Click Save.
11 Repeat these steps for each role that you created.

Setting objects to private for a simple or complex
deployment scenario
Depending on your business requirements, objects can be set to Private in the Sharing Settings window.
We recommend that these objects be set to private: Account, Contract and Asset, Address, Bill-to,
Lookup Category, Pay-from, Ship-to, Shipment, and Territory.

To set objects to private:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Security Controls > Sharing Settings.
4 Click Edit.
5 In the Default Access list, set these objects to Private:

• Default Account, Contract, and Asset
• Address
• Bill-to
• Lookup Category
• Pay-from
• Ship-to
• Shipment
• Territory

6 Click Save.

Assigning a role hierarchy
Role hierarchy assignments provide access to opportunities and cases associated with an account.
Role hierarchy is determined by your business requirements.

To assign role hierarchy:
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1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Manage Users > Roles.
4 Click Add Role.
5 Specify the information you desire for each account entity or location ID that you have mapped.
6 Click Save.
7 Repeat these steps for each role that you created.

Understanding the unique ID
The Unique ID is a globally unique value that is assigned to a BOD instance. In addition to supporting
customer any BODs, Infor Back Office Connect supports these 13 Master Data and Transactional
BODs. See "Creating Any BODs" on page 105.

Note: All BODs require a Unique ID in the list of required fields for Any BODs.

Transactional BODsMaster Data BODs

Customer ReturnBillToPartyMaster (two-way)

InvoiceCodeDefinition (two-way)

QuoteContactMaster (two-way)

Receivable TransactionCustomerPartyMaster (two-way)

Sales OrderItemMaster

ShipmentPayFromPartyMaster (two-way)

ShipToPartyMaster (two-way)

This is an example of the Unique ID of a Master Data BOD:

CustomerPartyMaster (Account):
Customer ID = C00001
Accounting Entity = 45WD
Unique ID = 45WD:C00001

This is an example of the Unique ID of a Transactional BOD:

Invoice:
Invoice ID = INV00231
Accounting Entity = 45WD
Location ID = 1
Unique ID = 45WD:1:INV00231
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Note: In this example, if the Location ID of the Transactional BOD was null, the Unique ID would be
reflected as 45WD::INV00231.

Modifying the Infor Back Office Connect page layout
to add the message source lookup
These Infor Back Office Connect Page Layouts must be modified to use the Master Source Lookup:
Infor Back Office Connect Account Layout, Infor Back Office Connect Bill-To Layout, Infor Back Office
Connect Contact Layout, Infor Back Office Connect Pay-From Layout, Infor Back Office Connect Ship-To
Layout, and Infor Back Office Connect Territory Layout.

Caution: The page layout modifications described in this section are only required for customers
who are upgrading Infor Back Office Connect from version 10.6.x to version 10.8.x. If you are
installing Infor Back Office Connect version 10.8.x, you do not have to complete this additional
configuration.

To modify an Infor Back Office Connect page layout to add the Message Source Lookup:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Customize > Accounts > Page Layouts.
5 Select the Infor Back Office Connect Account Layout and clickEdit.
6 In the Infor Back Office Connect Account Layout window, click and drag the Message Source field

into the Account Sample section.
7 Click Save.
8 Repeat Steps 5 through 7 for the Infor Back Office Connect Contact Layout.
9 In the sidebar column, selectApp Setup > Create > Objects > Bill-to > Page Layouts.
10 Click Edit.
11 In the Infor Back Office Connect Bill-to Layout window, click and drag the Message Source field into

the Account Sample section.
12 Click Save.
13 Repeat Steps 9 through 12 for the Ship To, Territory, and Pay From Page Layouts.
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Adding the user default message source to the user
page layout
If there is only one message source, the Default Message Source field can be deleted from all page
layouts if the message source field has been completed by the administrator.

To add the User Default Message Source to the User Page Layout:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectManage Users > Users.
5 Select the user and click Edit Layout.
6 In the User Layout window, click and drag the Default Message Source field to the Additional

Information section.
7 Click Save.

Configuring the default message sources for users
Configuring the default message sources for users in a multi-company environment is a three-step
process. To complete this part of the multi-company configuration, you must:

• Determine which message sources are required for your users
• Configure a pick list to define all the default message sources that are available to your users
• Set the default message sources for all users

See the appropriate section for detailed instructions on how to complete these tasks.

Determining the required message sources for users
View the list of available default message sources to determine which message sources are required
for your users. The required message sources must then be configured as a pick list to make those
message sources available to the required users.

To determine the required message sources for users:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 Click the Integration Setup tab.
5 Click Step 3: Configure Message Source Settings.
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6 View the list of available message sources in the Message Sources list. Make a note of the message
sources that are required for your users.

Creating the default message source pick list values
After determining which default message sources are required for your users, create a pick list of these
required message sources for the Default Message Source custom field to make them available for
the users.

To create the default message source pick list values:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Customize > Users > Fields.
5 In the User Custom Fields section, click the Default Message Source.
6 In the Picklist Values section, click New.
7 In the Default Message Source pick list window, add the required pick list values.

Note: Verify that the pick list value(s) are the same as the message source names on the Integration
Setup page.

8 Click Save.

Setting the default message source for a user
After creating the pick list of default message source values, configure each user record with a default
back office. The specified default message source for the user will be the default message source for
the user on all Infor Back Office Connect objects.

To set the default message source for a user:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectManage Users > Users.
5 Select a user and click Edit.
6 In the Additional Information section, select the default message source for the user from the Default

Message Source list.

Note: If the Default Message Source field has not been added to the page layout, click Edit Layout
and drag the Default Message Source field to the Additional Information section.

7 Click Save.
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Adding the lookup filter to a lookup object to include
message source
In Infor Back Office Connect, there are Lookup Categories and Lookups to support ERP published
Code Definitions. To ensure that users select the appropriate values, you will need to add a filter to
the field to include the Message Source.

This example shows how to add Geographic Areas as a Lookup to a Contact.

To add the Lookup filter to a Lookup object to include Message Source:

1 Log in to Salesforce as the Infor Back Office Connect user.
2 In your Infor Back Office Connect user menu, click Setup.
3 In the sidebar column, select, App Setup > Customize > Contacts > Fields.

Note:  For Custom Objects, select App Setup > Create > Objects.

4 Click New.
5 In the Data Type list, select the Lookup Relationship option.
6 Click Next.
7 In the Related to pull-down list, select Lookup.
8 Click Next.
9 In the Field Label field, specify Geographic Areas.
10 In the Lookup Filter section, select Show Filter Settings.
11 In the Filter Criteria section, click the Field Lookup icon.
12 In the Insert Field window, specify the Lookup > Lookup Category > Name options.
13 Click Insert.
14 In the Operator pull-down list, specify equals.
15 In the Value/Field pull-down list, specify Value then Geographic Areas.
16 Click the AND field Lookup icon.
17 In the Insert Field window, specify the Lookup > Message Source options.
18 In the Operator pull-down list, specify equals.
19 Click Insert.
20 In the Operator pull-down list, specify equals.
21 In the Value/Field pull-down list, specify Field then the Contact > Message Source options.
22 Click Insert.
23 Click Next.
24 Click Next.
25 Click Next.
26 Click Save.

Note: The user must select the Message Source field in the record before selecting a Lookup value.
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Adding fields to the search layouts for the account and
contact objects
To add fields to the search layout for the account and contact objects:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, selectApp Setup > Customize > Accounts > Search Layouts.
5 Select the Infor Back Office Connect Search Layout and click Edit.
6 In the Available Fields section, add these fields to each of the account search layouts:

Search Results
Account Name, Account Owner Alias, Account Record Type, Account Site, Accounting Entity ID,
Phone, and Type.

Lookup Dialogs
Account Name, Account Owner Alias, Account Site, Accounting Entity ID, Message Source, and
Type.

Lookup Phone Dialogs
Account Name, Account Owner Alias, Account Site, Accounting Entity ID, Phone, Other Phone,
and Type.

Tab
Account Name, Accounting Entity ID, Billing City, and Phone.

Search Filter Fields
Account Name, Accounting Entity ID, Billing City, and Phone.

7 In the sidebar column, selectApp Setup > Customize > Contacts > Search Layouts.
8 Select the Infor Back Office Connect Search Layout and click Edit.
9 In the Available Fields section, add these fields to each of these contact search layouts:

Search Results
Account Name, Account Record Type, Account Site, Accounting Entity ID, Contact Owner Alias,
Email, Name, and Phone.

Lookup Dialogs
Account ID, Account Name, Account Site, Accounting Entity ID, Message Source, and Name.

Lookup Phone Dialogs
Account Name, Account Site, Accounting Entity ID, Asst. Phone, Home Phone, Name, Mobile,
Mobile Office, Other Phone, and Phone.

Tab
Account Name, Accounting Entity ID, Name, and Phone.

Search Filter Fields
Account Name, Accounting Entity ID, First Name, Last Name, and Phone.

10 Click Save.
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Filtering standard field lookups for message sources
If your deployment uses multiple message sources, filters on lookups are recommended to ensure that
users do not select records from a different message source. This table shows the recommended filters
to add to the Parent Account, Account, and Reports To fields.

Compare FieldValue/FieldOperatorFilter Criteria
Field

FieldObject

Account Name:
Message
Source

FieldequalsAccount: Back
Office

Parent Ac-
count

Account

Contact Name:
Message
Source

FieldequalsContact: Back
Office

AccountContact

Contact Name:
Message
Source

FieldequalsContact: Back
Office

Reports ToContact

Adding a filter to standard field objects
To add a filter to a standard field object:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In your Infor Back Office Connect user menu, click Setup.
3 In the sidebar column, select App Setup > Customize > Accounts > Fields.

Note: For Contacts, select App Setup > Customize > Contacts > Fields.

4 In the Account Standard Fields section, select Parent Account.
5 Click Edit.
6 In the Lookup Filter section, select Show Filter Settings.
7 In the Filter Criteria section, click the Field Lookup icon.
8 In the Insert Field window, specify the Account > Message Source options.
9 Click Insert.
10 In the Operator drop-down list, specify equals.
11 In the Value/Field drop-down list, specify Field then the  Account > Message Source options.
12 In the Filter Type section, specify either the Required or Optional option.
13 Select the Active check box.
14 Click Save.

Note:  When you create a Bill-to from an Account, the Message Source and the Accounting Entities
are copied.
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Adding multi-company validation rules to lookups
(optional)
Validation rules must be added to any custom object with a Lookup to a Lookup object to support
multi-company data validation. These validation rules will display the error message on the field listed
with each message.

This table matches validation rules to the Message Source.

Error Condition FormulaError
Message

Rule NameField
Name

Object

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The Area
Type select-

AreaTypeMessage
SourceValidation

AreaAccount

(InforceEW__Message_Source__c <>ed does not
InforceEW__areaid__r.In-have the
forceEW__Message_Source__c ),same Back
NOT(ISBLANK ( In-Office as this

Account. forceEW__areaid__r.InforceEW__Mes-
sage_Source__c)))

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The Cus-
tomer Type

CustomerTypeMessage
SourceValidation

Cus-
tomer
Type

Account

(InforceEW__Message_Source__c <>
InforceEW__customertypeid__r.In-

selected does
not have the

forceEW__Message_Source__c ),same Back
NOT(ISBLANK (InforceEW__customer-Office as this

Account. typeid__r.InforceEW__Mes-
sage_Source__c)))

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The Market
selected does

MarketTypeMessage
SourceValidation

MarketAccount

(InforceEW__Message_Source__c <>not have the
InforceEW__marketid__r.In-same Back
forceEW__Message_Source__c ),Office as this

Account. NOT(ISBLANK (InforceEW__mar-
ketid__r.InforceEW__Mes-
sage_Source__c)))

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The Payment
Term select-

PaymentTermMessage
SourceValidation

Payment
Term

Account

(InforceEW__Message_Source__c <>ed does not
InforceEW__paymenttermid__r.In-have the
forceEW__Message_Source__c ),same Back
NOT(ISBLANK (InforceEW__payment-Office as this

Account. termid__r.InforceEW__Mes-
sage_Source__c)))

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The NAICS
selected does

NAICSMessage
SourceValidation

NAICSAccount

Infor Back Office Connect Administration Guide | 137

Multi-company installation and configuration



Error Condition FormulaError
Message

Rule NameField
Name

Object

(InforceEW__Message_Source__c <>
InforceEW__naicsid__r.In-

not have the
same Back

forceEW__Message_Source__c ),Office as this
Account. NOT(ISBLANK (InforceEW__naic-

sid__r.InforceEW__Mes-
sage_Source__c)))

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The Territory
selected does

TerritoryMessage
SourceValidation

TerritoryAccount

(InforceEW__Message_Source__c <>not have the
InforceEW__territory__r.In-same Back
forceEW__Message_Source__c ),Office as this

Account. NOT(ISBLANK (InforceEW__territo-
ry__r.InforceEW__Mes-
sage_Source__c)))

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The Industry
selected does

IndustryMessage
SourceValidation

IndustryAccount

(InforceEW__Message_Source__c <>not have the
InforceEW__industryid__r.In-same Back
forceEW__Message_Source__c ),Office as this

Account. NOT(ISBLANK (InforceEW__indus-
tryid__r.InforceEW__Mes-
sage_Source__c)))

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The Ship Ad-
dress Price

ShipAddress
PriceGroup

Ship Ad-
dress
Price
Group

Account

(InforceEW__Message_Source__c <>
InforceEW__

Group select-
ed does not
have the

MessageSource
Validation shipadrpricegroupid

same Back __r.InforceEW__Message_Source__c
), NOT(ISBLANK (InforceEW__Office as this

Account.
shipadrpricegroupid
__r.InforceEW__Mes-
sage_Source__c)))

AND (NOT(ISBLANK (In-
forceEW__Message_Source__c)),

The SIC
Code select-

SICCodeMessage
SourceValidation

SIC
Code

Account

(InforceEW__Message_Source__c <>
InforceEW__

ed does not
have the
same Back SICCode__
Office as this
Account. r.InforceEW__Message_Source__c ),

NOT(ISBLANK (InforceEW__
SICCode__
r.InforceEW__Message_Source__c)))
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This table shows the validation rules of a Message Source specific deployment.

Error Condition FormulaError
Message

Rule NameField
Name

Object

AND (NOT(ISBLANK ( In-
forceEW__Message_Source__c )), (

The Market
selected does

MarketTypeMessage
SourceValidation

MarketAccount

InforceEW__Message_Source__c <>not have the
InforceEW__marketid__r.In-same Back
forceEW__Message_Source__c ),Office as this

Account. NOT(ISBLANK (InforceEW__mar-
ketid__r.InforceEW__Mes-
sage_Source__c)))

Note:  The validation rules for accounting entities can be disabled if your deployment requires records
that are shared between accounting entities. For example, an account is in Accounting Entity Customer
#1 and the Infor Back Office Connect Order is in Accounting Entity Customer #2 (published by ERP.)

Note:  If your ERP does not support shared records between accounting entities, see "Setting validation
rules for ERPs that do not support shared records between accounting entities" on page 140.

Setting validation rules for a lookup
To set validation rules for a lookup:

1 Log in to Salesforce as the Infor Back Office Connect system administrator.
2 In your Infor Back Office Connect user menu, click Setup.
3 In the sidebar column, selectApp Setup > Customize > Accounts > Validation Rules.
4 Click New.
5 In the Validation Rule Edit section, specify this information:

• Rule Name
• Error Condition Formula
• Error Message

6 Select the Error Location Field option.
7 Click Save.
8 Repeat Steps 4 through 7 for each field.

Note:  See "Adding multi-company validation rules to lookups (optional)" on page 137.

Note:  We recommended that you add Validation Rules to all lookup fields based on your deployment
requirements.
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Setting validation rules for ERPs that do not support shared records
between accounting entities
To set validation rules for ERPs that do not support shared records between accounting entities:

1 Log in to Infor Back Office Connect as the system administrator.
2 In your Infor Back Office Connect user menu, click Setup.
3 In the sidebar column, select App Setup > Customize > Accounts > Validation Rules.
4 Select the ParentAccountAccountEntityvalidation rule.
5 Click Edit.
6 In the Validation Rule Edit section, select the Active checkbox.
7 Click Save.
8 Repeat Steps 4 through 7 for the ContactAccountAccountEntityValidation rule.
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8Multiple back office configuration

Optionally, you can configure the Infor Back Office Connect multiple back office functionality. The
multiple back office configuration enables Infor Back Office Connect to connect to multiple ERPs. This
is accomplished by leveraging ION’s Content Based Routing functionality which is based on Accounting
Entity to determine where BODs are sent. For example, Infor Back Office Connect can be connected
to an A+ ERP and a LN ERP simultaneously.

Caution: The multiple back office configuration is an optional part of the Infor Back Office
Connect installation, configuration, and implementation process. If you do not need to configure
multiple back office functionality for your Infor Back Office Connect implementation, you can
skip this chapter. Connection Points for each Back Office Logical ID and Infor Back Office
Connect need to be configured before starting these instructions.

Multiple back office configuration tasks
Complete these tasks to configure ION for multiple back office:

• Create a document flow for each BOD Noun and ERP
• Add an application to an activity
• Add documents to the activities
• Add routing to the document flow
• Set the top and bottom applications' routing
• Add a routing condition to the applications
• Create the first and second condition builders
• Select the condition branches
• Configuring message source settings for multiple back office integration

Note: These steps need to be repeated for each Process BOD Noun.
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Creating a document flow for each BOD noun and ERP
To create a document flow for each BOD Noun and ERP:

1 In Infor ION Desk, select Model > Connect > Document Flows.
2 Click New.
3 Specify this information:

Name
Specify a unique name for the new document flow.

Note:  We recommend that you include the BOD noun and the BOD in the document flow name.

Description
Specify the description of the new document flow.

Adding an application to an activity
To add an application to an activity:

1 In the Activities window, click the Application icon.
2 Click the line between the Start and End points to add the first 2 activities.
3 In the Application Task window, click Add.

Note: To add a new application, see the ION Connect Administration Guide.

4 In the Add Application window, select the source application and click OK.
5 Click the line between the first activity and the End point to add a second activity.
6 In the Add Application window, select the source application.
7 Click OK.

Adding documents to the activities
To add documents to the activities:

1 Click the Document icon between Activity 1 and Activity 2.
2 In the Documents window, click Add.
3 Select the document and verb to map. For example, Process Customer Party Master.

Add routing to the document flow
A routing must be added for each Accounting Entity in each Process Document Flow.
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To add routing to the document flow:

1 Click the Flow window to view the Routing icons.
2 Select the Routing icon and click the line between Activity 1 and Activity 2.
3 Click the Activities window and select the Application icon.
4 Click on both lines displayed in the routing flow to add activities to the destination applications.

Note: To add another flow to another connection point, right-click the Flow and select Add Branch.
Repeat Steps 3 and 4 for each Connection Point.

Setting the top and bottom applications' routing
To set the top and bottom applications' routing:

1 Click the top activity in the routing flow.
2 In the Application Task window, click Add.
3 In the Add Application window, select an application and click OK.
4 Click the bottom activity in the routing flow.
5 In the Application Task window, click Add.
6 In the Add Application window, select an application and click OK.

Adding a routing condition to the applications
To add a routing condition to the applications:

1 Select the Routing icon.
2 In the Routing Properties window, click Add.
3 In the Select Attributes window, expand the CustomerPartyMaster BOD.
4 Expand the Predefined Attributes folder.
5 Select the AccountingEntityID check box.
6 Click OK.

Note: Some ERP Nouns to not contain an Accounting Entity. For example, the Contact Master for
ERP A+. To determine whether the ERP noun for your ERP system contains an Accounting Entity,
see the integration guide for the specific ERP system(s) you have integrated with Infor Back Office
Connect.

Creating the first and second condition builders
To create the first and second condition builders:
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1 In the Routing Properties window, select the Conditions tab.
2 Click Add.
3 In the Condition Builder window, specify this information:

Name
Specify the name of the condition.

Parameter
Select AccountingEntityID.

Value
Specify the value of the AccountingEntityID.

4 Click OK.
5 Repeat Steps 3 and 4 for the next Condition Builder. This needs to be done for each Connection

point where Infor Back Office Connect is publishing a Process BOD for the Noun.

Selecting the condition branches
To select the condition branches:

1 In the Used Conditions section, select the name of the first condition for the first branch.
2 Repeat Step 1 for the second branch. Repeat this step for each condition.

Configuring message source settings for multiple back office
integration
The message source settings specify the Back Office, Default Accounting ID, and ION Logical ID that
are used to configure ERP to publish BOD documents to ION. Message source settings are
customer-specific based on the ERP system being connected with ION and Infor Back Office Connect.

To configure message source settings:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 Click Step 3: Configure Message Source.
5 Click New Message Source.
6 Specify this information:

Message SourceName
The default value is Message Source. To modify the value, specify the ERP that is your system of
record. The message source is the application you are integrating with Infor Back Office Connect
through ION. For example, ERP LN.
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Logical ID
The default value is Infor. To modify this value, specify the logical ID for the ERP application
connection point in ION. The application connection point is the unique identifier that connects the
ERP system with ION .

URL
The URL of the message source.

Default Accounting Entity ID
The default value is Default. To modify the value, specify the accounting entity from your ERP. For
example, if you are integrating with ERP LN, the value specified corresponds with the Company
Number in ERP LN. This value is required.

Default Location ID
Specify the default location for the ERP with which you are integrating. Default Location ID is used
when the ERP is configured with multiple sites. This value is optional.

Active?
Select this Active? check box to activate the message source.

Entity Selection
Specify the BOD entity mapping for the ERP. BOD entity mappings are used to define objects and
objects with BODs that are associated with outbound processes. This value is required.

Note: Ensure that you choose the nouns you want to be published to the message source you
selected.

7 Click Save.
8 Click Message Source Name.
9 Click New Message Source BOD Type Version.
10 Click the BOD Type Version lookup and select BOD Type Version.
11 Click Save.
12 Repeat steps 9 through 11 for each BOD Type Version supported by the back office.
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9Upgrading

This chapter describes the tasks that you must complete to upgrade to the latest version of Infor Back
Office Connect installed on your Salesforce organization.

Caution: Earlier Infor Back Office Connect implementations must be updated to version 10.6.x
prior to migrating to the latest version. The latest Infor Back Office Connect version release
contains several new enhancements that require transformation of the data structures and data
content of previous versions (10.6.x or earlier).

This is a list of enhancements and new features that are installed as a part of the upgrade to the current
Infor Back Office Connect version:

• Data Storage Reduction: Numerous schema changes have been implemented to reduce the
number of Salesforce records being consumed and thus reducing the cost of ownership. As a result
most of the transactional addresses have been moved from related records to the actual transactional
records. This data storage reduction will require updates to the existing page layouts once the data
has been migrated.

• Updated Street Address Interface: Street addresses have moved from the six individual address
lines to one formatted Text Area for the Street Address. This user interface enhancement will require
updates to the existing page layouts once the data has been migrated.

• Multi-Company Support: Infor Back Office Connect is now able to uniquely identify and track BODs
from multiple ERP companies based on the Accounting Entity ID. This enhanced implementation
of Accounting Entity requires migration of the existing data to be compatible with the new Unique
ID field.

• Multi-Back Office Support: Infor Back Office Connect is now able to support BOD interfaces with
multiple ERPs at the same time. This enhanced feature now supports the ability to define multiple
message sources in Infor Back Office Connect. Multiple ERPs routed through a common ION
interface may now be connected to a common instance of Infor Back Office Connect. The migration
process will update the existing data to be related to the existing Message Source.

• Infor Quotes: ERP Quotes and local Salesforce based quotes are accessed from a new, custom
object called Infor Quote. The Infor Quote object may still be related to an Opportunity, but it is no
longer constrained by a master-detail relationship with the Opportunity object. The Infor Quote can
be related to an Opportunity, Account and/or Contact via a lookup relationship. The generic Data
Migration process included in the upgrade does not include migration of standard quotes to the Infor
Quote object. The existing ERP Quotes and Salesforce based quotes must be migrated to the Infor
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Quote Object using a separate application called Infor Back Office Connect Migration. See "Infor
quote migration" on page 193.

• Any BOD Support: Enhanced BOD field mappings have been implemented to allow integrators
the ability to re-map or disable existing fields as well as implement new fields or complete BODs as
needed.

• Optional Master Data: With the enhanced BOD field mapping support, it is now possible to remove
the dependency upon the Master Data Ship-to, Bill-to, and Pay-from. The removal of these Master
Data items does not impact the usability of the transactional detail as the addresses of record,
Ship-to, Sold-to, Bill-to, and Pay-from are stored with each transaction.

• Unit Groups: The Enable Standard Group configuration setting has been added to the Integration
Setup page to specify the way in which unit groups for units of measure are processed within Infor
Back Office Connect. See "Understanding unit group processing in Infor Back Office Connect" on
page 34. When you upgrade Infor Back Office Connect to the current version, the unit groups
functionality is automatically enabled (the Enable Standard Group is not selected). If you choose
to enable the Standard unit group functionality (by selecting the Enable Standard Unit Group check
box), you must remove the Unit Group field from the Infor Back Office Connect Products page
layout and make the field optional for any other page layouts containing the field (by clearing the
Required check box in the field properties). If you enable the Standard unit group functionality, we
recommend that you perform the additional steps required to migrate your unit of measure data
from unit groups to the Standard unit group. This additional migration is not required, but is
recommended to reduce the data storage required for these units of measure. "Migrating unit group
data".

Overview of Infor Back Office Connect 10.8
compatibility
Infor Back Office Connect 10.6.1 data must be migrated prior to actively using it in Infor Back Office
Connect version 10.8. Infor Back Office Connect versions earlier than 10.6.1 must be upgraded to Infor
Back Office Connect version 10.6.1 or 10.6.3 prior to upgrading to Infor Back Office Connect version
10.8.

To reduce data storage requirements, schema changes have been made to Bill-to, Ship-to, or Pay-from
many-to-many relationships. The schema changes support the optional transition of data stored in the
many-to-many junction object for Accounts and their respective Bill-to, Ship-to, or Pay-from objects
using Lookup fields. As a result, an Account can have multiple Bill-to or Ship-to addresses.

To support these changes, a set of many-to-many configuration settings has been added to the Configure
Infor Back Office Connect Settings section of the Integration Setup page. When the respective
many-to-many configuration settings are disabled, the Bill-to or Ship-to addresses are related to only
one Account.

Caution: Many-to-many configuration settings must be configured manually prior to migrating
your existing data to Infor Back Office Connect version 10.8.
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See "Configuring Infor Back Office Connect settings" on page 45 and "Understanding many-to-many
configuration settings" on page 36.

Before migrating your data and configuring your many-to-many settings, see these version-specific
guidelines:

• If you are upgrading from version 10.6.1 or 10.6.3, your many-to-many configuration settings must
be determined based on your Salesforce Data Storage Report.

After analyzing the data in the Salesforce Data Storage Report, configure your many-to-many settings
based on these additional guidelines:

• Enable the Account Ship-to many-to-many setting if the record count for Account Ship-to Roles is
greater than the record count for Ship-to Records

• Enable the Account Bill-to many-to-many setting if the record count for Account Bill-to Roles is
greater than the record count for Bill-to Records

• Enable the Ship-to Bill-to many-to-many setting if the record count for Ship-to Bill-to Roles is greater
than the record count for Bill-to Records

• Enable the Bill-to Pay-from many-to-many setting if the record count for Bill-to Pay-from Roles is
greater than the record count for Pay-from Records

• Disable the many-to-many setting if the respective Roles record count is zero or is not found in the
Salesforce Data Storage report

Optionally, after completing the initial data migration, the Infor Back Office Connect administrator or
system administrator can also use the many-to-many configuration settings to enable or disable future
support of the Account Ship-to, Account Bill-to, Ship-to Bill-to, and Bill-to Pay-from many-to-many
relationships as necessary.

Note: Modifying the many-to-many configuration settings on the Integration Setup screen impacts BOD
processing (new inbound documents from ERP) and the data migration process from the many-to-many
role junction objects to the new one-to-many lookup fields.

Caution: The data migration process supports the transition of Infor Back Office Connect 10.6.x
data from many-to-many to the new one-to-many relationships to reduce data storage
requirements. The data migration does not support data conversion from one-to-many back to
the original many-to-many junction role-based relationships.

Infor Back Office Connect pre-upgrade checklist
This checklist includes the list of tasks you must complete to prior to upgrading Infor Back Office
Connect. See the appropriate section of this guide for detailed instructions on how to complete these
tasks.

We recommend that you complete these pre-upgrade tasks in this order:
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• Confirm that you have access to these user profiles and their passwords: Infor Back Office Connect
Administrator, integration user, the default record owner, and the system administrator

• Confirm the Infor Back Office Connect version number installed on your Salesforce organization
• Download the most recent version of the Infor Back Office Connect Release Notes from the Infor

Xtreme Support portal and review the content of the document
• Stop the scheduler and verify that it is stopped.
• Record the Infor Back Office Connect, ERP, and ION tenant configuration information and settings

from the Configure Message Source Settings, Configure Infor Back Office Connect Settings, and
the Infor Back Office Connect Adapter Scheduler Settings sections of the Integration Setup tab so
that you can verify that none of these settings change following the upgrade. See "Configuring the
Infor Back Office Connect application for ERP integration" on page 40.

Note: We recommend taking screen shots of the screens containing the configuration information
and settings.

Confirming the Infor Back Office Connect version number
Before beginning the upgrade process, verify the Infor Back Office Connect version number installed
on your Salesforce organization. The Infor Back Office Connect version number is displayed in the
Version Number field on the Installed Packages page. See "Confirming the Infor Back Office Connect
package installation" on page 30 .

Downloading the Infor Back Office Connect release notes
The  Infor Back Office Connect Release Notes provide you with detailed information on each Infor Back
Office Connect release, including the deliverables, product features, and product improvements in the
current release. We recommend that you download and review the  Infor Back Office Connect Release
Notes from the Infor Back Office Connect product knowledge base on the support portal web site before
beginning the Infor Back Office Connect upgrade process.

To download the Infor Back Office Connect release notes:

1 Open a web browser.
2 Enter the URL for the Infor Xtreme Support portal login screen: http://www.inforxtreme.com/allogin/

allogin.aspx.
3 Specify the e-mail address and password for your Infor Xtreme user account.
4 Click Login. The Infor Infor Xtreme Support Home Page is displayed.
5 Select Knowledge Base > Search. The KB Search page is displayed.
6 In the Available Product Lines list, select Salesforce and click Add.
7 In the Search For field, specify the Infor Back Office Connect KB number 1149054 and click Search.
8 Locate Infor Back Office Connect Release Updates in the search results and click the link.
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9 In the Infor Back Office Connect Documentation section click the link to the Infor Back Office Connect
Release Notes. The Infor Back Office Connect Release Notes are displayed.

10 Save the document to a local drive.

Stopping the scheduler
The scheduler is the Infor Back Office Connect component that sends messages. The messages trigger
the processing of inbound and outbound Batch Apex jobs (by the adapter) to process inbound and
outbound messages.

To stop the scheduler:

1 Log into Salesforce as the Integration context user.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 On the Integration Setup tab, click Step 7: Start/Stop Scheduler.
5 Click Stop ION Integration Scheduler. A confirmation message is displayed.

Note: Do not restart the scheduler until after data migration and validation have occurred.

See "Post-upgrade tasks checklist" on page 153.

Verifying whether the scheduler is stopped
To verify whether the scheduler is stopped:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Jobs > Scheduled Jobs.
4 In the All Scheduled Jobs list, verify that the Job Name IONBatchExecutor is not displayed. If the

IONBatchExecutor job is displayed, the scheduler is still running.

Upgrading Infor Back Office Connect
To upgrade Infor Back Office Connect, run the latest Infor Back Office Connect package on your
Salesforce organization. The latest Infor Back Office Connect package is available from the Infor Back
Office Connect product knowledge base on the support portal web site.

To upgrade Infor Back Office Connect:

1 Log into Salesforce as the system administrator.
2 Open an additional browser tab.
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Note: Do not log out of the Infor Back Office Connect application when you open another browser
tab.

3 Login to the Infor Xtreme Support portal and navigate to the Infor Back Office Connect KB page.
See "Downloading the Infor Back Office Connect release notes" on page 150.

4 Locate Infor Back Office Connect Installation URL and click the link to begin the package upgrade
installation. The Package Upgrade Details page is displayed in the Salesforce organization you are
currently logged into. This page displays a summary of the Infor Back Office Connect version you
are upgrading to, including the package components, the changed objects and resources, code
updates, and field and page updates.

5 Review the package upgrade details and click Continue. The Approve Third-Party Access window
is displayed.

6 Select the Yes, grant access to these third-party web sites check box and click Continue to
display the Step 1. Approve Package API Access page.

7 Review the extended object permissions and click Next to display the Step 2. Choose security level
page.

8 Select the Select security sections option. The Customize security section is displayed.
9 In the Profile list, select the Infor Back Office Connect Administrator profile.
10 In the Access Level list for the Infor Back Office Connect Administrator profile, select Infor Back

Office Connect Administrator.
11 In the Profile list, select the Infor Back Office Connect Developer profile.
12 In the Access Level list for the Infor Back Office Connect Developer profile, select Infor Back Office

Connect Developer.
13 In the Profile list, select the Infor Back Office Connect User profile.
14 In the Access Level list for the Infor Back Office Connect User profile, select Infor Back Office

Connect User.
15 In the Profile list, select the Infor Back Office Connect Read Only User profile.
16 In the Access Level list for the Infor Back Office Connect Read Only User profile, select Infor Back

Office Connect Read Only User.
17 Click Next to display the Step 3. Install Package page.
18 Click Install. The package installation begins and a confirmation is displayed. After the package is

installed successfully, Salesforce sends an e-mail notification to the Infor Back Office Connect
Administrator.

Caution: Before continuing to the data migration portion of the upgrade process, you must
log out of Salesforce and log back in as the integration context user.
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Post-upgrade tasks checklist
This checklist includes the list of tasks you must complete after installing the Infor Back Office Connect
10.8 upgrade package on your Salesforce organization. See the appropriate section of this guide for
detailed instructions on how to complete these tasks.

• Review any version-specific post-upgrade instructions in the for the latest version Infor Back Office
Connect Release Notes.

Note: If the Infor Back Office Connect Release Notes include any post-upgrade instructions, the
information in the Infor Back Office Connect Release Notes supersedes the information provided
in this document.

• Login to the Salesforce organization on which you upgraded Infor Back Office Connect as the
Integration context user and load the seed data for Infor Back Office Connect version 10.8. See
"Loading seed data for Infor Back Office Connect version 10.7" .

• On the Integration Setup page, enable or disable the Standard Unit Group and many-to-many
configuration settings based on the business requirements of your integration and save the updated
settings.

• Check the Infor Back Office Connect, ERP, and ION tenant configuration information and settings
on the Configure Message Source Settings, Configure Infor Back Office Connect Settings, and the
Infor Back Office Connect Adapter Scheduler Settings sections of the Integration Setup tab to
verify whether any of the settings changed as a result of the upgrade and make any necessary
corrections or revisions.
See "Configuring the Infor Back Office Connect application for ERP integration" on page 40.

• Test the adapter connection.
See "Testing the Infor Back Office Connect scheduler and scheduler connection" on page 52.
If the adapter connection is successful, a confirmation message is displayed. If the connection fails,
verify your adapter settings and test the connection again.

• Migrate existing Infor Back Office Connect data to the Infor Back Office Connect version 10.8.
See "Migrating existing data to Infor Back Office Connect version 10.8" on page 154 .

• Migrate quote data from the standard Salesforce Quote object to the new Infor Back Office Connect
Quote object.
See "Infor quote migration" on page 193.

• Update page layouts and verify existing data content.
See "Updating the account page layout for Infor Back Office Connect version 10.7", "Updating
custom object page layouts for Infor Back Office Connect version 10.7" on page 155, and "Verifying
existing data content for Infor Back Office Connect version 10.8" on page 161.

• Start the ION Integration Scheduler.
See "Starting the scheduler".

• Verify that the scheduler is started.
See "Verifying whether the scheduler is started" on page 57.
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Understanding the data migration process for the Infor Back Office
Connect 10.8 upgrade
This section describes the data migration tasks you must perform to complete the Infor Back Office
Connect version 10.8 upgrade. See the appropriate section of this guide for detailed instructions on
how to complete these tasks.

Caution: Before completing any of the data migration tasks, you must first have upgraded your
Salesforce organization to Infor Back Office Connect version 10.8 by installing the 10.8 package
as the Salesforce System Administrator user.

We recommend that you complete the data migration tasks in this order:

• On the Data Migration tab in Infor Back Office Connect Administration, migrate the 10.6.x data into
the 10.8.x schema. See "Migrating existing data to Infor Back Office Connect version 10.8" on page
154.

• Migrate quote data from the standard Salesforce Quote object to the new Infor Back Office Connect
object. To migrate your quote data, you must first install the Infor Back Office Connect Migration
application on your Salesforce organization. See "Installing the Infor Back Office Connect Migration
application" on page 198

After performing the data migration, verify that these conditions are true:

• The Address Object still contains secondary Master Data Addresses.
• If the Many-to-many relationship configuration settings are not selected, the Master Data Junction

Objects, Account Ship-to Roles, Account Bill-to Roles, Ship-to Bill-to Roles and Bill-to Pay-from
Roles are empty.

• All Transaction Address are empty except for Quote Related Addresses.

Migrating existing data to Infor Back Office Connect version 10.8
To migrate existing data to Infor Back Office Connect version 10.8:

1 Log into Salesforce as the Integration context user.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Data Migration tab.

Note: If the Data Migration tab is not displayed by default, click the plus icon (+) to display all tabs
and click the Data Migration link in the All Tabs list.

4 Specify this information:

Batch Name
The default value is ALL.

Object Name
The default value is All.
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Number of Records to Migrate
Specify ALL.

Include AEID in contact unique ID
Clear this checkbox only if you are migrating ERP-A+ based data.

5 Click Start Selected Batch.

Note: Depending upon the content of your pre-existing data, an error message can be displayed
indicating that there are no records to process. If this error message is displayed, click OK to complete
the data migration process.

Updating custom object page layouts for Infor Back Office Connect
version 10.7
These custom object page layouts must be updated for Infor Back Office Connect version 10.7: Bill-to,
Customer Return, Invoice, Pay-from, Receivable, Sales Order, Ship-to, and Shipment.

To update custom object page layouts for Infor Back Office Connect version 10.7:

1 Log in to Infor Back Office Connect as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 SelectSetup.
4 In the sidebar column, selectApp Setup > Create > Objects.
5 In the Custom Objects section, click the desired object in the Label column. See Salesforce

documentation.

Note:  Custom objects will display one page layout unless additional custom page layouts were
added by the implementation.

6 In the Page Layouts section, click Edit.

Caution: Each page layout must be saved before progressing to the next page layout.

7 For the Bill-to object page layout, add these new related lists:

• Infor Quotes
• Pay-from Records (if the Bill-to Pay-from Many-to-many setting is not selected)

8 For the Bill-to object page layout, remove these related lists:

• Bill-to- Pay-From Role (if the Bill-to Pay-from Many-to-many setting is not selected)
• Account Bill-to Role (if the Account Bill-to Many-to-many is not selected)
• Ship-to Bill-to Role (if the Ship-to Bill-to Many-to-many is not selected)

9 For the Bill-to object page layout, remove these retired fields:
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zz_Bill-to Lines 1 through 6•
• zz_Primary Contact

10 For the Bill-to object page layout, add these new fields:

• Account (if the Account Bill-to Many-to-many is not selected)
• Message Source
• Ship-to (if the Ship-to Bill-to Many-to-many is not selected)
• Street

11 Save the changes to the Bill-to object page layout.
12 For the Customer Return object page layout, remove these retired fields:

• zz_Bill-to Lines 1 through 6
• zz_Bill-to City
• zz_Bill-to Country/Region
• zz_Bill-to State
• zz_Bill-to Zip/Postal Code
• zz_Sold-to Lines 1 through 6
• zz_Sold-to City
• zz_Sold-to Country/Region
• zz_Sold-to State
• zz_Sold-to Zip/Postal Code

13 For the Customer Return object page layout, add these new fields:

• Bill-to City
• Bill-to Country/Region
• Bill-to Street
• Bill-to State/Province
• Bill-to Zip/Postal Code
• Sold-to City
• Sold-to Country/Region
• Sold-to Street
• Sold-to State/Province
• Sold-to Zip/Postal Code

14 Save the changes to the Customer Return object page layout.
15 For the Invoice object page layout, remove these retired fields:

• zz_Bill-to Lines 1 through 6
• zz_Bill-to City
• zz_Bill-to Country/Region
• zz_Bill-to State
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• zz_Bill-to Zip/Postal Code
• zz_Sold-to Lines 1 through 6
• zz_Sold-to City
• zz_Sold-to Country/Region
• zz_Sold-to State
• zz_Sold-to Zip/Postal Code

16 For the Invoice object page layout, add these new fields:

• Bill-to City
• Bill-to Country/Region
• Bill-to Street
• Bill-to State/Province
• Bill-to Zip/Postal Code
• Sold-to City
• Sold-to Country/Region
• Sold-to Street
• Sold-to State/Province
• Sold-to Zip/Postal Code

17 Save the changes to the Invoice object page layout.
18 For the Invoice Line object page layout, remove these retired fields:

• zz_Ship-to Lines 1 through 6
• zz_Ship-to City
• zz_Ship-to Country/Region
• zz_Ship-to State/Province
• zz_Ship-to Zip/Postal Code

19 Save the changes to the Invoice Line object page layout.
20 For the Pay-from object page layout, remove these retired related lists:

• zz_Primary Contact
• Quotes
• Bill-to Pay-From Roles (if the Bill-to Pay-from Many-to-many setting is not selected)

21 For the Pay-from object page layout, add this new related list:

• Infor Quotes

22 For the Pay-from object page layout, remove these retired fields:

• zz_Pay-from Lines 1 through 6
• zz_Primary Contact

23 For the Pay-from object page layout, add these new fields:
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Bill-to (if the Bill-to Pay-from Many-to-many setting is not selected)•
• Message Source
• Street

24 Save the changes to the Pay-from object page layout.
25 For the Receivable object page layout, remove these retired fields:

• zz_Attention of Name
• zz_Bill-to Lines 1 through 6
• zz_Bill-to City
• zz_Bill-to Country/Region
• zz_Bill-to State/Province
• zz_Bill-to Zip/Postal Code
• zz_Pay-from Lines 1 through 6
• zz_Pay-from City
• zz_Pay-from Country/Region
• zz_Pay-from State/Province
• zz_Pay-from Zip/Postal Code
• zz_Sold-to Lines 1 through 6
• zz_Sold-to City
• zz_Sold-to Country/Region
• zz_Sold-to State/Province
• zz_Sold-to Zip/Postal Code

26 For the Receivable object page layout, add these new fields:

• Bill-to Attention
• Bill-to City
• Bill-to Country/Region
• Bill-to Street
• Bill-to State/Province
• Bill-to Zip/Postal Code
• Pay-from Attention
• Pay-from City
• Pay-from Country/Region
• Pay-from Street
• Pay-from State/Province
• Pay-from Zip/Postal Code
• Sold-to Attention
• Sold-to City
• Sold-to Country/Region
• Sold-to Street
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• Sold-to State/Province
• Sold-to Zip/Postal Code

27 Save the changes to the Receivable object page layout.
28 For the Sales Order object page layout, remove these retired fields:

• zz_Bill-to Lines 1 through 6
• zz_Bill-to City
• zz_Bill-to Country/Region
• zz_Bill-to State/Province
• zz_Bill-to Zip/Postal Code
• zz_Ship-to Lines 1 through 6
• zz_Ship-to City
• zz_Ship-to Country/Region
• zz_Ship-to State/Province
• zz_Ship-to Zip/Postal Code
• zz_Sold-to Lines 1 through 6
• zz_Sold-to City
• zz_Sold-to Country/Region
• zz_Sold-to State/Province
• zz_Sold-to Zip/Postal Code

29 For the Sales Order object page layout, add these new fields:

• Bill-to City
• Bill-to Country
• Bill-to Street
• Bill-to State/Province
• Bill-to Zip/Postal Code
• Ship-to City
• Ship-to Country/Region
• Ship-to Street
• Ship-to State/Province
• Ship-to Zip/Postal Code
• Sold-to City
• Sold-to Country/Region
• Sold-to Street
• Sold-to State/Province
• Sold-to Zip/Postal Code

30 Save the changes to the Sales Order object page layout.
31 For the Ship-to object page layout, remove this retired related list:
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Quotes•
• Account Ship-to Roles (if the Account Ship-to Many-to-many setting is not selected)
• Ship-to Carrier Party Roles
• Ship-to Bill-to Roles (if the Ship-to Bill-to Many-to-many setting is not selected)

32 For the Ship-to object page layout, add these new related lists:

• Bill-to Records (if the Ship-to Bill-to Many-to-many is not selected)
• Infor Quotes

33 For the Ship-to object page layout, remove these retired fields:

• zz_Primary Contact
• zz_Ship-to Lines 1 through 6
• Unique ID

34 For the Ship-to object page layout, add these new fields:

• Account
• Carrier Name
• Message Source
• Street
• City
• State/Province
• Zip/Postal Code
• Country/Region

35 Save the changes to the Ship-to object page layout.
36 For the Shipment object page layout, remove these retired fields:

• zz_Return-to Lines 1 through 6
• zz_Return-to City
• zz_Return-to Country/Region
• zz_Return-to State/Province
• zz_Return-to Zip/Postal Code
• zz_Ship-to Lines 1 through 6
• zz_Ship-to City
• zz_Ship-to Country/Region
• zz_Ship-to State/Province
• zz_Ship-to Zip/Postal Code

37 For the Shipment object page layout, add these new fields:

• Account
• Return-to City
• Return-to Country/Region
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• Return-to Street
• Return-to State/Province
• Return-to Zip/Postal Code
• Ship-to City
• Ship-to Country/Region
• Ship-to Street
• Ship-to State/Province
• Ship-to Zip/Postal Code

38 Save the changes to the Shipment object page layout.

Verifying existing data content for Infor Back Office Connect version
10.8
Data Validation is accomplished by reviewing the content of known Accounts and Contacts and their
corresponding transactions.

Updating the Infor Back Office Connect logo for Infor Back Office
Connect version 10.8
After upgrading from Infor Back Office Connect version 10.7.x you must update the Infor Back Office
Connect logo.

To update the Infor Back Office Connect logo:

1 Log in to Salesforce as the system administrator.
2 Click the plus icon (+) to display all tabs.
3 In the All Tabs list, click Documents.
4 In the Document Folders pull-down list, select Shared Documents.
5 Click New Document.
6 In the Upload New Document section, specify information for these fields:

Document Name
Enter a name for this document.

Document Unique Name
Specify a unique name, for example: InforLogo_2013.

Externally Available Image
Select this checkbox.

Enter the path of the file or click browse to find the file.
Select this option and click Choose File.
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7 Click Save.
8 Select Setup.
9 In the sidebar column, selectApp Setup > Create > Apps.
10 In the App Label column, click Infor Back Office Connect > Edit.
11 In the Choose the Image Source for the Custom App Logo section, click Insert an Image.
12 In the File Location pull-down list, select Shared Documents.
13 Select the new logo file.
14 Click Save.

Migrating units of measure (optional)
If you are upgrading to the latest version of Infor Back Office Connect from a previous version, the unit
groups functionality is enabled by default. See "Understanding unit group processing in Infor Back
Office Connect" on page 34. If you want to enable the Standard unit group functionality as a part of
your upgrade, we recommend that you complete these additional configuration steps:

• Migrate all unit group data to the Standard unit group. See "Migrating units of measure from unit
groups to a Standard unit group" on page 162.

• Make the Unit Group field non-required on your page layouts and the Unit Group field must be
removed entirely from the Products page layout. See Salesforce documentation.

Note:  If you configured Infor Back Office Connect to process units of measure using a Standard unit
group and want to restore the default unit group processing functionality, you must complete these
steps to migrate your units of measure from the Standard unit group to unit groups:

• Clear the Enable Standard Unit Group check box in the Infor Back Office Connect Settings on the
Integration Setup page. See "Configuring Infor Back Office Connect settings" on page 45.

• Republish all Item Master BODs

Migrating units of measure from unit groups to a Standard unit group
If you configured Infor Back Office Connect to process units of measure using a Standard unit group
by checking the Enable Standard Unit Group check box in your Infor Back Office Connect Settings on
the Integration Setup page, we recommend that you migrate all of your units of measure from unit
groups to the Standard unit group. This migration process will:

• Create a Standard unit group
• Add a unique unit of measure in the Standard unit group for all existing units of measure
• Relate all existing products to the new units of measure
• Delete all unit groups and units of measure that are not assigned to the Standard unit group

Note: When the Standard unit group functionality is enabled and you are migrating your data from unit
groups to the Standard unit group, the migration process does not delete any unit groups that are not
related to a product.
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To migrate units of measure from unit groups to a Standard unit group:

1 Log into Salesforce as the Integration context user.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Data Migration tab.

Note: If the Data Migration tab is not displayed by default, click the plus icon (+) to display all tabs
and click the Data Migration link in the All Tabs list.

4 Specify this information:

• Select Migrate Unit Group Data from the Batch Name list.
• Verify that ALL is selected from the Object Name list.
• Specify ALL as the Number of Records to Migrate.
• Clear the Include AEID in contact unique ID checkbox

5 Click Start Selected Batch.

Migrating units of measure from a Standard unit group to unit groups
If you configured Infor Back Office Connect to process units of measure using a Standard unit group
and want to restore the default unit group processing functionality, you must complete these steps to
migrate your units of measure from the Standard unit group to unit groups:

• Clear the Enable Standard Unit Group check box in the Infor Back Office Connect settings on the
Integration Setup page. See "Configuring Infor Back Office Connect settings" on page 45.

• Republish all Item Master BODs

See "Understanding unit group processing in Infor Back Office Connect" on page 34.

Note: When you clear the Enabled Standard Unit Group setting and you migrate your data to unit
groups from a Standard unit group, all duplicate units of measure in the existing unit groups are deleted
during the migration process.
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10Creating a customized quote PDF template

By default, Infor Back Office Connect includes an PDF quote document template (QuoteToPDFPage)
that is used to generate Infor quote PDF documents.

To modify or customize a quote PDF template based on your business requirements, you must install
the Custom Quote PDF Reference package, and then update the customizable Infor Back Office
Connect static resource file (customPDF.zip), update your document controller settings, and modify
the Apex code on the custom Visualforce page (QuoteToPDFPage1) to implement your custom quote
PDF template.

Caution: Modifying the Apex code for the custom quote PDF Visualforce page
(QuoteToPDFPage1) requires knowledge of coding and development in the Salesforce Apex
programming language. If the administrator or developer attempting to modify or update the
Apex code on the Visualforce page is not familiar with coding and development in Apex code,
we recommend that a qualified resource delivers the code set required for your modifications.

After creating the customized quote PDF template, you must modify your Configure Quote PDF Settings
in the Step 6. Configure Infor quote and Opportunity Settings section of the Integration Setup screen
to point to the customized quote PDF template. See "Configuring Infor quote and opportunity settings"
on page 52.

Enabling development mode for the user creating or
editing Visualforce pages
Before creating or modifying Visualforce pages, you must enable development mode for the user record
of the administrator or developer who will be creating or modifying the Visualforce pages in your
Salesforce organization.

To enable development mode for the user creating or editing Visualforce pages:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Personal Setup > My Personal Information > Personal Information.
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4 Click Edit.
5 In the General Information section, select the Development Mode check box.
6 Click Save.

Installing the Custom Quote PDF Reference package
Install the Custom Quote PDF Reference package required to access the customizable Infor Back
Office Connect static resource file, document controller, and Visualforce page for customizing the quote
PDF template based on your business requirements.

To install the Custom Quote PDF Reference package:

1 Log in to Salesforce as the system administrator.
2 Click the URL for the Custom Quote PDF Reference package installer provided by Infor to display

the Package Installation Details  page.
3 Review the Custom Quote PDF Reference package installation details and click Continue to display

the Step 1. Approve Package API Access page.
4 Review object and object permission details and click Next to display the Step 2. Choose security

level page.
5 Select the Select security settings check box to display the Customize security section.
6 Select Full Access as the Access Level for the Infor Back Office Connect Administrator, Infor Back

Office Connect Developer, and Infor Back Office Connect User profiles.
7 Click Next to display the Step 3. Install Package page.
8 Click Install.
9 In the Install Package page, click Install. The reference package is installed and a confirmation

message is displayed.
10 Select Setup.
11 In the sidebar column, select Installed Packages.
12 In the Installed Packages list, verify that the Custom Quote PDF Reference package is installed in

your Salesforce organization.

Confirming the components installed with the Custom
Quote PDF Reference package
After installing the Custom Quote PDF Reference package, confirm the installation of the following
components:

• The customPDF static resource file (customPDF.zip) containing the custom logo and the .css file
• The QuoteDocumentController1 Apex class
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• The QuoteToPDFPage1 custom Visualforce page

Confirming the installation of the customPDF static resource file
The customPDF static resource file contains the customizable style sheet (customStyle.css) and the
default logo (logo.png) used to generate quote PDF documents. To customize your quote PDF templates,
you must download the customPDF static resource file as a .zip file and save it to a local drive. You
can then use the customStyle.css to modify your document template and replace the default logo with
your company logo.

To confirm the installation of the customPDF static resource file:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Static Resources.
4 In the Static Resources list, click the customPDF hyperlink to display the Static Resource Detail

page for the customPDF static resource.

Confirming the installation of the QuoteDocumentController1 Apex
class
The QuoteDocumentController1 is a customizable Apex class used to create a template for the PDF
quote document.

To confirm the installation of the QuoteDocumentController1 Apex class:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Apex Classes.
4 In the Static Resources list, click the QuoteDocumentController1 hyperlink to display the Apex Class

Detail page for the QuoteDocumentController1 Apex class.

Confirming the installation of the QuoteToPagePDF1 Visualforce
page
The QuoteToPagePDF1 is a customizable Visualforce page used to customize and modify a custom
quote PDF to replace the default quote PDF document.

To confirm the installation of the QuoteToPagePDF1 Visualforce page:
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1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Pages.
4 In the Visualforce Pages list, click the QuoteToPagePDF1 hyperlink to the Visualforce Page Detail

page for the QuoteToPagePDF1 page.

Replacing the default quote PDF logo with your
company logo
As a part of the quote PDF customization process, you can replace the default quote PDF logo (logo.png)
used to generate quote PDF documents with you custom company logo.

Complete these tasks to replace the default quote PDF logo with your company logo:

• Download the customPDF.zip static resource file to a local drive
• Replace the default logo in the customPDF.zip static resource file
• Update the customPDF.zip static resource file in Infor Back Office Connect
• Update the custom quote PDF Visualforce page (QuoteToPDFPage1) to reference your custom

company logo
• Validate that the custom logo is displayed in quote PDF output

Downloading the customPDF static resource file to a local drive
The customPDF static resource file (customPDF.zip ) contains the customizable style sheet
(customStyle.css) and the default logo (logo.png) used to generate quote PDF documents. To customize
your quote PDF templates, you must download the customPDF static resource file and extract its
contents to a local drive. You can then use the customStyle.css to modify your document template and
replace the default logo with your company logo.

To download the customPDF static resource file:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Static Resources.
4 In the Static Resources list, click the customPDF hyperlink to display the Static Resource Detail

page for the customPDF static resource.
5 Right-click on the  View File hyperlink in the Static Resource Details and choose Save link as...

and save the file to a local drive as customPDF.zip.
6 Extract all of the contents of the customPDF.zip file to a local drive.
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Note: We recommend that you extract the contents of the customPDF.zip file to the same location
to which you saved the .zip file.

7 Make a note of the location to which you saved and extracted the contents of the customPDF.zip
file. You must access the contents of the customPDF.zip file to define properties and customizations
for your quote PDF template.

8 Continue to the next step of the process. See "Replacing the default logo in the custom PDF static
resource file" on page 169 .

Replacing the default logo in the custom PDF static resource file
After saving a local copy of the customPDF.zip static resource file and extracting its contents to a local
drive, you can then replace the default logo (logo.png) with your company logo in the customPDF.zip
file.

To copy your replacement logo into the custom PDF static resource file:

1 Open the location to which you saved and extracted the contents of the customPDF.zip file.
2 Paste your replacement logo into the file location.
3 Right-click on your logo file and choose Add to "customPDF.zip".

Note: All the files contained in the customPDF.zip file must be located at the root level. Do not create
nested folders inside the customPDF.zip file. Any contents located in nested folders in the
customPDF.zip file are not accessible to the Visualforce page

4 Optionally, delete the default logo.png file from the customPDF.zip file.
5 Continue to the next step of the process. See "Updating the custom PDF static resource file in Infor

Back Office Connect" on page 169 .

Updating the custom PDF static resource file in Infor Back Office
Connect
After adding your custom company logo to the customPDF.zip static resource file, you must update
the static resource file referenced in the Infor Back Office Connect application to reference your updated
customPDF.zip file.

To update the custom PDF static resource file in Infor Back Office Connect:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Static Resources.
4 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
5 Click Choose File and upload the updated customPDF.zip file.
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6 Click Save.
7 Continue to the next step of the process. See "Updating the custom quote PDF Visualforce page

to reference your custom company logo" on page 170 .

Updating the custom quote PDF Visualforce page to reference your
custom company logo
The customizable QuoteToPDFPage1 Visualforce page is installed during the Custom Quote PDF
Reference package installation. The QuoteToPDFPage1 Visualforce page references a temporary logo
(logo.png). To complete the custom logo configuration for your quote PDFs, you must update the
Visualforce page to reference the exact name of the logo you added to your updated customPDF.zip
static resource file.

Caution: Modifying the Apex code for the custom quote PDF Visualforce page
(QuoteToPDFPage1) requires knowledge of coding and development in the Salesforce Apex
programming language. If the administrator or developer attempting to modify or update the
Apex code on the Visualforce page is not familiar with coding and development in Apex code,
we recommend that a qualified resource delivers the code set required for your modifications.

Note: The examples provided in these sections related to modifying properties and sections of Apex
code are instructional only and are insufficient for actual implementing modifications based your actual
business requirements. See Salesforce documentation for information on coding and development in
the Apex programming language.

This section describes the steps required to update the custom quote PDF Visualforce page to reference
your custom company logo

To the custom quote PDF Visualforce page to reference your custom company logo:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Pages.
4 In the Visualforce Pages list, locate the QuoteToPagePDF1 page and click Edit to display the

Visualforce Page Edit page.
5 Optionally, update the Page Information section.
6 Click the Visualforce Markup tab to display the Visualforce markup code for the QuoteToPDF1

Visualforce page.
7 Locate this area containing the markup code defining the reference to the temporary logo (logo.png):

<apex:image value="{!URLFOR($Resource.customPDF, 'logo.png')}"/>    

Note: There is only one reference to logo.png on the Visualforce page.
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8 Overwrite the existing reference to the temporary logo ('logo.png') with the exact file name of
the custom company logo added to the customPDF.zip static resource file. For, example, if the file
name for your custom company logo in the customPDF.zip static resource file is
"mycompany_logo.png," you must change the reference to 'logo.png' to 'yourcompany_logo.png.'
For example, after making this change, the markup code is:

<apex:image value="{!URLFOR($Resource.customPDF, 'mycompany_logo.png
')}"/>    

9 Click Save.
10 Continue to the next step of the process. See "Validating the custom logo is displayed in quote PDF

output" on page 171 .

Validating the custom logo is displayed in quote PDF output
To validate that the custom logo is displayed in quote PDF output, generate an Infor quote document
and verify that your custom company logo is displayed in the generated PDF. See "Generating an Infor
quote PDF" in the Infor Back Office Connect User Guide.

Configuring Infor Back Office Connect to use the
custom quote PDF Visualforce page
Infor Back Office Connect includes a default quote document template for generating PDF documents
(QuoteToPDFPage). If you want to create a custom quote PDF document template based on your
business requirements, you can configure Infor Back Office Connect to use a custom quote PDF
Visualforce page (QuoteToPDFPage1) that is available after you install the Custom Quote PDF
Reference package on your Salesforce organization.

To configure Infor Back Office Connect to use the custom quote PDF Visualforce page:

1 Login to Salesforce as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 On the Integration Setup tab, click Step 6: Quote and Opp Settings.
5 Locate the Configure Quote PDF Settings section.
6 In the Quote PDF URL field, delete the existing URL (/apex/QuoteToPDFPage?id=), and then paste

this URL pointing to the customizable quote PDF Visualforce page: /apex/QuoteToPDFPage1?id=
QuoteToPDFPage is the default Visualforce quote PDF that cannot be customized.
QuoteToPDFPage1 is the name of the of the customizable quote PDF Visualforce page.
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7 Click Save. All quote PDF documents generated on the Infor Quote object will now reference the
customizable QuoteToPDFPage1 Visualforce page.

Note: If you modify the original quote PDF document template, the original Infor quote document
template can be recovered and reactivated by reloading the Infor Back Office Connect seed data.
See "Recovering the original quote PDF document template" on page 191.

Verifying the custom PDF Visualforce page configuration
After you configure Infor Back Office Connect to use the custom quote PDF Visualforce page
(QuoteToPDFPage1) verify that quote PDFs are being generated using the custom Visualforce page.

To verify the custom PDF Visualforce page configuration:

1 Login to Infor Back Office Connect as an Infor Back Office Connect user.

Note: You must enable Development Mode for the logged in user. See "Enabling development
mode for the user creating or editing Visualforce pages" on page 165.

2 Create an Infor quote. See "Creating Infor quote headers".
3 Generate an Infor quote PDF. See "Generating an Infor quote PDF" in the Infor Back Office Connect

User Guide. The quote PDF document is displayed in the Create Quote PDF window.
4 Verify that QuoteToPDFPage1 and QuoteDocumentController1 are displayed in the lower left corner

of the Create Quote PDF window.

Defining properties for the custom quote PDF
Visualforce page custom.css file
Redefine properties in the custom.css file to make customizations or modification to the custom quote
PDF Visualforce page (QuoteToPDFPage1). You can make these modifications to style elements in
the custom.css file:

• Change the font weight of a style element
• Change the font size of a style element
• Change the defined text-transform property of a style element
• Change the background color on a table header
• Change the font family defined of a style element
• Change the text-align property of a style element
• Change font style of a style element
• Change the color of a text element
• Change the padding property of an element
• Add a section with static text to the custom quote PDF Visualforce page

172 | Infor Back Office Connect Administration Guide

Creating a customized quote PDF template



• Add multiple sections to the custom quote PDF Visualforce page
• Add nested sections to the custom quote PDF Visualforce page
• Add custom fields to the custom quote PDF Visualforce page

Caution: Modifying the Apex code for the custom quote PDF Visualforce page
(QuoteToPDFPage1) requires knowledge of coding and development in the Salesforce Apex
programming language. If the administrator or developer attempting to modify or update the
Apex code on the Visualforce page is not familiar with coding and development in Apex code,
we recommend that a qualified resource delivers the code set required for your modifications.

Note: The examples provided in these sections related to modifying properties and sections of Apex
code are instructional only and are insufficient for actual implementing modifications based your actual
business requirements. See Salesforce documentation for information on coding and development in
the Apex programming language.

Changing the font weight of a style element
This section describes the steps required to change the font weight of a style element used on your
generated Infor quote PDF documents. The weight of a font defines how bold or light the font is. The
heavier a font, the bolder it looks on the page.

This table displays a list of valid font-weights and their definitions:

DefinitionFont weight

The default standard font weight, which corresponds to 400 weight.normal

The standard bold weight of a font face, which corresponds to 700 weight.bold

A darker version of the font relative to the weight inherited from the
parent.

bolder

A lighter version of the font relative to the weight inherited from the par-
ent.

lighter

An ordered sequence in which each number indicates a weight that is
at least as dark as its predecessor.

100, 200, 300, 400, 500,
600, 700, 800, 900

The element is assigned the same font weight as the parent.inherit

To change the font weight of a style element on the QuoteToPDF1 Visualforce page:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor. For example, Notepad++.
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4 Locate the style element to modify. For example,

.companyName {  
font-weight:bold; 
font-size:24px;}

5 Overwrite the existing font weight with the updated font weight as necessary. For example, change
"bold" to "bolder."

Note: You must use the correct font-weight syntax. Refer to the font-weight in the customStyle.css
version for all options related to modifying font versions. See "Font weight syntax and definitions".

6 Save and close the updated customStyle.css file.
7 Add the updated customStyle.css to the customPDF static resource .zip file.

Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

8 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

9 Select Setup.
10 In the sidebar column, select App Setup > Develop > Static Resources.
11 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
12 Click Choose File and upload the updated customPDF static resource .zip file.
13 Click Save.
14 Generate an Infor quote document to verify that the updated font weight of the style element is

displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office Connect
User Guide.

Changing the font size of a style element
This section describes the steps required to change the font size of a style element used on your
generated Infor quote PDF documents. The size of a font defines how big or small a font appears on
a page.

To change the font size of a style element on the QuoteToPDF1 Visualforce page:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor. For example, Notepad++.
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4 Locate the style element to modify. For example,

.companyName {  
font-weight:bold; 
font-size:24px;}

5 Overwrite the existing font size with the updated font size as necessary. For example, in the font-
size:24px; style element change "24px" to "18px."

Note: The font size must be in pixel format. Verify that your updated font size includes the "px"
suffix.

6 Update additional font sizes as necessary.
7 Save and close the updated customStyle.css file.
8 Add the updated customStyle.css to the customPDF static resource .zip file.

Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

9 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

10 Select Setup.
11 In the sidebar column, select App Setup > Develop > Static Resources.
12 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
13 Click Choose File and upload the updated customPDF static resource .zip file.
14 Click Save.
15 Generate an Infor quote document to verify that the updated font size of the style element is displayed

in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office Connect User
Guide.

Changing the text-transform property of a style element
This section describes the steps required to change the text-transform property value of a style element
used on your generated Infor quote PDF documents. The text-transorm property is a .css file property
that determines the case of a text.

This table displays a list of valid text-transform properties:

DefinitionValue

The text case is rendered as is with no changes or transformations to
case. This is the default value.

none

Transforms the first character of each word to upper case.capitalize
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DefinitionValue

Transforms all characters to upper case.uppercase

Transforms all characters to lower case.lowercase

The text-transformation property of the text is inherited from the parent
element.

inherit

To change the text-transorm property of a style element on the QuoteToPDF1 Visualforce page:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor. For example, Notepad++.
4 Locate the style element to modify. For example,

.customerName {  
text-transform:uppercase; 
font-size:14px;

5 Overwrite the existing text-transform property with the updated font size as necessary. For example,
in the text-transform:uppercase; style element change "uppercase" to "capitalize."

Note: You must use valid text-transform properties. See "Text-transform property values".

6 Update additional text-transform properties as necessary.
7 Save and close the updated customStyle.css file.
8 Add the updated customStyle.css to the customPDF static resource .zip file.

Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

9 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

10 Select Setup.
11 In the sidebar column, select App Setup > Develop > Static Resources.
12 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
13 Click Choose File and upload the updated customPDF static resource .zip file.
14 Click Save.
15 Generate an Infor quote document to verify that the updated text-transform property of the style

element is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office
Connect User Guide.
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Changing the background color of a table header
This section describes the steps required to change the background color of a table header.

To change the background color of a table within the QuoteToPDF1 Visualforce page:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor. For example, Notepad++.
4 Locate the style element to modify. For example,

  .docHeader {   
text-align:right;   
color:#984806;   
font-family: Arial,Sans-Serif;   
font-weight:bold;   
font-size:28px;  }

5 Overwrite the existing color property with the updated color property as necessary. For example, in
the color:#984806; style element change "#984806" to "#686b73."

Note: We recommend using the HEX color scheme. The specified color must begin with a hash
symbol (#).

6 Update additional color properties as necessary.
7 Save and close the updated customStyle.css file.
8 Add the updated customStyle.css to the customPDF static resource .zip file.

Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

9 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

10 Select Setup.
11 In the sidebar column, select App Setup > Develop > Static Resources.
12 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
13 Click Choose File and upload the updated customPDF static resource .zip file.
14 Click Save.
15 Generate an Infor quote document to verify that the updated color property of the style element is

displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office Connect
User Guide.
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Changing the font family defined of a style element
This section describes the steps required to change the font family of a style element used on your
generated Infor quote PDF documents. A font family consists of a set of related fonts. For example,
the "Times" family includes different font sizes, styles (Roman, Italic), and weights (regular, bold).

To change the font family of a style element:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor. For example, Notepad++.
4 Locate the style element to modify. For example,

  .docHeader {   
text-align:right;   
color:#984806;   
font-family: Arial,Sans-Serif;   
font-weight:bold;   
font-size:28px;  }

5 Overwrite the existing font family property with the updated font family property as necessary. For
example, in the font-family: Arial,Sans-Serif; style element change "Arial,Sans-Serif"
to "Times,Sans-Serif."

Note: The actual appearance of a font depends on the browser and the fonts installed on the system.

6 Save and close the updated customStyle.css file.
7 Add the updated customStyle.css to the customPDF static resource .zip file.

Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

8 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

9 Select Setup.
10 In the sidebar column, select App Setup > Develop > Static Resources.
11 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
12 Click Choose File and upload the updated customPDF static resource .zip file.
13 Click Save.
14 Generate an Infor quote document to verify that the updated font weight of the style element is

displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office Connect
User Guide.
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Changing the text-align property of a style element
This section describes the steps required to change the text-align property of a style element used on
your generated Infor quote PDF documents. A text-align property specifies the horizontal alignment of
text in an element.

This table shows commonly used text alignment properties:

DescriptionValue

Aligns the text to the left.left

Aligns the text to the right.right

Centers the text.center

Stretches the lines so that each line has equal width, which is com-
monly used in newspapers and magazines.

justify

The text alignment is inherited from the parent element.inherit

To change the text-align property of a style element:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor. For example, Notepad++.
4 Locate the style element to modify. For example,

  .docHeader {   
text-align:right;   
color:#984806;   
font-family: Arial,Sans-Serif;   
font-weight:bold;   
font-size:28px;  }

5 Overwrite the existing text-align property with the updated text-align property as necessary. For
example, in the text-align:right; style element change "right" to "center."

6 Save and close the updated customStyle.css file.
7 Add the updated customStyle.css to the customPDF static resource .zip file.

Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

8 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

9 Select Your name > Setup.
10 In the sidebar column, select App Setup > Develop > Static Resources.
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11 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static
Resource Edit page.

12 Click Choose File and upload the updated customPDF static resource .zip file.
13 Click Save.
14 Generate an Infor quote document to verify that the updated text-align property of the style element

is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office Connect
User Guide.

Changing the font style property of a style element
This section describes the steps required to change the font style property of a style element used on
your generated Infor quote PDF documents. The font style property specifies text style in an element.
This table shows commonly used font style properties:

DescriptionValue

The browser displays a normal font style, which is the default font
style property.

normal

The browser displays an italic font style.italic

The browser displays an oblique font style.oblique

The font style is inherited from the parent element.inherit

To change the font style property of a style element:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor.
4 Locate the style element to modify. For example,

  .quotationValidUntil{   
font-family: Arial,Sans-Serif;   
font-style:italic;   
text-decoration:underline;   
text-align:right;   
font-size:12px;   
color:black;  }

5 Overwrite the existing font style property with the updated font style property as necessary. For
example, in the font-style:italic; style element change "italic" to "normal."

6 Save and close the updated customStyle.css file.
7 Add the updated customStyle.css to the customPDF static resource .zip file.
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Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

8 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

9 Select Setup.
10 In the sidebar column, select App Setup > Develop > Static Resources.
11 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
12 Click Choose File and upload the updated customPDF static resource .zip file.
13 Click Save.
14 Generate an Infor quote document to verify that the updated the font style property of the style

element is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office
Connect User Guide.

Changing the color of a text element
This section describes the steps required to change the color of a text element used on your generated
Infor quote PDF documents. The font style property specifies text style in an element.

The CSS Color Values table contains a complete list of possible color values. CSS colors can be
specified by these methods:

• Hexadecimal colors, which are supported by all major browsers
• RGB colors
• RGBA colors
• HSL colors
• HSLA colors
• Predefined/cross-browser color names

To change the color of a text element:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor.
4 Locate the style element to modify. For example,

  .quotationValidUntil{   
font-family: Arial,Sans-Serif;   
font-style:italic;   
text-decoration:underline;   
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text-align:right;   
font-size:12px;   
color:black;  }

5 Overwrite the existing font sty pleroperty with the updated font style property as necessary. For
example, in the color:black; style element change "black" to "white."

6 Save and close the updated customStyle.css file.
7 Add the updated customStyle.css to the customPDF static resource .zip file.

Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

8 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

9 Select Setup.
10 In the sidebar column, select App Setup > Develop > Static Resources.
11 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
12 Click Choose File and upload the updated customPDF static resource .zip file.
13 Click Save.
14 Generate an Infor quote document to verify that the updated the text color is displayed in the PDF

output. See "Generating an Infor quote PDF" in the Infor Back Office Connect User Guide.

Changing the padding property of an element
This section describes the steps required to change the padding property of an element used on your
generated Infor quote PDF documents. The padding property specifies the space between the element
border and the element content.

The padding shorthand property sets all the padding properties for an element in one declaration. The
property can be one of these four types:

• Top padding: sets the top space above an element
• Right padding: sets the space to the right of an element
• Bottom padding: sets the space beneath an element
• Left padding: sets padding to the left of an element

This table shows valid padding settings the padding types listed above:

DescriptionValue

Specifies the padding in pixels (px), points (pt), centimeters (ct). The
default value is 0px.

length

Specifies the padding percentage width of the containing element.%
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DescriptionValue

The padding is inherited from the parent element.inherit

Note: You cannot specify a negative value for a padding property.

To change the padding property of a style element:

1 Extract the contents of the customPDF static resource .zip file to a local drive. See "Downloading
the customPDF static resource file to a local drive" on page 168.

2 Open the file location to which you extracted the contents of the customPDF static resource .zip
file.

3 Locate the customStyle.css file and open the file in a text editor.
4 Locate the style element to modify. For example,

 .tHeader{  
padding-right: 5px;    
padding-left:3px;  
background-color:#686b73;  
color:white;  
font-family: Arial,Sans-Serif;  
font-weight:bold;  
font-size:10px;  
text-align:center;   }

5 Overwrite the existing padding property with the updated padding property as necessary. For
example, in the padding-right: 5px; style element change "italic" to "normal."

6 Save and close the updated customStyle.css file.
7 Add the updated customStyle.css to the customPDF static resource .zip file.

Note: All the files contained in the .zip file must be located at the root level. Do not create nested
folders inside the .zip file. Any contents located in nested folders in the .zip file are not accessible
to the Visualforce page.

8 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

9 Select Setup.
10 In the sidebar column, select App Setup > Develop > Static Resources.
11 In the Static Resources list, locate the customPDF static resource and click Edit to display the Static

Resource Edit page.
12 Click Choose File and upload the updated customPDF static resource .zip file.
13 Click Save.
14 Generate an Infor quote document to verify that the updated the font style property of the style

element is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office
Connect User Guide.
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Adding a block of static text to the QuoteToPDFPage1 Visualforce
page
This section describes the steps required to add a section with static text to your generated Infor quote
PDF documents. For example, you can add a section for "Terms and Conditions" or a "Legal Disclaimer"
section.

Caution: Modifying the Apex code for the custom quote PDF Visualforce page
(QuoteToPDFPage1) requires knowledge of coding and development in the Salesforce Apex
programming language. If the administrator or developer attempting to modify or update the
Apex code on the Visualforce page is not familiar with coding and development in Apex code,
we recommend that a qualified resource delivers the code set required for your modifications.

Note: The examples provided in these sections related to modifying properties and sections of Apex
code are instructional only and are insufficient for actual implementing modifications based your actual
business requirements. See Salesforce documentation for information on coding and development in
the Apex programming language.

To add a block of static text to the QuoteToPDFPage1 Visualforce page:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Pages.
4 Optionally, update the Page Information section.
5 Click the Visualforce Markup tab to display the Visualforce markup code for the QuoteToPDF1

Visualforce page.
6 Locate the area where you want to add the additional section with static text. This section of code

displays a block of code for a table:

   </table>
   
   <apex:pageBlock mode="detail">
    <table width="100%" class="myTable">
        <thead class="tHeader">
            <apex:repeat value="{!$ObjectType.InForceEW__Quote__c.
FieldSets.InForceEW__QuoteDocDetailInfo}" var="Header" >  
                <th><apex:outputText value="{!$ObjectType['InForce
EW__Quote__c'].Fields[Header].Label}" /></th>
            </apex:repeat>
        </thead>           
        <tr>
            <apex:repeat value="{!$ObjectType.InForceEW__Quote__c.
FieldSets.InForceEW__QuoteDocDetailInfo}" var="Field" >  
            <td class="tData"> 
                <apex:outputField value="{!InForceEW__Quote__c[Field]}
"/> 
            </td>
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            </apex:repeat>
        </tr>          
    </table> 
   </apex:pageBlock><br/>

To insert a section of static text for terms and conditions before the table header, place the cursor
at the empty line between the </table> and <apex:pageBlock mode="detail"> tags.

Note:  When inserting a line or space for a new section or set of code, verify that the inserted line
or space is completely blank. Delete any inherited code that automatically displays when you press
Enter on the keyboard.

7 Enter this tag at the line where the cursor is located: <apex:pageBlock title="Terms and
Conditions">

8 Press Enter to move to the next line of code.
9 Enter the static text you want to display at the line where the cursor is located. For example, "The

following terms and conditions apply to this quote:"
10 After entering the desired static text, press Enter to move to the next line of code.
11 Enter this tag at the line where the cursor is located: <apex:pageBlock>
12 Click Save.
13 Generate an Infor quote document to verify that the updated the font style property of the style

element is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office
Connect User Guide.

Adding multiple sections to the QuoteToPDFPage1 Visualforce page
This section describes the steps required to add multiple sections to your generated Infor quote PDF
documents.

Caution: Modifying the Apex code for the custom quote PDF Visualforce page
(QuoteToPDFPage1) requires knowledge of coding and development in the Salesforce Apex
programming language. If the administrator or developer attempting to modify or update the
Apex code on the Visualforce page is not familiar with coding and development in Apex code,
we recommend that a qualified resource delivers the code set required for your modifications.

Note: The examples provided in these sections related to modifying properties and sections of Apex
code are instructional only and are insufficient for actual implementing modifications based your actual
business requirements. See Salesforce documentation for information on coding and development in
the Apex programming language.

To add multiple sections to the QuoteToPDFPage1 Visualforce page:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
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3 In the sidebar column, select App Setup > Develop > Pages.
4 Optionally, update the Page Information section.
5 Click the Visualforce Markup tab to display the Visualforce markup code for the QuoteToPDF1

Visualforce page.
6 Locate the area where you want to add the additional section with static text. This section of code

appears at the end of the markup code.

   <apex:outputPanel layout="block" styleClass="tDataAL">{!$Label.
LBL_quoteNotification1}</apex:outputPanel><br/> 
</apex:form>       
</body>
</apex:page>

To insert multiple sections into the Visualforce page, place the cursor at the between the </apex:
outputPanel><br/> and </apex:form> tags and press Enter to insert a new line of code.

Note:  When inserting a line or space for a new section or set of code, verify that the inserted line
or space is completely blank. Delete any inherited code that automatically displays when you press
Enter on the keyboard.

7 Enter a tag for a new section at the line where the cursor is located. For example, <apex:pageBlock
title="Block Section Title">

8 Press Enter to move to the next line of code.
9 Enter this tag at the line where the cursor is located: <apex:pageBlock>
10 Press Enter to move to the next line of code.
11 Enter a tag for a new section at the line where the cursor is located. For example, <apex:pageBlock

title="Block Section Title2">
12 Press Enter to move to the next line of code.
13 Enter this tag at the line where the cursor is located: <apex:pageBlock>
14 Press Enter to move to the next line of code.
15 Enter a tag for a new section at the line where the cursor is located. For example, <apex:pageBlock

title="Block Section Title3">
16 Enter this tag at the line where the cursor is located: <apex:pageBlock>
17 Click Save.
18 Generate an Infor quote document to verify that the updated the font style property of the style

element is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office
Connect User Guide.

Adding nested sections to the generated quote PDF
This section describes the steps required to add nested sections to the generated Infor quote PDF
documents.
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Caution: Modifying the Apex code for the custom quote PDF Visualforce page
(QuoteToPDFPage1) requires knowledge of coding and development in the Salesforce Apex
programming language. If the administrator or developer attempting to modify or update the
Apex code on the Visualforce page is not familiar with coding and development in Apex code,
we recommend that a qualified resource delivers the code set required for your modifications.

Note: The examples provided in these sections related to modifying properties and sections of Apex
code are instructional only and are insufficient for actual implementing modifications based your actual
business requirements. See Salesforce documentation for information on coding and development in
the Apex programming language.

To add nested sections to the generated quote PDF:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Pages.
4 Optionally, update the Page Information section.
5 Click the Visualforce Markup tab to display the Visualforce markup code for the QuoteToPDF1

Visualforce page.
6 Locate the area where you want to add the additional section with static text. This section of code

appears at the end of the markup code.

   <apex:outputPanel layout="block" styleClass="tDataAL">{!$Label.
LBL_quoteNotification1}</apex:outputPanel><br/> 
</apex:form>       
</body>
</apex:page>

To insert nested sections into the Visualforce page, place the cursor at the between the </apex:
outputPanel><br/> and </apex:form> tags and press Enter to insert a new line of code.

Note:  When inserting a line or space for a new section or set of code, verify that the inserted line
or space is completely blank. Delete any inherited code that automatically displays when you press
Enter on the keyboard.

7 Enter a tag for a new section at the line where the cursor is located. For example, <apex:pageBlock
title="Block Section Title">

8 Press Enter to move to the next line of code.
9 Enter a tag for a new section at the line where the cursor is located. For example, <apex:pageBlock

title="Nested Section Title1">
10 Press Enter to move to the next line of code.
11 Enter this tag at the line where the cursor is located: <apex:pageBlock>
12 Press Enter to move to the next line of code.
13 Enter a tag for a new section at the line where the cursor is located. For example, <apex:pageBlock

title="Nested Section Title2">
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14 Enter this tag at the line where the cursor is located: <apex:pageBlock>
15 Press Enter to move to the next line of code.
16 To close the tag containing nested sections within the <apex:pageBlock title="Block

Section Title"> level, enter this tag at the line where the cursor is located: <apex:pageBlock>
All of the nested sections must be contained within the <apex:pageBlock title="Block
Section Title"> tag that opens the section and the <apex:pageBlock> tag that closes the
section. This section of code shows a sample of markup code for nested sections:

<apex:pageBlock title="Block Section Title">
    <apex:pageBlock title="Nested Section Title1">
    </apex:pageBlock>
        <apex:pageBlock title="Nested Section Title2">
        </apex:pageBlock>
</apex:pageBlock>

17 Click Save.
18 Generate an Infor quote document to verify that the updated the font style property of the style

element is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office
Connect User Guide.

Adding custom fields to the generated quote PDF
This section describes the steps required to add custom fields to your generated Infor quote PDF
documents.

Note: The content of this section is based on the assumption that you have added custom fields to the
Infor Quote page layout. See "Infor Back Office Connect customization" on page 73.

Caution: Modifying the Apex code for the custom quote PDF Visualforce page
(QuoteToPDFPage1) requires knowledge of coding and development in the Salesforce Apex
programming language. If the administrator or developer attempting to modify or update the
Apex code on the Visualforce page is not familiar with coding and development in Apex code,
we recommend that a qualified resource delivers the code set required for your modifications.

Note: The examples provided in these sections related to modifying properties and sections of Apex
code are instructional only and are insufficient for actual implementing modifications based your actual
business requirements. See Salesforce documentation for information on coding and development in
the Apex programming language.

To add custom fields to the generated quote PDF:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Apex Classes.
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4 In the Apex Classes list, locate the QuoteDocumentController1 Apex class and click Edit.
5 Click the Apex Class tab to display the markup code for the QuoteDocumentController1 Apex class.
6 Locate the private void retrieveQuoteLineItems(){  section where you want to add the

additional section with static text.
This section of markup code shows a sample of the fields retrieved for the Infor quote line items:

private void retrieveQuoteLineItems(){       
        String query= 'Select id, InForceEW__phone__c, InForceEW__otherphone__c, InForceEW__
fax__c, InForceEW__email__c, ' +
                            ' InForceEW__billto_contactname__c, InForceEW__billtostreet1__c,In
ForceEW__billtocity1__c,InForceEW__billtostateorprovince1__c,' +
                            ' InForceEW__billtopostalcode1__c,InForceEW__billtocountry1__c,In
ForceEW__shipto_contactname__c,InForceEW__shiptostreet1__c,InForceEW__shiptocity1__c,InForce
EW__shiptostateorprovince1__c,' +
                            ' InForceEW__shiptopostalcode1__c,InForceEW__shiptocountry1__c,In
ForceEW__soldto_contactname__c,InForceEW__soldtostreet1__c,InForceEW__soldtocity1__c,InForce
EW__soldtostateorprovince1__c,' +
                            ' InForceEW__soldtopostalcode1__c,InForceEW__soldtocountry1__c,In
ForceEW__quotetoname__c,InForceEW__quotetostreet1__c,InForceEW__quotetocity1__c,InForceEW__
quotetostateorprovince1__c,InForceEW__quotetopostalcode1__c,InForceEW__quotetocountry1__c, ' 
+
                            ' (Select Name, InForceEW__quantity__c, InForceEW__totalamount__c,
 InForceEW__unitprice__c, InForceEW__productid__c, InForceEW__productcode__c , InForceEW__
productdescription__c , InForceEW__discount__c,' + 
                            ' InForceEW__listPrice__c, InForceEW__subtotal__c, InForceEW__total
Price__c' +
                            ' From InForceEW__quote_quoteLineItems__r) From InForceEW__quote__
c where id=\'' + String.escapeSingleQuotes(quoteRecord.id) + '\'';
       list<InForceEW__quote__c> lstQuote = null;//DBManager.getSObjects(query);
       if(lstQuote != null && lstQuote.size()  > 0 ){
            quot = lstQuote[0];
            newQuoteLines = lstQuote[0].InForceEW__quote_quoteLineItems__r; 
       }      
}

7 To add a custom field, position your cursor in the place where you want the custom field to be added.
For example, position the cursor after the comma in InForceEW__billto_contactname__c,
and before the InForceEW__billtostreet1__c field.

8 Enter the exact API name of the custom field in the place where the cursor is positioned. For example,
enter TestQuoteField__c,.
This sample markup shows the newly added custom field TestQuoteField__c, in bold font:

InForceEW__billto_contactname__c, TestQuoteField__c, InForceEW__
billtostreet1__c,

9 Repeat steps 7-8 for each custom field to add.
10 Click Save.
11 Generate an Infor quote document to verify that the updated the font style property of the style

element is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office
Connect User Guide.
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Adding custom field sets to the generated quote PDF
This section describes the steps required to add custom field sets to your generated Infor quote PDF
documents.

Note: The content of this section is based on the assumption that you have added custom field sets
to the Infor Quote page layout. See "Infor Back Office Connect customization" on page 73.

Caution: Modifying the Apex code for the custom quote PDF Visualforce page
(QuoteToPDFPage1) requires knowledge of coding and development in the Salesforce Apex
programming language. If the administrator or developer attempting to modify or update the
Apex code on the Visualforce page is not familiar with coding and development in Apex code,
we recommend that a qualified resource delivers the code set required for your modifications.

Note: The examples provided in these sections related to modifying properties and sections of Apex
code are instructional only and are insufficient for actual implementing modifications based your actual
business requirements. See Salesforce documentation for information on coding and development in
the Apex programming language.

To add custom field sets to the generated quote PDF:

1 Login to Salesforce as the Infor Back Office Connect user for which you enabled development mode.
See "Enabling development mode for the user creating or editing Visualforce pages" on page 165.

2 Select Setup.
3 In the sidebar column, select App Setup > Develop > Pages.
4 Optionally, update the Page Information section.
5 Click the Visualforce Markup tab to display the Visualforce markup code for the QuoteToPDF1

Visualforce page.
6 Locate a section of markup code containing a field set.

This section of markup code shows a sample field set:

</apex:repeat>
<apex:repeat value="{!$ObjectType.InForceEW__Quote__c.FieldSets.InForceEW__QuoteDocTotal}" var=
"totalSecField" >
    <tr><td style="border:0px;" colspan="{!quoteLineFldSetNoOfClms}">&nbsp;</td>
        <td colspan="2" class="fontArial10pxblackBoldAR">                     
   <apex:outputLabel value="{!$ObjectType['InForceEW__Quote__c'].Fields[totalSecField].Label}
"/>
        </td>
        <td colspan="2" class="tDataAR">
                <apex:outputField value="{!InForceEW__Quote__c[totalSecField]}"/>
        </td>
    </tr>
</apex:repeat>

7 Copy the code that includes the field set to add to the clipboard.
8 Position your cursor in the place in the code where you want the custom field set to be added.
9 Press Enter to move to the next line of code.

For example, position the cursor after the closing bracket in the </apex:repeat> tag.
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Note:  When inserting a line or space for a new section or set of code, verify that the inserted line
or space is completely blank. Delete any inherited code that automatically displays when you press
Enter on the keyboard.

10 Paste the copied code into the markup code.
This section of markup code shows the newly copied sample field set in the markup code:

</apex:repeat>
<apex:repeat value="{!$ObjectType.InForceEW__Quote__c.FieldSets.InForceEW__QuoteDocTotal}" var=
"totalSecField" >
    <tr><td style="border:0px;" colspan="{!quoteLineFldSetNoOfClms}">&nbsp;</td>
        <td colspan="2" class="fontArial10pxblackBoldAR">                     
   <apex:outputLabel value="{!$ObjectType['InForceEW__Quote__c'].Fields[totalSecField].Label}
"/>
        </td>
        <td colspan="2" class="tDataAR">
                <apex:outputField value="{!InForceEW__Quote__c[totalSecField]}"/>
        </td>
    </tr>
</apex:repeat>
</apex:repeat>
<apex:repeat value="{!$ObjectType.InForceEW__Quote__c.FieldSets.InForceEW__QuoteDocTotal}" var=
"totalSecField" >
    <tr><td style="border:0px;" colspan="{!quoteLineFldSetNoOfClms}">&nbsp;</td>
        <td colspan="2" class="fontArial10pxblackBoldAR">                     
   <apex:outputLabel value="{!$ObjectType['InForceEW__Quote__c'].Fields[totalSecField].Label}
"/>
        </td>
        <td colspan="2" class="tDataAR">
                <apex:outputField value="{!InForceEW__Quote__c[totalSecField]}"/>
        </td>
    </tr>
</apex:repeat>

11 Repeat steps 7-10 for each custom field set to add.
12 Click Save.
13 Generate an Infor quote document to verify that the updated the font style property of the style

element is displayed in the PDF output. See "Generating an Infor quote PDF" in the Infor Back Office
Connect User Guide.

Recovering the original quote PDF document template
If you modify the original quote PDF document template, the original Infor quote document template
can be recovered and reactivated by reloading the Infor Back Office Connect seed data.

To recover the original quote document template:

1 Log in to Salesforce as the system administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 Click Step 1: Load Seed Data.
5 Select the Seed Data already exists. Do you want to replace it? check box. The page is refreshed

and displays a list of these objects that will be updated:
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• Message Source
• ION Integration Configuration
• BOD Type
• BOD Type Version
• Message Source BOD Type Version Junction
• Incoterms

6 Click Load Seed Data. The status of the data loading process is displayed until the load process
is complete.

Note: The Load Seed Data button does not automatically display on certain browsers. If you do
not see the button, click in the grey area of the page. The page will refresh and the button will be
displayed.

7 Click Step 6: Quote and Opp Settings.
8 Locate the Configure Quote PDF Settings section.
9 In the Quote PDF URL field, verify that this URL is displayed: /apex/QuoteToPDFPage?id=
10 Generate a quote PDF to verify that the URL is working correctly. See "Generating an Infor quote

PDF" in the Infor Back Office Connect User Guide.

Uninstalling the Custom Quote PDF Reference
package
Uninstalling the Custom Quote PDF Reference package removes all of these package components
from your Salesforce organization:

• The QuoteDocumentController1 Apex class
• The QuoteToPDFPage1 Visualforce page
• The customPDF static resource file

To uninstall the Custom Quote PDF Reference package:

1 Login to the Salesforce organization as the integration context user.
2 Select Setup.
3 In the sidebar column, selectApp Setup > Installed Packages.
4 In the Installed Packages section, select Custom Quote PDF Reference and click Uninstall.
5 Select the Yes, I want to uninstall this package and permanently delete all associated

components check box.
6 Click Uninstall. The package uninstallation begins. If the package is uninstalled successfully, a

confirmation message is displayed. If the uninstallation fails for any reason, an error message is
displayed and you must address the issue(s) identified in the error message prior to continuing.
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11Infor quote migration

This chapter describes the Infor Quote Migration and the tasks that you must complete to migrate all
of your existing quote data residing in the standard Salesforce Quote object to the new Infor Quote
object.

Note: If you have already migrated your Quotes to the Infor quote object during an upgrade or installation
of a previous version of Infor Back Office Connect 10.8.x, you do not have to run the Quote Migration
again for Infor Back Office Connect version 10.8.

The Quote Migration application is used to migrate your quote data from the standard Salesforce Quote
object to the new Infor Quote object. The migration of all quote data residing in the standard Salesforce
Quote object to the Infor Quote object is a required task in the Infor Back Office Connect version 10.8
installation and upgrade process. Install the Infor Back Office Connect Migration application and execute
quote migration after you have installed or upgraded Infor Back Office Connect to version 10.8 and
completed all other preliminary data migration for the Infor Back Office Connect application.

Note: If you are testing the quote migration in a Salesforce organization on which the Infor quote
Migration unmanaged package was installed for Infor Back Office Connect 10.8.x, you must first uninstall
the existing Infor Quote Migration unmanaged package and install the new one to complete the quote
migration for Infor Back Office Connect version 10.8.

Caution: If you execute quote migration before the Infor Back Office Connect installation or
upgrade to 10.8.x is complete, the migration process will fail and generate errors. To resolve
these errors, you must to uninstall the Infor Quote Migration application and complete the Infor
Back Office Connect installation or upgrade to version 10.8.x to successfully execute quote
migration.

Before beginning the migration process
In previous versions of Infor Back Office Connect (prior to version 10.8), quotes were created and
maintained on the standard Salesforce Quote object. In this Infor Back Office Connect release (version
10.8), Infor Back Office Connect extends the Salesforce quote functionality by introducing the Infor
Quote object, which is a custom managed object that replaces the standard Salesforce Quote object.
When Infor Back Office Connect is installed, the standard Salesforce Quote object is no longer used
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for any quote-related processes. All quote data residing in the standard Salesforce Quote object must
be migrated to the new Infor Quote object.

After quote migration is complete, we highly recommend that you retire usage of the standard Salesforce
Quote object. We recommend the following to the Infor Back Office Connect Administrator:

• Obtain confirmation from all Infor Back Office Connect Users that their quote data was migrated
completely, correctly, and is accessible from the Infor Quote tab.

• If your sales team needs to refer to the original standard Salesforce Quote data in the future, generate
backup of all standard quote data for reference and archival purposes. Save the exported file to a
separate location, not in your Salesforce Organization, for future access. For instance, the Infor
Back Office Connect Administrator can create/run a Salesforce report to export the quote data into
an Excel spreadsheet that can be accessed from a network location whenever users need to review
the source data.

• The Migration process creates a copy of the standard Salesforce quote data and uses that copied
data to generate new Infor Quote records on the Infor Quote object. After migration, there will be
two sets of quote data in the organization: the original, “source” , standard Salesforce Quote data
and the newly created “target” Infor Quote data on the Infor Quote object. If the standard and Infor
Quote related lists are visible to the Infor Back Office Connect User, the Infor Back Office Connect
User will see the same quote on both related lists. Given this scenario, there is a risk that Infor Back
Office Connect Users may accidentally continue working with the standard Salesforce quote object
when they should be working only from the Infor quote object. To mitigate this risk, we recommend
that the original, source Salesforce Quote data be deleted from the organization. Also, do not display
the Standard Quote related list from any page layout.

Also, if the source, standard Salesforce Quote record is synchronized with an Opportunity, after
migration, the newly created Infor Quote record will also be synchronized to the same Opportunity. As
stated earlier, the same quote will be accessible from the standard, Salesforce Quote object and the
Infor Quote object. Record updates in this scenario can result in unexpected behavior and errors in
Infor Back Office Connect. Also, Infor Back Office Connect Users may spend time updating the standard
Salesforce quote record and have to re-enter their data on the Infor Quote object to leverage the
features and functionality in Infor Back Office Connect.

To mitigate these risks, we highly recommend retiring the standard Salesforce Quote object and if
possible deleting all standard Salesforce Quote records from the organization.

If it is not possible to delete the standard Salesforce Quote records from the organization, we recommend
removal of the standard Salesforce Quote object from all Infor Back Office Connect User accessed
page layouts and the only action executed on the quote record is deletion. Infor Back Office Connect
Users should create and manage quotes from the Infor Quote object only. The Infor Quote object should
be accessible from the Account, Contact, and Opportunity related lists as well as the Infor Quote object
from the tab or All Tabs access points in Salesforce.

Infor quote migration task sequence
The following list defines the tasks to be executed by the Infor Back Office Connect Administrator.
Execute each task in the order presented:
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• Migration Objects: Confirm out of box Quote object and create custom migration objects to support
migration of the custom object in your organization, including error messages that help Administrators
understand why a record failed to migrate.

• Infor Back Office Connect Migration: Execute the migration and define general migration configuration
settings.

• Migration Errors: Review and address errors generated from records that were not successfully
migrated.

Overview of the quote migration process
The Infor quote migration process consists of three phases:

1 Preparing for the Infor quote migration.
See "Migrating quote data to the Infor quote object" on page 211 and "Preparing Infor Back Office
Connect for the Infor quote migration" on page 211.

2 Executing the Infor quote migration.
See "Executing the initial quote data migration" on page 212.

3 Post Infor quote migration tasks.
See "Post Infor quote migration tasks" on page 213.

These sections provides an overview of the steps required to prepare for, execute, and complete the
process of migrating your quote data from the standard Salesforce Quote object to the new Infor Quote
object.

Preparing for the Infor quote migration checklist

This checklist includes the list of tasks that you need to complete to prepare for the Infor quote migration
process. See the appropriate section of this guide for detailed instructions on how to complete these
tasks.

We recommend that you complete these tasks in the order in which they are presented:

• Complete the installation or upgrade of the base Infor Back Office Connect product to version 10.8
• Complete all of the required data migration for the base Infor Back Office Connect product
• Install the Infor Back Office Connect Migration application on your Salesforce organization
• Modify any migration object or field mapping settings as necessary in the Infor Back Office Connect

Migration application
• Stop the ION integration scheduler on the Integration Setup tab
• In the Step 6: Set Opportunity Default Values section of the Integration Setup tab, clear the Copy

Opportunity Products To Quote check box to prevent the migration process from duplicating quote
line items and opportunity products

Executing the Infor quote migration
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After completing the steps listed above to prepare for the Infor Quote migration, execute the quote
migration process on the Infor Back Office Connect Migration tab of the Infor Back Office Connect
Migration application.

Note: We recommend migrating a small number of test records (10 or less) to verify that the migration
is working properly purposes before attempting to migrate all of your production data.

Post Infor quote migration tasks checklist

This checklist includes the list of tasks that you need to complete after running the Infor quote migration
process. See the appropriate section of this guide for detailed instructions on how to complete these
tasks.

We recommend that you complete these post-migration tasks in the order in which they are presented:

• Delete the Infor Quote related workflows
• Delete sourceRecordId__c custom fields from the Infor Quote, Infor Quote Line Item, and the Quote

Documents objects
• Delete the formula fields from the Quote and Quote Line Item standard objects
• Reset Infor Back Office Connect Integration settings to support regular business processes
• Reassign Infor quote and system opportunities from the default record owner to Infor Back Office

Connect users
• Optionally, delete quotes owned by non-Infor Back Office Connect user from the Infor Quote object
• Manually delete all retired transaction addresses
• Optionally, re-implement any quote and opportunity triggers that were used on the Standard

Salesforce Quote object prior to the quote migration for the new Infor Quote custom object

Synchronized ERP quotes and the Infor Back Office
Connect Migration application
In the previous version of Infor Back Office Connect (version 10.6.x), the Infor Back Office Connect
application followed Salesforce standard opportunity-quote sync (master-detail relationship) functionality.
When an ERP quote is sent to Infor Back Office Connect, a system opportunity is automatically created
in Infor Back Office Connect which synchronizes the inbound ERP quote.

In the current version of Infor Back Office Connect (version 10.8), the master-detail relationship of the
ERP quote and opportunity has been replaced by a more flexible lookup relationship to the Opportunity
object.

When ERP quotes with synchronized opportunities are migrated to the Infor Quote object using the
Infor Back Office Connect Migration application, the Infor Back Office Connect Migration process
replaces the master-detail relationship of the opportunity-quote with a lookup relationship. Post migration,
the migrated ERP quote is related to the opportunity and synchronized.
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Understanding quote record types assignments in Infor
Back Office Connect version 10.8
In the current version of Infor Back Office Connect (version 10.8), significant changes have been made
to the quote record type assignments for Infor Back Office Connect and ERP quotes. This table shows
the differences between these quote types:

Quote type assignment in Infor
Back Office Connect version
10.8

Quote type assignment in Infor
Back Office Connect version
10.6.x (or earlier)

Quote

Infor quoteNo record type assignedStandard Salesforce quote

Infor ERP quoteInfor quoteERP quote

Setting the Infor Quote record type as the default
record type for the System Administrator user
All Salesforce standard quote records are migrated using the default record type assigned to the user
profile. We recommend that the actual quote migration be executed by the Infor Back Office Connect
Administrator profile. If the Infor quote migration is executed by users assigned to the System
Administrator profile, then the default record type of the profile must be updated from the Infor ERP
Quote record type to the Infor Quote record type.

In Infor Back Office Connect version 10.8, ERP quotes are assigned the Infor ERP Quote record type,
while standard Salesforce quotes are not assigned a quote record type, thus the default record type
must be assigned from the user. See "Understanding quote record types assignments in Infor Back
Office Connect version 10.8" on page 197.

Note: The Infor Back Office Connect Migration Application should be installed by the System
Administrator profile user.

To set the Infor Quote record type as the default record type for the System Administrator user:

1 Log in to Infor Back Office Connect as the system administrator.
2 Select Setup.
3 In the sidebar column, selectManage Users > Profiles.
4 In the Profile list, click the System Administrator hyperlink.
5 In the Record Type Settings section, locate the Custom Record Type Settings.
6 In the Custom Record Type Settings list, locate the Infor Quote setting and click the Edit hyperlink

to display the Edit Record Type Settings Infor Quote page.
7 In the Available Record Types list, select Infor Quote Record Type and click Add to add the

record type to the Selected Record Types list.
8 In the Selected Record Types list, select Infor ERP Quote Record Type and click Remove to

move the record type to the Available Record Types list.
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9 In the Default Record Type section, select Infor Quote Record Type in the Default drop-down list
to specify the Infor Quote record type as the default record type for the System Administrator user
profile.

10 Click Save.

Installing the Infor Back Office Connect Migration
application
This section describes the steps required to install the Infor Back Office Connect Migration.

Caution: You must complete the Infor Back Office Connect version 10.8 application installation
or upgrade and complete the required data migration for the base application prior to installing
and configuring the Infor Back Office Ordering application. See "Infor Back Office Connect
installation" on page 29 and "Upgrading" on page 147.

To install the Infor Back Office Connect Migration:

1 Log into Salesforce as the system administrator.
2 Copy the Infor Back Office Connect Migration application installation URL from the Infor Xtreme

Support site.
3 Paste the copied Infor Back Office Connect Migration application installation URL into the web

browser of the Salesforce organization into which you are logged in as the system administrator.
The Package Installation Details page is displayed.

4 Review the package installation details and click Continue. The Step 1. Approve Package API
Access window is displayed.

5 Click Next without modifying any of the default settings on this page. The Step 2. Choose security
level window is displayed.

6 Select the Select security settings check box. The Customize security section is displayed.
7 In the Profile list, locate the Infor Back Office Connect Administrator profile and select Infor Back

Office Connect Migration Administrator from the Access Level drop-down list.
8 In the Profile list, locate the Infor Back Office Connect Developer profile and select Infor Back Office

Connect Migration Administrator from the Access Level drop-down list.
9 Click Next. The Step 3. Install Package window is displayed.
10 Click Install. The application is installed and a confirmation message is displayed showing the

Installed Package Details.
11 Select Setup.
12 In the sidebar column, selectApp Setup > Installed Packages.
13 Verify that the Infor Back Office Connect Migration application is displayed in the list of installed

packages.
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Accessing the Infor Back Office Connect Migration
application
This section describes the steps required to access the Infor Back Office Connect Migration application.
After installing the Infor Back Office Connect Migration application, the Infor Back Office Connect
Migration application is added to the list of applications available in the Force.com App Menu. See
"Navigation and user interface" in the Infor Back Office Connect User Guide.

To access the Infor Back Office Connect Migration application:

1 Log into Salesforce as the Infor Back Office Connect administrator or the Infor Back Office Connect
developer.

2 From the Force.com App Menu select Infor Back Office Connect Migration. The Infor Back Office
Connect Migration application is opened.

The Infor Back Office Connect Migration application consists of three tabs:

• Migration Objects
• Infor Back Office Connect Migration
• Migration Errors

When the Infor Back Office Connect Migration application is opened, the Infor Back Office Connect
Migration tab is displayed by default.

Understanding the Infor Back Office Connect Migration
application
The Infor Back Office Connect Migration application is a managed, custom Infor Back Office Connect
object that consists of these tabs:

• Migration Objects
The Migration Objects tab is used to review the default "out-of-the-box" source objects that are
included in the migration process and to create custom migration objects to contain any custom
fields added to the standard Salesforce Quote object into the migration group.

• Infor Back Office Connect Migration
The Infor Back Office Connect Migration tab is used to execute the migration process.

• Migration Errors
The Migration Errors tab is used to review any errors generated during the migration process.
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Working with the Migration Objects tab
The Migration Objects tab lists the "out-of-the-box" objects that are migrated by the Infor Back Office
Connect Migration application.

Source object data is mapped to its corresponding target object. This table describes the mapping
details for each migration object that appears as in the header area of the Migration Objects grid:

DescriptionField

The name of the migration object pairing. The migration object pair
is composed of a source object and a target object. The source object
is defined first and then the target object.

Name

The name of the source object referenced in the Name field.Source Object Name

The name of the parent level source object and parent level target
object affected by the migration. The source object is defined first
and then the target object.

Target Object Name

The name of the parent level source object and parent level target
object affected by the migration. The source object is defined first
and then the target object.

Parent Migration Object

This check box indicates whether the migration object is currently
in active use in the organization. If the is Active? check box is not

is Active?

selected, the migration object pair defined in the Name field is ex-
cluded from the Infor Back Office Connect Migration process.

The Batch Scope Size field confirms that each name pairing repre-
sents a distinct batch process.

Batch Scope Size

These tables show the object pairs that are migrated if you accept the "out-of-the-box" migration settings:

Attachment > Attachment

Attachment > AttachmentMigration object

AttachmentSource object

Salesforce standard quote object - QUOTEParent migration object (source)

AttachmentTarget object

Infor Back Office Connect customer quote object - In-
ForceEW__Quote__c

Parent migration object (target)

Event > Event

Event > EventMigration object

EventSource object

Salesforce standard quote object - QUOTEParent migration object (source)

EventTarget object
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Event > Event

Infor Back Office Connect customer quote object - In-
ForceEW__Quote__c

Parent migration object (target)

Note > Note

Note > NoteMigration object

NoteSource object

Salesforce standard quote object - QUOTEParent migration object (source)

NoteTarget object

Infor Back Office Connect customer quote object - In-
ForceEW__Quote__c

Parent migration object (target)

Quote > InForceEW__Quote__c

Quote > InForceEW__Quote__cMigration object

QuoteSource object

Parent migration object (source)

InForceEW__Quote__cTarget object

Parent migration object (target)

Quote Document > Attachment

Quote Document > AttachmentMigration object

Quote DocumentSource object

Quote DocumentParent migration object (source)

AttachmentTarget object

InForceEW__Quote__cParent migration object (target)

Quote Document > InForceEW__QuoteDocument__c

Quote Document > InForceEW__QuoteDocument__cMigration object

Quote DocumentSource object

Salesforce standard quote object - QUOTEParent migration object (source)

InForceEW__QuoteDocument__cTarget object

Infor Back Office Connect customer quote object - In-
ForceEW__Quote__c

Parent migration object (target)
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QuoteLineItem > InForceEW__QuoteLineItem__c

QuoteLineItem > InForceEW__QuoteLineItem__cMigration object

QuoteLineItemSource object

Salesforce standard quote object - QUOTEParent migration object (source)

InForceEW__QuoteLineItem__cTarget object

Infor Back Office Connect customer quote object - In-
ForceEW__Quote__c

Parent migration object (target)

Task > Task

Task > TaskMigration object

TaskSource object

Salesforce standard quote object - QUOTEParent migration object (source)

TaskTarget object

Infor Back Office Connect custom quote object - In-
ForceEW__Quote__c

Parent migration object (target)

Confirming migration objects
This section describes the steps required to confirm the objects to migrate using the Infor Back Office
Connect Migration application:

To confirm migration objects:

1 In the Infor Back Office Connect Migration application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
3 Verify the list of the default migration objects.

Adding migration objects
This section describes the steps required to add migrations objects in the Infor Back Office Connect
Ordering application.

If you have a custom object to migrate to Infor Back Office Connect, create the custom object in Infor
Back Office Connect then create a migration object pairing to migrate the data from the source object
to the target object. You can also map a custom object field to the Infor Quote object, if the field is not
being used. You can only map to an object that is not part of a migration pairing.

Note: You cannot map to a target that is part of a migration pairing.

To add migration objects:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
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2 Click New to display the Migration Object Edit page.
3 In the Information section, specify information for these fields:

• In the Source Object Name drop-down list, select the custom object you added to Salesforce.
• In the Target Object Name drop-down list, select the custom object you added to Infor Back

Office Connect.
• Optionally, click the Parent Migration Object lookup and select a parent object if the source

and target objects are related to a parent object.
• By default, the batch scope size is set to 1. Optionally, specify a value in the Batch Scope Size

field based on your requirements.
• By default, the is Active? check box is selected and the new objects are included in the migration

process. Optionally, if you do not want this field mapping to be included in the migration process,
clear the is Active? check box.

4 Click Save. The new migration object is created and the Migration Object Detail page is displayed.

Cloning a migration object
A migration object can be copied or cloned to create a new migration object. This process can save
the Infor Back Office Connect Administrator configuration time because a currently used migration
object may have very similar specifications to the new, required migration object. In this instance, a
current migration object can be used as a template to create a new migration object.

This section describes the steps required to clone migration objects in the Infor Back Office Connect
Ordering application:

To clone migration objects:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
3 In the Recent Migration Objects list, click the Name hyperlink of the migration object to clone to

display the Migration Objects Detail page.
4 Click Clone to display the Migration Object Edit page.
5 In the Information Section, specify or update the information you require for the cloned migration

object. See "Adding migration objects" on page 202.
6 Click Save. The cloned migration object is created and the Migration Object Detail page is displayed.

Deactivating migration object field mappings
By default, all of the "out-of-the-box" migration objects are included in the migration process. If you do
not require a particular migration object for your business requirements, you can deactivate the migration
object from the migration process.

This section describes the steps required to deactivate migration objects in the Infor Back Office Connect
Ordering application:
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To deactivate migration objects:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
3 In the Recent Migration Objects list, select the migration object to exclude and click the Edit hyperlink

to display the Migration Object Edit page.
4 In the Information Section, clear the is Active? checkbox .
5 Click Save. The migration object is no longer included in the migration process.

Migration field mappings
The "out-of-the-box" migration field mappings in the Infor Back Office Connect Migration Application
include a map for the Expire On field, which is used on ERP quotes only for both source and target
objects. Infor Back Office Connect does not support the multiple source migration field maps to a single
target. All migration field maps must have a one-to-one relationship.

The Salesforce standard Quote object includes the Expiration Date field, which does not have a
defined field mapping in Infor Back Office Connect.

If you are performing an initial Infor Back Office Connect implementation (a fresh install rather than an
upgrade to version 10.8), all of your quote data resides in the Salesforce standard Quote object, and
if the Expiration Date field is required in your migration plan, the Expiration Date field must be mapped
manually to the Expire On field in Infor Back Office Connect.

There are two options for mapping your Expiration Date field data:

1 Do not use the Expire On --> Expire On field map. Instead, edit the migration field map to use the
Salesforce Expiration Date field (source) the Infor Back Office Connect version 10.8 Expire On
field (target) or any other useful field.

2 Create a custom field for the Expiration Date field in Infor Back Office Connect, and then map the
Salesforce Expiration Date field (source) to the Expiration Date custom field in Infor Back Office
Connect.

Note: If you are mapping data from the Infor Back Office Connect version 10.6.x release, the
"out-of-the-box" migration field mapping in Infor Back Office Connect is preset to use the Expire On
field for both source and target. If you are mapping ERP quote data using the Expire On field and need
to map the Expiration Date field data for the standard quote migration record, you must create an
Expiration Date custom field on the Infor Quote custom object and map the Expiration Date field
(source) from the Salesforce standard Quote object to the custom field (target).

Adding migration field mappings to a migration object

If you have a custom fields on the Standard Quote object that you want included in the migration scope,
you must first add or create the custom field on the Infor Quote object, then create a migration field
map for the source --> target field pairing.

Note: You cannot map to a target that is part of a migration field pairing.

This section describes the steps required to add migration field mappings to a migration object:
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To add migration field mappings to a migration object:

1 Add the custom field to the Salesforce standard Quote object or its related objects.
2 Add the same field to the Infor Quote object or its related objects.
3 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
4 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
5 In the Recent Migration Objects list, click the Name hyperlink of the migration object to clone to

display the Migration Objects Detail page.
6 In the Migration Fields section, click New Migration Field to display the Migration Field Edit page.
7 In the Information section, specify information for these fields:

• In the Source Field Name drop-down list, select the custom field you added to the source object.
• In the Target Field Name drop-down list, select the custom field you added to the source object.

Note: The types displayed in the Source Field Type and the Target Field Type fields must
match or be compatible. For example, if the source field data type is STRING, the target field
data type must also be a STRING or a text field.

• Optionally, enter a value in the Target Default Value field if you want the target field to
automatically be populated with a default value.

Note: If the source record has a value, the source record value is copied to the target record
and the value specified for the Target Default Value field is not used. If the source record does
not have a value, the value specified for Target Default Value is used.

• By default, the Active? check box is selected and the new field mapping is included in the
migration process. Optionally, if you do not want this field mapping to be included in the migration
process, clear the  Active? check box.

• Optionally, select the Recreate on update field to delete and recreate the field mapping record
during future migrations. You do not need to select the Recreate on update check box for initial
migrations. It is only valid for future migrations.

• Optionally, select the Concatenate? check box to join several text strings, such as addresses,
into a single text string.

• Optionally, define a Sequence Number for the field mapping.
• Optionally, select the Updateable? check box if you want this field mapping to be updated in

future migrations. Leave the check box unselected if you do not want to update the field mapping
in future migrations.

• Optionally, specify a Delimiter to define a character or space to mark the beginning or end of a
data element.

8 Click Save. The new field mapping is created and the Migration Field Detail page is displayed.

Accessing and editing a migration field mapping

This section describes the steps required to access and edit migration field mappings.

To access and edit a migration field mapping:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
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2 From the View drop-down list, select All and then click Go! to display a list of all the migration
objects.

3 In the Recent Migration Objects list, select the migration object pairing and click the Name hyperlink
to display the Migration Object Edit page.

4 In the Migration Fields section, select the migration field pairing and click the Edit hyperlink to display
the Migration Field Edit page.

5 In the Information section, specify or update the information you require for the field mapping. See
"Adding migration field mappings to a migration object" on page 204.

6 Click Save.

Cloning a migration field mapping

A migration field mapping can be copied or cloned to create a new migration field mapping. This process
can save the Infor Back Office Connect Administrator configuration time because a currently used
migration field mapping may have very similar specifications to the new, required migration field mapping.
In this instance, a current migration field mapping can be used as a template to create a new migration
field mapping.

This section describes the steps required to clone migration field mappings:

To clone migration field mappings:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
3 In the Recent Migration Objects list, select the migration object pairing and click the Name hyperlink

to display the Migration Object Edit page.
4 In the Migration Fields section, select the migration field pairing and click the Name hyperlink to

display the Migration Field Detail page.
5 Click Clone to display the Migration Field Edit page.
6 In the Information Section, specify or update the information you require for the cloned field mapping.

See "Adding migration field mappings to a migration object" on page 204.
7 Click Save.

Deleting a migration field mapping

This section describes the steps required to delete a migration field mapping:

To delete a migration field mapping:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
3 In the Recent Migration Objects list, select the migration object pairing and click the Name hyperlink

to display the Migration Object Edit page.
4 In the Migration Fields section, select the migration field pairing and click the Del hyperlink. A

confirmation message is displayed.
5 Click OK. The migration field mapping is deleted.

206 | Infor Back Office Connect Administration Guide

Infor quote migration



Migration record type mappings
The Infor Back Office Connect Ordering application maps the migrated fields from a source record type
to a target record type. The "out-of-thebox" record type mapping is defined for each migration object.

Accessing the migration record type for a migration object

This section describes the steps required to access the migration record type mapping for a migration
object.

To access the migration record type mapping for a migration object:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
3 In the Recent Migration Objects list, select the migration object pairing and click the Name hyperlink

to display the Migration Object Edit page for the migration object pairing.
4 In the Migration Record Type Mappings section, select the migration record type field mapping and

click the Name hyperlink to display the Migration Record Type Mapping Detail page.
5 View the migration record type mapping information. For the migration record type mapping, this

information is displayed:

• The Name field displays the source-to-target record type related to the migration object pairing.
• The Migration Object field displays the migration object pairing (source-to-target) for the selected

migration object.
• The Source Record Type Name field displays the source record type related to the source

object in the migration object pairing.
• The Target Record Type Name field displays the target record type related to the target object

in the migration object pairing.
• If the Active? check box is selected, the migration record type mapping is actively in use. If the

Active? check box is unselected, the migration record type mapping is deactivated and is not
currently in use.

• The Created By field displays the user and date/time stamp indicating when and by whom the
migration record type mapping was created.

• The Last Modified By field displays the user and date/time stamp indicating when and by whom
the migration record type mapping was last updated.

Editing the migration record type for a migration object

This section describes the steps required to edit the migration record type mapping for a migration
object.

To edit the migration record type mapping for a migration object:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
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3 In the Recent Migration Objects list, select the migration object pairing and click the Name hyperlink
to display the Migration Object Edit page for the migration object pairing.

4 In the Migration Record Type Mappings section, select the migration record type field mapping and
click the Edit hyperlink to display the Migration Record Type Edit page.

5 In the Information section, specify information for these fields:

• In the Source Record Type drop-down list, select a different record type. An error message is
displayed if only one record type is defined for the source or target object(s).

• In the Target Record Type drop-down list, select a different record type. An error message is
displayed if only one record type is defined for the source or target object(s).

6 Click Save.

Cloning the migration record type for a migration object

This section describes the steps required to clone the migration record type mapping for a migration
object.

To clone the migration record type mapping for a migration object:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
3 In the Recent Migration Objects list, select the migration object pairing and click the Name hyperlink

to display the Migration Object Edit page for the migration object pairing.
4 In the Migration Record Type Mappings section, select the migration record type field mapping and

click the Name hyperlink to display the Migration Record Type Mapping Detail page.
5 Click Clone to display the Migration Record Type Edit page.
6 In the Information Section, specify or update the information you require for the cloned migration

object. See "Editing the migration record type for a migration object" on page 207.
7 Click Save.

Deleting the migration record type mapping for a migration object

This section describes the steps required to edit the migration record type mapping for a migration
object.

To edit the migration record type mapping for a migration object:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the migration

objects.
3 In the Recent Migration Objects list, select the migration object pairing and click the Name hyperlink

to display the Migration Object Edit page for the migration object pairing.
4 In the Migration Record Type Mappings section, select the migration record type field mapping and

click the Del hyperlink. A confirmation message is displayed.
5 Click OK. The migration record type mapping deleted.
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Working with the Migration Errors tab
On the Migration Errors tab, you can create specific migration errors to accompany the migration
object, migration fields, and/or migration record type mappings for the Infor Back Office Connect
Ordering application. See "Migration errors" on page 224.

Creating a migration error
This section describes the steps required to create a migration error.

To create a migration error:

1 In the Infor Back Office Connect Ordering application, click the Migration Objects tab.
2 In the Recent Migration Errors section, click New.
3 In the Information section, specify information for these fields:

• Name
• Optionally, Parent Object Type.
• In the Migration Object lookup, select the migration object pairing for which to create the migration

error.
• Optionally, Error Message
• Optionally, Exception Stack Trace

Note: The Failed Object Type field is not used for Infor Back Office Connect version 10.8.

4 Click Save. The migration error is created and the Migration Error Detail page is displayed.

Working with the Infor Back Office Connect Migration tab
The Infor Back Office Connect Migration tab is only used to migrate data from the standard Salesforce
Quote object to the new Infor Quote managed object.

The Infor Back Office Connect Migration tab consists of these two sections:

• Migration Batch Information
• Load Seed Data Information

Note: The quote migration process does not migrate or change any customizations, workflows, or
triggers implemented on the standard Salesforce Quote object. After migration, all customizations,
workflows, and triggers remain intact. After migration is complete, you must reimplement all your
customizations, workflows, and triggers on the new Infor Quote object.
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Infor quote migration and quote ownership by non-Infor Back Office Connect
user profiles
When the quote migration is executed, the Infor Back Office Connect Migration application copies all
standard Salesforce quotes to the new Infor Quote object, including quotes owned by non-Infor Back
Office Connect users. All quotes owned by non-Infor Back Office Connect users will remain intact on
the standard Salesforce Quote object, but those quotes will also be duplicated on the new Infor Quote
object. This is also true when an opportunity that is the parent of a standard Salesforce quote is owned
by a user assigned to the standard Salesforce user profile.

Note: A non-Infor Back Office Connect user is any user who does not consume an Infor Back Office
Connect license.

We highly recommend that all users, regardless of profile, access their quotes records from the Infor
Quote object only. Access to the standard, Salesforce Quote object should be restricted to the Infor
Back Office Connect Administrator or Infor Back Office Connect Developer only. Also, the only action
taken on standard Salesforce Quote records residing in your organization (after Infor Back Office
Connect Migration) is deletion. Legacy standard, Salesforce Quote records should not be updated by
any user. New quote records should not be created on the standard, Salesforce Quote object.

Migration Batch Information section
This table shows the fields in the Migration Batch Information section of The Infor Back Office Connect
Migration tab and their descriptions:

DescriptionField

This drop-down list displays the selected parent migration object
pairing of the standard Salesforce quote object (source) and the
Infor quote object (target) for the quote migration process.

Migration Object

If any errors are logged during the initial migration process, you
can select this check box during future migrations to correct the

Migrate only error records?

records and rerun the migration. When selected, the migration
process will only migrate records from the error group.

This date selected in this data field segregates the migration record
set to include only records modified after the specified date.

Last Modified After

This date selected in this data field segregates the migration record
set to include only records modified before the specified date.

Last Modified Before

Using this alpha-numeric field, the Infor Back Office Connect ad-
ministrator can define a specific number of records to migrate. We

Number of Records to Migrate

recommend using this field to specify a small number of records
(10 or less) to migrate for testing purposes before attempting to
migrate all of your production data. When you are ready to migrate
all of your production data, specify ALL for this field.
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Load Seed Data Information section
This table shows the fields in the Migration Batch Information section of The Infor Back Office Connect
Migration tab and their descriptions:

DescriptionField

This is the namespace of the Infor Back Office Connect application
you are currently using.

Namespace Prefix

This is the URL pointing to the location of the seed data.Static Resource File Path

Migrating quote data to the Infor quote object
This section describes the tasks that you must complete to prepare Infor Back Office Connect for the
Infor Quote migration and the execution of the initial migration of your quote data to the Infor Quote.

See "Understanding the Infor Back Office Connect Migration application" on page 199 for additional
information on working with the Infor Back Office Connect Migration application to modify migration
settings related to the quote migration process.

Migrating addresses on Quote records
The account's billing address (also referred to as Primary Address) is mapped to the Quote to Address
fields on the Infor quote record. If the Quote contains a defined Bill-to and Ship-to role (commonly found
on ERP Quotes), the Bill-to and Ship-to address fields will migrate to the appropriate Bill-to and Ship-to
address fields defined in the Migration Object (Quote --> Infor quote) - Migration field map.

Preparing Infor Back Office Connect for the Infor quote migration
After completing the steps required for upgrading Infor Back Office Connect from version 10.6.x (or
earlier) to version 10.8, you can run the Infor Quote migration. See "Upgrading" on page 147. This
section describes the steps required to prepare Infor Back Office Connect for the Infor Quote migration.

Caution: You must complete all preliminary data migration for the base Infor Back Office Connect
application as a part of the version 10.8 upgrade process prior to attempting to run the Infor
Quote migration or using the Infor Back Office Connect Ordering application. See "Migrating
existing data to Infor Back Office Connect version 10.8" on page 154.

To prepare Infor Back Office Connect for the Infor Quote migration:

1 Log into Salesforce as the Integration context user.
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2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 On the Integration Setup tab, click Step 7: Start/Stop Scheduler.
5 Click Stop ION Integration Scheduler. A confirmation message is displayed.

Caution: The ION integration scheduler must not be running during the migration process.

6 On the Integration Setup tab, click Step 6: Set Opportunity Default Values.
7 Clear the Copy Opportunity Products To Quote check box. By unselecting this check box, you

prevent the migration process from duplicating quote line items and opportunity products.

Note: If no default value is specified for the Name configuration setting in the Name drop-down list
in the Configure System Opportunity Default Values section, all system opportunities are named
using the Quote EXTID.

8 Click Save.

Executing the initial quote data migration
This section describes the steps required to execute the Infor Quote migration using the Infor Back
Office Connect Migration application.

Note: Neither standard Salesforce quote or Infor quote records should be modified during the quote
migration process.

To execute the initial quote data migration:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 From the Force.com App Menu select Infor Back Office Connect Migration. The Infor Back Office

Connect Migration application is started and the Infor Back Office Connect Migration tab is
displayed.

3 In the Migration Batch Information section, specify information for these fields:

• In the Migration Object drop-down list, select quote-->InForEW__quote__c.
• Optionally,specify a date in the Last Modified After field.
• Optionally,specify a date in the Last Modified Before field.
• Specify a value in the Number of Records to Migrate field. By default, the Number of Records

to Migrate field is automatically populated with the value ALL. If you do not specify a different
value for this field, the initial migration process will migrate all your product data. We recommend
using this field to specify a small number of records (10 or less) to migrate for testing purposes
before attempting to migrate all of your production data. When you are ready to migrate all of
your production data, specify ALL for this field.

Note: Leave the Migrate only error records? check box unchecked for the initial quote data
migration.
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4 In the Load Seed Data Information section, click Load Seed Data. The seed data is loaded and a
confirmation message is displayed above the section header.

5 In the Migration Batch Information section, click Start Migration. The status of the migration process
is displayed in the section header. When the migration process is completed, a confirmation message
is displayed. You can review any migration errors on the Migration Errors tab. Optionally, you can
also check the progress of the quote migration process on the Infor Quote object. See "Infor quotes"
in the Infor Back Office Connect User Guide for information on the Infor Quote object.

Post Infor quote migration tasks
After the migration of the quote records from the standard Salesforce Quote object to the Infor Quote
object is complete and fully verified by your Infor Back Office Connect Users, Infor Back Office Connect
Administrators must prepare Infor Back Office Connect for regular business functions. After completion
of the post migration tasks, Infor Back Office Connect will be ready for deployment to Infor Back Office
Connect Users.

After performing the initial quote migration, complete each of these post-migration tasks:

1 Delete all "working" objects from the organization.
a Delete the Infor Quote related workflows.
b Delete sourceRecordId__c custom fields in the Infor Quote, Infor Quote Line Item, Quote

Documents, and Activity objects.
c Delete the formula fields from the Quote and Quote Line Item standard objects.

2 Reset Infor Back Office Connect Configuration - Integration settings to support regular quote and
opportunity business processes.
a Confirm Copy Opportunity Products To Quote configuration for your organization.
b Confirm Opportunity Default Values for system Opportunities.
c Confirm Quote Clone fields/related object default values.
d Restart the scheduler.

3 Users and Quote Record Ownership.
a Reassign Infor quote and system opportunities from the default record owner to Infor Back Office

Connect users.

4 Non-Infor Back Office Connect User Quote record clean-up on Infor Quote object.
a Optionally, delete quotes owned by non-Infor Back Office Connect user from the Infor Quote

object.

5 Re-implement quote and opportunity triggers and workflows to support quote processes from the
Infor Quote object.

6 Permanently delete Salesforce Quote records from the organization.
a Export source standard Salesforce Quote record to archive location (not in the organization).
b Mass delete source standard Salesforce Quote record from the organization.
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Deleting all Infor Back Office Connect Migration application working
objects from the organization
The Infor Back Office Connect Migration application installation created several “working” objects used
by the application to facilitate the migration process. These “working” objects include workflows and
fields that are no longer needed in your organization. The following tasks must be completed:

To delete all Infor Back Office Connect Migration application working objects from the organization:

1 Delete the Infor Quote related workflows.
2 Delete sourceRecordId__c custom fields from these objects:

• Infor Quote, Infor Quote Line Item, Quote Documents, and Activity objects

3 Delete the formula fields from these objects:

• Standard Salesforce Quote and Standard Salesforce Quote Line Item

Deleting workflows related to Infor quotes
This section describes the steps required to delete the workflows related to Infor quotes. The workflows
related to Infor quotes have the Rule Name "Set Infor quote Issyncing."

To delete the workflows related to Infor quotes:

1 Log into Salesforce as the system administrator or the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Create > Workflow & Approvals > Workflow Rules

to display the Understanding Workflow page.
4 Click Continue to display the All Workflow Rules page.
5 In the View list, select All Workflow Rules.
6 In the All Workflow Rules list, locate the workflow rule with Set Infor quote Issyincing in the Rule

Name column.
7 Click the Del hyperlink next to workflow rule record. A confirmation message is displayed.
8 Click OK. The workflow rule field is deleted.
9 Repeat steps 6 - 8 for each workflow rule with Set Infor quote Issyincing in the Rule Name column.

Deleting the sourceRecordID__c custom field
After running the quote migration, you must delete the sourceRecordID__c custom field from these
Infor Back Office Connect custom objects and activity custom fields:

• Infor quote
• Infor quote Line Item
• Quote Document
• Activity
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Deleting the sourceRecordID__c custom field from the Infor quote custom object

This section describes the steps required to delete the sourceRecordID__c custom field from the Infor
quote custom object.

To delete the sourceRecordID__c custom field from the Infor quote custom object:

1 Log into Salesforce as the system administrator or the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Create > Objects to display the Custom Objects page.
4 In the Custom Objects list, locate the Infor quote custom object and click the Infor quote hyperlink

name to display the Custom Object Infor quote (Managed) page.
5 In the Custom Fields & Relationships section, locate the sourceRecordID custom field. The Field

Label for the record is sourceRecordID and the API Name is sourceRecordID__c.
6 Click the Del hyperlink next to sourceRecordID custom field. A warning message is displayed.
7 Select the Yes, I want to delete the relationship check box.
8 Click Delete. The custom field is deleted.
9 Scroll to the end of the Custom Fields & Relationships section and click the Deleted Fields hyperlink.

The Infor quote Deleted Fields page is displayed.
10 Click Erase. A warning message is displayed.
11 Select the Yes, I want to permanently delete the custom field check box.
12 Click Delete. The custom field is permanently deleted.

Deleting the sourceRecordId__c custom field from the Infor quote Line Item custom object

This section describes the steps required to delete the sourceRecordID__c custom field from the Infor
quote Line Item custom object.

To delete the sourceRecordID__c custom field from the Infor quote Line Item custom object:

1 Log into Salesforce as the system administrator or the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select Custom ObjectsApp Setup > Create > Objects to display the page.
4 In the Custom Objects list, locate the Infor quote Line custom object and click the Infor quote Line

Item hyperlink name to display the Custom Object Infor quote Line Item (Managed) page.
5 In the Custom Fields & Relationships section, locate the sourceRecordID custom field. The Field

Label for the record is sourceRecordID and the API Name is sourceRecordID__c.
6 Click the Del hyperlink next to sourceRecordID custom field. A warning message is displayed.
7 Select the Yes, I want to delete the relationship check box.
8 Click Delete. The custom field is deleted.
9 Scroll to the end of the Custom Fields & Relationships section and click the Deleted Fields hyperlink.

The Infor quote Line Item Deleted Fields page is displayed.
10 Click Erase. A warning message is displayed.
11 Select the Yes, I want to permanently delete the custom field check box.
12 Click Delete. The custom field is permanently deleted.
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Deleting the sourceRecordId__c custom field from the Quote Document custom object

This section describes the steps required to delete the sourceRecordID__c custom field from the
Quote Document custom object.

To delete the sourceRecordID__c custom field from the Quote Document custom object:

1 Log into Salesforce as the system administrator or the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Create > Objects to display the Custom Objects page.
4 In the Custom Objects list, locate the Quote Document custom object and click the Quote Document

hyperlink name to display the Custom Object Quote Document (Managed) page.
5 In the Custom Fields & Relationships section, locate the sourceRecordID custom field. The Field

Label for the record is sourceRecordID and the API Name is sourceRecordID__c.
6 Click the Del hyperlink next to sourceRecordID custom field. A warning message is displayed.
7 Select the Yes, I want to delete the relationship check box.
8 Click Delete. The custom field is deleted.
9 Scroll to the end of the Custom Fields & Relationships section and click the Deleted Fields hyperlink.

The Infor quote Line Item Deleted Fields page is displayed.
10 Click Erase. A warning message is displayed.
11 Select the Yes, I want to permanently delete the custom field check box.
12 Click Delete. The custom field is permanently deleted.

Deleting the sourceRecordId__c custom field from the Activity custom fields

This section describes the steps required to delete the sourceRecordID__c custom field from the
Activity custom fields.

To delete the sourceRecordID__c custom field from the Activity custom fields:

1 Log into Salesforce as the system administrator or the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Activities > Activity Custom Fields to

display the Activity Fields page.
4 In the Activity Custom Fields section, locate the sourceRecordID custom field. The Field Label for

the record is sourceRecordID and the API Name is sourceRecordID__c.
5 Click the Del hyperlink next to sourceRecordID custom field. A warning message is displayed.
6 Select the Yes, I want to delete the relationship check box.
7 Click Delete. The custom field is deleted.
8 Scroll to the end of the Activity Custom Fields section and click the Deleted Fields hyperlink. The

Infor quote Line Item Deleted Fields page is displayed.
9 Click Erase. A warning message is displayed.
10 Select the Yes, I want to permanently delete the custom field check box.
11 Click Delete. The custom field is permanently deleted.
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Deleting the formula fields from the Quote and QuoteLineItem standard objects

After running the quote migration, you must delete these formula fields from the standard Salesforce
Quote object:

• account__c
• ownerId__c
• taxpercent__c

You must delete these formula fields from the standard Salesforce Quote Line Item object:

• product2__c
• productCode__c

Deleting the formula fields from the standard Salesforce Quote object

This section describes the steps required to delete the account__c, ownerId__c, and taxpercent__c
formula fields from the standard Salesforce Quote object.

To delete the formula fields from the standard Salesforce Quote object:

1 Log into Salesforce as the system administrator or the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Quotes > Fields to display the Quote

Fields page.
4 In the Quote Custom Fields & Relationships section, locate the account field. The Field Label for

the record is account and the API Name is account__c.
5 Click the Del hyperlink next to account custom field. A warning message is displayed.
6 Select the Yes, I want to delete the custom field check box.
7 Click Delete. The custom field is deleted.
8 In the Quote Custom Fields & Relationships section, locate the ownerId field. The Field Label for

the record is ownerId and the API Name is ownerId__c.
9 Click the Del hyperlink next to ownerId custom field. A warning message is displayed.
10 Select the Yes, I want to delete the custom field check box.
11 Click Delete. The custom field is deleted.
12 In the Quote Custom Fields & Relationships section, locate the taxpercent field. The Field Label

for the record is taxpercent and the API Name is taxpercent__c.
13 Click the Del hyperlink next to taxpercent custom field. A warning message is displayed.
14 Select the Yes, I want to delete the custom field check box.
15 Click Delete. The custom field is deleted.
16 Scroll to the end of the Quote Custom Fields & Relationships section and click the Deleted Fields

hyperlink. The Quote Deleted Fields page is displayed.
17 Click the Erase hyperlink next to account custom field. A warning message is displayed.
18 Select the Yes, I want to permanently delete the custom field check box.
19 Click Delete. The custom field is permanently deleted.
20 Click the Erase hyperlink next to ownerId custom field. A warning message is displayed. A warning

message is displayed.
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21 Select the Yes, I want to permanently delete the custom field check box.
22 Click Delete. The custom field is permanently deleted.
23 Click the Erase hyperlink next to taxpercent custom field. A warning message is displayed. A warning

message is displayed.
24 Select the Yes, I want to permanently delete the custom field check box.
25 Click Delete. The custom field is permanently deleted.

Deleting the formula fields from the standard Salesforce Quote Line Item object

This section describes the steps required to delete the product2 and productCode formula fields from
the standard Salesforce Quote Line Item object.

To delete the formula fields from the standard Salesforce Quote object:

1 Log into Salesforce as the system administrator or the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Quotes > Quote Line Items > Fields to

display the Quote Line Items Fields page.
4 In the Quote Line Items Custom Fields & Relationships section, locate the product2 field. The Field

Label for the record is product2 and the API Name is product2__c.
5 Click the Del hyperlink next to product2 custom field. A warning message is displayed.
6 Select the Yes, I want to delete the custom field check box.
7 Click Delete. The custom field is deleted.
8 In the Quote Custom Fields & Relationships section, locate the productCode field. The Field Label

for the record is productCode and the API Name is productCode__c.
9 Click the Del hyperlink next to ownerId custom field. A warning message is displayed.
10 Select the Yes, I want to delete the custom field check box.
11 Click Delete. The custom field is deleted.
12 Scroll to the end of the Quote Line Item Custom Fields & Relationships section and click the Deleted

Fields hyperlink. The Quote Deleted Fields page is displayed.
13 Click the Erase hyperlink next to product2 custom field. A warning message is displayed. A warning

message is displayed.
14 Select the Yes, I want to permanently delete the custom field check box.
15 Click Delete. The custom field is permanently deleted.
16 Click the Erase hyperlink next to productCode custom field. A warning message is displayed. A

warning message is displayed.
17 Select the Yes, I want to permanently delete the custom field check box.
18 Click Delete. The custom field is permanently deleted.
19 Click Delete. The custom field is permanently deleted.

Delete all retired transaction addresses

Additionally, because the quote migration process does not delete retired transaction address records
associated with standard Salesforce quotes, after completing the data migration required for upgrading
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the base Infor Back Office Connect product and running the quote migration process, you must manually
delete all retired transaction address records. See Salesforce documentation.

See "Upgrading" on page 147 and "Migrating existing data to Infor Back Office Connect version 10.8"
on page 154 for information on the upgrade and data migration process for the base Infor Back Office
Connect product.

Re-implement any quote and opportunity triggers

Optionally, if you disabled any custom quote or opportunity triggers prior to running the quote migration
process, you must re-implement the triggers for the new Infor quote custom object.

Integration settings to support regular quote and opportunity
business processes
During the Infor Back Office Connect Migration application installation, Infor Back Office Connect
Configuration - Integration Settings were changed to support the migration process. The following steps
describe how to reset Infor Back Office Connect to support your regular quote and opportunity business
processes using the Infor Quote object.

Resetting Infor Back Office Connect integration settings to support regular
business processes
This section describes the steps required to reset the Infor Back Office Connect integration settings to
support regular business processes for Infor Quotes.

To reset the Infor Back Office Connect integration settings to support regular business:

1 Log into Salesforce as the integration context user.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Integration Setup tab.
4 On the Integration Setup tab, click Step 6: Quote and Opp Settings.
5 Deselect the Copy Opportunity Products To Quote check box.

Note: There is a known issue with duplicated quotes and opportunity products copied to cloned
quotes. To mitigate this issue, deselect the Copy Opportunity Products To Quote checkbox.

6 Optionally, in the Configure System Opportunity Default Values section, in the Name drop-down
list, select Name from the available default configuration settings list.

7 Optionally, specify a name for system opportunities in the Default Value field.

Note: If you do not define a default value to name system opportunities, by default all system
opportunities are named using the quote EXTID.

Note: There is a known issue related to Quote Cloning. The Reason field is populated on the cloned
quote. The Reason field should be blank on cloned quotes. To mitigate this issue, follow steps 8-12.
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8 In the Configure Quote Clone fields/related objects section, scroll to the Infor Quote – Reason field.
9 Click Edit. Scroll to the configuration fields.
10 Leave the Default Value field empty (no value).
11 Select the Override checkbox.
12 Click Save.
13 On the Integration Setup tab, click Step 7: Start/Stop Scheduler.
14 Click Start ION Integration Scheduler.

A confirmation message is displayed.

Users and Quote Record ownership
During the Infor Back Office Connect Migration process, the Default Record Owner is automatically
assigned as the record owner for any Infor Quotes System Opportunity when an Infor Back Office
Connect User is not defined. Each Infor Quote should be assigned to an Infor Back Office Connect
User. We recommend that the Infor Back Office Connect Administrator or user with administrative
privileges reassign all of the records owned by the Default Record Owner to an actual Infor Back Office
Connect user using the Data Loader. For smaller sets of records to reassign, you can create List views
on the Infor Quote and Opportunity object to facilitate reassigning the records to the appropriate user.

Note: If the Opportunity Owner field is not displayed on the Infor Back Office Connect ERP Opportunity
Layout, you must add the field to the page layout to execute this task.

To reassign a small set of Infor quote and system opportunities from the default record owner to Infor
Back Office Connect users:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 From the Force.com app menu, select Infor Back Office Connect Administration.
3 Click the Opportunities tab to display the Opportunities Home page.
4 From the View drop-down list, select All Opportunities or create a specific view to list all

opportunities assigned to the Default Record Owner. Click Go! to display a list of all opportunities
based on your user permissions, security settings, and your specified search criteria.

Note: If the Opportunities tab list view does not include the Opportunity Owner Alias field in the
page layout, you must add it to the page layout to execute this task.

5 Locate the record that is assigned to the Default Record Owner.

Note: You can click the Opportunity Owner Alias heading to sort the records alphabetically.

6 Click the Opportunity Name hyperlink for the record to edit.
7 In the Opportunity Owner field, click the Change hyperlink to display the Ownership Edit page.
8 In the Owner lookup, select the Infor Back Office Connect user to whom to assign ownership of the

opportunity.
9 Optionally, select the Send Notification Email check box to automatically generate an e-mail to

the selected user to notify the user that they are assigned as the record owner of this opportunity.
10 Click Save.
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11 Optionally, repeat steps 5 - 10 for each record for which you need to reassign ownership to an Infor
Back Office Connect user.

Reassigning ownership of ERP quotes from the default record owner to Infor
Back Office Connect users
To reassign ERP quotes from the default record owner to Infor Back Office Connect users:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 From the Force.com app menu, select Infor Back Office Connect Administration.
3 Click the Infor Quotes tab to display the Infor Quotes Home page.
4 From the View drop-down list, create a specific view to list all quotes assigned to the Default Record

Owner. Click Go! to display a list of all opportunities based on your user permissions, security
settings, and your specified search criteria.

Note: If the Infor Quotes tab list view does not include the Owner Alias field in the page layout,
you must add it to the page layout to execute this task.

5 Locate the record that is assigned to the Default Record Owner.

Note: You can click the Owner Alias heading to sort the records alphabetically.

6 Select the Action check box for the record for which to reassign ownership and then click Change
Owner to display the Ownership Edit page.

7 In the Owner lookup, select the Infor Back Office Connect user to whom to assign ownership of the
opportunity.

8 Optionally, select the Send Notification Email check box to automatically generate an e-mail to
the selected user to notify the user that they are assigned as the record owner of this opportunity.

9 Click Save.
10 Optionally, repeat steps 5 - 9 for each record for which you need to reassign ownership to an Infor

Back Office Connect user.

Non-Infor quote record clean-up on Infor quote object
During the Infor Back Office Connect Migration process, the Infor Back Office Connect Migration
application migrates all quote records on the standard Salesforce quote object to the Infor Quote object
regardless of their ownership. If your organization assigns licenses to Salesforce.com and Infor Back
Office Connect licenses to users, you may have a situation where a non-Infor Back Office Connect
licensed user’s quotes are migrated to the Infor Quote object. If the Salesforce.com licensed user
intends to continue accessing their quotes from the standard, Salesforce quote object, the following
considerations must be made:

• The Salesforce.com licensed users records are now duplicated in your organization. We recommend
that the Infor Back Office Connect Administrator delete the non-Infor Back Office Connect users
records from the Infor Quote object to save on record space in the org and to prevent unexpected
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system behavior should the record be updated in the future from both the Infor Back Office Connect
and standard Salesforce venues.

• Business process must be in placed to ensure that opportunities used by the Salesforce.com licensed
user are not also used by Infor Back Office Connect Users. It is possible for an opportunity to be
related to an Infor Quote and also have a master-detail relationship to a standard Salesforce quote
object. This marriage of quotes to the Opportunity may result in unexpected system behavior or
errors.

• If possible, we recommend that all individuals creating, accessing or managing quotes use the Infor
Quote object. If possible, assign all users Infor Back Office Connect licenses and delete the standard
Salesforce quote records after quote migration is complete and validated by the Infor Back Office
Connect Users.

This section describes the steps to cleanup Non-Infor Back Office Connect User’s quotes that were
migrated to the Infor Quote object.

Deleting quotes that are owned by non-Infor Back Office Connect users from
the Infor Quote object
We recommend that the Infor Back Office Connect Administrator or user with administrative privileges
to delete quotes owned by non-Infor Back Office Connect users from the Infor Quote object using the
Data Loader. For smaller sets of records to delete, you can create List views on the Infor Quote and
Opportunity object to facilitate deleting the records.

Note: When you delete the non-Infor Back Office Connect User’s duplicated quotes from the Infor
Quote object, the original, source, standard Salesforce Quote record remains on the standard Salesforce
Quote object (until the source records are deleted by the Infor Back Office Connect Administrator).

To delete quotes that are owned by non-Infor Back Office Connect users from the Quote object:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 From the Force.com app menu, select Infor Back Office Connect.
3 Click the Infor Quotes tab to display the Infor Quotes Home page.
4 From the View drop-down list, create a specific view to list all quotes assigned to the Default Record

Owner. Click Go! to display a list of all opportunities based on your user permissions, security
settings, and your specified search criteria.

Note: If the Infor Quotes tab list view does not include the Owner Alias field in the page layout,
you must add it to the page layout to execute this task.

5 Locate the record that is assigned to the Default Record Owner.

Note: You can click the Owner Alias heading to sort the records alphabetically.

6 Select the Action check box for the record for which to reassign ownership and then click the Del
hyperlink. A confirmation message is displayed.

7 Click OK. The duplicate record is deleted.
8 Optionally, repeat steps 5 - 7 for each duplicate record you need to delete from the Infor Quote

object.
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Note: The steps in this section are recommended for working with a small record set of quotes
owned by non-Infor Back Office Connect users that have been copied to the Infor Quote object. If
you are working with a large set of records, we recommend using the Salesforce Data Loader
application to delete these records. See Salesforce documentation.

Re-implement Quote and Opportunity custom workflows, approval
processes, and triggers for use with the Infor quote object
The Infor Back Office Connect Migration application does not migrate any custom workflows, approval
processes, or triggers related to opportunities and quotes that may be actively used in your organization.
After migration, the Infor Back Office Connect Administrator must re-implement all custom workflows,
approval processes, and triggers to support regular quote processes from the Infor Back Office Connect
Quote object.

Permanently delete standard Salesforce Quote records from the
Salesforce Quote object
After quote migration is complete, we highly recommend that you retire usage of the standard Salesforce
Quote object. All users who create, access, or manage quotes should do so from the Infor Quote object.
The standard, Salesforce Quote object’s access should be restricted to only the Infor Back Office
Connect Administrator or Infor Back Office Connect Developer.

We recommend the following to the Infor Back Office Connect Administrator regarding the retirement
of the standard Salesforce Quote object:

• Obtain confirmation from all Infor Back Office Connect Users that their quote data was migrated
completely and correctly.

• If your sales team needs to refer to the original standard Salesforce Quote data in the future, generate
backup of all standard quote data for reference and archival purposes. Save to a separate location,
not in your Salesforce Organization, for future access. For instance, the Infor Back Office Connect
Administrator can create/run a Salesforce report to export the quote data into an Excel spreadsheet
that can be accessed from a network location whenever users need to review the source data.

• The Migration process creates a copy of the standard Salesforce quote data and uses that copied
data to generate new Infor Quote records on the Infor Quote object. After migration, there will be
two sets of quote data in the organization: the original, “source” , standard Salesforce Quote data
and the newly created “target” Infor Quote data on the Infor Quote object. If the standard and Infor
Quote related lists are visible to the Infor Back Office Connect User, the Infor Back Office Connect
User will see the same quote on both related lists. Given this scenario, there is a risk that Infor Back
Office Connect Users may accidentally continue working with the standard Salesforce quote object
when they should be working only from the Infor Quote object. To mitigate this risk, we recommend
that the original, source Salesforce Quote data be deleted from the organization.

Also, if the source, standard Salesforce Quote record is synchronized with an Opportunity, after
migration, the newly created Infor Quote record will also be synchronized to the same Opportunity. As
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stated earlier, the same quote will be accessible from the standard, Salesforce Quote object and the
Infor Quote object. Record updates in this scenario can result in unexpected behavior and errors in
Infor Back Office Connect. Also, Infor Back Office Connect Users may spend time updating the standard
Salesforce quote record and have to re-enter their data on the Infor Quote object to leverage the
features and functionality in Infor Back Office Connect.

To mitigate these risks, we highly recommend retiring the standard Salesforce Quote object and if
possible deleting all standard Salesforce Quote records from the organization. Use the Salesforce Data
Loader to mass delete records from the standard Salesforce Quote object.

• If it is not possible to delete the standard Salesforce Quote records from the organization, we also
recommend removal of the standard Salesforce Quote object from all Infor Back Office Connect
User accessed page layouts and the only action executed on the quote record is deletion. Infor Back
Office Connect Users should create and manage quotes from the Infor Quote object only. The Infor
Quote object should be accessible from the Account, Contact, and Opportunity related lists as well
as the Infor Quote object from the tab or All Tabs access points in Salesforce.

Migration errors
Review and resolve quote records that failed to migrate on the Migration Errors tab.

This table shows the fields displayed on theMigration Error tab and their descriptions:

DescriptionField

The migration object pairing (source --> target)Name

The active migration object defined in the Infor Back Office Connect
Ordering application Migration Object listing.

Migration Object

The actual quote record that failed to migrate.Parent Record

A system-generated error message describing the issue with the
quote record migration.

Error Message

The object associated with the parent record.Parent Object Type

This field is not populated during migration.Failed Object Type

The date of the failed record migration.Last Modified Date

The user who executed the migration.Last Modified By

Reviewing and resolving error details for records that fail to migrate
After the initial quote migration is complete, you can review and resolve any errors that occurred with
records that failed to migrate on the Migration Errors tab.
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To review and resolve error details for records that fail to migrate:

1 In the Infor Back Office Connect Ordering application, click the Migration Errors tab.
2 From the View drop-down list, select All and then click Go! to display a list of all the recent migration

error records.
3 In the Recent Migration Errors list, click the Name hyperlink of the migration object to clone to display

the Migration Error Detail page.
4 Review the error information. See "Migration errors" on page 224.

Note: Do not attempt to resolve migration errors on the Migration Error Edit page. This page is only
used to review the error messages related to the record.

5 Click the Parent Record hyperlink to open the record that failed to migrate.
6 Edit the record as necessary to resolve the issue.
7 Optionally, repeat steps 3 - 6 for each migration error record you need to resolve.

Rerunning the quote migration after fixing record errors
After you review and resolve any migration errors on the Migration Errors tab, you can rerun the
migration to migrate the fixed records.

This section describes the steps required to rerun the quote migration using the Infor Back Office
Connect Migration application.

Note: Neither standard Salesforce quote or Infor quote records should be modified during the quote
migration process.

To rerun the quote migration after fixing record errors:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 From the Force.com App Menu select Infor Back Office Connect Migration. The Infor Back Office

Connect Migration application is started and the Infor Back Office Connect Migration tab is
displayed.

3 In the Migration Batch Information section, specify information for these fields:

• In the Migration Object drop-down list, select quote-->InForEW__quote__c.
• Select the Migrate only error records? check box.
• Optionally,specify a date in the Last Modified After field.
• Optionally,specify a date in the Last Modified Before field.
• Specify a value in the Number of Records to Migrate field. By default, the Number of Records

to Migrate field is automatically populated with the value ALL. If you do not specify a different
value for this field, the initial migration process will migrate all your product data. We recommend
using this field to specify a small number of records (10 or less) to migrate for testing purposes
before attempting to migrate all of your production data. When you are ready to migrate all of
your production data, specify ALL for this field.
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4 In the Migration Batch Information section, click Start Migration. The status of the migration process
is displayed in the section header. When the migration process is completed, a confirmation message
is displayed. You can review any migration errors on the Migration Errors tab.

Uninstalling the Infor Back Office Connect Migration
application
This section describes the steps required to uninstall the Infor Back Office Connect Ordering application
from your Salesforce organization.

Caution: If you are testing the quote migration in a Salesforce organization on which the Infor
Quote Migration unmanaged package was installed for Infor Back Office Connect 10.8.x, you
must first uninstall the existing Infor Quote Migration unmanaged package and install the new
one to complete the quote migration for Infor Back Office Connect version 10.8.

To uninstall the Infor Back Office Connect Ordering application:

1 Login to the Salesforce organization as the Infor Back Office Connect Administrator.
2 Select Setup.
3 In the sidebar column, selectApp Setup > Installed Packages.
4 In the Installed Packages section, select Infor Back Office Connect Migration and click Uninstall.
5 Select the Yes, I want to uninstall this package and permanently delete all associated

components check box.
6 Click Uninstall. The package uninstallation begins. After the Infor Back Office Connect Ordering

application is uninstalled successfully, a confirmation message is displayed. If the uninstallation fails
for any reason, an error message is displayed and you must address the issue(s) identified in the
error message prior to continuing.

226 | Infor Back Office Connect Administration Guide

Infor quote migration



12Uninstallation

This chapter describes the tasks that you must complete to uninstall Infor Back Office Connect from
your Salesforce organization.

Preparing to uninstall Infor Back Office Connect
Complete these tasks before uninstalling Infor Back Office Connect:

• Login to the Salesforce organization as the integration context user
• Record any configuration information and settings associated with the Infor Back Office Connect

application that you might need in the future

Note: We recommend taking screen shots of the screens containing the configuration information
and settings.

• Stop the scheduler and verify that it is stopped
• Reassign standard Salesforce user profiles to Infor Back Office Connect profiles
• Delete the Infor Back Office Connect profiles
• Verify the number of accounts, contacts, opportunities, and quotes that will be affected by uninstalling

the Infor Back Office Connect application and clean up the affected records to prepare for the
uninstallation

Stopping the scheduler to uninstall Infor Back Office Connect
Before beginning the Infor Back Office Connect uninstallation process, you must stop the scheduler
and verify that the scheduler is stopped. See "Stopping the scheduler" on page 151 and "Verifying
whether the scheduler is stopped" on page 151.
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Reassigning standard profiles to Infor Back Office Connect users
Before uninstalling the Infor Back Office Connect application, you must reassign standard Salesforce
user profiles to all the users who were assigned the Infor Back Office Connect Administrator, Infor Back
Office Connect Developer, and Infor Back Office Connect User profiles.

To reassign standard profiles to Infor Back Office Connect users:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Manage Users > Users to display the All

Users page.
4 Select the user profile to modify and click Edit.
5 In the Profile field, select a standard Salesforce profile to assign to the user.
6 Click Save.
7 Repeat these steps for each user assigned an Infor Back Office Connect profile.

Deleting Infor Back Office Connect profiles
After reassigning standard Salesforce user profiles to all users assigned Infor Back Office Connect
profiles, delete the Infor Back Office Connect Administrator, Infor Back Office Connect Developer, and
Infor Back Office Connect User profiles from your Salesforce organziation.

To delete Infor Back Office Connect profiles:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Manage Users > Profiles to display the

User Profiles page.
4 Locate the Infor Back Office Connect user profile to delete and click Del. A confirmation message

is displayed.
5 Click OK.
6 Repeat these steps for each Infor Back Office Connect profile.

Uninstalling the Infor Back Office Connect package
Before uninstalling the Infor Back Office Connect package, verify that you have completed all the
prerequisite tasks required to uninstall Infor Back Office Connect. See "Preparing to uninstall Infor Back
Office Connect" on page 227.

Installing Infor Back Office Connect on your Salesforce organization creates a number of custom
objects, custom fields, tables, and modifications to standard Salesforce objects. Because of the
parent-child relationships created by these Infor Back Office Connect custom objects, tables, and fields,
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the uninstallation process will fail if the records affected by these parent-child relationships are not
deleted prior to removing the Infor Back Office Connect application.

Depending on the amount of data you have in your Salesforce organization that is affected by Infor
Back Office Connect, the uninstallation and data clean up process can be time-consuming and complex.
Because of this, we recommend that you do not uninstall Infor Back Office Connect unless you will no
longer be an Infor Back Office Connect customer in the future. If you have questions about the Infor
Back Office Connect uninstallation process, contact Infor customer support. See "Contacting Infor".

Caution: Do not attempt to uninstall the Infor Back Office Connect package without stopping
the scheduler and verifying that the scheduler is stopped. If the scheduler is still running, Infor
Back Office Connect will continue to process records based on the scheduler settings, the
installation process will fail, and transactional errors will occur. See "Stopping the scheduler"
on page 151 and "Verifying whether the scheduler is stopped" on page 151.

To uninstall the Infor Back Office Connect package:

1 Login to the Salesforce organization as the integration context user.
2 Select Setup.
3 In the sidebar column, selectApp Setup > Installed Packages.
4 In the Installed Packages section, select Infor Back Office Connect and click Uninstall.
5 Select the Yes, I want to uninstall this package and permanently delete all associated

components check box.
6 Click Uninstall. The package uninstallation begins. If the package is uninstalled successfully, a

confirmation message is displayed. If the uninstallation fails for any reason, an error message is
displayed and you must address the issue(s) identified in the error message prior to continuing.
After the package is uninstalled successfully, Salesforce sends an e-mail notification to the e-mail
address configured in the Salesforce user profile of the installer.

Note: If you have installed other applications purchased from the Salesforce AppExchange that use
or reference Infor Back Office Connect components, the Infor Back Office Connect uninstallation
process might be more complex because multiple products are referencing the same components,
records, and data. Sometimes, you must uninstall the additional applications referencing the Infor
Back Office Connect components before you can uninstall Infor Back Office Connect.
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13Data management

As message processing occurs over time, the inbound and outbound message queues can become
populated with large numbers of obsolete messages. Infor Back Office Connect includes the Data
Management object to enable you to manage your message queues. This chapter describes concepts
and tasks related to managing your messaging queues.

Understanding message processing status codes
Inbound and outbound messages are assigned status codes to indicate whether a message is in
process, is processed successfully, or generated an error messages. Messages can be assigned these
statuses:

• "0" indicates that the message is awaiting processing•
• "1" indicates that the message processed without error
• "9" indicates that the message encountered missing dependent data in Infor Back Office Connect

or contains a data related problem
• "99" indicates that a variation ID error has occurred and Infor Back Office Connect will not publish

a confirmation BOD
• "999" indicates that the message generated a Salesforce run time error

Note: Inbound Sync, Show, and Acknowledge messages are sent from ERP to Infor Back Office
Connect. Outbound Process and Confirm messages are sent from Infor Back Office Connect to the
ERP. See "Inbound messages" on page 266 and "Outbound messages" on page 267.

A variation ID is assigned to a BOD by Infor Back Office Connect to identify the number of times a
record with a specific set of attributes has been published for the accounting entity and location. The
variation ID is used to ensure that Infor Back Office Connect is reading in the latest version of the BOD.
For example, a BOD with a variation ID of 5 is received and read in Infor Back Office Connect. Infor
Back Office Connect then receives another BOD for the same record with a variation ID of 4. Upon
receiving the BOD with the variance ID of 4, this BOD is assigned a processing status of 99 to indicate
that the variation ID of 4 is older then the variation ID of 5.

Infor Back Office Connect Administration Guide | 231

 



Marking variation conflict BODs as successful
When an older version of a BOD is received in Infor Back Office Connect, the BOD will be processed
and marked as successful so that it can be automatically removed with other successful BODs.

Reprocessing inbound BODs
As inbound BODs are sent to Infor Back Office Connect, processing errors can occur due to configuration
settings or missing related records (dependencies), such as a missing contact record on an account.

These failed inbound BODs must be manually reprocessed after resolving the configuration errors or
the dependent objects have been loaded into Infor Back Office Connect. As a result, we recommend
reprocessing all of the BODs that have been assigned 9 or 999 for their Was Processed status. You
can verify BOD processing status on the Inbound Messages tab.

In some cases, BODs require dependent data to be present in Infor Back Office Connect before they
can be successfully processed. For example, contacts must be defined before the CustomerParty
Master BOD can reference them, or the Customer Party Master must be defined before the dependent
transactions can be loaded. BODs are marked with a Was Processed status of 9 if the dependent
data is not received prior to the retry count expiration.

If there are dependencies between BODs and the dependent BODs are delivered to Infor Back Office
Connect before the parent BOD, Infor Back Office Connect will delay the processing of the dependent
BOD and continue to retry processing until it locates the parent object in Infor Back Office Connect. If
the parent is not found within the number of retries specified for the Message Retry Count field in your
integration settings, the dependent BOD will not be processed and the processing status will be set to
"9" to indicate that an error in processing occurred.

To reprocess BODs:

1 Login to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Data Management tab.
4 In the Re-Process Inbound Messages section, specify information for these fields:

• Created After
• Created Before

5 In the Inbound Message Status field, select the 9 and/or 99 check box(es) to reprocess inbound
BODs with the selected processing status(es).

6 In the Re-Process Message Types field, select the type(s) of inbound messages to reprocess.
Select ALL to reprocess all types, or select a specific type, such as Sync.BillToPartyMaster to
reprocess only messages of the specified type.

7 Click Re-Process Messages. A confirmation message is displayed.
8 Click OK.
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Purging messages from the Infor Back Office Connect
message queue
The Data Management object is used to purge obsolete inbound and outbound messages from the
Infor Back Office Connect message queue based on the selected message status code(s).

Note: The Data Management object disregards messages that are marked with "0" as their status
code, which indicates that the message has not been processed.

To delete messages from the Infor Back Office Connect message queue:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Data Management tab.

Note: If the Data Management tab is not displayed by default, click the plus icon (+) to display all
tabs and click the Data Management link in the All Tabs list.

4 Specify this information:

Inbound Message Status
Select the check box for each of the status code(s) to indicate which inbound messages you want
to delete from the queue. You can select one of more of the status codes. For example, select the
1 and 999 check boxes to purge all inbound messages that have already been processed and
inbound messages that failed due to an integration error from the queue.

Outbound Message Status
Select the check box for each of the status code(s) to indicate which outbound messages you want
to delete from the queue. You can select one of more of the status codes. For example, select the
9 and 999 check boxes to purge all outbound messages that have already been processed and
outbound messages that could not be processed from the queue.

5 Click Delete Messages. A confirmation message is displayed.
6 Click OK. All messages marked for deletion by the specified criteria are purged from the message

queue.

Note: Do not click OK unless you are certain that you want to delete the messages selected for
deletion. Clicking OK permanently deletes all of the messages in the queue matching the specified
criteria and the messages cannot be recovered.
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14Error logging

The Logging tab is used to configure and manage Infor Back Office Connect error logging. The errors
recorded in the log can be used to investigate, interpret, debug inbound and outbound message
processing errors, and reduce the amount of storage space consumed by each error. Having a log of
processing errors is helpful when communicating error messages to Infor support teams. Infor support
also uses the error log information to resolve support case incidents.

Note: If the Logging tab is not displayed by default, click the plus icon (+) to display all tabs and click
the Logging link in the All Tabs list.

This chapter describes concepts and tasks related to the configuration of Infor Back Office Connect
error logging and using the error logs to manage different types of logging and debugging errors.

Setting the error logging level and number of log
messages
Use the Log Setup section of the Logging tab to configure the error logging level and maximum number
of log messages.

The logging level determines the types of errors that are captured in the error log. The maximum number
of log messages determines the amount of storage space consumed by each error logging level. Three
log levels are currently supported in Infor Back Office Connect: Debug, Error, and Warn. This table
describes the different log levels:

DescriptionLog Level

When set to Debug, Infor Back Office Connect generates log entries for
error messages and warning messages that occur during message pro-
cessing.
We recommend that you only set the log level to Debug when you are
debugging an issue. After the issue is resolved, reset the log level to Error.

Debug

Caution: The Debug setting generates the most log entries and
can create storage issues for your Salesforce organization. Use
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DescriptionLog Level

this log-type only when debugging and issue. Once the issue is
resolved, reset the Log type to Error.

When set to Error, Infor Back Office Connect only generates log entries
for error messages that occur during message processing.
We recommend Error as the default setting for the log level.

Error

When set to Warning, Infor Back Office Connect only generates log entries
for warning messages that occur during message processing.

Warning

To set the error logging level and number of log messages:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Logging tab.
4 In the Log Setup section, specify this information:

Log Level
Select the logging level to define from the Log Level list.

Max number of log messages
The default value of log messages is 100. The maximum number of log messages should be entered
as a value between 50 and 5000 based on your storage requirements.

5 Click Save.

Downloading and deleting the error log
Use the Download/Delete Logs section of the Logging tab to download or delete the error logs created
by the object. You can download or delete the error log based on the message type for a specified
date range.

This table describes the different log types:

DescriptionLog Type

When selected, the process will compile the error log for only inbound
messages.

Inbound

When selected, the process will compile the error log for only outbound
messages.

Outbound

When selected, the process will compile the error log for any available
messages that are not inbound or outbound.

Other
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DescriptionLog Type

When selected, the process will compile the error log for all available
messages.

All

Downloading the error log
Download the error log for a specified log type and date range. You can download the file in either a
comma-separated values (.csv) format or a gzip file.

To download the error log:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Logging tab.
4 In the Download/Delete Logs section, select the logging type to download from the Log Type list.
5 Specify the date range to download in the Created After and Created Before fields.
6 Click Download Logs.

Deleting the error log
Delete the error log for a specified log type and date range. Deleting the logs created by the logger is
helpful to clear the error logs when performing controlled debugging activities.

To delete the error log:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Logging tab.
4 In the Download/Delete Logs section, select the logging type to delete from the Log Type list.
5 Specify the date range to delete in the Created After and Created Before fields.
6 Click Delete Logs.

Working with the error log list
The Logging tab list displays the error messages that are currently logged based on the Log Level
settings. From the list, you can create a new logger, change the owner of a message, and edit and
delete individual error messages.

For each error recording in the log, this information is displayed:
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• The Logger Name field displays a unique identifier assigned to the logger record by Infor Back
Office Connect. For example, a0dG0000006Yg4F.

• The Entity field displays the entity type of the record. For example, account.
• The Message field displays the actual message recorded by the log during inbound or outbound

message processing.
• The Message Type field displays the type of message that generated the error. For example,

Inbound.
• The Related Entity URL field displays a URL to the inbound or outbound message associated with

the logger record. Clicking the link launches the corresponding inbound or outbound message detail
screen.

• The Created By field displays the owner of the BOD. All inbound and outbound messages are
created by the Integration user.

• The Created Date field displays the date that the message was created and added to the log.
• The Last Modified Date field displays the date the message was last processed.

Creating a custom logger
Create a custom logger to record or communicate information for a specific message type and entity.

To create a custom logger:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Logging tab.
4 In the list view section, click New Logger.
5 Specify this information:

Logger Name
Specify a name for the custom log.

Message
Specify the log entry message to record for the message type and entity.

Message Type
Select the type of message for which to record this custom log message.

Entity
Specify the entity to associate with the custom log message.

6 Click Save.

Changing the owner of an error message
Change the owner of a logged error to reassign logs to specific users.
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To change the owner of an error message:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Logging tab.
4 In the list view section, select the logger to reassign and click Change Owner.
5 Specify the user to whom to reassign the logger in the Owner field.
6 Optionally, select the Send Notification Email check box to generate an e-mail notification to the

new owner of the logger.
7 Click Save.

Editing a logger
To edit a logger:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Logging tab.
4 In the list view section, select the logger to modify and click Edit.
5 Edit the logger information. See "Creating a custom logger" on page 238.
6 Click Save.

Deleting a logged error message
Delete a single logged error message. Deleting the logs created by the logger is helpful to clear the
error logs when performing controlled debugging activities.

To delete a logger:

1 Log in to Salesforce as the Infor Back Office Connect developer.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Logging tab.
4 In the list view section, select the logger to delete and click Delete. A confirmation message is

displayed.
5 Click OK.
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15Territories

The Territories tab is used to configure and manage territories. Territories can be updated by both
inbound and outbound processes. Territories can also be managed manually. When changes are made
to territories in Infor Back Office Connect, the changes trigger an outbound message from Infor Back
Office Connect to update ERP.

Territories are also code definitions, but territory code definition is a custom object in Infor Back Office
Connect and can be synchronized both ways between ERP and Infor Back Office Connect.

If territory management is enabled in Salesforce or if the Salesforce organization is using custom
territory management, then you must customize your territories by mapping the ERP territories with
your existing territories. Doing so will enable you to continue using your existing territory sharing rules.
Also, any changes made to territories in Infor Back Office Connect will automatically synchronize with
their equivalent records in ERP.

Note: Only users with Infor Back Office Connect Administrator privileges can create or modify territories.

This chapter describes concepts and tasks related to managing territories in Infor Back Office Connect.

Viewing territories
To view territories:

1 Login to Salesforce as the Infor Back Office Connect administrator or Infor Back Office Connect
developer.

2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Territories tab.
4 Select All from the View list and click Go! to display the complete list of territories.
5 View the territory information.
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Creating territories
To create territories in Infor Back Office Connect:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Territories tab.
4 Click New Territory.
5 Specify the information that you require.

Note: Infor Back Office Connect includes multi-back office and multi-company features that publish
BODs to different ERP accounting entities and locations based on your configuration. Ownership
of new records is based on the accounting entity ID and location ID configured in the Accounting
Entity Table (AET). If the multi-back office and multi-company features are configured, specify the
appropriate values for the Accounting Entity ID and Location ID fields.

6 Click Save.

Note: When the record is synchronized, the In Sync check box is selected.

Modifying a territory
When a territory is modified or updated, Infor Back Office Connect generates an outbound message.

To modify a territory:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Click the Territories tab.
4 In the list view section, select the territory to modify and click Edit.
5 Edit the territory information. See "Creating territories" on page 242.

Deleting a territory
When a territory is deleted, Infor Back Office Connect generates an outbound message. Upon receipt
of the outbound message, the message source (ERP) or system of record determines if the territory
record is deleted. An Acknowledge BOD is then sent from the message source (ERP) to Infor Back
Office Connect communicate the status of the update.

To delete a territory:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
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3 Click the Territories tab.
4 In the list view section, select the territory to delete and click Del. A confirmation message is displayed.
5 Click OK.
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16Troubleshooting

This chapter provides information on troubleshooting issues that occur in the Infor Back Office Connect
application and the integration process.

Common failure scenarios
The section describes common failure scenarios that occur related to the Infor Back Office Connect
integration and provides suggestions for troubleshooting and resolving these issues.

ION Adapter Connection test fails
After configuring the Infor Back Office Connect application for ERP integration, you must test the ION
adapter connection to see if the configuration is successful. See "Testing the Infor Back Office Connect
scheduler and scheduler connection" on page 52.

If the connection fails, there are a number of potential causes and steps you can take to resolve the
issue. This table shows common causes and resolution steps:

ResolutionCause

Verify the remote site configuration and confirm that it is active. To
verify the remote site configuration:

The remote site might not be
configured properly, or the re-
mote site is not activated. 1 Login to Salesforce as the Infor Back Office Connect administrator.

2 Select Setup.
3 In the sidebar column, select Administration Setup > Security

Controls > Remote Site Settings.
4 In the Remote Site Name column, click the hyperlink of the remote

site to verify.
5 Verify that the remote site is configured properly and that it is active.
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ResolutionCause
6 Verify that the URL of the remote site is the same as the URL of

the ION Proxy Container Endpoint URL in the Adapter Settings on
the Integration Setup tab.

Browse the ION Proxy Container Endpoint URL. If the Web Service
Definition Language (WSDL) does not display, contact Infor customer
support.

The remote site may be down.

Verify that the username and password or your ION tenant are correct
in the Adapter Settings on the Integration Setup tab.

The username and password
may be wrong.

Verify that you have specified the ION Proxy Tenant in the Adapter
Settings on the Integration Setup tab. The ION Proxy Tenant must

The ION Proxy Tenant may be
wrong.

be the same as the ION connection point settings. See "Configuring
the Infor Back Office Connect adapter and scheduler settings" on
page 48.

Verify that you have specified the correct Logical ID in the Infor Back
Office Connect settings. See "Configuring Infor Back Office Connect
settings" on page 45.

The wrong Logical ID is config-
ured in the Infor Back Office
Connect settings on the Inte-
gration Setup tab.

ION integration scheduler is down
The scheduler is the Infor Back Office Connect component that sends messages. Certain integration
events can cause the scheduler to fail.

If the scheduler fails, there are a number of potential causes and steps you can take to resolve the
issue. This table shows common causes and resolution steps:

ResolutionCause

Restart the scheduler. See "Starting the scheduler".The scheduled job entry is
deleted.

Delete the IONBatchExecutor job from the scheduled jobs list and
restart the scheduler.
To delete the IONBatchExecutor job from the scheduled jobs list:

The Start/Stop Scheduler
button on the Integration Set-
up tab continually resets to
"Start Ion Integration Sched-
uler." 1 Login to Salesforce as the integration context user.

2 Select Setup.
3 In the sidebar column, select Administration Setup > Monitoring

> Scheduled Jobs.
4 Locate the IONBatchExecutor job in the All Scheduled Jobs list

and click Del. A confirmation message is displayed.
5 Click OK.
6 Restart the scheduler. See "Starting the scheduler".
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ResolutionCause

Apex job error:
Error message: Too many code
statements: 1000001

1 See "Recommended Inbound Batch Scope values for initial data
load" on page 33 for the recommended setting for the BOD noun
being processed.

2 Change the Inbound Batch Scope setting to the recommended
setting for the BOD noun being processed. See "Configuring the
scheduler settings" on page 50.

Batch Apex job fails
When the scheduler messages trigger the processing of inbound and outbound, the adapter invokes
a Batch Apex job to process inbound and outbound messages. Certain integration events can cause
Batch Apex jobs to fail.

If a Batch Apex job fails, there are a number of potential causes and steps you can take to resolve the
issue. This table shows common causes and resolution steps:

ResolutionCause

Verify that the Update Adapter Settings are correct. See "Configuring
the Infor Back Office Connect adapter and scheduler settings" on
page 48.

The web service callout from
the Batch Apex job can fail be-
cause the configuration set-
tings specified in the Update
Adapter Settings section of the
Integration Setup tab are in-
correct.

Contact Infor support. See "Contacting Infor".A response time out error oc-
curred because the Infor ION
Cloud server is unavailable.

Contact Infor support and provide them with the failure error details.
Browse the apex job entries in your error log to capture the message.
See "Error logging" on page 235.

A failure in the Batch Apex
code execution occurred.

Activate ION User in ION.First error: Web service callout
failed: WebService returned a
SOAP Fault: {ION User} is of-
fline. faultcode=S:Server fault-
actor=: ION User account is in-
active in ION.

Contact Infor support.InboundMessageBatch is not
in the Apex Jobs list view

Decrease the Inbound Batch Scope setting in the Update Scheduler
Settings section of the Integration Setup tab. See "Configuring the

Too many SOQL queries: 201
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ResolutionCause
Infor Back Office Connect adapter and scheduler settings" on page
48.

InboundMessageBatch job is not displayed in the Apex Jobs list
The Apex Jobs page lists all Batch Apex jobs that have been submitted for execution. See Salesforce
documentation.

If the InboundMessageBatch job does not appear in the Apex jobs queue, you must contact Infor
support. See "Contacting Infor".

To view the status of the InboundMessageBatch job, see "Verifying the status of Apex Jobs" on page
248.

OutboundMessageBatch job is not displayed in the Apex Jobs list
The OutboundMessageBatch is run on-demand when there are outbound messages with a was_process
= 0 status or ionoutransactions. If you have outbound messages with either of these statuses and the
OutboundMessageBatch is not displayed job does not appear in the Apex jobs queue, you must contact
Infor support. See "Contacting Infor".

To view the status of the InboundMessageBatch job, see "Verifying the status of Apex Jobs" on page
248.

Verifying the status of Apex Jobs
The Apex Jobs page lists all Batch Apex jobs that have been submitted for execution. See Salesforce
documentation. If the InboundMessageBatch job does not appear in the Apex jobs queue, you must
contact Infor support. See "Contacting Infor".

To view the status of the InboundMessageBatch Apex job:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 Select Setup.
3 In the sidebar column, select Administration Setup > Jobs > Apex Jobs.
4 Locate the job in the Apex Jobs list. The job names are displayed in the Apex Class column. For

example, locate InboundMessageBatch or OutboundMessageBatch.
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Inbound message processing unable to obtain exclusive access to
a record
Problem: When multiple transaction BODs sharing the same account are processed by different batch
jobs, BOD processing randomly fails. This issue occurs when the batch job tries to update a sales order
in a single batch job and the batch job locks the parent account. When another batch job simultaneously
tries to update another sales order with the same account, it cannot be updated because the account
is locked. When this scenario occurs, this error is generated:

First error: Update failed. First exception on row 0 with ID a0Rd0000001OMSrEAO; first error:
UNABLE_TO_LOCK_ROW, unable to obtain exclusive access to this record

Resolution: Republish the BOD.

Salesforce storage usage is over limit
Your data storage exceeds your purchased Salesforce storage limits.

Problem: This problem is often caused by leaving the Log Level set to Debug. When this scenario
occurs, this error is generated:

First exception on row 0; first error: STORAGE_LIMIT_EXCEED ED, storage limit exceeded

Resolution:

• Empty the Salesforce recycling bin. See Salesforce documentation.
• Delete your error logs. See "Deleting the error log" on page 237.
• Reset the logging level to Error or Warning. See "Setting the error logging level and number of log

messages" on page 235.

ION Connect and proxy tenant names do not match
Problem: If the Infor ION Connect tenant name does not match with proxy alternate tenant name in
your Integration Setup settings, the integration fails. When this scenario occurs, this error is generated:

First error: Web service callout failed: WebService returned a SOAP Fault: Cannot fetch details in the
given time :{Time in milliseconds} milliseconds faultcode=S:Server faultactor=

Resolution: Verify the values specified for your Cloud tenants in the Infor Back Office Connect settings,
Infor Back Office Connect Adapter, and Scheduler settings on the Integration Setup tab. See "Getting
Infor Back office Connect logical ID and ION tenant information from Infor" on page 20, "Understanding
ION Tenant Information" on page 42, and "Configuring the Infor Back Office Connect adapter and
scheduler settings" on page 48.

If the proxy tenant has been created, contact Infor support to verify whether the two tenant names
match.
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NO_ROUTE_FOUND error
Problem: This error occurs when Infor Back Office Connect attempts to publish a BOD for which no
document flow is defined in ION for the message source.

Resolution: Create a message flow in ION for the specified BOD and message source.

Account or contact record will not publish
Problem: An invalid email format was published from the system of record and the Can Send BOD
field has been set to False.

Resolution:
Fix the email in the system of record and republish the BOD.

Common Apex error messages
The section lists common Apex error messages that occur related to the Infor Back Office Connect
integration and provides suggestions for troubleshooting and resolving these issues.

ResolutionPossible causeApex error message

This is frequently an ION related
issue.

IO Exception: Unexpected end of
file from server

Older inbound/outbound BODs
that have been processed are

Delete failed. First exception on
row 0 with id

automatically deleted based ona12C0000001yHW2IAM; first er-
the value specified for Messageror: ENTITY_IS_DELETED, entity

is deleted Expiry (in minutes) in the Con-
figure Infor Back Office Connect
Settings on the Integration Set-
up tab. If the related record has
been manually deleted and is no
longer available for automatic
deletion, this error message is
generated. See "Configuring Infor
Back Office Connect settings" on
page 45.

If this error is generated during
processing, there is no issue to

This error is sometimes generat-
ed when traffic on the Infor24
Cloud servers is extremely heavy.

IO Exception: Read timed out

resolve. The affected message(s)
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ResolutionPossible causeApex error message
will be processed by the next
Apex job.

This message should no longer
be generated when the on-

This message is generated when
the on-premise ION document

IO Exception: Remote host
closed connection during hand-
shake premise ION service is available

and Infor24 Cloud is able to con-
flow is not accessible from In-
for24 Cloud, which is often the

nect. As a best practice, we rec-result of theION service being
ommend that you stop therestarted or is temporarily unavail-

able. scheduler whenever ION service
is going to be unavailable to
avoid the logging of this error.
Once the maintenance is com-
plete restart the scheduler. See
"Stopping the scheduler" on page
151 and "Starting the scheduler".

Web service callout failed: Web-
Service returned a SOAP Fault:
XMPPError connecting to
100.00.0.00:5222. fault-
code=S:Server faultactor=

IO Exception: Unable to tunnel
through proxy. Proxy returns
"HTTP/1.0 404 Not Found"

IO Exception: Unable to tunnel
through proxy. Proxy returns
"HTTP/1.0 503 Service Unavail-
able"

We recommend deactivating the
document flow in the on-premise

This message is generated when
the on-premise ION document

Web service callout failed: Web-
Service returned a SOAP Fault:

ION desk, and then reactivatingflow is not accessible from In-iboc-
the document flow. If this doesfor24 Cloud, which is often the00D0000000000.name@yours-

erver.com
is offline. faultcode=S:Server
faultactor=

resolve the error, restart the ION
service. If the issue persists,
contact the Infor ION support
team and log an Incident.

result of theION service being
restarted or is temporarily unavail-
able.

Confirm the setting of Message
Expiry (in minutes) in Configure

This error is generated when
there are more than 50001 In-
bound / Outbound BODs in the
Organization.

InForceEW:Too many query
rows: 50001

Infor Back Office Connect Set-
tings on the Integration Setup
tab. The default value of the
Message Expiry (in minutes)
field is 30. To reduce the number
of records, you can also manually
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ResolutionPossible causeApex error message
purge obsolete inbound and out-
bound messages from the Infor
Back Office Connect message
queue by deleting all records with
a status processing code = 1.
See "Purging messages from the
Infor Back Office Connect mes-
sage queue" on page 233.

This error is possibly related to
metadata corruption.

Argument 1 cannot be null

This message should no longer
be generated when the on-

This message is generated when
the on-premise ION document

Web service callout failed: Web-
Service returned a SOAP Fault:

premise ION service is availableflow is not accessible from In-Cannot fetch details in the given
and Infor24 Cloud is able to con-for24 Cloud, which is often thetime :40000 milliseconds fault-

code=S:Server ... nect. As a best practice, we rec-
ommend that you stop the

result of theION service being
restarted or is temporarily unavail-
able. scheduler whenever ION service

is going to be unavailable to
avoid the logging of this error.
Once the maintenance is com-
plete restart the scheduler. See
"Stopping the scheduler" on page
151 and "Starting the scheduler".

InForceEW.addressCRUD: exe-
cution of AfterUpdate caused by:
System.DmlException: Update
failed. First exception on row 0
with id 000000; first error: INSUF-
FICIENT_ACCESS_OR_READ-
ONLY, insufficient access rights
on object id:

The setting for the Total Batch
Jobs field in Update Scheduler

Salesforce limits the number of
concurrent Apex batches to 5.
This message is generated if
more than 5 batches are started.

'InForceEW.InboundMessage-
Batch' : ApexBatchItems Limit
exceeded. Settings in the Configure Infor

Back Office Connect Adapter,
Scheduler Settings section of the
Integration Setup tab deter-
mines the number of batches that
are started by Infor Back Office
Connect. If your organization has
custom Apex batch jobs, then you
must reduce the number speci-
fied for the Total Batch Jobs.
Infor Back Office Connect re-
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ResolutionPossible causeApex error message
quires a minimum of 2 batch jobs
for incoming and outgoing BODs.
The remaining 3 can be used for
custom Apex batch jobs as
needed. See "Configuring Infor
Back Office Connect scheduler
settings" on page 49 and "Config-
uring the scheduler settings" on
page 50.

'InForceEW.OutboundMessage-
Batch' for job id
'707a000000Qb01x' : IO Excep-
tion: Error writing to server

The setting for the Total Batch
Jobs field in Update Scheduler

This error is generated by jobs
that are stuck during processing.
Salesforce limits the number of

Apex script unhandled exception
by user/organization:
000000000000oKD/00D00000000I84X Settings in the Configure Infor

concurrent Apex batches to 5.Failed to process batch for class
'InForceEW.InboundMessage-

Back Office Connect Adapter,
Scheduler Settings section of the
Integration Setup tab deter-

This message is generated if
more than 5 batches are started.Batch' for job id

'000o000000OOO0o' mines the number of batches that
are started by Infor Back Office
Connect. If your organization has
custom Apex batch jobs, then you
must reduce the number speci-
fied for the Total Batch Jobs.
Infor Back Office Connect re-
quires a minimum of 2 batch jobs
for incoming and outgoing BODs.
The remaining 3 can be used for
custom Apex batch jobs as
needed. See "Configuring Infor
Back Office Connect scheduler
settings" on page 49 and "Config-
uring the scheduler settings" on
page 50.

Verify the recommended Inbound
Batch Scope setting for the BOD

Too many code statements;
1000001

noun. See "Recommended In-
bound Batch Scope values for
initial data load" on page 33.
Modify the Inbound Batch Scope
setting in Update Scheduler Set-
tings in the Configure Infor Back
Office Connect Adapter, Sched-
uler Settings section of the Inte-
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ResolutionPossible causeApex error message
gration Setup tab. See "Config-
uring the scheduler settings" on
page 50.

Setting the Infor Back Office Connect Opportunity page
layouts for the Opportunity layout master record type
Due to an issue in Salesforce, the Infor Back Office Connect Opportunity and Infor Back Office Connect
ERP Opportunity page layouts are not being set as the page layout for the Opportunity Layout master
record during the installation of the Infor Back Office Connect package. As a result you must manually
set the Infor Back Office Connect Opportunity and Infor Back Office Connect ERP Opportunity page
layouts for the Opportunity Layout master record.

Assigning the Infor Back Office Connect Opportunities page layout
to the Opportunity layout master record
To assign the Infor Back Office Connect Opportunities page layout to the Opportunity layout master
record:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Opportunities > Page Layouts.
4 Click Page Layout Assignment.
5 Click Edit Assignment.
6 In the Profiles list, press Ctrl + Click to select the Infor Back Office Connect Administrator, Infor

Back Office Connect Developer, and Infor Back Office Connect User profiles.
7 In the Page Layout to Use list, select Infor Back Office Connect Opportunity Layout for the

selected profiles.
8 Click Save.

Assigning the Infor Back Office Connect ERP Opportunities page
layout to the Opportunity layout master record
To assign the Infor Back Office Connect Opportunities page layout to the Opportunity layout master
record:
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1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Opportunities > Page Layouts.
4 Click Page Layout Assignment.
5 Click Edit Assignment.
6 In the Profiles list, press Ctrl + Click to select the Infor Back Office Connect Administrator, Infor

Back Office Connect Developer, and Infor Back Office Connect User profiles.
7 In the Page Layout to Use list, select Infor Back Office Connect ERP Opportunity Layout for

the selected profiles.
8 Click Save.

Cloning ERP Quotes owned by sales users
When the Bill-to Contact owner differs from the ERP Quote owner, and the Contact has no Account
reference, Salesforce generates an error message based on the ownership discrepancy violating its
Security Model. In the Infor Back Office Connect v10.8 release, the user will be presented with a
non-descriptive error message that simply reads: ERROR.

To resolve the ERROR, align the Bill-to Contact and ERP Quote owner and if possible, relate the
Contact to an Account (also aligned with the same record owner.) A future Infor Back Office Connect
release will update the error message to one that is more descriptive and user-friendly.

Increasing External ID field capacity
When you install Infor Back Office Connect, another External ID field is added to the Contact and
Account objects. By default, Salesforce.com limits the number of External ID fields to seven per object.
If seven External ID fields have already been defined for the Contact and Account objects in your
Salesforce organization, the Infor Back Office Connect installation will fail.

To determine whether to increase the External ID field capacity for your Salesforce organization, verify
the number of External ID fields you have defined for the Contact and Account objects.

If you have defined seven External ID fields for either or both the Contact and Account objects in
Salesforce.com, you must log a case with Salesforce support to increase the External ID field capacity
for your organization.

Verifying the number of External ID fields for the Account object
To verify the number of External ID fields for the Account object:
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1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Accounts.
4 In the Accounts section, click Add a custom field to accounts to display the Account Fields page.
5 In the Account Standard Fields and Account Custom Fields & Relationships sections, view the field

information in the Data Type column. If a field is defined as an External ID, (External ID) is displayed.
For example, if an External ID has been defined for the Customer ID field, Text(255) (External ID)
(Unique Case Insensitive) is displayed in the Data Type column for the field.

Verifying the number of External ID fields for the Contact object
To verify the number of External ID fields for the Contact object:

1 Log in to Salesforce as the system administrator.
2 Select Setup.
3 In the sidebar column, select App Setup > Customize > Contacts.
4 In the Accounts section, click Add a custom field to contacts to display the Contact Fields page.
5 In the Contact Standard Fields and Contact Custom Fields & Relationships sections, view the field

information in the Data Type column. If a field is defined as an External ID, (External ID) is displayed.
For example, if an External ID has been defined for the Customer ID field, Text(255) (External ID)
(Unique Case Insensitive) is displayed in the Data Type column for the field.
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AUnderstanding BODs

The information in this appendix provides an overview of functionality associated with messaging
through BODs. It also introduces key terminology and concepts associated with messaging through
BODs, Infor Back Office Connect, and an overview of the screens and objects used to manage BODs
in the integration of Salesforce with external ERP systems using Infor Back Office Connect.

Messaging through BODs
Communications between Infor Back Office Connect and ERP are sent as business object documents
(BODs) that are routed through Infor ION Connect.

Some BODs used in the Infor Back Office Connect and ERP integration support one-way communication.
All one-way communication BODs flow from ERP to Infor Back Office Connect.

Other BODs also support two-way communication data flow in both directions (to and from both Infor
Back Office Connect and ERP). For example, if a customer account is created or updated in Infor Back
Office Connect, a ProcessCustomerPartyMaster BOD is sent to ERP. The ERP will assign a Customer
Number to the Account created. As a result, the ERP sends the SyncCustomerPartyMaster BOD.

This diagram illustrates the directional message flow of BODs between Infor Back Office Connect and
ERP:
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Generating BODs
As business events or actions generate BODs, ION receives the BOD messages from the source
application outbox and places them into the target application inbox.

Some examples of business events or actions that generate BODs are:

• Creating a contact
• Creating an account
• Creating a product
• Creating a ship-to or bill-to account role
• Creating or updating a ship-to address
• Creating or updating a customer type
• Creating or updating payment terms
• Creating or updating INCO terms
• Creating or updating a territory
• Creating a quote
• Converting a quote to a customer order
• Creating a sales order
• Creating a shipment
• Shipping a customer order
• Creating an invoice
• Creating or updating a receivable transaction
• Creating or posting customer payments

Understanding the execution flow of BOD processing
by the Infor Back Office Connect scheduler
This diagram illustrates the directional flow of inbound and outbound Batch Apex jobs through the Infor
Back Office Connect scheduler:
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Posting Chatter feeds for BOD sync failure notifications
Infor Back Office Connect sends BOD sync failure notifications using Chatter. See Salesforce for
information on Chatter feeds.

Note: When a BOD is processed successfully, Infor Back Office Connect does not send a Chatter
notification message.

When a BOD sync failure occurs, Infor ION Connect sends an Acknowledge BOD with rejected status
to Infor Back Office Connect. The BOD contains the ResponseExpressionActionCode=Rejected. Upon
receipt of the BOD, Infor Back Office Connect generates a Chatter message for the Integration context
user, who owns the BOD record.

The Chatter message format is: ERROR: The {Object Name} {Record Name} has failed to sync with
your back office application. Details {Error Message}.

This table shows the elements of the error messages and their descriptions:
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DescriptionElement

Indicates the Infor Back Office Connect name for the BOD object.
For example, the object name for the ContactPartyMaster BOD
is "Contact."

{Object Name}

Indicates the name of the problem record, which contains a hy-
perlink to the actual record that failed to sync. For example, if the
record is a contact, the record name displayed is "John Smith."

{Record Name}

Displays the actual error message returned in the BOD. if there
is no error message ("identifiers: IDs_ID="), a standard message
"Undefined Error, contact your system administrator" is displayed.

{Error Message}

These are examples of error messages:

• ERROR: The Contact John Smith has failed to sync with your back office. Details: Country Code is
not 2 characters.

• ERROR: The Account ACME Inc. has failed to sync with your back office. Details: Undefined Error,
contact your system administrator.

Key concepts and terminology
This section provides a basic definition or explanation of key concepts and terminology related to Infor
Back Office Connect and BOD messaging.

BODs
A BOD is a business object document. BODs are XML documents that are used to pass data between
integrated systems. A BOD is composed of two elements, namely, a verb and a noun. The BOD's verbs
and nouns are paired to execute inbound and/or outbound processes.

BOD nouns
The BOD noun describes the object or table where data resides. Infor Back Office Connect uses these
nouns:

DescriptionBOD Noun

This BOD noun includes fields that indicate how the customer is billed
from ERP

BillToPartyMaster
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DescriptionBOD Noun

This BOD noun includes fields that load the basic default system data
values required by ERP

CodeDefinition

This BOD noun includes fields that create the contact record and its
relationship to the customer in ERP

ContactMaster

This BOD noun includes fields that create the customer in ERPCustomerPartyMaster

This BOD noun includes fields that indicate how customers returns are
managed in ERP

CustomerReturn

This BOD noun includes fields that indicate how the customer is in-
voiced in ERP

Invoice

This BOD noun includes fields that describe how products are sold and
maintained in the ERP

ItemMaster

This BOD noun includes fields that indicate the party responsible for
paying the invoice

PayFromPartyMaster

This BOD noun includes fields that generate quotesQuote

This BOD noun includes fields that manage receivablesReceivableTransaction

This BOD noun includes fields related that generate/execute sales or-
ders

SalesOrder

This BOD noun includes fields that indicate how the customer wants
their purchases to be shipped

ShipToPartyMaster

This BOD noun includes fields that execute the shipment of goods to
the customer

Shipment

BOD verbs
The BOD verb describes the action to be executed relative to its associated BOD noun.

For example, SyncCodeDefinition combines the BOD Verb - Sync with the BOD Noun - CodeDefinition
to create a BOD Type. Each BOD verb/noun combination or BOD Type support by Infor Back Office
Connect configured for the message source is listed in the Message Source BOD Type Versions related
list.

In general, Infor Back Office Connect inbound processing uses the BOD verbs Sync, Show and
Acknowledge in numerous combinations with the supported BOD Nouns.

Each BOD TYPE Version Name is mapped to one or more Salesforce standard objects or Infor Back
Office Connect Application custom objects.

Infor Back Office Connect uses these BOD verbs:
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How it is usedBOD Verb

The Acknowledge verb is used to denote a successful data process.
When the acknowledge verb is paired with a noun, it signifies that
the update was performed.
The BOD verb is used to indicate that an outbound process (an
outbound message sent from Infor Back Office Connect) was ac-
cepted or rejected by ERP.

Acknowledge

The Confirm verb used to denote an unsuccessful data process.
When the confirm verb is paired with a noun, it indicates that the

Confirm

update was not successful and that an error exists in the system
that requires investigation and resolution.
The Confirm verb is used to indicate that an inbound process (to
Infor Back Office Connect via inbound messaging) was rejected
by Infor Back Office Connect due to an error. Confirm BODs are
sent from Infor Back Office Connect to the ERP or Message Source.

In Outbound Processes, the process verb is used to pass data
from Infor Back Office Connect to ERP.
The Process verb is used to indicate that an outbound process
(sent from Infor Back Office Connect via outbound messaging)

Process

was executed. Infor Back Office Connect is attempting to send an
outbound message to the ERP.

This verb is used to execute an update to a specific system. When
the show verb is paired with a noun, it indicates that an attempt to

Show

pass data from ERP to Infor Back Office Connect has or will be
made.
This verb is used to indicate that an inbound process (from the
ERP to Infor Back Office Connect) was executed. The ERP is at-
tempting to send an inbound message to Infor Back Office Connect.
The Inbound process could result in the creation of new records
or update to existing sync'd records in Infor Back Office Connect.
When the Show verb is used, this further indicates that the message
was sent exclusively to Infor Back Office Connect. No other back
offices received the inbound message.
After its initial creation, the Infor Back Office Connect record is
"sync'd with the ERP.

In Inbound Processes, the sync verb is used to pass data from
ERP to Infor Back Office Connect.
This verb is used to indicate that an inbound process (from the
ERP to Infor Back Office Connect) was executed. The ERP is at-

Sync

tempting to send an inbound message to Infor Back Office Connect.
The Inbound process could result in the creation of new records
or update to existing sync'd records in Infor Back Office Connect.
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How it is usedBOD Verb
After its initial creation, the Infor Back Office Connect record is
"sync'd with the ERP.

BOD type names
The BOD type name is the combination of a BOD verb and BOD noun. The BOD type name describes
the action and the object involved in the data process. For example, the BOD type name
AcknowledgeContactMaster is a combination of the BOD noun ContactMaster and the BOD verb
Acknowledge. See "Viewing BOD type names" on page 96.

BOD type versions
A BOD type version is the iteration or release number assigned to a BOD, which consists of the BOD
type name, the BOD Release ID, and the BOD Version ID. For example, the BOD type version
AcknowledgeContactMaster 9.2-2.8.0 is a combination of the BOD type name
AcknowledgeContactMaster, the BOD Release ID 9.2, and the BOD Version ID 2.8.0.

BOD documents are periodically updated to include new fields or Xpaths or to remove obsolete fields
or Xpaths. When the BOD is updated, the new release number assigned to the BOD is the BOD type
version number. See "Viewing the BOD type version number" on page 96.

Note: Multiple BOD type versions can exist for a BOD, but Infor Back Office Connect only uses the
first BOD type version for a particular BOD Type.

BOD field mappings
BOD fields mappings indicate which CRM object and field should be updated in the Salesforce when
an inbound message is received. The default BOD data set containing all the standard BOD field
mappings is published in the Infor Back Office Connect BOD Mapping and Descriptions (Inbound) and
Infor Back Office Connect BOD Mapping and Descriptions (Outbound) guides. These guides are
available for download on the Integration Setup tab of the Infor Back Office Connect application.

Infor Back Office Connect includes the Bod Field Mappings custom object to view, manage, and
customize BOD field mappings to configure the data import process to conform to your business needs.
On this screen, Infor Back Office Connect administrators and developers can add or change the location
where a BOD message data element (custom field) is mapped to Infor Back Office Connect. See
"Viewing BOD field mappings in Infor Back Office Connect" on page 97

During inbound processing, Infor Back Office Connect compares the BOD Field Mappings against the
BOD type version details specified in the messages. The BOD Field Mapping object allow the message
schema to be revised when it is necessary to receive new or custom data in a BOD message. As future
versions of the BOD schemas (BOD verbs and BOD noun combinations) are released, updates to the
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BOD field mappings will allow Infor Back Office Connect to respond to new inbound message requests
while maintaining previously defined versions of the BOD schema.

Each XML BOD message contains a root element that determines the BOD Type, releaseID, and
versionID. Using these values, Infor Back Office Connect identifies which set of BOD Field Mappings
should be used to interpret the inbound message.

The data payload in located in the BOD (Noun) portion of the BOD message. Consequently, the BOD's
XML x-path expression (defined in the BOD Field Mappings) is relative to the noun element. For
example, if your are working with the CustomerPartyMaster BOD XML message, the noun element in
the message is CustomerPartyMaster.

BOD entity mappings
BOD entity mappings are used to define objects and objects with BODs that are associated with
outbound processes. Outbound processes are triggered by insert, update or delete events. See "Creating
conditional BOD trigger events and conditions" on page 93.

Infor Back Office Connect includes the Bod Entity Mappings custom object to view, manage, and
customize BOD entity mappings.

Message source
A message source is an ERP system that is configured to send inbound messages to Infor Back Office
Connect. During the Infor Back Office Connect configuration process, the Infor Back Office Connect
administrator defines one or more message sources that are integrated with Infor Back Office Connect.
See "Configuring message source settings" on page 44. After establishing the message source(s) and
the remaining integration/configuration tasks are complete, Infor Back Office Connect is ready to receive
inbound messages.

During the Infor Back Office Connect configuration process, the administrator can specify a default
message source and can also add or modify message sources and their settings for specific BODs
and BOD types. Users can also specify a message source when they create a new master record,
such as a new account. See the Infor Back Office Connect User Guide.

View a list of all the configured message sources on the Message Source object. See "Viewing the
configured BOD message sources" on page 102.

Message source BOD type version
Message source BOD type versions are used to map the BOD type versions to a message source.
See "BOD type versions" on page 264 and "Message source" on page 265.
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Message source BOD type versions are managed on the Message Source BOD Type Versions tab
where you can:

• Delete an existing message source BOD type version. See "Deleting a message source BOD type
version" on page 87.

• Clone an existing message source BOD type version. See "Cloning a message source BOD type
version" on page 86.

Note: You cannot edit an existing message source BOD type version.

The message source BOD type version is used for multi-back office and any BOD functionality to define
which BOD type versions are integrated with a particular message source, which enables the message
sources to leverage the same BOD type versions that are used on other message sources.

Inbound messages
An inbound message is generated when a BOD is sent from the ERP to Infor Back Office Connect. As
inbound messages are sent to Infor Back Office Connect, the Inbound Messages object records the
process. See "Viewing inbound messages in Infor Back Office Connect" on page 100.

Infor Back Office Connect uses a SYNC BOD to record that an inbound message was received from
the ERP. When the inbound message is received, Infor Back Office Connect will attempt to execute
the insert, update or delete action related to the inbound update.

Infor Back Office Connect uses an ACK BOD to send an inbound message to ERP to communicate
that the outbound message was rejected.

Understanding inbound message processing
During the Infor Back Office Connect configuration process, the Infor Back Office Connect administrator
defines one or more message sources. See "Configuring message source settings" on page 44. The
back office is the application you are integrating with Infor Back Office Connect through ION.

After the message source is established and the remaining integration tasks are complete, Infor Back
Office Connect is ready to receive inbound messages. You can view the message sources that are
configured to send inbound messages to Infor Back Office Connect on the Message Sources object.
See "Viewing the configured BOD message sources" on page 102.

Inbound BOD field mappings are associated with a particular BOD Type Version. See "BOD type
versions" on page 264. As updated mappings are created, new BOD schema versions become available.
When an inbound message is received, the message source is verified to determine which associated
BOD Type Versions can be used to parse the message. When Infor Back Office Connect processes
the inbound BOD, it locates the highest version ID number found in the BOD Type Version Name to
parse the message. For example, if there are multiple versions of the SyncCustomerPartyMaster BOD
numbered BTV-0000000000 to BTV-0000000040, Infor Back Office Connect will process
BTV-0000000040.

Note: BOD type versions are backwards compatible with prior BOD type versions.
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Outbound messages
An outbound message is generated when a BOD is sent from the Infor Back Office Connect to the
ERP. As outbound messages are sent to ERP, the Outbound Messages object records the process.
See "Viewing outbound messages in Infor Back Office Connect" on page 101.

Infor Back Office Connect uses a PROCESS BOD to execute an outbound insert, update or delete
event from Infor Back Office Connect to the ERP.

Infor Back Office Connect uses a CONFIRM BOD to send an outbound message to the ERP to indicate
that the inbound message was received.

Infor Back Office Connect uses an ACK TIMEOUT BOD to delete outbound transactions so that inbound
BOD’s for a particular noun can process.

The retry count is used for dependent BOD’s for both inbound and outbound. For inbound, if we are
getting a child BOD, we wait for the parent BOD for the set retry. If parent BOD is not received in the
set retry, child BOD will get ‘was processed’ = 9 and a confirmBOD is sent out.

Outbound transactions
When an outbound message is triggered, the Outbound Transaction object temporarily queues the
transaction for processing. See "Viewing outbound transactions in Infor Back Office Connect" on page
102.

Based on Salesforce traffic and other processes that may be running in your environment, the Outbound
Transaction object may house the queued transaction for a few sections up to the Salesforce service
level agreement (SLA)transaction processing maximum.
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BObject permission settings for Infor Back
Office Connect user profiles

When you work with objects in Infor Back Office Connect, the actions you can perform with the object
are defined by update privileges that are associated with your assigned user profile. These update
privileges determine whether information sent from the ERP to Infor Back Office Connect can be created,
updated, deleted, or is read-only for each user.

The information in this appendix describes the recommended profile object permission configuration
settings to assign when creating required Infor Back Office Connect user profiles. See "Creating Infor
Back Office Connect profiles" on page 21. Object permission settings for the Infor Back Office Connect
profiles are the same as the available Salesforce object permissions: Read, Create, Edit, and Delete.

Recommended object permissions for Infor Back Office
Connect User profile
This table shows the recommended profile permissions for standard objects the Infor Back Office
Connect User profile:

DeleteEditCreateReadObject

XXXXAccounts

XXXXAssets

XCampaigns

XXXCases

XXXXContacts

XXXXContracts

XXXXDocuments

XXIdeas

XXXXLeads
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DeleteEditCreateReadObject

XXXXOpportunities

XPrice Books

XProducts

Push Topics

XXXXQuotes

XXSolutions

This table shows the recommended profile permissions for custom Infor Back Office Connect objects
the Infor Back Office Connect User profile:

DeleteEditCreateReadObject

XXXXAccount Bill-to Roles

XXXXAccount Contact Relationships

Accounting Entity - Group Mappings

XXXXAccount Ship-to Roles

XXXXAddresses

XXXXAd Groups

XXXXBill-to Records

XXXXBillTo-PayFrom Roles

XBod Entity Mappings

XBod Field Mappings

XBod Types

XBod Type Versions

XCarrier Party

Classification Codes

XProduct Lookup Associations

ConfigCategories

ConfigCategoryProp

XXXXContact Bill-to Roles

XXXXMessengers

XXXXContact PayFrom Roles

XXXXShip-to Roles

XCustomer Returns
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DeleteEditCreateReadObject

XCustomer Return Lines

Custom

XXXXGoogle Campaigns

Inbound Messages

XInvoices

XInvoice Lines

XXXXKeywords

XXLoggers

XLookups

XLookup Categories

XMessage Sources

XMessage Source BOD Type Ver-
sions

Outbound Confirm BODs

Outbound Messages

XXOutbound Transactions

XXXXPay-from Records

Person

XPrice List

XXXXQuotes

XXXQuote Documents

XXXXQuote Line Items

XReceivables

XReceivable Lines

XSales Orders

XSales Order Addresses

XSales Order Line

XXXXSearch Phrases

XSerial Lots

XXXXSFGA Version

XShipments
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DeleteEditCreateReadObject

XShipment Lines

XXXXShip-to Records

XXXXShip-to Bill-to Roles

XShipto-Carrier Party Roles

XXXXSocial Media

XTerritories

XXXXText Ads

XTransaction Addresses

XUnit Groups

XUOM's

Recommended object permissions for Infor Back Office
Connect Administrator and Developer profiles
This table shows the recommended profile permissions for standard objects the Infor Back Office
Connect Administrator and Developer profiles:

DeleteEditCreateReadObject

XXXXAccounts

XXXXAssets

XXXXCampaigns

XXXCases

XXXXContacts

XXXXContracts

XXXXDocuments

XXXXIdeas

XXXXLeads

XXXXOpportunities

XXXXPrice Books

XXXXProducts

XXXXPush Topics
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DeleteEditCreateReadObject

XXXXQuotes

XXXXSolutions

This table shows the recommended profile permissions for custom Infor Back Office Connect objects
the Infor Back Office Connect Administrator and Developer profiles:

DeleteEditCreateReadObject

XXXXAccount Bill-to Roles

XXXXAccount Contact Relationships

XXXXAccounting Entity - Group Mappings

XXXXAccount Ship-to Roles

XXXXAddresses

XXXXAd Groups

XXXXBill-to Records

XXXXBillTo-PayFrom Roles

XXXXBod Entity Mappings

XXXXBod Field Mappings

XXXXBod Types

XXXXBod Type Versions

XXXXCarrier Party

XXXXClassification Codes

XXXXProduct Lookup Associations

XXXXConfigCategories

XXXXConfigCategoryProp

XXXXContact Bill-to Roles

XXXXMessengers

XXXXContact PayFrom Roles

XXXXShip-to Roles

XXXXCustomer Returns

XXXXCustomer Return Lines

XXXXCustom

XXXXGoogle Campaigns

XXXXInbound Messages
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DeleteEditCreateReadObject

XXXXInvoices

XXXXInvoice Lines

XXXXKeywords

XXXXLoggers

XXXXLookups

XXXXLookup Categories

XXXXMessage Sources

XXXXMessage Source BOD Type Ver-
sions

XXXXOutbound Confirm BODs

XXXXOutbound Messages

XXXXOutbound Transactions

XXXXPay-from Records

Person

XXXXPrice List

XXXXQuotes

XXXQuote Documents

XXXXQuote Line Items

XXXXReceivables

XXXXReceivable Lines

XXXXSales Orders

XXXXSales Order Addresses

XXXXSales Order Line

XXXXSearch Phrases

XXXXSerial Lots

XXXXSFGA Version

XXXXShipments

XXXXShipment Lines

XXXXShip-to Records

XXXXShip-to Bill-to Roles

XXXXShipto-Carrier Party Roles

274 | Infor Back Office Connect Administration Guide

Object permission settings for Infor Back Office Connect user profiles



DeleteEditCreateReadObject

XXXXSocial Media

XXXXTerritories

XXXXText Ads

XXXXTransaction Addresses

XXXXUnit Groups

XXXXUOM's
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CStandard object custom fields

The information in this appendix provides information on the custom fields that can be added to standard
Salesforce objects to support Infor Back Office Connect. Custom fields information is located in the
Custom Fields & Relationships section of the object you want to customize. See Salesforce
documentation.

Account object custom fields
This table shows custom fields that can be added to the standard Salesforce Account object to support
Infor Back Office Connect:

Controlling
Field

Data TypeAPI NameField NameField Label

Text (255)extaccountingentityid__cextaccountingentityidAccounting Entity
ID

PicklistActive__cActiveActive

Text (255)addresstype__caddresstypeAddress Type

Lookupareaid__careaidArea

Text (255)primaryaddressname__cprimaryaddressnameAttention of Name

Check boxHasOptedOut
OfBulkEmail__c

HasOptedOut
OfBulkEmail

Bulk Email Opt
Out

Checkboxcansendbod__ccansendbodCan Send Bod

Text (255)primaryaddresscity__cprimaryaddresscityCity

Text (255)primaryaddresscountry__cprimaryaddresscountryCountry

Numbercreditlimit__ccreditlimitCredit Limit

Text (255)extRecordId__cextRecordIdCustomer ID

PicklistCustomerPriority__cCustomerPriorityCustomer Priority
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Controlling
Field

Data TypeAPI NameField NameField Label

Lookupcustomertypeid__ccustomertypeidCustomer Type

Emailemail__cemailEmail

CheckboxHasOptedOutOfEmail__cHasOptedOutOfEmailEmail Opt Out

CheckboxHasOptedOutOfFax__cHasOptedOutOfFaxFax Opt Out

Lookupincotermid__cincotermidInco Term

Lookupindustryid__cindustryidIndustry

CheckboxInSync__cInSyncIn Sync

Text (255)primaryaddressline1__cprimaryaddressline1Line1

Text (255)primaryaddressline2__cprimaryaddressline2Line2

Text (255)primaryaddressline3__cprimaryaddressline3Line3

Text (255)primaryaddressline4__cprimaryaddressline4Line4

Text (255)primaryaddressline5__cprimaryaddressline5Line5

Text (255)primaryaddressline6__cprimaryaddressline6Line6

Text (255)locationid__clocationidLocation ID

Text (255)extlogicalid__cextlogicalidLogical ID

CheckboxHasOptedOutOfMail__cHasOptedOutOfMailMail Opt Out

Lookupmarketid__cmarketidMarket

LookupMessage_Source__cMessage_SourceMessage Source

Lookupnaicsid__cnaicsidNAICS

NumberNumberofLocations__cNumberofLocationsNumber of Loca-
tions

Phoneotherphone__cotherphoneOther Phone

Text (255)parentaccountextid__cparentaccoun
textid

parentaccoun
textid

Lookuppaymenttermid__cpaymenttermidPayment Term

CheckboxHasOptedOutOfPhone__cHasOptedOutOfPhonePhone Opt Out

PicklistPreferred_Contact_
Method__c

Preferred_Contact_
Method

Preferred Contact
Method

Account IDLookupprimaryaddress__cprimaryaddressPrimary Address

Lookupprimarycontact__cprimarycontactPrimary Contact
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Controlling
Field

Data TypeAPI NameField NameField Label

Lookupshipadrpricegroupid__cshipadrpricegroupidShip Address
Price Group

LookupSICCode__cSICCodeSIC Code

LookupSLA__cSLASLA

DateSLAExpirationDate__cSLAExpirationDateSLA Expiration
Date

Text (255)SLASerialNumber__cSLASerialNumberSLA Serial Num-
ber

Text (255)primaryaddressstate__cprimaryaddressstateState/Province

Pickliststatuscode__cstatuscodeStatus

Lookupterritory__cterritoryTerritory

Textextid__cextidUnique ID

PicklistUpsellOpportunity__cUpsellOpportunityUpsell Opportunity

NumbervariationId__cvariationIdVariation Id

Textprimaryaddress
postalcode__c

primaryaddress
postalcode

Zip/Postal Code

Contact object custom fields
This table shows custom fields that can be added to the standard Salesforce Contact object to support
Infor Back Office Connect:

Controlling
Field

Data TypeAPI NameField NameField Label

Text (255)extaccountingentityid__cextaccountingentityidAccounting Entity
ID

Lookupprimaryaddress__cprimaryaddressAddress

Text (255)addresstype__caddresstypeAddress Type

Text (255)primaryaddressname__cprimaryaddressnameAttention of Name

Checkboxcansendbod__ccansendbodcansendbod

Text (255)primaryaddresscity__cprimaryaddresscityCity

Text (255)extRecordId__cextRecordIdContact ID
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Controlling
Field

Data TypeAPI NameField NameField Label

Text (255)primaryaddresscountry__cprimaryaddresscountryCountry

Checkboxdonotmail__cdonotmailDo Not Mail

Text (255)extemprefid__cextemprefidEmployer Ref ID

Picklistgendercode__cgendercodeGender Code

Emailhomeemail__chomeemailHome Email

CheckboxInSync__cInSyncIn Sync

Text (255)jobtitle__cjobtitleJob Title

Text (255)Languages__cLanguagesLanguages

PicklistLevel__cLevelLevel

Text (255)primaryaddressline1__cprimaryaddressline1Line1

Text (255)primaryaddressline2__cprimaryaddressline2Line2

Text (255)primaryaddressline3__cprimaryaddressline3Line3

Text (255)primaryaddressline4__cprimaryaddressline4Line4

Text (255)primaryaddressline5__cprimaryaddressline5Line5

Text (255)primaryaddressline6__cprimaryaddressline6Line6

Text (255)locationid__clocationidLocation ID

Text (255)extlogicalid__cextlogicalidLogical ID

Picklistmaritalstatus__cmaritalstatusMarital Status

LookupMessage_Source__cMessage_SourceMessage Source

Text (255)middlename__cmiddlenameMiddle Name

Phonemobileoffice__cmobileofficeMobile Office

Text (255)nickname__cnicknameNick Name

Text (255)parentaccountextid__cparentaccoun
textid

Parent Account
ExtID

PicklistPreferred_Contact_
Method__c

Preferred_Contact_
Method

Preferred Contact
Method

Picklistpreferredemail__cpreferredemailPreferred Email

Picklistprimaryphone__cprimaryphonePrimary Phone

Text (255)primaryaddressstate__cprimaryaddressstateState/Province

Pickliststatuscode__cstatuscodeStatus
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Controlling
Field

Data TypeAPI NameField NameField Label

Text (255)extid__cextidUnique ID

Text (255)url__curlurl

NumbervariationId__cvariationIdVariation Id

URLWebsite__cWebsiteWebsite

Textprimaryaddress
postalcode__c

primaryaddress
postalcode

Zip/Postal Code

Leads object custom fields
This table shows custom fields that can be added to the standard Salesforce Leads object to support
Infor Back Office Connect:

Controlling
FieldData TypeAPI NameField NameField Label

Picklistaddresstype__caddresstypeAddress Type

Long Text
Area

SFGA__Correlation_
Data__c

Correlation_DataCorrelation Data

Text (255)SFGA__CorrelationID__cCorrelationIDCorrelationID

Text (100)CurrentGenerators__cCurrentGeneratorsCurrent Genera-
tor(s)

NumberNumberofLocations__cNumberofLocationsNumber of Loca-
tions

PicklistPrimary__cPrimaryPrimary

PicklistProductInterest__cProductInterestProduct Interest

Text (15)SICCode__cSICCodeSIC Code

Text (255)SFGA__Web_Source__cWeb_SourceWeb Source

Opportunities object custom fields
This table shows custom fields that can be added to the standard Salesforce Opportunities object to
support Infor Back Office Connect:
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Controlling
Field

Data TypeAPI NameField NameField Label

Text (100)CurrentGenerators__cCurrentGeneratorsCurrent Genera-
tor(s)

PicklistDeliveryInstallation
Status__c

DeliveryInstallation
Status

Delivery/Installa-
tion Status

Checkboxisystemopportunity__cisystemopportunityIs System Oppor-
tunity

Text (100)MainCompetitors__cMainCompetitorsMain Competi-
tor(s)

Text (8)OrderNumber__cOrderNumberOrder Number

LookupSyncedQuote__cSyncedQuoteSynced Quote

Text (12)TrackingNumber__cTrackingNumberTracking Number

Text (255)extid__cextidUnique ID

Products object custom fields
This table shows custom fields that can be added to the standard Salesforce Products object to support
Infor Back Office Connect:

Controlling
Field

Data TypeAPI NameField NameField Label

Text (255)extaccountingentityid__cextaccountingentityidAccounting Entity
Id

CurrencyBaseCost__cBaseCostBase Cost

Text (3)BaseCost_Currency__cBaseCost_CurrencyBase Cost Curren-
cy

Checkboxcansendbod__ccansendbodCan Send Bod

Lookupdefaultuomid__cdefaultuomidDefault Unit

CheckboxInSync__cInSyncIn Sync

TextlocationId__clocationIdLocation Id

Text (255)extlogicalid__cextlogicalidLogical Id

Text (255)extRecordId__cextRecordIdProduct ID

Checkboxserviceindicator__cserviceindicatorService Indicator
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Controlling
Field

Data TypeAPI NameField NameField Label

Pickliststatuscode__cstatuscodeStatus

Text (255)extId__cextIdUnique ID

Lookupdefaultuomscheduleid__cdefaultuomscheduleidUnit Group

Numbervariationid__cvariationidVariation Id

Quotes object custom fields
This table shows custom fields that can be added to the standard Salesforce Quote object to support
Infor Back Office Connect:

Controlling
Field

Data TypeAPI NameField NameField Label

Text (100)extaccountingentityid__cextaccountingentityidAccounting Entity
Id

Lookupbillto__cbilltoBill-to

Lookupbilltoaddress__cbilltoaddressBill-to Address

Formulabilltoline1__cbilltoline1Bill-to Line 1

Formulabilltoline2__cbilltoline2Bill-to Line 2

Formulabilltoline3__cbilltoline3Bill-to Line 3

Formulabilltoline4__cbilltoline4Bill-to Line 4

Formulabilltoline5__cbilltoline5Bill-to Line 5

Formulabilltoline6__cbilltoline6Bill-to Line 6

Text (255)billtoname__cbilltonameBill-to Name

Checkboxcansendbod__ccansendbodCan Send Bod

Text (50)carriercode__ccarriercodeCarrier Code

Text (100)carriername__ccarriernameCarrier Name

Text (255)department__cdepartmentDepartment

Date/Timeeffectivefrom__ceffectivefromEffective From

Currencytotalamount__ctotalamountERP Grand Total

Date/Timeexpireon__cexpireonExpire On

Currencyextendedamount__cextendedamountExtended Amount
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Controlling
Field

Data TypeAPI NameField NameField Label

Text (255)freighttermcode__cfreighttermcodeFreight Term
Code

CheckboxInSync__cInSyncIn Sync

Text (100)locationid__clocationidLocation ID

Text (255)extlogicalid__cextlogicalidLogical ID

Lookuppayfrom__cpayfromPay-from

Text (255)payfromcontactname__cpayfromcontactnamePay-from Contact
Name

Text (255)payfromname__cpayfromnamePay-from Name

Numberprobability__cprobabilityProbability

Text (255)extRecordId__cextRecordIdQuotes Id

Date/Timerequesteddeliveryby__crequesteddeliverybyRequested Deliv-
ery By

Text (255)rfqnumber__crfqnumberRFQ Number

Checkboxshipcompleteflag__cshipcompleteflagShip Complete
Flag

Formulashiptoline1__cshiptoline1Ship-to Line 1

Formulashiptoline2__cshiptoline2Ship-to Line 2

Formulashiptoline3__cshiptoline3Ship-to Line 3

Formulashiptoline4__cshiptoline4Ship-to Line 4

Formulashiptoline5__cshiptoline5Ship-to Line 5

Formulashiptoline6__cshiptoline6Ship-to Line 6

Text (255)shiptoname__cshiptonameShip-to Name

Lookupsoldtoaddress__csoldtoaddressSold-to Address

Formulasoldtoline1__csoldtoline1Sold-to Line 1

Formulasoldtoline2__csoldtoline2Sold-to Line 2

Formulasoldtoline3__csoldtoline3Sold-to Line 3

Formulasoldtoline4__csoldtoline4Sold-to Line 4

Formulasoldtoline5__csoldtoline5Sold-to Line 5

Formulasoldtoline6__csoldtoline6Sold-to Line 6

Text (255)soldtoname__csoldtonameSold-to Name
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Quote line item object custom fields
This table shows custom fields that can be added to the standard Salesforce Quote Line Item object
to support Infor Back Office Connect:

Controlling
Field

Data TypeAPI NameField NameField Label

Numberlinenumber__clinenumberERP Line Number

Currencytotalamount__ctotalamountERP Total
Amount

Lookupproductid__cproductidExisting Product
Name

Currencyextendedamount__cextendedamountExtended Amount

Currencyextendedcost__cextendedcostExtended Cost

Checkboxispriceoveridden__cispriceoveriddenIs Price Overidden

Text (255)ownershiptransfer__cownershiptransferOwnership Trans-
fer

Currencypriceperpriceunit__cpriceperpriceunitPrice Per Price
Unit

Text (10)priceperpriceuom__cpriceperpriceuomPrice Per Price
Uom

Currencypriceperunit__cpriceperunitPrice Per Unit

Numberprobability__cprobabilityProbability

Long Text
Area

productdescription__cproductdescriptionProduct Descrip-
tion

Date/Timepromisedshipdate__cpromisedshipdatePromised Ship
Date

Checkboxshipcompleteflag__cshipcompleteflagShip Complete
Flag

Text (50)shiptocity__cshiptocityShip-to City

Text (100)shiptocontactname__cshiptocontactnameShip-to Contact

Text (255)shiptocontactid__cshiptocontactidShip-to Contact Id

Text (50)shiptocountry__cshiptocountryShip-to Coun-
try/Region

Text (50)shiptoline1__cshiptoline1Ship-to Line 1

Text (50)shiptoline2__cshiptoline2Ship-to Line 2

Text (50)shiptoline3__cshiptoline3Ship-to Line 3
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Controlling
Field

Data TypeAPI NameField NameField Label

Text (50)shiptoline4__cshiptoline4Ship-to Line 4

Text (50)shiptoline5__cshiptoline5Ship-to Line 5

Text (50)shiptoline6__cshiptoline6Ship-to Line 6

Text (100)shiptolocation__cshiptolocationShip-to Location

Text (100)shiptoname__cshiptonameShip-to Name

Text (50)shiptostateorprovince__cshiptostateorprovinceShip-to
State/Province

Text (20)shiptopostalcode__cshiptopostalcodeShip-to Zip/Postal
Code

Pickliststatuscode__cstatuscodeStatus

Currencytax__ctaxTax

Lookupuomid__cuomidUnit

Text (50)warehousecity__cwarehousecityWarehouse City

Text (255)warehousecode__cwarehousecodeWarehouse Code

Text (100)warehousecontact
name__c

warehousecontactnameWarehouse Con-
tact Name

Text (50)warehousecountry__cwarehousecountryWarehouse Coun-
try/Region

Text (50)warehouseline1__cwarehouseline1Warehouse Line 1

Text (50)warehouseline2__cwarehouseline2Warehouse Line 2

Text (50)warehouseline3__cwarehouseline3Warehouse Line 3

Text (50)warehouseline4__cwarehouseline4Warehouse Line 4

Text (50)warehouseline5__cwarehouseline5Warehouse Line 5

Text (50)warehouseline6__cwarehouseline6Warehouse Line 6

Text (100)warehouselocation__cwarehouselocationWarehouse Loca-
tion

Text (100)warehousename__cwarehousenameWarehouse Name

Text (50)warehousestateor
province__c

warehousestateor
province

Warehouse
State/Province

Text (20)warehousepostalcode__cwarehousepostalcodeWarehouse
Zip/Postal Code
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Controlling
Field

Data TypeAPI NameField NameField Label

Text (100)writeinproduct__cwriteinproductWrite-In Product
Name
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DCustom objects and tabs

The information in this appendix provides information on Infor Back Office Connect custom objects and
tabs. Including their definition details, standard fields, and custom fields and relationships.

Custom objects
Custom objects are managed objects installed with the Infor Back Office Connect package to enable
Infor Back Office Connect functionality.

Caution: Making modifications to Infor Back Office Connect custom objects can prevent Infor
Back Office Connect from working properly.

To view a list of all Infor Back Office Connect custom objects:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, select App Setup > Create > Objects.
5 View the list of custom objects. In the Installed Package column, Infor Back Office Connect is

displayed for all Infor Back Office Connect custom objects.
6 Optionally, in the Label column, click the custom object hyperlink to view the custom object definition

detail for an object. For example, click BOD Entity Mapping. See also "Custom object definition
details" on page 291.

Controlled custom objects
A number of the Infor Back Office Connect custom objects controlled custom objects used to Infor ION
with ERP. These controlled custom objects must not be modified without assistance from Infor customer
support. This is a list of all the Infor Back Office Connect controlled custom objects:

• Bod Entity Mapping
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• Bod Field Mapping
• Bod Type
• Bod Type Version
• Carrier Party
• Classification Code
• ConfigCategory
• ConfigCategoryProp
• Contact Messenger
• Message Source
• Message Source BOD Type Version
• Person
• Price List
• Serial Lot
• Shipto-Carrier Party Role
• Social Media
• Transaction Address
• Unit Group
• UOM
• Warehouse

Account contact role and address sync
Account Contact Role and Address Sync keeps standard object data in sync with data in Infor Back
Office Connect custom objects.

Address custom object
The Address custom object supports multiple addresses. The primary address is stored in the Account,
Contact, Bill-to, Pay-from and Ship-to. All additional addresses are stored in the custom Address object.

Account contact role custom object
The Account Contact role custom object supports ERP integration requirements. To support existing
reporting, data stored in custom Account Contact Role object records is copied to the standard Account
Contact Role object record whenever the back office adds or updates the custom Account Contact
Role record.
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Custom tabs
Custom tabs display Infor Back Office Connect custom object data. Infor Back Office Connect are
created in the Salesforce application during the Infor Back Office Connect installation. Infor Back Office
Connect tabs are enabled and disabled based on the privileges assigned to each Infor Back Office
Connect user based on their associated profile configuration. See "Creating Infor Back Office Connect
profiles" on page 21.

To view a list of all Infor Back Office Connect custom tabs:

1 Log in to Salesforce as the Infor Back Office Connect administrator.
2 In the Force.com App menu, select Infor Back Office Connect Administration.
3 Select Setup.
4 In the sidebar column, select App Setup > Create > Tabs.
5 View the list of custom object tabs.
6 Optionally, in the Label column, click the custom object hyperlink to view the custom tab definition

detail for a tab.

Custom object definition details
The custom object definitions in this section provide information on the Infor Back Office Connect
custom objects that can be useful during the BOD field mapping and customization process. You can
also view more information about each custom object in the Infor Back Office Connect application. See
"Custom objects" on page 289.

Note:  Retired custom objects are denoted by the zz_ prefix at the beginning of the object name. For
example, zz_Account Bill-to Role.

Retired custom objects must be updated on the page layouts and reports by the Infor Back Office
Connect Administrator.

Account Contact Relationship object
This table shows the Custom Object Definition Details for the Account Contact Relationship object:

Definition DetailCustom Object

Account Contact RelationshipSingular Label

Account Contact RelationshipsPlural Label

AccountContactRoleObject Name

AccountContactRole__cAPI Name
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This table shows the standard fields on the Account Contact Relationship object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNameReference #

This table shows the custom fields and relationships on the Account Contact Relationship object:

Data TypeAPI NameField NameField Label

Master-Detail(Account)account__caccountAccount

Master-Detail(Account)contact__ccontactContact

Formula (Text)employeraccount__cemployeraccountEmployer Account

CheckboxisPrimary__cisPrimaryIs Primary

PicklistRole__cRoleRole

Accounting Entity Table object
This object is installed with the Multi-company reference package. This table shows the Custom Object
Definition Details for the Accounting Entity Table object:

Definition DetailCustom Object

Accounting Entity TableSingular Label

Accounting Entity TablesPlural Label

aegrpmappingObject Name

aegrpmapping__cAPI Name

This table shows the standard fields on the Accounting Entity Table object:

Data TypeField NameField Label

Auto NumberNameAccounting Entity Name

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User,Queue)OwnerOwner
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This table shows the custom fields and relationships on the Accounting Entity Table object:

Data TypeAPI NameField NameField Label

Text(255)accountingentityid__caccountingentityidAccounting Entity ID

Formula(Text)compositeKey__ccompositekeyComposite Key

Text(255)locationid__clocationidLocation ID

Lookup(User)owner__cownerOwner

Address object
This table shows the Custom Object Definition Details for the Address object:

Definition DetailCustom Object

AddressSingular Label

AddressesPlural Label

addressObject Name

address__cAPI Name

This table shows the standard fields on the Address object:

Data TypeField NameField Label

Auto NumberNameAddress Name

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User,Queue)OwnerOwner

This table shows the custom fields and relationships on the Address object:

Data TypeAPI NameField NameField Label

Lookup(Account)Account__cAccountAccount

Picklistaddresstype__caddresstypeAddress Type

Text(255)attentionofname__cattentionofnameAttention of Name

Lookup(Bill-to)billto__cbilltoBill To

Text(255)city__ccityCity

Lookup(Contact)contact__ccontactContact
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Data TypeAPI NameField NameField Label

Text(255)country__ccountryCountry

Checkboxisprimaryaddress__cisprimaryaddressIs Primary Address

Lookup(Pay-from)payfrom__cpayfromPay From

Lookup(Ship-to)Shipto__cShiptoShip To

Text(100)stateorprovince__cstateorprovinceState/Province

Text Area(255)street__cstreetStreet

Text (255)postalcode__cpostalcodeZip/Postal Code

Text(255)line1__cline1zz_Line 1

Text(255)line2__cline2zz_Line 2

Text(255)line3__cline3zz_Line 3

Text(255)line4__cline4zz_Line 4

Text(255)line5__cline5zz_Line 5

Text(255)line6__cline6zz_Line 6

Message Source object
This table shows the Custom Object Definition Details for the Message Source object:

Definition DetailCustom Object

Message SourceSingular Label

Message SourcesPlural Label

messagesourceObject Name

messagesource__cAPI Name

This table shows the standard fields on the Message Source object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameMessage Source Name

Lookup(User, Queue)OwnerOwner
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This table shows the custom fields and relationships on the Message Source object:

Data TypeAPI NameField NameField Label

Text(255)defaultexternalaccountin-
gentityid__c

defaultexternalaccountingen-
tityid

Default Accounting
Entity ID

Text(255)defaultexternallocation-
id__c

defaultexternallocationidDefault Location ID

Text(255)entityacronym__centityacronymEntity Acronym

Long Text
Area(32768)

entitytype__centitytypeEntity Type

CheckboxisActive__cisActiveisActive

Text(255)logicalid__clogicalidLogical ID

Text(255) (External
ID) (Unique Case In-
sensitive)

sequenceid__csequenceidSequence Id

URL(255)messagesourceurl__cmessagesourceurlURL

Message Source BOD Type Versions object
This table shows the Custom Object Definition Details for the Message Source BOD Type Versions
object:

Definition DetailCustom Object

Message Source BOD Type VersionSingular Label

Message Source BOD Type VersionsPlural Label

msgsrcbodtypeversionObject Name

msgsrcbodtypeversion__cAPI Name

This table shows the standard fields on the Message Source BOD Type Versions object:

Data TypeField NameField Label

Lookup (User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup (User)LastModifiedByLast Modified By

Auto NumberNameMessage Source BOD Type Ver-
sion Name
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This table shows the custom fields and relationships on the Message Source BOD Type Versions
object:

Data TypeAPI NameField NameField Label

Master-Detailbodtypeversion__cbodtypeversionBod Type Version

Master-Detailmessagesource__cmessagesourceMessage Source

Text (255)sequenceid__csequenceidSequence Id

Bill-to object
This table shows the Custom Object Definition Details for the Bill-to object:

Definition DetailCustom Object

Bill-toSingular Label

Bill-to RecordsPlural Label

billtoObject Name

billto__cAPI Name

This table shows the standard fields on the Bill-to object:

Data TypeField NameField Label

Text(80)NameBill-to Name

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User,Queue)OwnerOwner

This table shows the custom fields and relationships on the Bill-to object:

Data TypeAPI NameField NameField Label

Lookup(Account)Account__caccountAccount

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Text(255)primaryaddressname__cprimaryaddressnameAttention of Name

Lookup(Message
Source)

Message_Source__cMessage_SourceMessage Source

Text(255)extRecordId__cextRecordIdBill-to ID

Checkboxcansendbod__ccansendbodCan Send Bod
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Data TypeAPI NameField NameField Label

Text(255)carriername__ccarriernameCarrier Name

Text(255)carriernumber__ccarriernumberCarrier Number

Text(255)primaryaddresscity__cprimaryaddresscityCity

Text(255)primaryaddresscountry__cprimaryaddresscountryCountry

Emailemail__cemailEmail

Phonefax__cfaxFax

CheckboxInSync__cInSyncIn Sync

Text(255)locationid__clocationidLocation ID

Text(255)extlogicalid__cextlogicalidLogical ID

Phoneotherphone__cotherphoneOther Phone

Lookup(Lookup)paymenttermid__cpaymenttermidPayment Term

Phonemainphone__cmainphonePrimary Phone

Lookup(Ship-to)shipto__cshiptoShip-to

Lookup(Lookup)SICCode__cSICCodeSIC Code

Text(100)primaryaddressstate__cprimaryaddressstateState/Province

Pickliststatuscode__cstatuscodeStatus

Long Text Area(256)primaryaddressstreet__cprimaryaddressstreetStreet

Text(255) (External
ID) (Unique Case In-
sensitive)

extid__cextidUnique ID

Number(18, 0)variationId__cvariationIdVariation Id

URL(255)website__cwebsiteWeb Site

Text(255)primaryaddresspostal
code__c

primaryaddresspostalcodeZip/Postal Code

Text(255)addresstype__caddresstypezz_Address Type

Text(255)primaryaddressline1__cprimaryaddressline1zz_Bill-to Line 1

Text(255)primaryaddressline2__cprimaryaddressline2zz_Bill-to Line 2

Text(255)primaryaddressline3__cprimaryaddressline3zz_Bill-to Line 3

Text(255)primaryaddressline4__cprimaryaddressline4zz_Bill-to Line 4

Text(255)primaryaddressline5__cprimaryaddressline5zz_Bill-to Line 5

Text(255)primaryaddressline6__cprimaryaddressline6zz_Bill-to Line 6

Lookup(Address)primaryaddress__cprimaryaddresszz_Primary Address
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Data TypeAPI NameField NameField Label

Lookup(Contact)primarycontactid__cprimarycontactidzz_Primary Contact

Bod Entity Mapping object
This table shows the Custom Object Definition Details for the Bod Entity Mapping object:

Definition DetailCustom Object

Bod Entity MappingSingular Label

Bod Entity MappingsPlural Label

bodentitymappingObject Name

bodentitymapping__cAPI Name

This table shows the standard fields on the Bod Entity Mapping object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Auto NumberNameID

Lookup(User)LastModifiedByLast Modified By

Lookup(User,Queue)OwnerOwner

This table shows the custom fields and relationships on the Bod Entity Mapping object:

Data TypeAPI NameField NameField Label

CheckboxisActive__cisActiveActive

Lookup(Message
Source)

messagesource__cmessagesourceMessage Source

Text(255)bodentitymappingname__cbodentitymappingnameBod Entity Mapping
Name

Text(255)bodnoun__cbodnounBOD Noun

Long Text
Area(5000)

condition__cconditionBOD Trigger Condi-
tion

Picklist(Multi-Select)triggerevent__ctriggereventBOD Trigger Event

Lookup(Bod Type)bodtype__cbodtypeBod Type

Lookup(Bod Type
Version)

bodtypeversionid__cbodtypeversionidBod Type Version
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Data TypeAPI NameField NameField Label

Text(255)crmentityname__ccrmentitynameCRM Entity Name

Text(3)entityacronym__centityacronymEntity Acronym

Text(255)handlerClass__chandlerClassHandler Class Name

CheckboxisCustom__cisCustomIs Custom

Text(255)keyfields__ckeyfieldsKey Fields

Text(255)parentcrmentityname__cparentcrmentitynameParent CRM Entity
Name

Text(255)refencefield__crefencefieldReference Field

Text(255) (External
ID) (Unique Case
Insensitive)

sequenceid__csequenceidSequence Id

Checkboxsharable__csharableSharable

PicklistsyncDirection__csyncDirectionSync Direction

Bod Field Mapping object
This table shows the Custom Object Definition Details for the Bod Field Mapping object:

Definition DetailCustom Object

Bod Field MappingSingular Label

Bod Field MappingsPlural Label

bodfieldmappingObject Name

bodfieldmapping__cAPI Name

This table shows the standard fields on the Bod Field Mapping object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Auto NumberNameID

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Bod Field Mapping object:
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Data TypeAPI NameField NameField Label

CheckboxisActive__cisActiveActive

Text(255)bodfieldmappingname__cbodfieldmappingnameBod Field Mapping
Name

Lookupbodtypeversion__cbodtypeversionBod Type Version

Text(255)bodxpath__cbodxpathBOD Xpath

Text(255)crmattributename__ccrmattributenameCRM Attribute Name

Text(255)crmentityname__ccrmentitynameCRM Entity Name

Text(255)defaultvalue__cdefaultvalueDefault Value

PicklistdataType__cdataTypeField Type

CheckboxisCustom__cisCustomIs Custom

CheckboxisSystem__cisSystemIs System

Checkboxiskeyattribute__ciskeyattributeKey Attribute

CheckboxisMandatory__cisMandatoryMandatory Flag

Text(80)relatedObjApiName__crelatedObjApiNameRelated Object Api
Name

Long Text
Area(32768)

repeatedElements__crepeatedElementsRepeated Elements

Text(255) (External
ID) (Unique Case In-
sensitive)

sequenceid__csequenceidSequence Id

Bod Type object
This table shows the Custom Object Definition Details for the Bod Type object:

Definition DetailCustom Object

Bod TypeSingular Label

Bod TypesPlural Label

Bod_TypeObject Name

Bod_Type__cAPI Name

This table shows the standard fields on the Bod Type object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By
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Data TypeField NameField Label

PicklistCurrencyIsoCodeCurrency

Auto NumberNameID

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Bod Type object:

Data TypeAPI NameField NameField Label

CheckboxisActive__cisActiveActive

Text(255)bodtypename__cbodtypenameBod Type Name

Checkboxiscustom__ciscustomIs Custom

Text(255)noun__cnounNoun

Text(255) (External ID)
(Unique Case Insensi-
tive)

sequenceId__csequenceIdSequence Id

Text(255)verb__cverbVerb

Bod Type Version object
This table shows the Custom Object Definition Details for the Bod Type Version object:

Definition DetailCustom Object

Bod Type VersionSingular Label

Bod Type VersionsPlural Label

bodtypeversionObject Name

bodtypeversion__cAPI Name

This table shows the standard fields on the Bod Type Version object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Auto NumberNameID

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner
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This table shows the custom fields and relationships on the Bod Type Version object:

Data TypeAPI NameField NameField Label

CheckboxisActive__cisActiveActive

Text(255)bodreleaseid__cbodreleaseidBod Release Id

Lookup(Bod Type)bodtypeid__cbodtypeidBod Type

Text(255)bodtypeversionname__cbodtypeversionnameBod Type Version
Name

Text(255)bodversionid__cbodversionidBod Version Id

Checkboxiscustom__ciscustomIs Custom

Lookup(Message
Source)

messagesourceid__cmessagesourceidMessage Source

Text(255) (External
ID) (Unique Case In-
sensitive)

sequenceId__csequenceIdSequence Id

Classification Code object
This table shows the Custom Object Definition Details for the Classification Code object:

Definition DetailCustom Object

Classification CodeSingular Label

Product Lookup AssociationsPlural Label

productlookupassociationObject Name

productlookupassociation__cAPI Name

This table shows the standard fields on the Classification Code object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNameProduct Lookup Name

This table shows the custom fields and relationships on the Classification Code object:

Data TypeAPI NameField NameField Label

Formula (Text)lookupcategory__clookupcategoryClassification Name
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Data TypeAPI NameField NameField Label

Master De-
tail(Lookup)

lookup__clookupClassification Value

Lookup(Product)product__cproductProduct

ConfigCategory object
This table shows the Custom Object Definition Details for the ConfigCategory object:

Definition DetailCustom Object

ConfigCategorySingular Label

ConfigCategoriesPlural Label

ConfigCategoryObject Name

ConfigCategory__cAPI Name

This table shows the standard fields on the ConfigCategory object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Auto NumberNameID

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the ConfigCategory object:

Data TypeAPI NameField NameField Label

Text(200) (Unique
Case Insensitive)

CategoryName__cCategoryNameCategoryName

Lookup(ConfigCatego-
ry)

parent_id__cparent_idParent Category

ConfigCategoryProp object
This table shows the Custom Object Definition Details for the ConfigCategoryProp object:
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Definition DetailCustom Object

ConfigCategoryPropSingular Label

ConfigCategoryPropPlural Label

ConfigCategoryPropObject Name

ConfigCategoryProp__cAPI Name

This table shows the standard fields on the ConfigCategoryProp object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Auto NumberNameId

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the ConfigCategoryProp object:

Data TypeAPI NameField NameField Label

Lookup(ConfigCatego-
ry)

ConfigCategory__cConfigCategoryConfigCategory

Text(200) (Unique
Case Insensitive)

prop_name__cprop_nameProperty Name

Text(200)prop_value__cprop_valueProperty Value

Contact Bill-to Role object
This table shows the Custom Object Definition Details for the Contact Bill-to Role object:

Definition DetailCustom Object

Contact Bill-to RoleSingular Label

Contact Bill-to RolesPlural Label

contactbilltoroleObject Name

contactbilltorole__cAPI Name

This table shows the standard fields on the Contact Bill-to Role object:
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Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Auto NumberNameID

Lookup(User)LastModifiedByLast Modified By

This table shows the custom fields and relationships on the Contact Bill-to Role object:

Data TypeAPI NameField NameField Label

Master-Detail(Bill-to)billto__cbilltoBill-to

Master-Detail(Contact)Contact__cContactContact

CheckboxisPrimary__cisPrimaryPrimary Contact

Picklistrole__croleRole

Contact Messenger object
This table shows the Custom Object Definition Details for the Contact Messenger object:

Definition DetailCustom Object

Contact MessengerSingular Label

MessengersPlural Label

contactmessengerObject Name

contactmessenger__cAPI Name

This table shows the standard fields on the Contact Messenger object:

Data TypeField NameField Label

Auto NumberNameContact Messenger Name

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

This table shows the custom fields and relationships on the Contact Messenger object:

Data TypeAPI NameField NameField Label

Master-Detail(Contact)Contact__cContactContact

Picklistmessengertype__cmessengertypeMessenger Type
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Data TypeAPI NameField NameField Label

Text(255)uri__curiURI

Contact PayFrom Role object
This table shows the Custom Object Definition Details for the Contact PayFrom Role object:

Definition DetailCustom Object

Contact PayFrom RoleSingular Label

Contact PayFrom RolesPlural Label

contactpayfromroleObject Name

contactpayfromrole__cAPI Name

This table shows the standard fields on the Contact PayFrom Role object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNameName

This table shows the custom fields and relationships on the Contact PayFrom Role object:

Data TypeAPI NameField NameField Label

Master-Detail(Contact)Contact__cContactContact

Master-Detail(Pay-
from)

payfrom__cpayfromPay From

CheckboxisPrimary__cisPrimaryPrimary Contact

Picklistrole__croleRole

Contact Shipto Role object
This table shows the Custom Object Definition Details for the Contact Shipto Role object:

Definition DetailCustom Object

Contact Shipto RoleSingular Label
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Definition DetailCustom Object

Contact Ship-to RolesPlural Label

shiptocontactroleObject Name

shiptocontactrole__cAPI Name

This table shows the standard fields on the Contact Shipto Role object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Auto NumberNameID

Lookup(User)LastModifiedByLast Modified By

This table shows the custom fields and relationships on the Contact Shipto Role object:

Data TypeAPI NameField NameField Label

Master-Detail(Contact)Contact__cContactContact

CheckboxisPrimary__cisPrimaryPrimary Contact

Picklistrole__croleRole

Master-Detail(Ship-to)Shipto__cShiptoShip-to

Customer Return object
This table shows the Custom Object Definition Details for the Customer Return object:

Definition DetailCustom Object

Customer ReturnSingular Label

Customer ReturnsPlural Label

customerreturnObject Name

customerreturn__cAPI Name

This table shows the standard fields on the Customer Return object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Text(80)NameCustomer Return Name
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Data TypeField NameField Label

Lookup(User)LastModifiedByLast Modified By

This table shows the custom fields and relationships on the Customer Return object:

Data TypeAPI NameField NameField Label

Text(100)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Lookup(Bill-to)billto__cbilltoBill-to

Text(100)billtocity__cbilltocityBill-to City

Formula (Text)billto_contactname__cbillto_contactnameBill-to Contact Name

Text(100)billtocountry__cbilltocountryBill-to Country

Text(255)billtoname__cbilltonameBill-to Name

Text(100)billtostate__cbilltostateBill-to State

Long Text Area(256)billtostreet__cbilltostreetBill-to Street

Text(100)billtozip__cbilltozipBill-to Zip

Checkboxcansendbod__ccansendbodCan Send Bod

Text(50)carriercode__ccarriercodeCarrier Code

Text(100)carriername__ccarriernameCarrier Name

Text(100)custordernumber__ccustordernumberCustomer Order
Number

Text(255)extRecordId__cextRecordIdCustomer Return Id

Currency(16, 2)extendedamount__cextendedamountExtended Amount

Text(100)extlocationid__cextlocationidExt Location ID

Lookup(Lookup)incotermid__cincotermidInco Term

CheckboxInSync__cInSyncIn Sync

Text(100)locationid__clocationidLocation ID

Text(50)ownershiptransfer__cownershiptransferOwnership Transfer

Text(50)paymentmethod__cpaymentmethodPayment Method

Lookup(Lookup)paymenttermid__cpaymenttermidPayment Term

Text(255)pricebook__cpricebookPrice List

Date/Timepromisereturndate__cpromisereturndatePromise Return date

Master-Detail(Ac-
count)

account__caccountSold-to

Text(100)soldtocity__csoldtocitySold-to City
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Data TypeAPI NameField NameField Label

Formula (Text)soldto_contactname__csoldto_contactnameSold-to Contact
Name

Text(255)soldtoname__csoldtonameSold-to Name

Text(100)soldtostate__csoldtostateSold-to State

Long Text Area(256)soldtostreet__csoldtostreetSold-to Street

Text(100)soldtozip__csoldtozipSold-to Zip

Text(100)extsourceid__cextsourceidSource ID

Pickliststatuscode__cstatuscodeStatus

Text(100) (External
ID) (Unique Case In-
sensitive)

extid__cextidUnique ID

Number(18, 0)variationid__cvariationidVariation Id

Lookup(zz_Transac-
tion Address)

billtoaddress__cbilltoaddresszz_Bill-to Address

Formula (Text)billtocity__cbilltocityzz_Bill-to City

Formula (Text)billtocountry__cbilltocountryzz_Bill-to Country

Formula (Text)billtoline1__cbilltoline1zz_Bill-to Line 1

Formula (Text)billtoline2__cbilltoline2zz_Bill-to Line 2

Formula (Text)billtoline3__cbilltoline3zz_Bill-to Line 3

Formula (Text)billtoline4__cbilltoline4zz_Bill-to Line 4

Formula (Text)billtoline5__cbilltoline5zz_Bill-to Line 5

Formula (Text)billtoline6__cbilltoline6zz_Bill-to Line 6

Formula (Text)billtostateorprovince__cbilltostateorprovincezz_Bill-to
State/Province

Formula (Text)billtopostalcode__cbilltopostalcodezz_Bill-to Zip/Postal
Code

Lookup(zz_Transac-
tion Address)

soldtoaddress__csoldtoaddresszz_Sold-to Address

Formula (Text)soldtocity__csoldtocityzz_Sold-to City

Formula (Text)soldtocountry__csoldtocountryzz_Sold-to Country

Formula (Text)soldtoline1__csoldtoline1zz_Sold-to Line 1

Formula (Text)soldtoline2__csoldtoline2zz_Sold-to Line 2

Formula (Text)soldtoline3__csoldtoline3zz_Sold-to Line 3
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Data TypeAPI NameField NameField Label

Formula (Text)soldtoline4__csoldtoline4zz_Sold-to Line 4

Formula (Text)soldtoline5__csoldtoline5zz_Sold-to Line 5

Formula (Text)soldtoline6__csoldtoline6zz_Sold-to Line 6

Formula (Text)soldtostateorprovince__csoldtostateorprovincezz_Sold-to
State/Province

Formula (Text)soldtopostalcode__csoldtopostalcodezz_Sold-to Zip/Postal
Code

Customer Return Line object
This table shows the Custom Object Definition Details for the Customer Return Line object:

Definition DetailCustom Object

Customer Return LineSingular Label

Customer Return LinesPlural Label

customerreturnlineObject Name

customerreturnline__cAPI Name

This table shows the standard fields on the Customer Return Line object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Text(80)NameCustomer Return Line Number

Lookup(User)LastModifiedByLast Modified By

This table shows the custom fields and relationships on the Customer Return Line object:

Data TypeAPI NameField NameField Label

Text(100)extaccountingentityid__cextaccountingentityidAccounting Entity

Text(50)carriercode__ccarriercodeCarrier Code

Text(100)carriername__ccarriernameCarrier Name

Master-Detail(Cus-
tomer Return)

customerreturn__ccustomerreturnCustomer Return

Formula (Text)documentNumber__cdocumentNumberDocument Number
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Data TypeAPI NameField NameField Label

Lookup(Product)productid__cproductidExisting Product

Currency(16, 2)extendedamount__cextendedamountExtended Amount

Lookup(Lookup)incotermid__cincotermidInco Term

Number(18, 0)lineitemnumber__clineitemnumberLine Item Number

Text(100)locationid__clocationidLocation Id

Long Text
Area(32000)

note2__cnote2Note

Text(100)note__cnoteNote

Text(200)ownershiptransfer__cownershiptransferOwnership Transfer

Lookup(Lookup)paymenttermid__cpaymenttermidPayment Term

Currency(16, 2)priceperpriceunit__cpriceperpriceunitPrice Per Price Unit

Text(20)priceperpriceuom__cpriceperpriceuomPrice Per Price Uom

Currency(16, 2)priceperunit__cpriceperunitPrice Per Unit

Long Text
Area(1024)

productdescription__cproductdescriptionProduct Description

Number(16, 2)quantity__cquantityQuantity

Date/Timerequireddeliverydate__crequireddeliverydateRequired Delivery
Date

Picklistisproductoverridden__cisproductoverriddenSelect Product

Text(50)shipto_locationcode__cshipto_locationcodeShip-to Location

Text(100)shipto_locationname__cshipto_locationnameShip-to Location
Name

Pickliststatuscode__cstatuscodeStatus

Lookup(UOM)uomid__cuomidUOM

Text(100)writeinproduct__cwriteinproductWrite-In Product

Inbound Message object
This table shows the Custom Object Definition Details for the Inbound Message object:

Definition DetailCustom Object

Inbound MessageSingular Label

Inbound MessagesPlural Label
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Definition DetailCustom Object

ioninboundmessageObject Name

ioninboundmessage__cAPI Name

This table shows the standard fields on the Inbound Message object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameMessage ID

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Inbound Message object:

Data TypeAPI NameField NameField Label

Long Text
Area(32000)

bodxml__cbodxmlBod Xml

Long Text
Area(2000)

errormessage__cerrormessageError Message

Long Text
Area(32000)

headerxml__cheaderxmlHeader Xml

Number(1, 0)markedasprocessed__cmarkedasprocessedMarked As Pro-
cessed

Number(5, 0)messagepriority__cmessagepriorityMessage Priority

Text(255)messagetype__cmessagetypeMessage Type

Picklistprocessingstatus__cprocessingstatusProcessing Status

Text(20)relatedloggerId__crelatedloggerIdRelated logger

Formula (Text)relatedloggerurl__crelatedloggerurlRelated Logger URL

Text(100)relatedrecordextId__crelatedrecordextIdRelated Record Ex-
tId

Text(100)relatedrecordsfid__crelatedrecordsfidRelated Record SFId

Formula (Text)relatedrecordurl__crelatedrecordurlRelated Record URL

Number(5, 0)retrycount__cretrycountRetry Count

Number(18, 0)wasprocessed__cwasprocessedWas Processed
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Infor quote object
This table shows the Custom Object Definition Details for the Infor Quote object:

Definition DetailCustom Object

Infor quoteSingular Label

Infor QuotesPlural Label

quoteObject Name

quote__cAPI Name

This table shows the standard fields on the Infor quote object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

Text(80)NameQuote Name

Record TypeRecordTypeRecord Type

This table shows the custom fields and relationships on the Infor Quote object:

Data TypeAPI NameField NameField Label

Text(100)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Lookup(Account)account__caccountAccount Name

Text(255)additionaltocity__cadditionaltocityAdditional-to City

Text(255)additionaltocountry__cadditionaltocountryAdditional-to Country

Text(255)additionaltoname__cadditionaltonameAdditional-to Name

Text(255)additionaltostateor-
province__c

additionaltostateorprovinceAdditional-to
State/Province

Text Area(255)additionaltostreet__cadditionaltostreetAdditional-to Street

Text(255)additionaltopostalcode__cadditionaltopostalcodeAdditional-to
Zip/Postal Code

Lookup(Bill-to)billto__cbilltoBill-to

Text(100)billtocity__cbilltocityBill-to City

Lookup(Contact)billto_contactid__cbillto_contactidBill-to Contact

Formula (Text)billto_contactname__cbillto_contactnameBill-to Contact Name
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Data TypeAPI NameField NameField Label

Text(100)billtocountry__cbilltocountryBill-to Country

Text(255)billtoname__cbilltonameBill-to Name

Text(255)billtopostalcode__cbilltopostalcodeBill-to Postal Code

Text(255)billtostateorprovince__cbilltostateorprovinceBill-to State/Province

Long Text Area(256)billtostreet__cbilltostreetBill-to Street

Checkboxcansendbod__ccansendbodCan Send Bod

Text(50)carriercode__ccarriercodeCarrier Code

Text(100)carriername__ccarriernameCarrier Name

Lookup(Contract)contact__ccontactContact Name

Text(255)department__cdepartmentDepartment

Long Text
Area(32000)

description__cdescriptionDescription

Date/Timeeffectivefrom__ceffectivefromEffective From

Emailemail_cemailEmail

Currency(16, 2)erpextendedamount__cerpextendedamountERP Extended
Amount

Currency(16, 2)totalamount__ctotalamountERP Grand Total

Pickliststatuscode__cstatuscodeERP Status

Formula (Currency)erptax__cerptaxERP Tax

Formula (Percent)erptaxpercent__cerptaxpercentERP Tax %

Dateexpirationdate__cexpirationdateExpiration Date

Date/Timeexpireon__cexpireonExpire On

Text(255)externalsalesrepcode__cexternalsalesrepcodeExternal Sales Rep
Code

Text(255)externalsalesrepname__cexternalsalesrepnameExternal Sales Rep
Name

Phonefax_cfaxFax

Text(255)freighttermcode__cfreighttermcodeFreight Term Code

Formula (Currency)globaldiscount__cglobaldiscountGlobal Discount

Percent(3, 2)discount__cdiscountGlobal Discount %

Formula (Currency)grandtotal__cgrandtotalGrand Total

Lookup(Lookup)incotermid__cincotermidInco Term
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Data TypeAPI NameField NameField Label

CheckboxInSync__cInSyncIn Sync

Text(255)internalsalesrepcode__cinternalsalesrepcodeInternal Sales Rep
Code

Text(255)internalsalesrepname__cinternalsalesrepnameInternal Sales Rep
Name

Roll-Up Summary
(COUNT Infor quote
Line Item)

lineitemcount__clineitemcountLine Items Count

Text(100)locationid__clocationidLocation ID

Text(255)logicalid__clogicalidLogical ID

Formula (Currency)totalprice__ctotalpriceNet Price

Lookup(Opportunity)opportunity__copportunityOpportunity Name

Phoneotherphone__cotherphoneOther Phone

Lookup(Pay-from)payfrom__cpayfromPay-from

Text(255)payfromcity__cpayfromcityPay-from City

Lookup(Contact)payfromcontactid__cpayfromcontactidPay-from Contact

Text(255)payfromcontactname__cpayfromcontactnamePay-from Contact
Name

Text(255)payfromcountry__cpayfromcountryPay-from Country

Text(255)payfromname__cpayfromnamePay-from Name

Text(255)payfrompostalcode__cpayfrompostalcodePay-from Postal
Code

Text(255)payfromstateorprovince__cpayfromstateorprovincePay-from
State/Province

Text(255)payfromstreet__cpayfromstreetPay-from Street

Lookup(Lookup)paymenttermid__cpaymenttermidPayment Term

Text(20)pricebook2ld__cpricebook2ldPricebook2ld

Text(255)pricebook2Name__cpricebook2NamePrice Book Name

Number(16, 2)probability__cprobabilityProbability

Text(255)extRecordId__cextRecordIdQuote Id

Long Text
Area(32768)

statusnote__cstatusnoteQuote Note

Autonumberquotenumber__cquotenumberQuote Number

Text(255)quotetocity__cquotetocityQuote-to City
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Data TypeAPI NameField NameField Label

Text(255)quotetocountry__cquotetocountryQuote-to Country

Text(255)quotetoname__cquotetonameQuote-to Name

Text(255)quotetostateorprovince__cquotetostateorprovinceQuote-to
State/Province

Text Area(255)quotetostreet__cquotetostreetQuote-to Street

Text(255)quotetopostalcode__cquotetopostalcodeQuote-to Zip/Postal
Code

Pickliststatusreason__cstatusreasonReason

Date/Timerequesteddeliveryby__crequesteddeliverybyRequested Delivery
By

Text(255)rfqnumber__crfqnumberRFQ Number

Checkboxshipcompleteflag__cshipcompleteflagShip Complete Flag

Currency(16, 2)shippinghandling__cshippinghandlingShipping and Han-
dling

Lookup(Ship-to)shipto__cshiptoShip-to

Text(255)shiptocity__cshiptocityShip-to City

Lookup(Contact)shiptocontactid__cshiptocontactidShip-to Contact

Text(255)shiptocontactname__cshiptocontactnameShip-to Contact
Name

Text(255)shiptocountry__cshiptocountryShip-to Country

Text(255)shiptoname__cshiptonameShip-to Name

Text(255)shiptopostalcode__cshiptopostalcodeShip-to Postal Code

Text(255)shiptostateorprovince__cshiptostateorprovinceShip-to
State/Province

Text(255)shiptostreet__cshiptostreetShip-to Street

Text(100)soldtocity__csoldtocitySold-to City

Text(255)soldtocontactname__csoldtocontactnameSold-to Contact
Name

Text(255)soldtocountry__csoldtocountrySold-to Country

Text(255)soldtoname__csoldtonameSold-to Name

Text(255)soldtostateorprovince__csoldtostateorprovinceSold-to
State/Province

Long Text Area(256)soldtostreet__csoldtostreetSold-to Street

Pickliststatuscode__cstatuscodeStatus
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Data TypeAPI NameField NameField Label

Checkboxissyncing__cissyncingSyncing

Formula (Currency)tax__ctaxTax

Percent(3, 2)taxpercent__ctaxpercentTax %

Text(20)templatequoteid__ctemplatequoteidTemplateQuoteId

Roll-Up Summary
(SUM Infor quote
Line Item)

totallinediscount__ctotallinediscountTotal Line Discount

Formula (Percent)totallinediscountpercent__ctotallinediscountpercentTotal Line Discount
%

Roll-Up Summary
(SUM Infor quote
Line Item)

subtotal__csubtotalTotal Line Extended
Amount

Roll-Up Summary
(SUM Infor quote
Line Item)

totallinenetamount__ctotallinenetamountTotal Line Net
Amount

Text(100) (External
ID) (Unique Case In-
sensitive)

extid__cextidUnique ID

Number(18, 0)variationid__cvariationidVariation Id

Infor quote Clone Setting object
This table shows the Custom Object Definition Details for the Infor Quote Clone Setting object:

Definition DetailCustom Object

Infor Quote Clone SettingSingular Label

Infor Quote Clone SettingPlural Label

quotecloneconfigObject Name

quotecloneconfig__cAPI Name

This table shows the standard fields on the Infor Quote Clone Setting object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By
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Data TypeField NameField Label

Text(80)NameName

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Infor Quote Clone Setting object:

Data TypeAPI NameField NameField Label

Text(100)Default_Value__cDefault_ValueDefault Value

Text(100)Field_Name__cField_NameField Name

Text(100)FieldType__cFieldTypeField Type

Text(100)Object_Name__cObject_NameObject Name

CheckboxOverrideField__cOverrideFieldOverride

Text(255) (Unique Case
Sensitive)

Unique_ID__cUnique_IDUnique Name

Infor quote Line Item object
This table shows the Custom Object Definition Details for the Infor Quote Line Item object:

Definition DetailCustom Object

Infor Quote Line ItemSingular Label

Infor Quote Line ItemsPlural Label

QuoteLineItemObject Name

QuoteLineItem__cAPI Name

This table shows the standard fields on the Infor Quote Line Item object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNameLine Item Number

Record TypeRecordTypeRecord Type

This table shows the custom fields and relationships on the Infor Quote Line Item object:
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Data TypeAPI NameField NameField Label

Dateservicedate__cservicedateDate

Number(18, 0)linenumber__clinenumberERP Line Number

Pickliststatuscode__cstatuscodeERP Status

Currency(14, 4)totalamount__ctotalamountERP Total Amount

Lookup(Product)productid__cproductidExisting Product Name

Currency(14, 4)extendedamount__cextendedamountExtended Amount

Currency(14, 4)extendedcost__cextendedcostExtended Cost

Checkboxincludeinsync__cincludeinsyncIncluded With Sync

Lookup(Lookup)incotermid__cincotermidInco Term

Checkboxispriceoveridden__cispriceoveriddenIs Price Overidden

Formula (Currency)linediscount__clinediscountLine Discount

Percent(14, 4)discount__cdiscountLine Discount %

Formula (Currency)subtotal__csubtotalLine Extended Amount

Text(255)description__cdescriptionLine Item Description

Formula (Currency)totalprice__ctotalpriceLine Net Amount

Currency(14, 4)listprice__clistpriceList Price

Lookup(Lookup)marketid__cmarketidMarket ID

Text(20)opportunitylineid__copportunitylineidOpportunityLineId

Text(255)ownershiptransfer__cownershiptransferOwnership Transfer

Text(20)pricebookEntryId__cpricebookEntryIdPricebookEntryId

Currency(14, 4)priceperpriceunit__cpriceperpriceunitPrice Per Price Unit

Text(10)priceperpriceuom__cpriceperpriceuomPrice Per Price Uom

Currency(14, 4)priceperunit__cpriceperunitPrice Per Unit

Number(14, 4)probability__cprobabilityProbability

Lookup(Product)product2__cproduct2Product

Text(255)productcode__cproductcodeProduct Code

Long Text Area(1024)productdescription__cproductdescriptionProduct Description

Date/Timepromisedshipdate__cpromisedshipdatePromised Ship Date

Number(14, 4)quantity__cquantityQuantity

Master-Detail(Infor
quote)

quote__cquoteQuote Name

Infor Back Office Connect Administration Guide | 319

Custom objects and tabs



Data TypeAPI NameField NameField Label

Picklistisproductoverridden__cisproductoverriddenSelect Product

Checkboxshipcompleteflag__cshipcompleteflagShip Complete Flag

Lookup(Ship-to)shipto__cshiptoShip-to

Text(50)shiptocity__cshiptocityShip-to City

Text(255)shiptocontactid__cshiptocontactidShip-to Contact Id

Text(100)shiptocontactname__cshiptocontactnameShip-to Contact Name

Text(50)shiptocountry__cshiptocountryShip-to Country/Region

Text(100)shiptolocation__cshiptolocationShip-to Location

Text(100)shiptoname__cshiptonameShip-to Name

Text(50)shiptostateorprovince__cshiptostateorprovinceShip-to State/Province

Text Area(255)shiptostreet__cshiptostreetShip-to Street

Text(20)shiptopostalcode__cshiptopostalcodeShip-to Zip/Postal Code

CheckboxsyncWithOpportunity__csyncWithOpportunitySync with Oppty

Currency(14, 4)tax__ctaxTax

Lookup(UOM)uomid__cuomidUnit

Currency(14, 4)unitprice__cunitpriceUnit Price

Text(50)warehousecity__cwarehousecityWarehouse City

Text(255)warehousecode__cwarehousecodeWarehouse Code

Text(100)warehousecontact-
name__c

warehousecontactnameWarehouse Contact
Name

Text(50)warehousecountry__cwarehousecountryWarehouse Country/Re-
gion

Text(50)warehouseline3__cwarehouseline3Warehouse Line 3

Text(100)warehouselocation__cwarehouselocationWarehouse Location

Text(100)warehousename__cwarehousenameWarehouse Name

Text(50)warehousestateor-
province__c

warehousestateor-
province

Warehouse
State/Province

Text Area(255)warehousestreet__cwarehousestreetWarehouse Street

Text(20)warehousepostal-
code__c

warehousepostalcodeWarehouse Zip/Postal
Code

Text(100)writeinproduct__cwriteinproductWrite-In Product Name
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Invoice object
This table shows the Custom Object Definition Details for the Invoice object:

Definition DetailCustom Object

InvoiceSingular Label

InvoicesPlural Label

invoiceObject Name

invoice__cAPI Name

This table shows the standard fields on the Invoices object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Text(80)NameInvoice Name

Lookup(User)LastModifiedByLast Modified By

This table shows the custom fields and relationships on the Invoices object:

Data TypeAPI NameField NameField Label

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Lookup(Bill-to)billto__cbilltoBill-to

Text(100)billtocity__cbilltocityBill-to City

Lookup(Contact)billtocontactid__cbilltocontactidBill-to Contact ID

Formula (Text)billtocontactname__cbilltocontactnameBill-to Contact Name

Text(100)billtocountry1__cbilltocountry1Bill-to Country

Text(255)billtoname__cbilltonameBill-to Name

Text(100)billtostate__cbilltostateBill-to State

Long Text
Area(256)

billtostreet__cbilltostreetBill-to Street

Text(100)billtozip__cbilltozipBill-to Zip

Checkboxcansendbod__ccansendbodCan Send Bod

Lookup(Contact)contact__ccontactContact

Master-Detail(Ac-
count)

account__caccountCustomer

Infor Back Office Connect Administration Guide | 321

Custom objects and tabs



Data TypeAPI NameField NameField Label

Long Text
Area(1024)

description__cdescriptionDescription

Currency(16, 2)discountamount__cdiscountamountDiscount Amount

Date/Timeduedate__cduedateDue Date

Currency(16, 2)extendedamount__cextendedamountExtended Amount

CheckboxInSync__cInSyncIn Sync

Text (255)extRecordId__cextRecordIdInvoice Id

Currency(16, 2)latepaymentamount__clatepaymentamountLate Payment
Amount

Date/Timelatepaymentduedate__clatepaymentduedateLate Payment Due
Date

Text (255)locationid__clocationidLocation ID

Text (255)extlogicalid__cextlogicalidLogical ID

Lookup(Lookup)paymenttermid__cpaymenttermidPayment Term

Text(255)pricebook__cpricebookPrice List

Text(255)salescontactname__csalescontactnameSales Contact Name

Text(100)soldtocity1__csoldtocity1Sold-to City

Formula (Text)soldtocontactname__csoldtocontactnameSold-to Contact
Name

Text(100)soldtocountry1__csoldtocountry1Sold-to Country

Text(255)soldtoname__csoldtonameSold-to Name

Text(100)soldtostate__csoldtostateSold-to State

Long Text
Area(256)

soldtostreet__csoldtostreetSold-to Street

Text(100)soldtozip__csoldtozipSold-to Zip

Pickliststatuscode__cstatuscodeStatus

Text(255)suppliername__csuppliernameSupplier Name

Currency(16, 2)taxbasisamount__ctaxbasisamountTax Basis Amount

Currency(16, 2)taxexemptamount__ctaxexemptamountTax Exempt Amount

Currency(16, 2)totalamount__ctotalamountTotal Amount

Text(100) (External
ID) (Unique Case
Insensitive)

extid__cextidUnique ID
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Data TypeAPI NameField NameField Label

Number(18, 0)variationid__cvariationidVariation Id

Lookup(zz_Transac-
tion Address)

billtoaddress__cbilltoaddresszz_Bill-to Address

Formula (Text)billtocity__cbilltocityzz_Bill-to City

Formula (Text)billtocountry__cbilltocountryzz_Bill-to Country

Formula (Text)billtoline1__cbilltoline1zz_Bill-to Line 1

Formula (Text)billtoline2__cbilltoline2zz_Bill-to Line 2

Formula (Text)billtoline3__cbilltoline3zz_Bill-to Line 3

Formula (Text)billtoline4__cbilltoline4zz_Bill-to Line 4

Formula (Text)billtoline5__cbilltoline5zz_Bill-to Line 5

Formula (Text)billtoline6__cbilltoline6zz_Bill-to Line 6

Formula (Text)billtostateorprovince__cbilltostateorprovincezz_Bill-to
State/Province

Formula (Text)billtopostalcode__cbilltopostalcodezz_Bill-to Zip/Postal
Code

Lookup(zz_Transac-
tion Address)

soldtoaddress__csoldtoaddresszz_Sold-to Address

Formula (Text)soldtocity__csoldtocityzz_Sold-to City

Formula (Text)soldtocountry__csoldtocountryzz_Sold-to Country

Formula (Text)soldtoline1__csoldtoline1zz_Sold-to Line 1

Formula (Text)soldtoline2__csoldtoline2zz_Sold-to Line 2

Formula (Text)soldtoline3__csoldtoline3zz_Sold-to Line 3

Formula (Text)soldtoline4__csoldtoline4zz_Sold-to Line 4

Formula (Text)soldtoline5__csoldtoline5zz_Sold-to Line 5

Formula (Text)soldtoline6__csoldtoline6zz_Sold-to Line 6

Formula (Text)soldtostateorprovince__csoldtostateorprovincezz_Sold-to
State/Province

Formula (Text)soldtopostalcode__csoldtopostalcodezz_Sold-to Zip/Postal
Code

Formulabilltoline1__cbilltoline1zz_Bill-to Line 1

Formulabilltoline2__cbilltoline2zz_Bill-to Line 2

Formulabilltoline3__cbilltoline3zz_Bill-to Line 3

Formulabilltoline4__cbilltoline4zz_Bill-to Line 4
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Data TypeAPI NameField NameField Label

Formulabilltoline5__cbilltoline5zz_Bill-to Line 5

Formulabilltoline6__cbilltoline6zz_Bill-to Line 6

Invoice Line object
This table shows the Custom Object Definition Details for the Invoice Line object:

Definition DetailCustom Object

Invoice LineSingular Label

Invoice LinesPlural Label

invoicelineObject Name

invoiceline__cAPI Name

This table shows the standard fields on the Invoice Line object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Text(80)NameInvoice Line Number

Lookup(User)LastModifiedByLast Modified By

This table shows the custom fields and relationships on the Invoice Line object:

Data TypeAPI NameField NameField Label

Text(100)shiptocontactname__cshiptocontactnameAddress Contact

Currency(14, 4)allowanceamount__callowanceamountAllowance Amount

Currency(14, 4)chargeamount__cchargeamountCharge Amount

Lookup(Lookup)ItemClassification__cItemClassificationClassification Code

Text(255)countryoforigin__ccountryoforiginCountry Of Origin

Text(255)customerpo__ccustomerpoCustomer PO

Lookup(Customer
Return)

returnordernumber__creturnordernumberCustomer Return
Number

Long Text
Area(1024)

description__cdescriptionDescription

Lookup(Product)productid__cproductidExisting Product
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Data TypeAPI NameField NameField Label

Currency(14, 4)extendedamount__cextendedamountExtended Amount

Currency(14, 4)extendedcost__cextendedcostExtended Cost

Master-Detail(In-
voice)

invoice__cinvoiceInvoice

Checkboxispriceoveridden__cispriceoveriddenIs Price Overidden

Number(18, 0)linenumber__clinenumberLine Number

Number(18, 0)orderlinenumber__corderlinenumberOrder Line Number

Currency(14, 4)priceperpriceunit__cpriceperpriceunitPrice Per Price Unit

Text(10)priceperpriceuom__cpriceperpriceuomPrice Per Price Uom

Currency(14, 4)priceperunit__cpriceperunitPrice Per Unit

Text(255)productserialnumber__cproductserialnumberProduct Serial Num-
ber

Number(14, 4)quantity__cquantityQuantity

Lookupordernumber__cordernumberSales Order Number

Picklistisproductoverridden__cisproductoverriddenSelect Product

Lookupshipto__cshiptoShip-to

Text (50)shiptoline1__cshiptoline1Ship-to Line 1

Text (50)shiptoline2__cshiptoline2Ship-to Line 2

Text (50)shiptoline3__cshiptoline3Ship-to Line 3

Text (50)shiptoline4__cshiptoline4Ship-to Line 4

Text (50)shiptoline5__cshiptoline5Ship-to Line 5

Text (50)shiptoline6__cshiptoline6Ship-to Line 6

Text (100)shiptolocation__cshiptolocationShip-to Location

Text (100)shiptoname__cshiptonameShip-to Name

Text (50)shiptostateorprovince__cshiptostateorprovinceShip-to
State/Province

Text (20)shiptopostalcode__cshiptopostalcodeShip-to Zip/Postal
Code

Pickliststatuscode__cstatuscodeStatus

Text (64)Supplier__cSupplierSupplier

Text (100)Supplier_ID__cSupplier_IDSupplier ID

Currencytax__ctaxTax
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Data TypeAPI NameField NameField Label

Text (255)taxcode__ctaxcodeTax Code

Text (255)taxdescription__ctaxdescriptionTax Description

Currencytotalamount__ctotalamountTotal Amount

Lookupuomid__cuomidUnit

Long Text Areaproductdescription__cproductdescriptionWrite-In Product De-
scription

Text (100)writeinproduct__cwriteinproductWrite-In Product Id

Logger object
This table shows the Custom Object Definition Details for the Logger object:

Definition DetailCustom Object

LoggerSingular Label

LoggersPlural Label

loggerObject Name

logger__cAPI Name

This table shows the standard fields on the Logger object:

Data TypeField NameField Label

Lookup (User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup (User)LastModifiedByLast Modified By

Text (80)NameLogger Name

Lookup (User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Logger object:

Data TypeAPI NameField NameField Label

Text (255)entity__centityEntity

Long Text Areamessage__cmessageMessage

Text (18)messagesfid__cmessagesfidMessage SF Id

Picklistmessagetype__cmessagetypeMessage Type

Formularelatedentityurl__crelatedentityurlRelated Entity URL

326 | Infor Back Office Connect Administration Guide

Custom objects and tabs



Lookup object
This table shows the Custom Object Definition Details for the Lookup object:

Definition DetailCustom Object

LookupSingular Label

LookupsPlural Label

lookupObject Name

lookup__cAPI Name

This table shows the standard fields on the Lookup object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameName

This table shows the custom fields and relationships on the Lookup object:

Data TypeAPI NameField NameField Label

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Text(128)code__ccodeCode

Long Text
Area(1024)

description__cdescriptionDescription

Text(255)extRecordId__cextRecordIdID

Text(255)locationid__clocationidLocation ID

Master-Detail(Lookup
Category)

lookupcategory__clookupcategoryLookup Category

Lookup(Message
Source)

Message_Source__cMessage_SourceMessage Source

Pickliststatuscode__cstatuscodeStatus

Text(255) (External
ID) (Unique Case In-
sensitive)

extid__cextidUnique ID

Number(18, 0)variationId__cvariationIdVariation ID
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Lookup Category object
This table shows the Custom Object Definition Details for the Lookup Categories object:

Definition DetailCustom Object

Lookup CategorySingular Label

Lookup CategoriesPlural Label

lookupcategoryObject Name

lookupcategory__cAPI Name

This table shows the standard fields on the Lookup Categories object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameLookup Category name

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Lookup Categories object:

Data TypeAPI NameField NameField Label

Text(255) (External ID)
(Unique Case Insensi-
tive)

extid__cextidLookup Category ID

Lookup(Message
Source)

Messages_Source__cMessage_SourceMessage Source

Outbound Confirm BOD object
This table shows the Custom Object Definition Details for the Outbound Confirm BOD object:

Definition DetailCustom Object

Outbound Confirm BODSingular Label

Outbound Confirm BODsPlural Label

ConfirmObject Name

Confirm__cAPI Name

This table shows the standard fields on the Outbound Confirm BOD object:
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Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameName

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Outbound Confirm BOD object:

Data TypeAPI NameField NameField Label

Checkboxcansendbod__ccansendbodcansendbod

Long Text Area(2000)errorMessage__cerrorMessageError Message

Long Text
Area(32000)

errorStackTrace__cerrorStackTraceError Stack Trace

CheckboxInSync__cInSyncInSync

Lookup(Message
Source)

message_source__cmessage_sourceMessage Source

Lookup(Inbound Mes-
sage)

inboundMessageId__cinboundMessageIdOriginal Inbound
Message

Pickliststatuscode__cstatuscodeStatus

Text(255) (External
ID)

extId__cextIdUnique ID

Outbound Message object
This table shows the Custom Object Definition Details for the Outbound Message object:

Definition DetailCustom Object

Outbound MessageSingular Label

Outbound MessagesPlural Label

ionoutboundmessageObject Name

ionoutboundmessage__cAPI Name

This table shows the standard fields on the Outbound Message object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

Infor Back Office Connect Administration Guide | 329

Custom objects and tabs



Data TypeField NameField Label

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameMessage ID

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Outbound Message object:

Data TypeAPI NameField NameField Label

Long Text
Area(32000)

bodxml__cbodxmlBod Xml

Long Text Area(2000)errormessage__cerrormessageError Message

Long Text
Area(32000)

headerxml__cheaderxmlHeader Xml

Number(5, 0)messagepriority__cmessagepriorityMessage Priority

Text(255)messagetype__cmessagetypeMessage Type

Text(20)relatedloggerId__crelatedloggerIdRelated Logger Id

Formula (Text)relatedloggerurl__crelatedloggerurlRelated Logger URL

Text(100)relatedrecordextId__crelatedrecordextIdRelated Record Ex-
tId

Text(100)relatedrecordsfid__crelatedrecordsfidRelated Record SFId

Formula (Text)relatedrecordurl__crelatedrecordurlRelated Record URL

Number(18, 0)wasprocessed__cwasprocessedWas Processed

Outbound Transaction object
This table shows the Custom Object Definition Details for the Outbound Transaction object:

Definition DetailCustom Object

Outbound TransactionSingular Label

Outbound TransactionsPlural Label

ionoutboundtxnObject Name

ionoutboundtxn__cAPI Name

This table shows the standard fields on the Outbound Transaction object:

330 | Infor Back Office Connect Administration Guide

Custom objects and tabs



Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNameName

Lookup(User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Outbound Transaction object:

Data TypeAPI NameField NameField Label

Picklistactioncode__cactioncodeAction Code

Text(100)apiname__capinameApi Name

Long Text
Area(2000)

errormessage__cerrormessageError Message

Text(255)externalid__cexternalidExternal Id

Number(5, 0)retrycount__cretrycountRetry Count

Text(18)salesforceid__csalesforceidSalesforce Id

Pickliststatus__cstatusStatus

Number(18, 0)statuscode__cstatuscodeStatus Code

Pay-from object
This table shows the Custom Object Definition Details for the Pay-from object:

Definition DetailCustom Object

Pay-fromSingular Label

Pay-from RecordsPlural Label

payfromObject Name

payfrom__cAPI Name

This table shows the standard fields on the Pay-from object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By
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Data TypeField NameField Label

Lookup(User, Queue)OwnerOwner

Text(80)NamePay-from Name

This table shows the custom fields and relationships on the Pay-from object:

Data TypeAPI NameField NameField Label

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Text(255)primaryaddressname__cprimaryaddressnameAttention of Name

Lookup(Bill-to)Billto__cBilltoBill-to

Checkboxcansendbod__ccansendbodCan Send Bod

Emailemail__cemailEmail

Phonefax__cfaxFax

CheckboxInSync__cInSyncIn Sync

Text(255)locationid__clocationidLocation ID

Text(255)extlogicalid__cextlogicalidLogical ID

Lookup(Message
Source)

Message_Source__cMessage_SourceMessage Source

Phoneotherphone__cotherphoneOther Phone

Text(255)extRecordId__cextRecordIdPayfrom ID

Lookup(Lookup)paymenttermid__cpaymenttermidPayment Term

Phonemainphone__cmainphonePrimary Phone

Text(100)primaryaddressstate__cprimaryaddressstateState/Province

Pickliststatuscode__cstatuscodeStatus

Long Text Area(256)primaryaddressstreet__cprimaryaddressstreetStreet

Text(255)extid__cextidUnique ID

Number(18, 0)variationId__cvariationIdVariation Id

URL(255)website__cwebsiteWeb Site

Text(255)primaryaddresspostal
code__c

primaryaddresspostalcodeZip/Postal Code

Lookupprimarycontactid__cprimarycontactidPrimary Contact

Text(255)addresstype__caddresstypezz_Address Type

Text(255)primaryaddressline1__cprimaryaddressline1zz_Pay-from Line 1

Text(255)primaryaddressline2__cprimaryaddressline2zz_Pay-from Line 2
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Data TypeAPI NameField NameField Label

Text(255)primaryaddressline3__cprimaryaddressline3zz_Pay-from Line 3

Text(255)primaryaddressline4__cprimaryaddressline4zz_Pay-from Line 4

Text(255)primaryaddressline5__cprimaryaddressline5zz_Pay-from Line 5

Text(255)primaryaddressline6__cprimaryaddressline6zz_Pay-from Line 6

Lookup(Address)primaryaddress__cprimaryaddresszz_Primary Address

Lookup(Contact)primarycontactid__cprimarycontactidzz_Primary Contact

Person object
This table shows the Custom Object Definition Details for the Person object:

Definition DetailCustom Object

PersonSingular Label

PersonsPlural Label

PersonObject Name

Person__cAPI Name

This table shows the standard fields on the Person object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

Text(80)NamePerson Name

This table shows the custom fields and relationships on the Person object:

Data TypeAPI NameField NameField Label

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Lookup(Message
Source)

Message_Source__cMessage_SourceMessage Source

Checkboxcansendbod__ccansendbodCan Send Bod

Text(255)city__ccityCity

Text(255)country__ccountryCountry
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Data TypeAPI NameField NameField Label

Text(255)description__cdescriptionDescription

Emailemail__cemailEmail

Text(255) (External
iD) (Unique Case In-
sensitive)

extId__cextIdExt Id

Text(255)extlogicalid__cextlogicalidExt Location ID

Text(255)extRecordId__cextRecordIdExt Record ID

Phonefax__cfaxFax

CheckboxInSync__cInSyncIn Sync

Text(255)locationid__clocationidLocation ID

Phonemobile_phone_office__cmobile_phone_officeMobile Phone Office

Text(255)personID__cpersonIDPerson ID

Phoneprimaryphone__cprimaryphonePhone

Lookup(User)relateduser__crelateduserRelated User

Text(255)stateorprovince__cstateorprovinceState or Province

Pickliststatuscode__cstatuscodeStatus Code

Text Area(255)street__cstreetStreet

Text(255)title__ctitleTitle

Number(18, 0)variationid__cvariationidVariation Id

Text(255)postalcode__cpostalcodeZip/Postal Code

Price List object
This table shows the Custom Object Definition Details for the Price List object:

Definition DetailCustom Object

Price ListSingular Label

Price ListPlural Label

pricelistObject Name

pricelist__cAPI Name

This table shows the standard fields on the Price List object:
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Data TypeField NameField Label

Lookup (User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Auto NumberNameId

Lookup (User)LastModifiedByLast Modified By

Lookup (User, Queue)OwnerOwner

This table shows the custom fields and relationships on the Price List object:

Data TypeAPI NameField NameField Label

Lookupmessagesource__cmessagesourceMessage Source

Text (18)pricebookId__cpricebookIdPrice Book ID

Quote Document object
This table shows the Custom Object Definition Details for the Quote Document object:

Quote DocumentSingular Label

Quote DocumentsPlural Label

quoteDocumentObject Name

quoteDocument__cAPI Name

This table shows the standard fields on the Quote Document object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameQuote PDF Name

This table shows the custom fields and relationships on the Quote Document object:

Data TypeAPI NameField NameField Label

CheckboxIsDeleted__cIsDeletedDeleted

Percent(5, 2)Discount__cDiscountDiscount

Currency(16, 2)grandTotal__cgrandTotalGrand Total
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Data TypeAPI NameField NameField Label

Master-Detail(Infor
quote)

quoteId__cquoteIdQuote

Checkboxwon__cwonWon

Receivable object
This table shows the Custom Object Definition Details for the Receivable object:

Definition DetailCustom Object

ReceivableSingular Label

ReceivablesPlural Label

ReceivableObject Name

Receivable__cAPI Name

This table shows the standard fields on the Receivable object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Text(80)NameDocument Number

Lookup(User)LastModifiedByLast Modified By

This table shows the custom fields and relationships on the Receivable object:

Data TypeAPI NameField NameField Label

Master-Detail(Account)account__caccountAccount

Text(255)extaccounting
entityid__c

extaccountingentityidAccounting Entity ID

Formula (Text)soldto_contactname__csoldto_contactnameAttention of Name

Currency(16, 2)baseamount__cbaseamountBase Amount

Lookup(Bill-to)billto__cbilltoBill-to

Text(100)billtoattention__cbilltoattentionBill-to Attention

Text(100)billtocity__cbilltocityBill-to City

Lookup(Contact)billtocontact__cbilltocontactBill-to Contact

Text(100)billtocountry__cbilltocountryBill-to Country
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Data TypeAPI NameField NameField Label

Text(100)billtostate__cbilltostateBill-to State

Long Text Area(256)billtostreet__cbilltostreetBill-to Street

Text(100)billtozip__cbilltozipBill-to Zip

Checkboxcansendbod__ccansendbodCan Send Bod

Text(255)departmentname__cdepartmentnameDepartment Name

Text(255)departmentnumber__cdepartmentnumberDepartment Number

Text(255)description__cdescriptionDescription

Currency(16, 2)discountallowed
amount__c

discountallowedamountDiscount Allowed
Amount

Currency(16, 2)discount
amount__c

discountamountDiscount Amount

Currency(16, 2)discounttaken
amount__c

discounttakenamountDiscount Taken
Amount

Text(255)documenttype__cdocumenttypeDocument Type

Number(16, 2)exchangerate__cexchangerateExchange Rate

Currency(16, 2)extendedamount__cextendedamountExtended Amount

CheckboxInSync__cInSyncIn Sync

Checkboxlatediscountflag__clatediscountflagLate Discount Indica-
tor

Currency(16, 2)latepaymentamount__clatepaymentamountLate Payment
Amount

Date/Timelatepaymentduedate__clatepaymentduedateLate Payment Due
Date

Text(255)locationid__clocationidLocation ID

Text(255)extlogicalid__cextlogicalidLogical ID

Currency(16, 2)nondiscountamount__cnondiscountamountNon Discount
Amount

Lookup(Pay-from)Payfrom__cPayfromPay-from

Text(100)payfromname1__cpayfromname1Pay-from Attention

Text(100)payfromcity__cpayfromcityPay-from City

Lookup(Contact)payfromcontact__cpayfromcontactPay-from Contact

Text(100)payfromline1__cpayfromline1Pay-from Country

Text(100)payfromline2__cpayfromline2Pay-from State
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Data TypeAPI NameField NameField Label

Long Text Area(256)payfromstreet__cpayfromstreetPay-from Street

Text(100)payfromzip__cpayfromzipPay-from Zip

Text(255)paymentmethod__cpaymentmethodPayment Method

Lookup(Lookup)paymenttermid__cpaymenttermidPayment Term

Text(255)penaltycode__cpenaltycodePenalty Code

Text(255)penaltydescription__cpenaltydescriptionPenalty Description

Text(255)pricebook__cpricebookPrice List

Currency(16, 2)receiptamount__creceiptamountReceipt Amount

Currency(16, 2)receivableamount__creceivableamountReceivable Amount

Text (255)extRecordId__cextRecordIdReceivable ID

Currency(16, 2)receivedamount__creceivedamountReceived Amount

Text(100)soldtocity1__csoldtocity1Sold-to City

Text(100)soldtocountry1__csoldtocountry1Sold-to Country

Text(255)soldtoname__csoldtonameSold-to Name

Text(100)soldtostate__csoldtostateSold-to State

Long Text Area(256)soldtostreet__csoldtostreetSold-to Street

Text(100)soldtozip__csoldtozipSold-to Zip

Pickliststatuscode__cstatuscodeStatus

Currency(16, 2)taxamount__ctaxamountTax Amount

Currency(16, 2)taxexemptamount__ctaxexemptamountTax Exempt Amount

Text(255)taxexemptcode__ctaxexemptcodeTax Exempt Code

Text(255)taxexempt
description__c

taxexemptdescriptionTax Exempt Descrip-
tion

Currency(16, 2)totalamount__ctotalamountTotal Amount

Text(255) (External ID)
(Unique Case Insensi-
tive)

extid__cextidUnique ID

Number(18, 0)variationId__cvariationIdVariation Id

Currency(16, 2)writeoffamount__cwriteoffamountWriteoff Amount

Formula (Text)billtoname__cbilltonamezz_Attention of
Name
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Data TypeAPI NameField NameField Label

Formula (Text)payfromname__cpayfromnamezz_Attention of
Name

Lookup(zz_Transaction
Address)

billtoAddress__cbilltoAddresszz_Bill-to Address

Formula (Text)billtocity__cbilltocityzz_Bill-to City

Formula (Text)billtocountry__cbilltocountryzz_Bill-to Country

Formula (Text)billtoline1__cbilltoline1zz_Bill-to Line 1

Formula (Text)billtoline2__cbilltoline2zz_Bill-to Line 2

Formula (Text)billtoline3__cbilltoline3zz_Bill-to Line 3

Formula (Text)billtoline4__cbilltoline4zz_Bill-to Line 4

Formula (Text)billtoline5__cbilltoline5zz_Bill-to Line 5

Formula (Text)billtoline6__cbilltoline6zz_Bill-to Line 6

Formula (Text)billtostateorprovince__cbilltostateorprovincezz_Bill-to
State/Province

Formula (Text)billtopostalcode__cbilltopostalcodezz_Bill-to Zip/Postal
Code

Lookup(zz_Transaction
Address)

payfromAddress__cpayfromAddresszz_Pay-from Ad-
dress

Text(100)payfromcity__cpayfromcityzz_Pay-from City

Lookup(Contact)payfromcountry__cpayfromcountryzz_Pay-from Country

Formula (Text)payfromline1__cpayfromline1zz_Pay-from Line 1

Formula (Text)payfromline2__cpayfromline2zz_Pay-from Line 2

Formula (Text)payfromline3__cpayfromline3zz_Pay-from Line 3

Formula (Text)payfromline4__cpayfromline4zz_Pay-from Line 4

Formula (Text)payfromline5__cpayfromline5zz_Pay-from Line 5

Formula (Text)payfromline6__cpayfromline6zz_Pay-from Line 6

Formula (Text)payfromstateor-
province__c

payfromstateorprovincezz_Pay-from
State/Province

Formula (Text)payfrompostalcode__cpayfrompostalcodezz_Pay-from
Zip/Postal Code

Lookup(zz_Transaction
Address)

soldtoAddress__csoldtoAddresszz_Sold-to Address

Formula (Text)soldtocity__csoldtocityzz_Sold-to City

Formula (Text)soldtocountry__csoldtocountryzz_Sold-to Country
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Data TypeAPI NameField NameField Label

Formula (Text)soldtoline1__csoldtoline1zz_Sold-to Line 1

Formula (Text)soldtoline2__csoldtoline2zz_Sold-to Line 2

Formula (Text)soldtoline3__csoldtoline3zz_Sold-to Line 3

Formula (Text)soldtoline4__csoldtoline4zz_Sold-to Line 4

Formula (Text)soldtoline5__csoldtoline5zz_Sold-to Line 5

Formula (Text)soldtoline6__csoldtoline6zz_Sold-to Line 6

Formula (Text)soldtostateor-
province__c

soldtostateorprovincezz_Sold-to
State/Province

Formula (Text)soldtopostalcode__csoldtopostalcodezz_Sold-to Zip/Postal
Code

Receivable Line object
This table shows the Custom Object Definition Details for the Receivable Line object:

Definition DetailCustom Object

Receivable LineSingular Label

Receivable LinesPlural Label

receivablelineObject Name

receivableline__cAPI Name

This table shows the standard fields on the Receivable Line object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameReceivable Line Number

This table shows the custom fields and relationships on the Receivable Line object:

Data TypeAPI NameField NameField Label

Currency(16, 2)amount__camountAmount

Currency(16, 2)baseamount__cbaseamountBase Amount

Text(255)description__cdescriptionDescription
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Data TypeAPI NameField NameField Label

Currency(16, 2)extendedamount
amount__c

extendedamountExtended Amount

Currency(16, 2)extendedbaseamount
amount__c

extendedbaseamountExtended Base
Amount

Lookup(Product)product__cproductProduct

Master-Detail(Receiv-
able)

receivable__creceivableReceivable

Text (255)extRecordId__cextRecordIdReceivable ID

Pickliststatuscode__cstatuscodeStatus

Currency(16, 2)taxamount__ctaxamountTax Amount

Currency(16, 2)taxbaseamount__ctaxbaseamountTax Base Amount

Currency(16, 2)totalamount__ctotalamountTotal Amount

Currency(16, 2)totalbaseamount__ctotalbaseamountTotal Base Amount

Sales Order object
This table shows the Custom Object Definition Details for the Sales Order object:

Definition DetailCustom Object

Sales OrderSingular Label

Sales OrdersPlural Label

salesorderObject Name

salesorder__cAPI Name

This table shows the standard fields on the Sales Order object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameSales Order Name

This table shows the custom fields and relationships on the Sales Order object:

Infor Back Office Connect Administration Guide | 341

Custom objects and tabs



Data TypeAPI NameField NameField Label

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Checkboxbackorderflag__cbackorderflagBack Order Flag

Text(255)billingtriggercode__cbillingtriggercodeBilling Trigger Code

Lookup(Bill-to)billto__cbilltoBill-to

Text(100)billtocity1__cbilltocity1Bill-to City

Text(100)billtocountry1__cbilltocountry1Bill-to Country

Text(255)billtoname__cbilltonameBill-to Name

Text(100)billtostate__cbilltostateBill-to State

Text(100)billtozip__cbilltozipBill-to Zip

Text(255)carriercode__ccarriercodeCarrier Code

Text(255)carriername__ccarriernameCarrier Name

Text(255)contractnumber__ccontractnumberContract Number

Master-Detail(Account)Account__cAccountCustomer

Text(255)custordernumber__ccustordernumberCustomer Order
Number

Text(255)department__cdepartmentDepartment

Checkboxdropshipflag__cdropshipflagDrop Ship Flag

Currency(16, 2)extendedpretaxam-
ount__c

extendedpretaxamountExtended Pretax
Amount

Text(255)externalsalesrepcode__cexternalsalesrepcodeExternal Sales Rep
Code

Text(255)externalsalesrepname__cexternalsalesrepnameExternal Sales Rep
Name

Currency(16, 2)totalamount__ctotalamountGrand Total

Lookup(Lookup)incotermid__cincotermidInco Term

Text(255)internalsalesrepcode__cinternalsalesrepcodeInternal Sales Rep
Code

Text(255)internalsalesrepname__cinternalsalesrepnameInternal Sales Rep
Name

Currency(16, 2)extendedamount__cextendedamountLine Total

Text(255)locationid__clocationidLocation ID

Text(255)extlogicalid__cextlogicalidLogical ID

Date/TimeOrderEntryDate__cOrderEntryDateOrder Entry Date

342 | Infor Back Office Connect Administration Guide

Custom objects and tabs



Data TypeAPI NameField NameField Label

Text(255)extRecordId__cextRecordIdOrder ID

Text(50)ownershiptransfer__cownershiptransferOwnership Transfer

Checkboxshipcompleteflag__cshipcompleteflagPartial Shipments
Allowed

Lookup(Pay-from)payfrom__cpayfromPay-from

Text(255)payfromcontactname__cpayfromcontactnamePay-from Contact
Name

Text(100)paymentmethod__cpaymentmethodPayment Method

Lookup(Lookup)paymenttermid__cpaymenttermidPayment Term

Text(18)priceBookId__cpriceBookIdPrice Book

Text(255)productmethod__cproductmethodProduct Method

Date/Timepromiseddeliverydate__cpromiseddeliverydatePromised Delivery
Date

Date/Timepromisedshipdate__cpromisedshipdatePromised Ship Date

Date/Timerequesteddeliverydate__crequesteddeliverydateRequested Delivery
Date

Checkboxrushflag__crushflagRush Flag

Checkboxselfbillingflag__cselfbillingflagSelf Billing Flag

Lookup(Ship-to)shipto__cshiptoShip-to

Text(100)shiptocity__cshiptocityShip-to City

Text(100)shiptocountry__cshiptocountryShip-to Country

Text(255)shiptoname__cshiptonameShip-to Name

Text(100)shiptostate__cshiptostateShip-to State

Long Text Area(256)shiptostreet__cshiptostreetShip-to Street

Text(100)shiptozip__cshiptozipShip-to Zip

Text(100)soldtocity1__csoldtocity1Sold-to City

Text(100)soldtocountry1__csoldtocountry1Sold-to Country

Text(255)soldtoname__csoldtonameSold-to Name

Text(100)soldtostate__csoldtostateSold-to State

Long Text Area(256)soldtostreet__csoldtostreetSold-to Street

Text(100)soldtozip__csoldtozipSold-to Zip

Pickliststatuscode__cstatuscodeStatus
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Data TypeAPI NameField NameField Label

Currency(16, 2)totaldiscountamount__ctotaldiscountamountTotal Discounted
Amount

Text(100) (External ID)
(Unique Case Insensi-
tive)

extid__cextidUnique ID

Number(18, 0)variationid__cvariationidVariation Id

Lookup(zz_Sales Or-
der Address)

billtoaddress__cbilltoaddresszz_Bill-to Address

Formula (Text)billtocity__cbilltocityzz_Bill-to City

Formula (Text)billtocounrty__cbilltocountryzz_Bill-to Country

Formula (Text)billtoline1__cbilltoline1zz_Bill-to Line 1

Formula (Text)billtoline2__cbilltoline2zz_Bill-to Line 2

Formula (Text)billtoline3__cbilltoline3zz_Bill-to Line 3

Formula (Text)billtoline4__cbilltoline4zz_Bill-to Line 4

Formula (Text)billtoline5__cbilltoline5zz_Bill-to Line 5

Formula (Text)billtoline6__cbilltoline6zz_Bill-to Line 6

Formula (Text)billtostateorprovince__cbilltostateorprovincezz_Bill-to
State/Province

Formula (Text)billtopostalcode__cbilltopostalcodezz_Bill-to Zip/Postal
Code

Lookup(zz_Sales Or-
der Address)

shiptoaddress__cshiptoaddresszz_Ship-to Address

Formula (Text)shiptocity__cshiptocityzz_Ship-to City

Formula (Text)shiptocountry__cshiptocountryzz_Ship-to Country

Formula (Text)shiptoline1__cshiptoline1zz_Ship-to Line 1

Formula (Text)shiptoline2__cshiptoline2zz_Ship-to Line 2

Formula (Text)shiptoline3__cshiptoline3zz_Ship-to Line 3

Formula (Text)shiptoline4__cshiptoline4zz_Ship-to Line 4

Formula (Text)shiptoline5__cshiptoline5zz_Ship-to Line 5

Formula (Text)shiptoline6__cshiptoline6zz_Ship-to Line 6

Formula (Text)shiptostateorprovince__cshiptostateorprovincezz_Ship-to
State/Province

Formula (Text)shiptopostalcode__cshiptopostalcodezz_Ship-to Zip/Postal
Code
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Lookup(zz_Sales Or-
der Address)

soldtoaddress__csoldtoaddresszz_Sold-to Address

Formula (Text)soldtocity__csoldtocityzz_Sold-to City

Formula (Text)soldtocountry__csoldtocountryzz_Sold-to Country

Formula (Text)soldtoline1__csoldtoline1zz_Sold-to Line 1

Formula (Text)soldtoline2__csoldtoline2zz_Sold-to Line 2

Formula (Text)soldtoline3__csoldtoline3zz_Sold-to Line 3

Formula (Text)soldtoline4__csoldtoline4zz_Sold-to Line 4

Formula (Text)soldtoline5__csoldtoline5zz_Sold-to Line 5

Formula (Text)soldtoline6__csoldtoline6zz_Sold-to Line 6

Formula (Text)soldtostateorprovince__csoldtostateorprovincezz_Sold-to
State/Province

Formula (Text)soldtopostalcode__csoldtopostalcodezz_Sold-to Zip/Postal
Code

Sales Order Line object
This table shows the Custom Object Definition Details for the Sales Order Line object:

Definition DetailCustom Object

Sales Order LineSingular Label

Sales Order LinePlural Label

salesorderlineObject Name

salesorderline__cAPI Name

This table shows the standard fields on the Sales Order Line object:

Data TypeField NameField Label

Lookup (User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup (User)LastModifiedByLast Modified By

Text (80)NameLine Number

This table shows the custom fields and relationships on the Sales Order Line object:
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Date/Timeactualshipdate__cactualshipdateActual Ship Date

Text (100)shipto_contactname__cshipto_contactnameAddress Contact

Checkboxbackorderflag__cbackorderflagBack Order Flag

Text (50)carriercode__ccarriercodeCarrier Code

Text (100)carriername__ccarriernameCarrier Name

LookupItemClassification__cItemClassificationClassification Code

Text (100)contactname__ccontactnameContact Name

Text (100)contractnumber__ccontractnumberContract Number

Lookupproductid__cproductidExisting Product

Currencyextendedamount__cextendedamountExtended Amount

Currencybaseamount__cbaseamountExtended Unit Base
Amount

Checkboxfixedpriceflag__cfixedpriceflagFixed Price Flag

Lookupincotermid__cincotermidInco Term

Text (50)ownershiptransfer__cownershiptransferOwnership Transfer

Lookuppaymenttermid__cpaymenttermidPayment Term

Numberpolinenumber__cpolinenumberPO Line Number

Text (100)ponumber__cponumberPO Number

Numberpriceperpriceunit__cpriceperpriceunitPrice Per Price Unit
Quantity

Text (10)priceperpriceuom__cpriceperpriceuomPrice Per Price Uom

Currencypriceperunit__cpriceperunitPrice Per Unit

Date/Timepromiseddeliverydate__cpromiseddeliverydatePromised Delivery
Date

Date/Timepromisedshipdate__cpromisedshipdatePromised Ship Date

Numberquantity__cquantityQuantity

Numberquotelinenumber__cquotelinenumberQuote Line Number

Text (100)quotenumber__cquotenumberQuote Number

Date/Timerequestdeliveryby__crequestdeliverybyRequest Date

Checkboxrushflag__crushflagRush Flag

Master-Detailsalesorderid__csalesorderidSales Order

Picklistisproductoverridden__cisproductoverriddenSelect Product

346 | Infor Back Office Connect Administration Guide

Custom objects and tabs



Data TypeAPI NameField NameField Label

Checkboxselfbillingflag__cselfbillingflagSelf Billing Flag

Checkboxshipcompleteflag__cshipcompleteflagShip Complete Flag

Text (100)shipfromcode__cshipfromcodeShip From Code

Numberquantityshipped__cquantityshippedShipped

Lookupshiptoid__cshiptoidShip-to

Text (50)shipto_line1__cshipto_line1Ship-to Line 1

Text (50)shipto_line2__cshipto_line2Ship-to Line 2

Text (50)shipto_line3__cshipto_line3Ship-to Line 3

Text (50)shipto_line4__cshipto_line4Ship-to Line 4

Text (50)shipto_line5__cshipto_line5Ship-to Line 5

Text (50)shipto_line6__cshipto_line6Ship-to Line 6

Text (100)shipto_location__cshipto_locationShip-to Location

Text (50)Shipto_Locationtype__cShipto_LocationtypeShip-to Location
Type

Text (100)shipto_name__cshipto_nameShip-to Name

Text (50)shipto_stateorprovince__cshipto_stateorprovinceShip-to
State/Province

Text (20)shipto_postalcode__cshipto_postalcodeShip-to Zip/Postal
Code

Text (20)shipuomcode__cshipuomcodeShip UOM Code

Pickliststatuscode__cstatuscodeStatus

Text (64)Supplier__cSupplierSupplier

Text (100)Supplier_ID__cSupplier_IDSupplier ID

Currencytax__ctaxTax

Currencytotaldiscountamount__ctotaldiscountamountTotal Discount
Amount

Lookupuomid__cuomidUnit

Currencyunitbaseprice__cunitbasepriceUnit Base Price

Text (50)warehousecode__cwarehousecodeWarehouse Code

Long Text Areaproductdescription__cproductdescriptionWrite-In Product De-
scription

Text (100)writeinproduct__cwriteinproductWrite-In Product Id
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Ship-to object
This table shows the Custom Object Definition Details for the Ship-to object:

Definition DetailCustom Object

Ship-toSingular Label

Ship-to RecordsPlural Label

shiptoObject Name

shipto__cAPI Name

This table shows the standard fields on the Ship-to object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

Text(80)NameShip-to Name

This table shows the custom fields and relationships on the Ship-to object:

Data TypeAPI NameField NameField Label

Lookup(Account)Account__cAccountAccount

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Text(255)primaryaddressname __cprimaryaddressnameAttention of Name

Checkboxcansendbod__ccansendbodCan Send Bod

Text(255)carriername__ccarriernameCarrier Name

Text(255)carriernumber__ccarriernumberCarrier Number

Text(255)primaryaddresscity__cprimaryaddresscityCity

Text(255)primaryaddresscountry__cprimaryaddresscountryCountry

Emailemail__cemailEmail

Phonefax__cfaxFax

CheckboxInSync__cInSyncIn Sync

Text(255)locationid__clocationidLocation ID

Text(255)extlogicalid__cextlogicalidLogical ID

Lookup(Message
Source)

Message_Source__cMessage_SourceMessage Source
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Data TypeAPI NameField NameField Label

Phoneotherphone__cotherphoneOther Phone

Phonemainphone__cmainphonePrimary Phone

Text(255)extRecordId__cextRecordIdShip-to ID

Lookup(Lookup)SICCode__cSICCodeSIC Code

Text(100)primaryaddressstate__cprimaryaddressstateState/Province

Pickliststatuscode__cstatuscodeStatus

Long Text
Area(256)

primaryaddressstreet__cprimaryaddressstreetStreet

Text(255) (Exter-
nal ID) (Unique
Case Insensitive)

extid__cextidUnique ID

Number(18, 0)variationId__cvariationIdVariation Id

URL(255)website__cwebsiteWeb Site

Text(255)primaryaddresspostalcode__cprimaryaddresspostalcodeZip/Postal Code

Text(255)addresstype__caddresstypezz_Address Type

Lookup(Address)primaryaddress__cprimaryaddresszz_Primary Address

Lookup(Contract)primarycontactid__cprimarycontactidzz_Primary Contact

Text (255)primaryaddressline1__cprimaryaddressline1zz_Ship-to Line 1

Text (255)primaryaddressline2__cprimaryaddressline2zz_Ship-to Line 2

Text (255)primaryaddressline3__cprimaryaddressline3zz_Ship-to Line 3

Text (255)primaryaddressline4__cprimaryaddressline4zz_Ship-to Line 4

Text (255)primaryaddressline5__cprimaryaddressline5zz_Ship-to Line 5

Text (255)primaryaddressline6__cprimaryaddressline6zz_Ship-to Line 6

Shipment object
This table shows the Custom Object Definition Details for the Shipment object:

Definition DetailCustom Object

ShipmentSingular Label

ShipmentsPlural Label

shipmentObject Name
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Definition DetailCustom Object

shipment__cAPI Name

This table shows the standard fields on the Shipment object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

Text(80)NameShipment Name

This table shows the custom fields and relationships on the Shipment object:

Data TypeAPI NameField NameField Label

LookupAccount__cAccountAccount

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Dateactualshipdate__cactualshipdateActual Ship Date

Text(255)carriercode__ccarriercodeCarrier Code

Text(255)carriername__ccarriernameCarrier Name

LookupContact__cContactContact

Text(255)extlocationid__cextlocationidExt Location ID

Text(255)extsourceid__cextsourceidExt Source ID

Numbergrossweight__cgrossweightGross Weight

Text (18)grossweightuom__cgrossweightuomGross Weight UOM

Lookupincotermid__cincotermidInco Term

Dateloadingdate__cloadingdateLoading Date

Text(255)shipfrom_location__cshipfrom_locationLocation Code

Text (100)locationid__clocationidLocation ID

Text(255)shipfrom_location-
name__c

shipfrom_locationnameLocation Name

Long Text Areaownershiptransfer__cownershiptransferOwnership Transfer

Checkboxpartialshipflag__cpartialshipflagPartial Ship Flag

Text(255)referencename__creferencenameReference Name

Text(255)returnto_city__creturnto_cityReturn-to City
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Data TypeAPI NameField NameField Label

Text(255)returnto_code__creturnto_codeReturn-to Code

Text(255)returnto_contactname__creturnto_contactnameReturn-to Contact
Name

Text(255)returnto_country__creturnto_countryReturn-to Coun-
try/Region

Text(255)returnto_name__creturnto_nameReturn-to Name

Text(255)returnto_stateor-
province__c

returnto_stateorprovinceReturn-to
State/Province

Long Text Area(256)returnto_street__creturnto_streetReturn-to Street

Text(255)returnto_warehousec-
ode__c

returnto_warehousecodeReturn-to Ware-
house Code

Text(255)returnto_warehouse-
name__c

returnto_warehousenameReturn-to Ware-
house Name

Text(255)returnto_postalcode__creturnto_postalcodeReturn-to Zip/Postal-
code

Datescheduleddelivery-
date__c

scheduleddeliverydateScheduled Delivery
Date

Datescheduledshipdate__cscheduledshipdateScheduled Ship Date

Text(255)extRecordId__cextRecordIdShipment Id

Lookupextshipto__cextshiptoShip-to

Lookupshiptoaddress__cshiptoaddressShip-to Address

Formulashipto_city__cshipto_cityShip-to City

Text(255)shipto_contactname__cshipto_contactnameShip-to Contact
Name

Text(100)shipto_country__cshipto_countryShip-to Country

Text(255)shipto_locationname__cshipto_locationnameShip-to Location
Name

Text(255)shipto_name__cshipto_nameShip-to Name

Text(100)shipto_state__cshipto_stateShip-to State

Long Text Area(256)shiptostreet__cshiptostreetShip-to Street

Text(100)shipto_zip__cshipto_zipShip-to Zip

Pickliststatuscode__cstatuscodeStatus

Currencytotalamount__ctotalamountTotal Amount
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Data TypeAPI NameField NameField Label

Text(255)transportationmethod __ctransportationmethodTransportation
Method

Text(255)extid__cextidUnique ID

Numbervariationid__cvariationidVariation Id

Text(255)warehousecode__cwarehousecodeWarehouse Code

Text(255)warehousename__cwarehousenameWarehouse Name

LookupBill_to__cBill_tozz_Bill-to

LookupPay_from__cPay_fromzz_Pay-from

Text(255)returnto_line1__creturnto_line1zz_Return-to Line 1

Text(255)returnto_line2__creturnto_line2zz_Return-to Line 2

Text(255)returnto_line3__creturnto_line3zz_Return-to Line 3

Text(255)returnto_line4__creturnto_line4zz_Return-to Line 4

Text(255)returnto_line5__creturnto_line5zz_Return-to Line 5

Text(255)returnto_line6__creturnto_line6zz_Return-to Line 6

Formula (Text)shipto_city__cshipto_cityzz_Ship-to City

Formula (Text)shipto_country__cshipto_countryzz_Ship-to Coun-
try/Region

Formula (Text)shipto_line1__cshipto_line1zz_Ship-to Line 1

Formula (Text)shipto_line2__cshipto_line2zz_Ship-to Line 2

Formula (Text)shipto_line3__cshipto_line43zz_Ship-to Line 3

Formula (Text)shipto_line4__cshipto_line4zz_Ship-to Line 4

Formula (Text)shipto_line5__cshipto_line5zz_Ship-to Line 5

Formula (Text)shipto_line6__cshipto_line6zz_Ship-to Line 6

Formula (Text)shipto_stateor-
province__c

shipto_stateorprovincezz_Ship-to
State/Province

Formula (Text)shipto_postalcode__cshipto_postalcodezz_Ship-to
Zip/Postalcode

Shipment Line object
This table shows the Custom Object Definition Details for the Shipment Line object:
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Definition DetailCustom Object

Shipment LineSingular Label

Shipment LinesPlural Label

shipmentlineObject Name

shipmentline__cAPI Name

This table shows the standard fields on the Shipment Line object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameShipment Line Number

This table shows the custom fields and relationships on the Shipment Line object:

Data TypeAPI NameField NameField Label

Checkboxautoadjustflag__cautoadjustflagAuto Adjust

Text(20)countryoforgin__ccountryoforginCountry of Orgin

Long Text
Area(1024)

Description__cDescriptionDescription

Lookup(Product)productid__cproductidExisting Product

Text(100)extaccountingentityid__cextaccountingentityidExt Accounting Enti-
ty

Text(100)extlocationid__cextlocationidExt Location ID

Text(100)extsourceid__cextsourceidExt Source

Checkboxinspectionrequiredflag__cinspectionrequiredflagInspection Required

Number(14, 4)loadweight__cloadweightLoad Weight

Text(20)loadweightuom__cloadweightuomLoad Weight UOM

Text(100)locationid__clocationidLocation ID

Number(18, 0)orderlinenumber__corderlinenumberOrder Line Number

Text(100)ordernumber__cordernumberOrder Number

Number(14, 4)orderquantity__corderquantityOrder Quantity

Long Text
Area(1024)

productdescription__cproductdescriptionProduct Description

Picklistisproductoverridden__cisproductoverriddenSelect Product
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Data TypeAPI NameField NameField Label

Checkboxserviceflag__cserviceflagService Indicator

Master-Detail(Ship-
ment)

shipmentid__cshipmentidShipment

Number(18, 0)shipmentlinenumber__cshipmentlinenumberShipment Line Num-
ber

Number(14, 4)shippedquantity__cshippedquantityShipped Quantity

Text(20)shippedquantityuomshippedquantityuomShipping UOM

Pickliststatuscode__cstatuscodeStatus

Lookup(UOM)uomid__cuomidUom

Text(100)writeinproduct__cwriteinproductWrite-In Product

Social Media object
This table shows the Custom Object Definition Details for the Social Media object:

Definition DetailCustom Object

Social MediaSingular Label

Social MediaPlural Label

socialmediaObject Name

socialmedia__cAPI Name

This table shows the standard fields on the Social Media object:

Data TypeField NameField Label

Lookup (User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup (User)LastModifiedByLast Modified By

Auto NumberNameSocial Media Name

This table shows the custom fields and relationships on the Social Media object:

Data TypeAPI NameField NameField Label

Master-DetailContact__cContactContact

Picklistmediatype__cmediatypeMedia Type

URLuri__curiURI
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Territory object
This table shows the Custom Object Definition Details for the Territory object:

Definition DetailCustom Object

TerritorySingular Label

TerritoriesPlural Label

TerritoryObject Name

Territory__cAPI Name

This table shows the standard fields on the Territory object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

Text(80)NameTerritory Name

This table shows the custom fields and relationships on the Territory object:

Data TypeAPI NameField NameField Label

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity ID

Checkboxcansendbod__ccansendbodCan Send Bod

Long Text
Area(1024)

description__cdescriptionDescription

CheckboxInSync__cInSyncIn Sync

Text(255)locationid__clocationidLocation ID

Text(255)extlogicalid__cextlogicalidLogical ID

Lookup(Message
Source)

Message_Source__cMessage_SourceMessage Source

Pickliststatuscode__cstatuscodeStatus

Text(255)extRecordId__cextRecordIdTerritory Code

Text(255) (External
ID) (Unique Case In-
sensitive)

extid__cextidUnique Code

Number(18, 0)variationid__cvariationidVariation Id
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Warehouse object
This table shows the Custom Object Definition Details for the Warehouse object:

Definition DetailCustom Object

WarehouseSingular Label

WarehousesPlural Label

WarehouseObject Name

Warehouse__cAPI Name

This table shows the standard fields on the Warehouse object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User,Queue)OwnerOwner

Text(80)NameWarehouse Name

This table shows the custom fields and relationships on the Warehouse object:

Data TypeAPI NameField NameField Label

Text(255)extaccountingentityid__cextaccountingentityidAccounting Entity Id

Text(255)ERPLocation__cERPLocationERP Location

Lookup(Product)Product__cProductProduct

Text(255)SiteID__cSiteIDSite ID

Text(255)SiteName__cSiteNameSite Name

Text(255)UniqueID__cUniqueIDUniqueID

Text(255)warehouseid__cwarehouseareaidWarehouseAreaID

Text(255)WarehouseID__cWarehouseIDWarehouse ID

Text(255)WarehouseName__cWarehouseNameWarehouse Name

UOM Object
This table shows the Custom Object Definition Details for the UOM object:
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Definition DetailCustom Object

UOMSingular Label

UOM'sPlural Label

uomObject Name

uom__cAPI Name

UOMSingular Label

UOM'sPlural Label

uomObject Name

uom__cAPI Name

This table shows the standard fields on the UOM object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Text(80)NameName

This table shows the custom fields and relationships on the UOM object:

Data TypeAPI NameField NameField Label

Lookup(UOM)baseuom__cbaseuomBase UOM

Checkboxisschedulebaseunit__cisschedulebaseunitIs Schedule Base
Unit

Number(13, 5)Quantity__cQuantityQuantity

Master-Detail(Unit
Group)

unitgroup__cunitgroupUnit Group

Unit Group object
This table shows the Custom Object Definition Details for the Unit Group object:

Definition DetailCustom Object

Unit GroupSingular Label

Unit GroupsPlural Label

Infor Back Office Connect Administration Guide | 357

Custom objects and tabs



Definition DetailCustom Object

unitgroupObject Name

unitgroup__cAPI Name

This table shows the standard fields on the Unit Group object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

Text(80)NameUnit Group Name

This table shows the custom fields and relationships on the Unit Group object:

Data TypeAPI NameField NameField Label

Text(100)baseuomname__cbaseuomnameBase Unit Name

Text Area(255)description__cdescriptionDescription

zz_Account Bill-to Role object
This table shows the Custom Object Definition Details for the zz_Account Bill-to Role object:

Definition DetailCustom Object

zz_Account Bill-to RoleSingular Label

zz_Account Bill-to RolesPlural Label

accountbilltoroleObject Name

accountbilltorole__cAPI Name

This table shows the standard fields on the zz_Account Bill-to Role object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNamezz_Account Name
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This table shows the custom fields and relationships on the zz_Account Bill-to Role object:

Data TypeAPI NameField NameField Label

Master-Detail(Account)Account__cAccountzz_Account

Master-Detail(Bill-to)billto__cbilltozz_Bill-to

zz_Account Ship-to Role object
This table shows the Custom Object Definition Details for the zz_Account Ship-to Role object:

Definition DetailCustom Object

zz_Account Ship-to RoleSingular Label

zz_Account Ship-to RolesPlural Label

accountshiptoroleObject Name

accountshiptorole__cAPI Name

This table shows the standard fields on the zz_Account Ship-to Role object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNamezz_ID

This table shows the custom fields and relationships on the zz_Account Ship-to Role object:

Data TypeAPI NameField NameField Label

Master-Detail(Account)account__caccountzz_Account

Master-Detail(Ship-to)shipto__cshiptozz_Ship-to

zz_BillTo-PayFrom Role object
This table shows the Custom Object Definition Details for the zz_BillTo-PayFrom Role object:

Definition DetailCustom Object

zz_BillTo-PayFrom RoleSingular Label

zz_BillTo-PayFrom RolesPlural Label
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Definition DetailCustom Object

billtopayfromroleObject Name

billtopayfromrole__cAPI Name

This table shows the standard fields on the zz_BillTo-PayFrom Roles object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNamezz_Name

This table shows the custom fields and relationships on the zz_BillTo-PayFrom Roles object:

Data TypeAPI NameField NameField Label

Master-Detail(Bill-to)billto__cbilltozz_Bill To

Master-Detail(Pay-from)payfrom__cpayfromPay From

zz_Carrier Party object
This table shows the Custom Object Definition Details for the zz_Carrier Party object:

Definition DetailCustom Object

zz_Carrier PartySingular Label

zz_Carrier PartyPlural Label

carrierpartyObject Name

carrierparty__cAPI Name

This table shows the standard fields on the zz_Carrier Party object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User, Queue)OwnerOwner

Text(80)Namezz_Carrier Name
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This table shows the custom fields and relationships on the zz_Carrier Party object:

Data TypeAPI NameField NameField Label

Text(255) (External ID)
(Unique Case Insensi-
tive)

carriernumber__ccarriernumberCarrier Number

zz_Classification Code object
This table shows the Custom Object Definition Details for the zz_Classification Codes object:

Definition DetailCustom Object

zz_Classification CodeSingular Label

zz_Classification CodesPlural Label

classificationcodeObject Name

classificationcode__cAPI Name

This table shows the standard fields on the Classification Codes object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User,Queue)OwnerOwner

Text(80)Namezz_Code

This table shows the custom fields and relationships on the Classification Codes object:

Data TypeAPI NameField NameField Label

Text(255)classificationvalue__cclassificationvalueClassification Value

Long Text
Area(1024)

classificationdescription__cclassificationdescriptionDescription

Lookup(Product)productid__cproductidProduct

zz_Sales Order Address object
This table shows the Custom Object Definition Details for the zz_Sales Order Address object:
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Definition DetailCustom Object

zz_Sales Order AddressSingular Label

zz_Sales Order AddressesPlural Label

salesorderaddressObject Name

salesorderaddress__cAPI Name

This table shows the standard fields on the zz_Sales Order Address object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup (User,Queue)OwnerOwner

Auto NumberNamezz_Name

This table shows the custom fields and relationships on the zz_Sales Order Address object:

Data TypeAPI NameField NameField Label

Picklistaddresstype__caddresstypezz_Address Type

Text(255)attentionofname__cattentionofnamezz_Attention of
Name

Text(255)city__ccityzz_City

Text(255)country__ccountryzz_Country

Text(255)line1__cline1zz_Line 1

Text(255)line2__cline2zz_Line 2

Text(255)line3__cline3zz_Line 3

Text(255)line4__cline4zz_Line 4

Text(255)line5__cline5zz_Line 5

Text(255)line6__cline6zz_Line 6

Text(255)stateorprovince__cstateorprovincezz_State/Province

Text(255)postalcode__cpostalcodezz_Zip/Postal Code

zz_Serial Lot object
This table shows the Custom Object Definition Details for the zz_Serial Lot object:
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Definition DetailCustom Object

zz_Serial LotSingular Label

zz_Serial LotsPlural Label

serializedlotObject Name

serializedlot__cAPI Name

This table shows the standard fields on the zz_Serial Lot object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto Numberzz_Serial Lot NameSerial Lot Name

This table shows the custom fields and relationships on the zz_Serial Lot object:

Data TypeAPI NameField NameField Label

Master-Detail(Cus-
tomer Return Line)

customerreturnline__ccustomerreturnlinezz_Customer Return
Line

Text(100)lotnumber__clotnumberzz_Lot Number

Text(100)lotselection__clotselectionzz_Lot Selection

Text(100)serialnumber__cserialnumberzz_Serial Number

zz_Ship-to Bill-to Role object
This table shows the Custom Object Definition Details for the zz_Ship-to Bill-to Role object:

Definition DetailCustom Object

zz_Ship-to Bill-to RoleSingular Label

zz_Ship-to Bill-to RolesPlural Label

shiptobilltoroleObject Name

shiptobilltorole__cAPI Name

This table shows the standard fields on the zz_Ship-to Bill-to Role object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By
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Data TypeField NameField Label

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNamezz_ID

This table shows the custom fields and relationships on the zz_Ship-to Bill-to Role object:

Data TypeAPI NameField NameField Label

Master-Detail(Bill-to)billto__cbilltozz_Bill To

Master-Detail(Ship-to)shipto__cshiptozz_Ship To

zz_Shipto-Carrier Party Role object
This table shows the Custom Object Definition Details for the zz_Shipto-Carrier Party Role object:

Definition DetailCustom Object

zz_Shipto-Carrier Party RoleSingular Label

zz_Shipto-Carrier Party RolesPlural Label

shiptocarrierpartyroleObject Name

shiptocarrierpartyrole__cAPI Name

This table shows the standard fields on the zz_Shipto-Carrier Party Role object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Auto NumberNamezz_ID

This table shows the custom fields and relationships on the zz_Shipto-Carrier Party Role object:

Data TypeAPI NameField NameField Label

Master-Detail(zz_Car-
rier Party)

carrierparty__ccarrierpartyCarrier Party

Master-Detail(Ship-
to)

shipto__cshiptoShipto
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zz_Transaction Address object
This table shows the Custom Object Definition Details for the zz_Transaction Address object:

Definition DetailCustom Object

zz_Transaction AddressSingular Label

zz_Transaction AddressesPlural Label

transactionaddressObject Name

unitgroup__cAPI Name

This table shows the standard fields on the zz_Transaction Address object:

Data TypeField NameField Label

Lookup(User)CreatedByCreated By

PicklistCurrencyIsoCodeCurrency

Lookup(User)LastModifiedByLast Modified By

Lookup(User,Queue)OwnerOwner

Auto NumberNamezz_Transaction Address Name

This table shows the custom fields and relationships on the zz_Transaction Address object:

Data TypeAPI NameField NameField Label

Picklistaddresstype__caddresstypezz_Address Type

Text(255)attentionofname__cattentionofnamezz_Attention of
Name

Text(255)city__ccityzz_City

Text(255)country__ccountryzz_Country

Text(255)line1__cline1zz_Line 1

Text(255)line2__cline2zz_Line 2

Text(255)line3__cline3zz_Line 3

Text(255)line4__cline4zz_Line 4

Text(255)line5__cline5zz_Line 5

Text(255)line6__cline6zz_Line 6

Text(255)stateorprovince__cstateorprovincezz_State/Province

Text(255)postalcode__cpostalcodezz_Zip/Postal Code
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Glossary

Account
An account is a customer or prospect that is synced with
ERP. See "Enterprise Resource Planning (ERP)" on page
367. Salesforce, the Account Type field pick list is used to
define the account as a customer or prospect.

back office system
A system that manages your financial, manufacturing, or
distribution processes and acts as the System of Record
(SOR) for your business.

BOD
See Business Object Document.

BOD field mapping
A collection of associations between Infor Back Office
Connect and the back office system (ERP) fields to support
data synchronization and integration between the two
systems.

Business Object Document (BOD)
The common XML message structure provided by OAGIS
is the BOD, which provides a message architecture based
on the following reusable components:

• Nouns describe a common business object and are
composed of components, which are basic building
blocks shared across all nouns.

• Verbs describe the action to be applied to the noun.
For example, the ProcessPurchaseOrder BOD is
constructed from the PurchaseOrder Noun and the
Process Verb. BOD messages are based on common
nouns combined with a verb.

corporate currency
The currency of the organization, which is the currency in
the location where the corporate headquarters are located.
The Salesforce administrator sets the corporate currency.
See "multi-currency" on page 368.

CRM
See Customer Relationship Management.

Customer Relationship Management (CRM)
A tool that is used to manage outward-facing front office
sales and service activities.

Demilitarized Zone (DMZ)
A physical or logical sub-network that contains and exposes
an organization's external services to a larger untrusted
network, usually the Internet.

DMZ
See Demilitarized Zone.

domain data
A list of system-defined values for an attribute. Domain
data can be displayed within a window, list, check box, or
radio button. Typically, you can select only one value for
an attribute. For example, domain data for address type
can include home or office.

Enterprise Resource Planning (ERP)
Provides the functionality used to manage the demands of
complex manufacturing, distribution, and service industries.
It is an "On Premise" solution.

entity
A type of record in Infor Back Office Connect or Infor ERP.
Orders, invoices, accounts, contacts, or items are all
examples of an entity.

entity record
A specific occurrence of an entity. An ERP customer record,
a product, or an Infor Back Office Connect account are
examples of an entity record.

ERP
See Enterprise Resource Planning.

ESB
A software architecture model used for designing and
implementing the interaction and communication between
mutually interacting software applications.

exception
An abnormal condition or error that occurs during the
integration between a source entity and a destination entity.

External ID
An External ID is a custom field with an External ID attribute
that contains a unique record identifier from a system
outside of Salesforce, such as an ERP. See Salesforce
documentation.
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filtered lookup
A filtered lookup is an administrator setting that restricts
the valid values and lookup dialog results for a lookup,
master-detail, and hierarchical relationship fields.

Infor ION Proxy Server
The Infor ION Proxy Server is deployed on Infor Cloud to
integrate Infor applications with each other and with outside
applications. The Infor ION Proxy Server consists of the
ION Proxy Container and the ION Proxy XMPP Server.
See Integrated Open Network Platform.

Integrated Open Network Platform (ION)
An ESB engine that is deployed on-premise. It allows
modeling the integration of different Infor products to
interact seamlessly. The runtime is mainly JMS-based
solution although it provides different types of connectors
allowing any Infor solution to get connected.

ION
See Integrated Open Network Platform.

map
A collection of associations between fields in one Infor Back
Office Connectobject with fields in another ERP object.

master data
Master data is used as the main data set which is also used
by the transactional data. For example, an Account's master
data list includes a list of all of the available customers.

multi-currency
When multi-currency is enabled in Salesforce, users and
customers can view prices of products and services in
multiple currencies. International organizations can use
multiple currencies in opportunities, forecasts, reports,
quotes, and other currency fields. In addition to the
corporate currency, the system includes a list of active
currencies and their conversion rates relative to the
"corporate currency" on page 367. Every user also has a
personal currency, which is used as the default currency
their quotas, forecasts (depending on which forecasting
version you use), opportunities, quotes, and reports. Users
can also create opportunities and enter amounts using
other active currencies.

object
A type of record in the ERP. For example, orders, invoices,
accounts, customers, products, or items are objects.

object record
A specific occurrence of an object. An ERP customer
record, a product, or an Infor Back Office Connect account
are examples of an object record.

Return Material Authorization (RMA)
Customer returns a previously purchased product. A RMA
is also known as a customer return.

RMA
See Return Material Authorization.

Salesforce.com (SFDC)
A web-architected, cloud-based internet application.

Salesforce.com Adapter
The Salesforce.com Adapter exposes a set of web-services
to create the communication channel between the
Salesforce application and ERP.

SFDC
See Salesforce.com.

SOR
See System of Record.

System of Record (SOR)
A system that maintains information.

transactional data
A set of data in a data-processing area in which the
incidence of the data is essentially unpredictable, for
example shipments and invoices.

variation ID
A variation ID is assigned to a BOD by Infor Back Office
Connect to identify the number of times a record with a
specific set of attributes has been published for the
accounting entity and location. The variation ID is used to
ensure that Infor Back Office Connect is reading in the
latest version of the BOD. For example, a BOD with a
variation ID of 5 is received and read in Infor Back Office
Connect. Infor Back Office Connect then receives another
BOD for the same record with a variation ID of 4. Upon
receiving the BOD with the variance ID of 4, this BOD is
assigned a processing status of 99 to indicate that the
variation ID of 4 is older then the variation ID of 5.
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